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About this document

Purpose

This document provides the information and procedures necessary to install, self-test and 
turn up the 1665 Data Multiplexer (1665 DMX) system.

Product naming

As a result of the Alcatel-Lucent merger and new corporate branding guidelines, 
Metropolis®  DMX Access Multiplexer (DMX)  (Metropolis® DMX is now Alcatel-Lucent 
1665 Data Multiplexer (1665 DMX). The company logo and product name will be 
changed on many items including the shelves, circuit packs, cables, software banners, the 
WaveStar® CIT, documentation, ED drawings, software CD labels, configurators, OMS, 
and INC. Please be patient as we migrate each of these items. You may experience a 
period of transition when you may receive a mixture of the company logo and product 
names on any of these items. For example, a document may say 1665 DMX while the 
software says Metropolis® DMX. Despite the name change, rest assured that Metropolis® 

DMX and 1665 DMX are the same product with the same product features, 
interoperability, and operations remain unchanged

Reason for reissue

This document is being reissued to include information about new features and hardware 
associated with Release 7.1 and the name change to Alcatel-Lucent 1665 Data Multiplexer 
(1665 DMX).

Intended audience

This installation manual is intended to provide individuals and customers the information 
and procedures necessary to install, self-test and turn up the 1665 DMX system.

This manual is not a service or operations manual. Refer to 365-372-301, 1665 DMX Data 
Multiplexer User Operations Guide for any activities involving circuit turn-up, regular 
maintenance, or trouble analysis.
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How to use this document

This manual is divided into the following sections with a brief description of the contents 
of each major part/chapter/appendix:

About this document

This chapter describes the purpose, intended audience, reason for reissue, and 
organization of this document. This section references related documentation and explains 
how to order, make comments or recommend changes to this document.

Part I: “1665 Data Multiplexer (1665 DMX) physical installation and powering”

Chapter 1, “Equipment and cable installation for 1665 Data Multiplexer (1665 DMX)”

This chapter provides the information and procedures for installing and cabling the 1665 
DMX system. It provides the additional cabling information needed for the added DS1 
and DS3 capacity.

Chapter 2, “Powering and initial circuit pack installation for 1665 Data Multiplexer 
(1665 DMX)”

This chapter provides information for verifying that the shelf is being supplied with the 
proper power and provides instructions for circuit pack installation.

Part II: “1665 Data Multiplexer (1665 DMX) stand-alone installation tests”

Chapter 3, “Software download and circuit pack installation”

Software download and circuit pack installation is covered in this chapter.

Chapter 4, “Installation tests”

This chapter verifies proper transmission cabling installation and functionality.

Chapter 5, “Operational tests”

This chapter provides instructions to test protection switching and the non-transmission 
cabling. This section is not intended to replace acceptance test procedures.

Part III: “1665 Data Multiplexer (1665 DMX) ring setup and testing”

Chapter 6, “Ring setup and testing: integration procedures”

This chapter provides the tests to verify proper ring fiber cabling and protection switching.
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Part IV: “1665 Data Multiplexer (1665 DMX) supplementary information and 
installation checklist”

Appendix A, “Laser safety and classifications and Electrostatic Discharge (ESD) 
considerations”

This appendix provides lightwave and laser safety information and precautions.

Appendix B, “Fiber cleaning”

This appendix describes the Lucent recommended method for the cleaning and inspection 
of optical connectors using specific tools and materials that have been proven to be 
effective in the assembly and testing of optical equipment.

Appendix C, “Installing fiber connectors and LBOs”

This appendix provides procedures for installing and removing the types of Line Build 
Out (LBO) units and fiber connectors onto input and output ports found on the 1665 DMX 
circuit packs.

Appendix D, “Backplane pin replacement”

This appendix provides information and the procedures used when a pin or blade on the 
1665 DMX backplane has been bent or broken.

Appendix E, “Installation checklist”

This appendix provides a checklist to ensure that all necessary procedures have been 
completed. Use of the installation checklist is required to ensure a quality installation, all 
completed tasks should be checked off and those not completed should be duly noted as to 
the reason why. This checklist should be turned in as part of your job complete paperwork.

Appendix F, “Fiber labeling”

This appendix provides a description of how to label the fiber.

Appendix G, “Pluggable transmission module installation”

Provides examples of various SFP installation.

Appendix H, “Technical support”

This appendix provides information on Technical Support Services.

Glossary

The Glossary provides definitions for telecommunication acronyms and terms.
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Index

The Index supplies users with specific subjects and corresponding page numbers to find 
necessary information.

Safety information

This information product contains hazard statements for your safety. Hazard statements 
are given at points where safety consequences to personnel, equipment, and operation may 
exist. Failure to follow these statements may result in serious consequences.

Safety precautions

Adhere to the following safety precautions:

• Electrostatic discharge (ESD)

You must be properly grounded when making contact with the 1665 Data Multiplexer 
(1665 DMX) frame and handling circuit packs, disk drives, and tapes. Wrist strap ground 
cords should be routinely tested for the minimum 1-megohm resistance.

• Plug-in storage

Circuit packs should be stored in static-safe packaging or in a grounded cabinet.

For additional safety precautions, please see the 1665 Data Multiplexer (1665 DMX) User 
Operations Guide.

Laser safety

For more detailed information and safety precautions, refer to Appendix A, “Laser safety 
and classifications and Electrostatic Discharge (ESD) considerations”.

Conventions used

Italic typeface denotes a particular product line or information product.

Helvetica Bold typeface signifies a window, section, command or parameter used with 
the TL1 Command Builder.

Helvetica typeface indicates a faceplate or 1665 DMX label designation, as in the 
ACTIVE LED on a circuit pack.

CAUTION

Laser safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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Courier Bold indicates a TL1 command typed in a terminal window by the user, as in 
act-user:LT-DMX:LUC01:ctag::DMX2.5G10G;

Courier typeface indicates the system or PC response to a command.

For the remainder of this document, “1665 DMX” is used in place of 1665 Data 
Multiplexer (1665 DMX) in most cases.

Related information

1665 DMX Documentation Set

The following is a list of related documents:

• 365-372-300R7.1 1665 Data Multiplexer, Release 7.1 Applications and Planning 
Guide

• 365-372-301R7.1 1665 Data Multiplexer, Release 7.1 User Operations Guide

• 365-372-302R7.1 1665 Data Multiplexer, Release 7.1 Alarm Messages and 
Troubleclearing Guide

• 365-372-304R7.1 1665 Data Multiplexer, Release 7.1 Installation Manual

• 365-372-306R7.1 1665 Data Multiplexer, Release 7.1 TL1 Message Details

• 1665 Data Multiplexer Software Release Description

– Paper - 109665943

– CD-ROM -109665950

1665 DMX drawings

• ED8C871-10 1665 Data Multiplexer, Release 1.0 - 7.1.0 Engineering and Ordering 
Information

• ED8C871-20 1665 Data Multiplexer, Release 1.0 - 7.1.0 Interconnect Information

Document support

Alcatel-Lucent provides a referral telephone number for document support. Use this 
number to report errors or to ask questions about the document. This is a non-technical 
number. The referral number is 1 (888) 727 3615 (continental United States) or +1 (630) 
713 5000 (for all countries). 

Technical support

For technical support, contact your local customer support team. Reach them via the web 
at http://alcatel-lucent.com/support at or the telephone number listed under the Technical 
Assistance Center menu at http://www.alcatel-lucent.com/contact. Refer to Appendix H, 
“Technical support” for more information.

http://alcatel-lucent.com/support
http://alcatel-lucent.com/support
http://www.alcatel-lucent.com/contact
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How to order

To order Alcatel-Lucent documents and courses, use the following websites, or the e-mail, 
phone, and fax contacts linked from “Contact Us” on the following sites: 

Documentation:

http://www.lucentdocs.com/

Training:

http://training.lucent.com/

How to comment

To comment on this information product, go to the Online Comment Form 
(http://www.lucent-info.com/comments) or email your comments to the Comments 
Hotline (comments@alcatel-lucent.com).

Packaging collection and recovery requirements

Countries, states, localities, or other jurisdictions may require that systems be established 
for the return and/or collection of packaging waste from the consumer, or other end user, 
or from the waste stream. Additionally, reuse, recovery, and/or recycling targets for the 
return and/or collection of the packaging waste may be established.

For more information regarding collection and recovery of packaging and packaging 
waste within specific jurisdictions, please contact the Alcatel-Lucent Field 
Services/Installation - Environmental Health and Safety organization.

For installations not performed by Alcatel-Lucent, please contact the Alcatel-Lucent 
Customer Support Center at:

Technical Support Services, Alcatel-Lucent

• Within the United States: 1 (866) 582-3688, prompt 1

• From all other countries: +1 (630) 224 4672, prompt 2

Recycling/take-back/disposal of product

Electronic products bearing or referencing the symbol shown below, when put on the 
market within the European Union, shall be collected and treated at the end of their useful 
life in compliance with applicable European Union and local legislation. They shall not be 

http://www.lucentdocs.com
https://training.lucent.com
http://www.lucent-info.com/comments/enus
http://www.lucent-info.com/comments
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disposed of as part of unsorted municipal waste. Due to materials that may be contained in 
the product, such as heavy metals or batteries, the environment and human health may be 
negatively impacted as a result of inappropriate disposal.

Important! In the European Union, a solid bar under the crossed-out wheeled bin 
indicates that the product was put on the market after 13 August 2005.

Moreover, in compliance with legal requirements and contractual agreements, where 
applicable, Alcatel-Lucent will offer to provide for the collection and treatment of Alcatel-
Lucent products at the end of their useful life. Alcatel-Lucent will also offer to provide for 
the collection and treatment of existing products displaced by Alcatel-Lucent equipment.

For information regarding take-back of equipment by Alcatel-Lucent, or for more 
information regarding the requirements for recycling/disposal of product, please contact 
your Alcatel-Lucent Account Manager or Alcatel-Lucent Take-Back Support at 
takeback@alcatel-lucent.com.
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Part I:  1665 Data Multiplexer (1665 
DMX) physical installation and 
powering

........................................................................................................................................................................
Overview

Purpose

Part I covers the physical mounting of the 1665 Data Multiplexer (1665 DMX) shelf, the 
running and connecting of power cables, interconnecting cables, alarm cables, and as 
required, external timing and communication cables. This section also covers initial circuit 
pack installation (not seated).

Important! The high capacity shelf does not require the installation of an additional 
fan shelf since the fan unit is integral to the shelf itself. Check Figure 1-1, “1665 DMX 
High-Capacity shelf backplane” (p. I-2) to determine if the shelf is a 1665 DMX High-
Capacity shelf shelf. If the shelf you are installing is NOT equipped with the additional 
middle connectors (J20 - J27), refer to the 1665 DMX Release 5.0 Installation Manual. 
Installation details for the 1665 DMX standard shelf are not included in this issue.
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Figure 1-1 1665 DMX High-Capacity shelf backplane

Contents

This section is organized into the following chapters:

Tools, test equipment, and accessories

This section lists the tools, test equipment and accessories needed to perform all the 
procedures in this installation manual.

Listed below are the required tools, test equipment and accessories.

J8
D OUT

J6
C OUT

J19
INTEROP

J16
IAOLAN

J3
B OUT

J1
A OUT

J4
B IN

J2
A IN

J13
ALM MULT

J12
ALM

J18
DLAN

J10
X.25

J5
C IN

J7
D IN

NC-DMX-156

J22 C IN

J23 D IN

J26 C OUT

J27 D OUT

J20 A IN

J21 B IN

J24 A OUT

J25 B OUT

IN

OUT

EXP2 EXP1

IN

OUT

CTL

-48RTNB

P15
J14

SYNC2
J11

MISC
J17

MODEM

J9
SYNC1 P14

-48RTNA

-48VA-48VB

CTL

J15
FAN

Equipment and cable installation for 1665 Data Multiplexer (1665 DMX) Chapter 1

Powering and initial circuit pack installation for 1665 Data Multiplexer 
(1665 DMX)

Chapter 2

Quantity Description Comments

Screwdriver(s) A screwdriver(s) with the appropriate head(s) is 
(are) required for securing the mounting screws, 
repositioning the mounting brackets, installing the 
interfacing cables, and for setting the circuit 
breakers to the OFF position.



1665 Data Multiplexer (1665 DMX) physical installation 
and powering

............................................................................................................................................................................................................................................................

365-372-304R7.1
Issue 1, November 2007

I - 3

1 Thomas & Betts* R-
5648B Crimping Tool

The crimping tool and wire stripper are only 
required if installing DS3 cables. The replacement 
cassette is for the wire stripper tool.

1 Paladin† Coaxial Wire 
Stripper R-5648B

Replacement Paladin† 
Cassette R-5648B D5

1 Wire-Wrap Gun
R-4496A

The wire-wrap gun is required for terminating 
DS1 cable and must be able to accommodate 24 
gauge wire.

1 ESD Wrist Strap
R-4987C

A wrist strap must be worn when handling circuit 
packs. Use the electrostatic discharge (ESD) jack 
provided on the shelf.

1 Torque Wrench
R-5952

A torque wrench (50-250 IN-LBS) is used when 
tightening the 1665 DMX shelf to the frame. It is 
also used when reattaching the mounting brackets 
to the 1665 DMX shelf.

1 Multimeter (Optional)
ITE-6379C

The voltmeter must be capable of measuring DC 
voltage in the 40 to 60 volt range. The use of the 
voltmeter is optional since the shelf will alarm or 
shut down if the proper voltage is not supplied.

1 Ohmmeter

ITE-6379C

An ohmmeter is required to verify that the 1665 
DMX is properly grounded.

1 DS1 Error Rate Test Set
ITE-7113

A DS1 error rate test set is required for testing of 
DS1 cabling. A T-BERD 2209 or equivalent is 
recommended.

1 DS3 Error Rate Test Set
ITE-7113

A DS3 error rate test set is required for testing of 
DS3 cabling. A T-BERD 209 or equivalent is 
recommended.

1 SONET Optical Test Set An OC3, OC12 or OC48 test set as required for 
testing of optical circuit packs. An Agilent 
OmniBER 718 or equivalent is recommended.

Quantity Description Comments
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2 or 3 LC-Type Optical Fiber 
Jumper ITE-7169 
(108918269)

Two optical fiber jumpers with LC type 
connectors are required to optically loop the 1665 
DMX shelf for test purposes. In addition, for 
shelves containing optical circuit packs in any of 
the Function Unit slots, a single optical fiber 
jumper is required for testing of the individual 
ports.

2 or 3 15-dB LC-Type LBO 
ITE-7196 (108279480)

Two 15-dB LBOs are required when optically 
looping the 1665 DMX shelf for test purposes. In 
addition, for shelves containing optical circuit 
packs in any of the Function Unit slots, a single 
15-dB LBO is required for testing of the 
individual ports

2 20-dB LC-Type LBO 
ITE-7196 (108279530)

Two 20-dB LBOs are required when optically 
looping the 1665 DMX shelf equipped with 
LNW60.

2 LC-Type Optical Fiber 
Jumper (108918269)

Two optical fiber jumpers with LC type 
connectors are required to optically loop the 1665 
DMX shelf for test purposes.

Noyes OFS 300-200X 
Optical Fiber Scope
ITE-7129

Optical Fiber Scope

2.5 mm Universal 
Adapter Cap ITE-7129 
D1

For use with the Noyes OFS 300-200X Optical 
Fiber Scope

1.25mm Universal 
Adapter Cap ITE-7129 
D2

Noyes VFS-1 ITE-7187 
Video Fiber Scope1

This equipment may not be necessary at all 
locations. It is to be used when the ports need to 
be verified for cleanliness. If care is exercised 
when cleaning fibers, the video scope may not be 
needed

Individual Presaturated 
Alcohol Wipes ITE-
7136

99% pure isopropyl alcohol

1 CLETOP Cleaning 
Cassette ITE-7137

Type A Reel

Quantity Description Comments
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PC and cable requirements for WaveStar® CIT

This section lists the required equipment needed to run the WaveStar® CIT software with 
the 1665 DMX. 

1 CLETOP Cleaning
Cassette Replacement
Reel
ITE-7137 D1

Type A Reel

Luminex Stick Port 
Cleaners ITE-7134 & 
ITE-7135

1.25 mm and 2.5 mm sizes

Luminex Cloth R-6033 5.5” x 5.5”
* Registered trademark of Thomas & Betts Corporation
† Registered trademark of Paladin Corporation. 

..............................................................................................................................................

Quantity Description Comments

Quantity Description Comments

1 Personal Computer 
(PC)

See PC minimum requirements 
below.

1 CIT Interface Cable 8-ft. long RJ45 to 9-pin D-sub 
serial cable (Comcode 
848748869).

1 Cross Over LAN 
Cable (If CIT cable is 
not available)

10-ft. long cable (Comcode 
109321810) or equivalent.
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PC minimum requirements

It is anticipated that most customers will dedicate a laptop or personal computer (PC) to 
run the WaveStar® CIT software. However, any properly configured computer will also 
suffice. The following table shows the requirements for the computer:

Table 1-1 Computer requirements

Important! Minimum requirements are sufficient to run two to three GUI System 
Views, unless otherwise noted. Recommended requirements are intended to be used as 
a general guideline to optimize WaveStar® CIT performance. As the CIT is used with 
multiple NE connections and multiple NE types, the processor type and speed and the 
memory size will all factor into CIT performance.

Components Minimum Recommended

Processor Pentium 266 MHz Pentium III 500 MHz

RAM (1 system 
view)

128 MB 256 MB

RAM (up to 5 
system views)

256 MB 256 MB

Virtual Memory 139 MB 267 MB

Available Hard 
Disk Space*

* Available hard disk space required to install and store the CIT and Generic Software
is approximately 250 MB (it is 550 MB, if all graphical packages are installed). The
additional disk space specified is to provide hard disk space to store DMX backup
files.

500 MB 600 MB

Video 800X600 256 Colors
(8 Bit)

1024X768 16 Million 
Colors (24 Bit)

Network Interface 10/100 baseT Network 
Card

10/100 baseT Network 
Card

CD ROM Drive Required Required

Operating System Windows® NT 4.0, 
Windows® 2000 or 
Windows® XP

Windows® NT 4.0, 
Windows® 2000 or 
Windows® XP

Internet Browser Internet Explorer
5.0/5.5/6.0

Internet Explorer
5.0/5.5/6.0
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1 Equipment and cable installation 
for 1665 Data Multiplexer (1665 
DMX)

............................................................................................................................................................................................................................................................

Overview

Purpose

This section provides installation and cabling instructions for the 1665 Data Multiplexer 
(1665 DMX). 

Contents

This chapter provides information on the following topics: 

Planning  1-3

Connector references  1-7

Inspection  1-8

1665 DMX High-Capacity shelf installation  1-9

Heat baffle installation  1-14

Power cable and cable bracket installation  1-16

Fiber management installation (optional)  1-27

Installing the fiber ducts (optional)  1-31

Cable and optical fiber installation  1-32

DS1 cable installation  1-34

DS3/EC1 and 48TMUX cable installation  1-41

12TMUX (LNW18) cable installation  1-54

10/100BaseT backplane Ethernet cable installation  1-58

Ethernet cabling to SFP modules on circuit pack faceplates  1-62

IAO LAN and TCP/IP cable installation  1-64
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Modem cable installation  1-69

Sync cable installation  1-72

Office alarm cable installation  1-78

Miscellaneous (environmental) discrete telemetry cable installation  1-84

Main optical fiber installation (OC-12, OC-48, OC-192)  1-88

Fiber installation for low-speed packs  1-90

1000Base-F and 100Base-F fiber installation  1-92

Fibre channel fiber installation  1-94

CIT cable installation  1-96

Final operations  1-99
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Planning

Description

This section provides information about the following:

• Tools, test equipment and accessories

• Mounting options

• Cabling checklist.

Tools, test equipment and accessories

Listed below are the tools, test equipment and accessories necessary to perform the 
procedures in this section. Installers should have both metric and English unit tools.

Quantity Description Comments

Screwdriver(s) A screwdriver(s) with the appropriate head(s) is 
(are) required for securing the mounting screws, 
repositioning the mounting brackets, installing the 
interfacing cables, and for setting the circuit 
breakers to the OFF position.

1 Thomas & Betts*

R-5648B Crimping Tool
The crimping tool, wire stripper and soldering iron 
are only required if installing DS3 cables. The 
replacement cassette is for the wire stripper tool.1 Paladin† Coaxial Wire 

Stripper
R-5648B D5

Replacement Paladin† 
Cassette R-5648B D5

1 Wire-Wrap Gun
R-4496A

The wire-wrap gun is required for terminating DS1 
cable and must be able to accommodate 24 gauge 
wire.

1 ESD Wrist Strap
R-4987C

A wrist strap must be worn when handling circuit 
packs. Use the electrostatic discharge (ESD) jack 
provided on the shelf.

1 Multimeter (Optional) 
ITE-6379

The voltmeter must be capable of measuring DC 
voltage in the 40- to 60-volt range. The use of the 
voltmeter is optional since the shelf will alarm or 
shut down if the proper voltage is not supplied.
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Mounting options

The mounting brackets on the 1665 DMX High-Capacity shelf are designed to allow for 
mounting in the following:

• Standard 23-inch wide network bay frames

The recommended network bay frames are the ED-8C500 and the ED-8C501 (rear 
access only). Refer to Figure 1-4, “Typical 1665 DMX High-Capacity shelf bay 
mounting arrangements” (p. 1-12) for 1665 DMX shelf placement in a network bay 
frame. 

• Seismic 23-inch network bay frame

The ED-8C800-500 and ED-8C801-501 seismic network bay frames are designed for 
use in all earthquake zones, and in general, do not require top support at the 7-foot 
level. These frames meet Pacific Bell Equipment Framework Standard PBS-000-
102PT. 

• 19-inch bay frames

• 23-inch wide EIA-Type bay frames

1665 DMX added to the Lambda Unite® MSS configurations 

In order for the 1665 DMX shelf to be placed in a NEBS-2000 Cabinet frame combined 
with Lambda Unite® MSS, mounting kit 848856514 is required. For a more complete 
view of mounting the 1665 DMX into the Lambda Unite® Frame, see SIG-L-WW-161A, 
1665 DMX added to the Lambda Unite® MSS Configurations.

Cabling checklist

This section briefly describes cabling information. For information regarding available 
cable lengths and ordering comcodes, refer to ED8C871-10.

Table 1-1, “Cable requirements and options” (p. 1-5) lists available cables.

1 Torque Wrench
ITE-5952

A torque wrench (50-250 IN-LBS) is used when 
tightening the 1665 DMX High-Capacity shelf to 
the frame. It is also used when reattaching the 
mounting brackets to the 1665 DMX High-Capacity 
shelf.

1 Ohmmeter ITE-6379 An ohmmeter is required to verify that the 1665 
DMX is properly grounded.______________________________________________________________

* Registered trademark of Thomas & Betts Corporation
† Registered trademark of Paladin Corporation. 

Quantity Description Comments
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Table 1-1 Cable requirements and options

Notes:  

1. One -48VA and -48VB main power feeder is required per shelf. Many varieties of 45-amp 
connector cables are available as well. 

2. One Fan Cable (848839551) is shipped with each 1665 DMX High-Capacity shelf.
3. One CIT Cable Assembly or Crossover LAN cable is required for PC interface with the 1665 

DMX High-Capacity shelf (not included with equipment).

4. Two DS1 Cable Assemblies are required for each Function Unit equipped for 28 DS1 service 
(LNW6, LNW7). Four DS1 Cable Assemblies are required for each Function Unit equipped 
for 56 DS1 service (LNW8). Each DS1 Cable Assembly consists of two separate cable 
assemblies, both containing 28 pairs of 24 gauge cable. One cable is for input and the other 
cable is for output.

Cable assembly description Required See note

Power Yes 1

Fan Yes 2

CIT or Cross over LAN Cable Yes 3, 10

DS1 Optional 4

DS3 Optional 5

TMUX Optional 6

10/100BaseT Ethernet Optional 7

Office Alarm Optional 8

Office Alarm Mult Optional 8

Miscellaneous Discrete Optional 9

LAN 10BaseT (Crossover) Optional 10

LAN 10BaseT (Straight Through) Optional 10

Sync Timing Optional 11

Modem Optional 12
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5. a. Two DS3 Cable Assemblies are required for each Function Unit equipped for 12 DS3 
service (LNW16). One cable consists of 12 inputs and the other cable consists of 12 outputs. 
Two 24-coax cable assemblies may be used if growth to 48 DS3 packs is planned.

b. Four DS3 Cable Assemblies are required for each Function Unit equipped for 48 DS3 
service (LNW19/19B). Each DS3 Cable Assembly consists of two separate cable assemblies, 
both containing 735A cables. One cable consists of 24 inputs and the other cable consists of 
24 outputs.

6. One DS3 Cable Assembly is required for each Function Unit Group to support use of the 
TMUX pack, since 12 DS3 signals are supported.

7. One cable is required for channels 1 through 12 and another for channels 13 through 24 
(LNW66 and LNW71). LNW74 provides only ports 1 through 16.

8. When cabling the 1665 DMX High-Capacity shelf for office alarm applications, one Office 
Alarm Cable Assembly is required for the bottom 1665 DMX shelf in a bay frame. One 
Office Alarm Mult Cable Assembly is required for each additional 1665 DMX shelf in the 
bay frame. 
For example, if four 1665 DMX shelves are located in a single 7-foot bay frame, one Office 
Alarm Cable Assembly and three Office Alarm Mult Cable Assemblies are required.

9. One misc. discrete cable per shelf as required.

10. These cables are used for IAO LAN (OSI/TCP-IP)/Front LAN (OSI/TCP-IP) connection (J16 
and Front LAN port). LAN 10BaseT cross over cable should be used if the shelf is directly 
connected to a PC and LAN 10BaseT straight through cable should be used if shelf is 
connected to a hub.

11. Two cables per shelf for Ref1 and Ref2.

12. RS232 modem cable (RJ45 to 25-pin).
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Connector references

Description

Figure 1-1, Connector types and pinouts (p. 1-7) provides the pinouts of some of the 
connectors used to interface with the 1665 DMX.

Figure 1-1 Connector types and pinouts

DB-9 male-type connector

DB-15 male-type connector

DB-25 male-type connector

DB-62 male-type connector

1 5

6 9

1 8

9 15

1 13

14 25

1 21

43 62

22 42

DB-9 female-type connector

DB-15 female-type connector

DB-25 female-type connector

DB-62 female-type connector

15

69

8 1

15 9

13 1

24 14

21 1

62 43

42 22

RJ-45 type connector

1

8 1 8
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Inspection

Description

Perform the following procedure before installing the 1665 DMX High-Capacity shelf and 
cables.

Procedure

........................................................................................................................................................................................................................

1 Inspect the shelf for visible damage including bent or touching backplane pins.

Important! If any backplane pins are damaged, refer to Appendix D, “Backplane pin 
replacement” for instructions on repairing the damaged pin(s).

........................................................................................................................................................................................................................

2 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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1665 DMX High-Capacity shelf installation

Description

As an example of the 1665 DMX High-Capacity shelf installation, the following steps 
describe mounting the shelf from the rear of a 23-inch bay frame. Mounting from the front 
of a 23-inch bay frame or from the front/rear of a 19-inch bay frame is similar with the 
exception of the position of the side brackets.

Positioning of the side brackets is also specified.

Important! This section requires previous bay frame installation and grounding.

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Determine the mounting configuration for the 1665 DMX High-Capacity shelf:

• Type of bay frame (23-inch or 19-inch wide)

• Mounting position (front or rear)

• Position in bay (bottom to top).

Important! The 1665 DMX High-Capacity shelf is shipped with the mounting 
brackets positioned for mounting to the rear of a 23-inch wide network bay frame.

The 1665 DMX High-Capacity shelf mounting brackets may have to be repositioned and 
remounted, depending on the frame type and mounting position (front or rear).

........................................................................................................................................................................................................................

2 If necessary, reposition the shelf mounting brackets accordingly.

For 23-inch frame, front or rear mounting, refer to Figure 1-2, “1665 DMX High-Capacity 
shelf mounting bracket positions — 23-inch frame” (p. 1-10).

For 19-inch frame, front or rear mounting, refer to Figure 1-3, “1665 DMX High-Capacity 
shelf mounting bracket positions — 19-inch frame” (p. 1-11).
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Figure 1-2 1665 DMX High-Capacity shelf mounting bracket positions — 23-inch 
frame
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Figure 1-3 1665 DMX High-Capacity shelf mounting bracket positions — 19-inch 
frame

........................................................................................................................................................................................................................

3 Determine the position that the 1665 DMX High-Capacity shelf will be mounted. 
Figure 1-4, “Typical 1665 DMX High-Capacity shelf bay mounting arrangements” 
(p. 1-12) shows the recommended mounting positions. Start at the bottom of the bay and 
add shelves from bottom to top.

Important! There is a switch on the fan unit controller board. It is labeled "CF ALM 
ON" (Clogged Filter Alarm ON) and "CF ALM OFF" (Clogged Filter OFF). The fan 
ships with the switch in the disable position which prevents the filter alarm from 
working. To enable the filter alarm, remove the fan unit from the 1665 DMX High-
Capacity shelf, move the switch to the "CF ALM ON" position and then reinstall the 
fan unit in the shelf.

TIGHTEN SCREWS
TO 10 IN.-LB.
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........................................................................................................................................................................................................................

4  Position the 1665 DMX High-Capacity shelf in the frame and secure it to the frame using 
the thread-forming screws included with the shelf (4 screws per side). Tighten the screws 
to 21 in.-lb. (minimum)/30 in.-lb. (maximum).

Important! Be sure to mount the shelf using the thread-forming screws provided 
with the shelf to ensure a solid ground connection from the bay to the shelf.

Figure 1-4 Typical 1665 DMX High-Capacity shelf bay mounting arrangements



1665 DMX High-Capacity shelf installationEquipment and cable installation for 1665 Data Multiplexer 
(1665 DMX)

............................................................................................................................................................................................................................................................

365-372-304R7.1
Issue 1, November 2007

1 - 1 3

........................................................................................................................................................................................................................

5 Verify with an ohmmeter that the 1665 DMX High-Capacity shelf is grounded to the bay 
frame. Measure between the 1665 DMX High-Capacity shelf mounting bracket and the 
office ground lug on the bay frame.

Requirement: The ohmmeter reads less than 1 ohm.

........................................................................................................................................................................................................................

6 If the Ohmmeter reading is not less than 1 ohm, a secondary ground should be used for 
each shelf. Use an 8 AWG wire from the UL (Green M5 Screw) safety ground on the side 
of the shelf to bay frame or office ground.

Important! It is important to remove the paint in the area where the wire is to be 
connected to the bay and to apply no-ox before connecting the wire.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Heat baffle installation

Description

If a shelf is added above existing non-1665 DMX equipment, one heat baffle (848862181) 
must be installed between the shelf and the existing equipment.

........................................................................................................................................................................................................................

1 Determine the mounting configuration for the heat baffle:

• Type of bay frame (23-inch or 19-inch wide)

• Mounting position (front or rear)

• Position in bay (below shelf mounted above non-DMX heat generating equipment).

Important! The heat baffle is shipped with the mounting brackets positioned for 
mounting to the rear of a 23-inch wide network bay frame.

The heat baffle mounting brackets may have to be repositioned and remounted, depending 
on the frame type and mounting position (front or rear).

........................................................................................................................................................................................................................

2 If necessary, reposition the heat baffle mounting brackets to match the position of the 1665 
DMX High-Capacity shelf.

........................................................................................................................................................................................................................

3 Refer to Figure 1-5, Heat baffle position (p. 1-15) for the mounting position and 
orientation of the heat baffle.



Heat baffle installationEquipment and cable installation for 1665 Data Multiplexer 
(1665 DMX)

............................................................................................................................................................................................................................................................

365-372-304R7.1
Issue 1, November 2007

1 - 1 5

Figure 1-5 Heat baffle position

........................................................................................................................................................E N D  O F  S T E P S
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Power cable and cable bracket installation

Description

This section provides instructions on installing the power cable and cable bracket for the 
1665 DMX High-Capacity shelf.

Important! Two feeders (A and B) are required from the battery distribution fuse 
board (BDFB) or battery distribution circuit breaker bay (BDCBB) to the 1665 DMX 
bay.

Table 1-2, “Power cable assemblies” (p. 1-25) and Table 1-3, “Power connections” 
(p. 1-26) list the available power cable assemblies and power connections, respectively.

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Install cable brackets (two per 1665 DMX High-Capacity shelf, 1 on each side) as shown 
in Figure 1-6, “Cable brackets” (p. 1-17).

CAUTION

Verify that the BDCBB breakers are off or that the BDFB fuses are 
not installed. 
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Figure 1-6 Cable brackets

Important! Depicted above is the 1665 DMX shelf for reference purposes only, the 
cable bracket is the same for the 1665 DMX High-Capacity shelf.

........................................................................................................................................................................................................................

2 If installation is on raised floors, rotate the power connectors on each side of the shelf 180 
degrees, as shown:

CABLE
BRACKET
(sold separately)
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Otherwise, ensure that power connector is in the following position:

........................................................................................................................................................................................................................

3 There are two mounting positions on each side of the 1665 DMX High-Capacity shelf 
chassis as shown in Figure 1-7, “Power connector mounting positions” (p. 1-19). It is 
recommended that if multiple shelves are being installed in a frame, the power connector 
positions be alternated as shown in Figure 1-8, “Alternating power cable routing” 
(p. 1-20). 

Determine if the power connector needs to be moved to the other mounting position. If so, 
move the power connector to the other mounting position now.

CAUTION

Use provided hardware only to adjust the position of the power 
connector housing.
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Figure 1-7 Power connector mounting positions 

Important! Figure 1-8, “Alternating power cable routing” (p. 1-20) shows the typical 
power cabling for four 1665 DMX High-Capacity shelf shelves in a standard bay 
frame. The side view shows the power connectors for shelves 3 and 1 mounted closest 
to the rear of the shelves (default position) with the cabling for shelf 1 bending away 
from the power connector on shelf 3 and running over it until the power cables exit the 
bay. The power connectors for shelves 4 and 2 are mounted in the alternate position on 
the shelf and the power cables routed in the same manner.

POWER CONNECTOR
MOUNTING POSITIONS

RIGHT SIDE
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Figure 1-8 Alternating power cable routing 

........................................................................................................................................................................................................................

4 Connect power cable to the power connector housing on the 1665 DMX High-Capacity 
shelf chassis [Figure 1-9, “Power connection” (p. 1-21)].
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Figure 1-9 Power connection

........................................................................................................................................................................................................................

5 Route the power cable out of the bay and toward the BDCBB or BDFB, stacking the cable 
in the bay as shown in Figure 1-10, “Power cable routing with cable bracket” (p. 1-22) or 
Figure 1-11, “Power cable routing without cable bracket” (p. 1-23).

Important! The 1665 DMX High-Capacity shelf is powered by -48 V DC.

CAUTION

Equipment damage

Ensure that the 4 pins inside the connector attached to the power cable are 
properly aligned before inserting the connector into the power connector 
housing. Failure to do so may result in damage to the connector.

POWER

POWER CONNECTORHOUSING MOUNTING
POSITION HOUSING

CABLE
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:

Figure 1-10 Power cable routing with cable bracket

Important! The shelf shown in Figure 1-10 is the 1665 DMX and not the 1665 DMX 
High-Capacity shelf, however the power cabling remains the same and is depicted here 
for reference.

CAUTION

Verify that the BDCBB breakers are off or that the BDFB fuses are 
not installed.

POWER

CABLE

POWER
CONNECTOR

CABLES

BRACKET



Power cable and cable bracket installationEquipment and cable installation for 1665 Data Multiplexer 
(1665 DMX)

............................................................................................................................................................................................................................................................

365-372-304R7.1
Issue 1, November 2007

1 - 2 3

Figure 1-11 Power cable routing without cable bracket

Important!  The shelf shown in Figure 1-10 is the 1665 DMX and not the 1665 
DMX High-Capacity shelf, however the power cabling remains the same and is 
depicted here for reference.

........................................................................................................................................................................................................................

6 Splice feeders from the BDCBB or BDFB to the 1665 DMX High-Capacity shelf power 
cable. Refer to Table 1-3, “Power connections” (p. 1-26).

Important! Four cables are spliced to each power cable:

1. BAT A

2. BAT A RTN

3. BAT B

4. BAT B RTN

POWER

POWER
CONNECTOR

CABLES
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........................................................................................................................................................................................................................

7 Label the feeders at the BDCBB or BDFB as follows:

1. BAT A

2. BAT A RTN

3. BAT B

4. BAT B RTN

Important! Each feeder at the BDCBB should be rated 1.25 times the rating of the 
circuit breaker on the shelf. For the BDFB, the fuse rating should be 1.5 times the 
rating of the circuit breaker on the shelf.

........................................................................................................................................................................................................................

8 Leave the BDCBB breakers off or BDFB fuses out until you are ready to perform the 
procedures in Chapter 2, “Powering and initial circuit pack installation for 1665 Data 
Multiplexer (1665 DMX)” of this manual.

........................................................................................................................................................................................................................

9 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Table 1-2 Power cable assemblies

Description
Cable 
gauge

Cable 
assembly #

Cable 
length 
(feet)

1665 DMX High-
Capacity shelf 
backplane 
connections

Power cable 10 848841839 12 Connectors mounted on 
sides of the shelf (BAT A 
and BAT B)

6 848635009 12

848635033 50

848635041 75

848635058 100

4 848935268 35

848634986 55

848635025 100

2 848935276 55

848634978 85

848635017 100

Cable 
connector kit

2 848635231

4 848635249

6 848635934

Cable bracket 846593002
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Table 1-3 Power connections

1665 DMX 
High-
Capacity 
shelf bkpl 
conn.

Shelf power 
connectors 
(on sides) Pin# Color Designation Name

P14 BAT A 1 R -48VA BAT A

2 W -48RTNA BAT A RTN

P15 BAT B 1 R -48VB BAT B

2 W -48RTNB BAT B RTN

Notes:  

1. Power cables for shelves 4 and 2 are mounted using the connector mounting holes located 
closest to the rear of the shelves with the cabling for shelf 2 bending away (out) from the 
power connector in shelf 4 and running over it until the power cables exit the bay. The 
power runs for shelves 1 and 3 are run in the same manner as described for shelves 2 and 
4 using the connector holes located furthest from the rear of the shelf.
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Fiber management installation (optional)

Description

This section describes how to install the fiber management pieces that may be shipped 
with the bay.

Important! If fiber management is to be installed, the width of the bay footprint must 
be extended by at least 2.5 inches beyond the bay upright on each side. This is 
typically done using base fillers.

Comcode numbers are in parentheses next to the part number.

Procedure

........................................................................................................................................................................................................................

1 Locate three spools (106738156), one fiber radius control module (321-1B), one left fiber 
spool bracket (848919213) and 3 M4 X 6 bracket mounting screws (901340059) for each 
shelf being installed.

........................................................................................................................................................................................................................

2 For each spool, put a nylach fastener through the middle. Then insert a pin halfway 
through.

Important! It is very important that the pin is not completely inserted. This will 
deform the fastener and prevent it from being assembled to the bracket.

........................................................................................................................................................................................................................

3 Line up the nylach fastener in one of the spools with the large holes on the top arm of the 
bracket.
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........................................................................................................................................................................................................................

4 Spin the spool until the peg on its back fits into the smaller hole on the arm of the bracket. 
This will keep the spool from spinning any further.

........................................................................................................................................................................................................................

5 Push the pin until it is completely fastened.

........................................................................................................................................................................................................................

6 Repeat Step 3 through Step 5 for all the spools, with three per bracket. 

........................................................................................................................................................................................................................

7 Attach one fiber radius control module to the bottom of each bracket, as shown:
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........................................................................................................................................................................................................................

8 Position one of the brackets along the left side of shelf 1. Secure with 3 bracket mounting 
screws.

........................................................................................................................................................................................................................

9 Repeat Step 8 for all the other shelves being installed.

........................................................................................................................................................................................................................

10 Locate three spools (848919221), one fiber radius control module (321-1B), one right 
fiber spool bracket (848919221) and 3 M4 X 6 bracket mounting screws (901340059) for 
each shelf being installed.

........................................................................................................................................................................................................................

11 For each spool, put a nylach fastener through the middle. Then insert a pin halfway 
through.

Important! It is very important that the pin is not completely inserted. This will 
deform the fastener and prevent it from being assembled to the bracket.

........................................................................................................................................................................................................................

12 Line up the nylach fastener in one of the spools with the large holes on the top arm of the 
bracket.

........................................................................................................................................................................................................................

13 Spin the spool until the peg on its back fits into the smaller hole on the arm of the bracket. 
This will keep the spool from spinning any further.

........................................................................................................................................................................................................................

14 Push the pin until it is completely fastened.

........................................................................................................................................................................................................................

15 Repeat Step 12 through Step 14 for all the spools, with three per bracket.

........................................................................................................................................................................................................................

16 Attach one fiber radius control module to the bottom of each bracket.

........................................................................................................................................................................................................................

17 Position one of the brackets along the right side of shelf 1. Secure with 3 bracket mounting 
screws.

........................................................................................................................................................................................................................

18 Repeat Step 17 for all the other shelves being installed.
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........................................................................................................................................................................................................................

19 Using a label maker, create 16 labels "LS" and 8 labels "HS".

........................................................................................................................................................................................................................

20 Attach the "HS" labels to the uppermost spool on each of the brackets.

........................................................................................................................................................................................................................

21  Attach the "LS" labels to the middle and lower spools on each of the brackets.

........................................................................................................................................................................................................................

22 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Installing the fiber ducts (optional)

Description

This procedure describes how to install the fiber ducts on either side of the bay. The fiber 
ducts may be shipped with the 1665 DMX. 

Important! If fiber management is to be installed, the width of the bay footprint must 
be extended by at least 2.5 inches beyond the bay upright on each side. This is 
typically done using base fillers. 

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 From the 848920476 Fiber Duct Components Kit, locate 2 fiber ducts (848955845), 6 
metal fiber duct brackets (848915153), 12 12-24 X 3/8” HWH screws (901211177) and 6 
M5 X 8 (901340547).

........................................................................................................................................................................................................................

2 Using the 12-24 X 3/8” screws, secure the metal brackets to the front of the bay (three on 
each side), using the holes in between shelf 1 and shelf 2; shelf 2 and shelf 3; shelf 3 and 
shelf 4.

........................................................................................................................................................................................................................

3 Position one of the fiber ducts along the left side of the shelves.

........................................................................................................................................................................................................................

4 From the front of the duct, use the M5 X 8 screws to secure it to the metal brackets.

........................................................................................................................................................................................................................

5 Position the other fiber ducts along the right side of the shelves.

........................................................................................................................................................................................................................

6 From the front of the duct, use the M5 X 8 screws to secure it to the metal brackets. 

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Cable and optical fiber installation

Introduction

Important! Ensure only ANGLED LC connectors appear at IN ports of optical 
circuit packs.

........................................................................................................................................................................................................................

1 If fiber management systems have been installed:

a. High-speed fibers should be routed along the fiber radius control module and then 
up to the uppermost spool. 

b. Fiber management of low speed fibers should start with the lowest spool. Once 
full, fiber should be routed along the fiber radius control module and then up to the 
middle spool.

c. As shown in the picture below, fiber from the lowest spool (low speed) is routed in 
the outermost section of the fiber duct; the middle spool (low speed) to the middle 
section; and the upper spool (high speed) to the inner section.

Important! The high-speed fiber, routed in the innermost duct, should be held with 
Hellerman Tyton RED grip tie (GT.75X1802) or equivalent. The low speed fiber 
should be held with Hellerman Tyton YELLOW grip tie (GT.75X1804) or equivalent.
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........................................................................................................................................................................................................................

2 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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DS1 cable installation

Description

This section describes how to connect the DS1 transmission cables to the shelf, route the 
cables out of the bay and connect the cables to the DSX. Perform this procedure if DS1 
cables are required.

Important! When cabling the 1665 DMX High-Capacity shelf to a DSX, the DSX 
becomes an extension of the 1665 DMX High-Capacity shelf backplane connections. 
Thus the IN on the 1665 DMX High-Capacity shelf backplane connects to the IN of 
the DSX and the OUT of the 1665 DMX High-Capacity shelf backplane connects to 
the OUT of the DSX respectively.

The cables are connectorized at the 1665 DMX High-Capacity shelf end and must be 
wire-wrapped at the DSX end. A total of four function groups fully cabled will have 224 
DS1 drop capacity when the higher density DS1 circuit packs become available.

Important! The connectorized cable end is grounded to the 1665 Data Multiplexer 
(1665 DMX) frame ground through the backplane. Alcatel-Lucent recommends that 
the shield at both ends of the cable be grounded. Ground at the DSX end per office 
requirements.

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Obtain the DS1 cables per Table 1-4, “DS1 
cable assemblies” (p. 1-37) and note the function group where each cable will be used. 
Label the cables, indicating bay, shelf, function group (A, B, C or D) and direction (IN or 
OUT of the bay) at each end.

Important! The first 28 DS1s of a Function Group, must be connected to the bottom 
connectors (J1- J8). The additional capacity (28 additional DS1s, 29-56) of the 
Function Group use the connectors located in the middle of the backplane (J20 - J27).
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........................................................................................................................................................................................................................

2 Connect the function group cables at the 1665 DMX High-Capacity shelf end, carefully 
matching the correct connector with the appropriate backplane connectors as shown in 
Figure 1-12, “DS1 cable installation” (p. 1-35).

Important! DS1 cable retaining screws must be tightened to a maximum of 6.5 in-lb. 
Do not overtighten.

Figure 1-12 DS1 cable installation

........................................................................................................................................................................................................................

3 Route the cables along the backplane and out of the bay to the DSX per Figure 1-13, “DS1 
cable routing” (p. 1-36).
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Figure 1-13 DS1 cable routing

........................................................................................................................................................................................................................

4 Route the cables along the cable rack and into the terminating bay.

........................................................................................................................................................................................................................

5 Remove slack and cut the DS1 cables to the desired length at the DSX.

........................................................................................................................................................................................................................

6 Referring to Table 1-5, “DS1 transmission connections” (p. 1-38), carefully observe color 
codes and wire-wrap the cables at the DSX.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Table 1-4 DS1 cable assemblies

Cable length
(feet)

Cable 
assembly # Description

1665 DMX 
backplane 
connections

10 848954988 DS1 Cables, 24 gauge J1, J24 - J2, J20
(A OUT - A IN)

J3, J25 - J4, J21
(B OUT - B IN)

J6, J26 - J5, J22
(C OUT - C IN)

J8, J27 - J7, J23
(D OUT - D IN)

20 848955001

30 848923074

50 848548327

75 848923082

100 848548335

125 848923090

150 848548343

175 848923108

200 848923116

250 848548350

350 848790762

450 848548368

550 848790770

655 848790788

Notes:  

1. Each group listed includes all the DS1 cables for one function group.

2. One code provides one input and one output cable for 28 DS1's, i.e., for one 
DS1 function group, e.g, "J1 A OUT" & "J2 A IN"

3. For Input connections use cable CA1 (DS1 IN) and for Output connections use 
cable CA2 (DS1 OUT).

4. Cables are terminated in J1 through J8 and J20 through J27 connectors at the 
1665 DMX High-Capacity shelf end and unterminated at the other end for 
wire-wrap installation.

5. P1 through P8 are 62 pins D-Sub male-type connectors fit into J1 through J8. 
P20 through P27 are 62 pins DSUB male type connectors fit into J20 through 
J27.

6. Two codes required for the high-capacity 56 DS1 LNW8, i.e., for DS1 function 
groups, e.g., "J1 A OUT" & "J2 A IN" and "J24 A OUT"&"J20 A IN"
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Table 1-5 DS1 transmission connections

DSX-1 connections 1665 DMX High-Capacity shelf backplane connections

G
r
o
u
p

Chan
DS1

T/R 
term

T/R 
color

62 pin 
conn.
Pin# 
T/R

Function 
group   A 
conn.

Function 
group   B 
conn.

Function 
group   C 
conn.

Function 
group   D 
conn.

In Out In Out In Out In Out

1 1 (1)

2 (2)

3 (3)

4 (4)

B8/B7

B6/B5

B4/B3

B2/B1

W/BL¹

W/O¹

W/G¹

W/BR

19/40

18/39

60/59

17/38

J2

A

In

J1

A

Out

J4

B

In

J3

B

Out

J5

C

In

J6

C

Out

J7

D

In

J8

D

Out

2 1 (5)

2 (6)

3 (7)

4 (8)

B8/B7

B6/B5

B4/B3

B2/B1

W/S

R/BL

R/O

R/G

58/57

16/37

15/36

14/35

3 1 (9)

2 (10)

3 (11)

4 (12)

B8/B7

B6/B5

B4/B3

B2/B1

R/BR

R/S

BK/BL

BK/O

56/55

13/34

54/53

12/33

4 1 (13)

2 (14)

3 (15)

4 (16)

B8/B7

B6/B5

B4/B3

B2/B1

BK/G

BK/BR

BK/S

Y/BL

11/32

10/31

52/51

9/30

5 1 (17)

2 (18)

3 (19)

4 (20)

B8/B7

B6/B5

B4/B3

B2/B1

Y/O

Y/G

Y/BR

Y/S

50/49

8/29

7/28

6/27

6 1 (21)

2 (22)

3 (23)

4 (24)

B8/B7

B6/B5

B4/B3

B2/B1

V/BL

V/O

V/G

V/BR

48/47

5/26

46/45

4/25

7 1 (25)

2 (26)

3 (27)

4 (28)

B8/B7

B6/B5

B4/B3

B2/B1

V/S

W/BL¹

W/O¹

W/G¹

3/24

2/23

44/43

1/22
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1 1 (29)

2 (30)

3 (31)

4 (32)

B8/B7

B6/B5

B4/B3

B2/B1

W/BL¹

W/O¹

W/G¹

W/BR

19/40

18/39

60/59

17/38

J20

A

In

J24

A

Out

J21

B

In

J25

B

Out

J22

C

In

J26

C

Out

J23

D

In

J27

D

Out

2 1 (33)

2 (34)

3 (35)

4 (36)

B8/B7

B6/B5

B4/B3

B2/B1

W/S

R/BL

R/O

R/G

58/57

16/37

15/36

14/35

3 1 (37)

2 (38)

3 (39)

4 (40)

B8/B7

B6/B5

B4/B3

B2/B1

R/BR

R/S

BK/BL

BK/O

56/55

13/34

54/53

12/33

4 1 (41)

2 (42)

3 (43)

4 (44)

B8/B7

B6/B5

B4/B3

B2/B1

BK/G

BK/BR

BK/S

Y/BL

11/32

10/31

52/51

9/30

5 1 (45)

2 (46)

3 (47)

4 (48)

B8/B7

B6/B5

B4/B3

B2/B1

Y/O

Y/G

Y/BR

Y/S

50/49

8/29

7/28

6/27

6 1 (49)

2 (50)

3 (51)

4 (52)

B8/B7

B6/B5

B4/B3

B2/B1

V/BL

V/O

V/G

V/BR

48/47

5/26

46/45

4/25

7 1 (53)

2 (54)

3 (55)

4 (56)

B8/B7

B6/B5

B4/B3

B2/B1

V/S

W/BL¹

W/O¹

W/G¹

3/24

2/23

44/43

1/22

DSX-1 connections 1665 DMX High-Capacity shelf backplane connections

G
r
o
u
p

Chan
DS1

T/R 
term

T/R 
color

62 pin 
conn.
Pin# 
T/R

Function 
group   A 
conn.

Function 
group   B 
conn.

Function 
group   C 
conn.

Function 
group   D 
conn.

In Out In Out In Out In Out
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Notes:  

1. Some wire colors are used twice. White binder cables are for Channel 1 through 25 and 29 through 53 
blue binder cables are for Channels 26, 27, 28, 54, 55 and 56. 

DSX-1 connections 1665 DMX High-Capacity shelf backplane connections

G
r
o
u
p

Chan
DS1

T/R 
term

T/R 
color

62 pin 
conn.
Pin# 
T/R

Function 
group   A 
conn.

Function 
group   B 
conn.

Function 
group   C 
conn.

Function 
group   D 
conn.

In Out In Out In Out In Out
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DS3/EC1 and 48TMUX cable installation

Description

This section describes how to connect the DS3/EC1 and 48TMUX cables to the 1665 
DMX High-Capacity shelf and route the cables out of the bay and to the DS3/EC1 
terminating equipment. Perform this procedure if DS3/EC1 or 48TMUX cables are 
required.

Important! When cabling the 1665 DMX High-Capacity shelf to a DSX, the DSX 
becomes an extension of the 1665 DMX High-Capacity shelf backplane connections. 
Therefore, the IN on the 1665 DMX High-Capacity shelf backplane connects to the IN 
of the DSX and the OUT of the 1665 DMX High-Capacity shelf backplane connects to 
the OUT of the DSX.

DS3/EC1 and TMUX cable options are listed in Table 1-7, “DS3/EC1 or TMUX cable 
assemblies” (p. 1-44).

DS3/EC1 and TMUX transmission connections are in Table 1-8, “DS3/EC1 and TMUX 
transmission connections” (p. 1-50). A total of four function groups fully cabled will have 
192 DS3 drop capacity.

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Obtain the DS3 cables per Table 1-7, 
“DS3/EC1 or TMUX cable assemblies” (p. 1-44) and note the function group where each 
cable will be used. Label the cables, indicating bay, shelf, function group (A, B, C or D) 
and direction (IN or OUT of the bay) at each end.

Important! The first 24 ports of a Function Unit must be cabled to the bottom 
connectors (J1 - J8), the additional DS3 ports (25 - 48) are cabled to the middle section 
of the shelf (J20 - J27).

........................................................................................................................................................................................................................

2 Connect the function group cables at the 1665 DMX High-Capacity shelf end, carefully 
matching the correct connector with the appropriate backplane connectors as shown in 
Figure 1-14, “DS3/EC1 and 48TMUX cable installation” (p. 1-42).

Important! DS3/EC1 and TMUX cable retaining screws must be tightened to a 
maximum of 6.5 in-lb. Do not overtighten.



............................................................................................................................................................................................................................................................

DS3/EC1 and 48TMUX cable installationEquipment and cable installation for 1665 Data Multiplexer 
(1665 DMX)

1 - 4 2  365-372-304R7.1
Issue 1, November 2007

........................................................................................................................................................................................................................

3

Table 1-6 DS3 connections for different function groups

Figure 1-14 DS3/EC1 and 48TMUX cable installation

........................................................................................................................................................................................................................

4 Route the cables along the backplane and out of the bay to the DSX per Figure 1-15, 
“DS3/EC1 and 48TMUX cable routing” (p. 1-43).

Function group Associated connectors

A A IN (J2 and J20) A OUT (J1 and J24)

B B IN (J4 and J21) B OUT (J3 and J25)

C C IN (J5 and J22) C OUT (J6 and J26)

D D IN (J7 and J23) D OUT (J8 and J27)

J8
D OUT

J6
C OUT

J19
INTEROP

J16
IAOLAN

J3
B OUT

J1
A OUT

J4
B IN

J2
A IN

J13
ALM MULT

J12
ALM

J18
DLAN

J10
X.25

J5
C IN

J7
D IN

NC-DMX-156

J22 C IN

J23 D IN

J26 C OUT

J27 D OUT

J20 A IN

J21 B IN

J24 A OUT

J25 B OUT

IN

OUT

EXP2 EXP1

IN

OUT

CTL

-48RTNB

P15
J14

SYNC2
J11

MISC
J17

MODEM

J9
SYNC1 P14

-48RTNA

-48VA-48VB

CTL

J15
FAN
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Figure 1-15 DS3/EC1 and 48TMUX cable routing

Important! This figure shows DS3 cabling for FNA and FNB.

........................................................................................................................................................................................................................

5 Route the cables along the cable rack and into the terminating bay (DSX or other 
terminating transmission equipment).

........................................................................................................................................................................................................................

6 Cut the cables to desired length and install the BNC connectors shipped with the cable 
assemblies.

Important! When installing BNC connectors, follow the manufacturer’s instruction 
carefully to ensure a proper connection. Failure to do so may result in faulty DS3 
signals as a result of improperly installed BNC connectors.

........................................................................................................................................................................................................................

7 Connect the cables to their respective positions on the terminating equipment.

Important! The 12 port cable and the 24 port cable use different signal grounds 
based on the circuit pack not the backplane. There is no issue interchanging these 
cables on the backplane. The Signals are common between both cables.
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........................................................................................................................................................................................................................

8 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Table 1-7 DS3/EC1 or TMUX cable assemblies

Description
Cable 
assembly #

Cable length
(feet)

1665 DMX 
backplane 
connections

DS3#1-12 Cables with ITT Canon 
BNC’s, for LNW16, LNW18 only

12 individual 735A coaxial cables 
with 12 ITT Canon 75ohm BNC 
plugs shipped loose.

848955407 10 J1, J24 - J2, J20
(A OUT - A IN)

J3, J25 - J4, J21
(B OUT - B IN)

J6, J26 - J5, J22
(C OUT - C IN)

J8, J27 - J7, J23
(D OUT - D IN)

848955415 20

848955423 30

848955431 40

848548277 50

848980504 60

848548285 100

848548293 150

848548301 250

848548319 450 (NE to NE)

848815742 450 (NE to NE)

848815734 750 (NE to NE)

848815759 900 (NE to NE)
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DS3#1-12 Cables with no BNC, 
LNW16, LNW18 only

Similar to above except no BNC’s 
are shipped loose.

849040779 uses 735A cable, and 
450ft is the maximum amount of 
735A allowed between two DMX’s

849041710 and lengths > 450ft use 
~10ft 735A spliced to 734D cable 
and 900ft is the maximum amount 
of 734D allowed between two 
DMX’s. This splice is factory made. 
Stagger the splices in the cable rack 
to save space.

849040688 10 J1, J24 - J2, J20
(A OUT - A IN)

J3, J25 - J4, J21
(B OUT - B IN)

J6, J26 - J5, J22
(C OUT - C IN)

J8, J27 - J7, J23
(D OUT - D IN)

849040696 20

849040704 30

849040712 40

849040720 50

849040738 60

849040746 100

849040753 150

849040761 250

849040779 450

849041710 450

849041736 750

849041744 900

Description
Cable 
assembly #

Cable length
(feet)

1665 DMX 
backplane 
connections
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DS3#1-24 Cables with ITT Canon 
BNCs, for LNW16, LNW18, 
LNW19, LNW19B or LNW20

24 individual 735A coaxial cables 
and 24 ITT Canon 75ohm BNC 
plugs shipped loose.

848923124 10 J1, J24 - J2, J20
(A OUT - A IN)

J3, J25 - J4, J21
(B OUT - B IN)

J6, J26 - J5, J22
(C OUT - C IN)

J8, J27 - J7, J23
(D OUT - D IN)

848923132 20

848923140 30

848923157 40

848839478 50

848923165 60

848923173 70

848923181 80

848923199 90

848839486 100

848923207 110

848923215 120

848923223 140

848838494 150

848923231 160

848923249 180

848923256 200

848839502 250

848923264 300

848923272 400

848839510 450

Description
Cable 
assembly #

Cable length
(feet)

1665 DMX 
backplane 
connections
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DS3#1-24 Cables with no BNC, for 
the LNW16, LNW18, LNW19, 
LNW19B or LNW20

Similar to above except no BNC’s 
are shipped loose

849040886 10 J1, J24 - J2, J20
(A OUT - A IN)

J3, J25 - J4, J21
(B OUT - B IN)

J6, J26 - J5, J22
(C OUT - C IN)

J8, J27 - J7, J23
(D OUT - D IN)

849040894 20

849040902 30

849040910 40

849040928 50

849040936 60

849040944 70

849040951 80

849040969 90

849040977 100

849040985 110

849040993 120

849041009 140

849041017 150

849041025 160

849041033 180

849041041 200

849041066 250

849041074 300

849041082 400

849041090 450

Description
Cable 
assembly #

Cable length
(feet)

1665 DMX 
backplane 
connections
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DS3#1-24 Cables with ITT Canon 
BNCs

Similar to above except ~10 ft of 
735A spliced to 734D coaxial cable 
with loose ITT Canon BNCs for > 
450ft between two DMX’s.

900ft is the maximum amount of 
734D cable allowed between two 
DMX’s.

This is a factory splice. Stagger the 
splices in the cable rack to save 
space.

848932083 250 J1, J24 - J2, J20
(A OUT - A IN)

J3, J25 - J4, J21
(B OUT - B IN)

J6, J26 - J5, J22
(C OUT - C IN)

J8, J27 - J7, J23
(D OUT - D IN)

848932018 275

848932026 300

848932034 325

848932042 350

848932059 375

848932067 400

848932075 425

848839528 450

848839536 750

848839544 900

DS3#1-24 Cables with no BNC

Similar to above except no BNC’s 
are shipped loose.

849041785 250 J1, J24 - J2, J20
(A OUT - A IN)

J3, J25 - J4, J21
(B OUT - B IN)

J6, J26 - J5, J22
(C OUT - C IN)

J8, J27 - J7, J23
(D OUT - D IN)

849041793 275

849041801 300

849041819 325

849041827 350

849041835 375

849041843 400

849041850 425

849041868 450

849041876 750

849041884 900

Customer Specific DS3#1-24 
Cables

Similar to above except DMX 
backplane 62 pin plugs on both ends 
of 735A coaxial cable

848956249 150 J1, J24 - J2, J20
(A OUT - A IN)

J3, J25 - J4, J21
(B OUT - B IN)

J6, J26 - J5, J22
(C OUT - C IN)

J8, J27 - J7, J23
(D OUT - D IN)

Description
Cable 
assembly #

Cable length
(feet)

1665 DMX 
backplane 
connections
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Customer Specific 12 pack Mini-
BNC Cable Harness

12 individual 735A coaxial cables 
under one jacket, one harness per 
code, with 12 Mini-BNC plugs to 12 
standard BNC plugs for customer 
specific applications.

109508416 25

109508424 50

109508432 75

109508440 100

109508457 125

109508465 150

109508473 175

109508481 200

109508499 250

Customer Specific Mini-BNC Cable

One 735A coaxial cable per code 
with one mini-BNC plug to one 
standard BNC plug for customer 
specific applications.

109508325 25 J1, J24 - J2, J20
(A OUT - A IN)

J3, J25 - J4, J21
(B OUT - B IN)

J6, J26 - J5, J22
(C OUT - C IN)

J8, J27 - J7, J23

109508333 50

109508341 75

109508358 100

109508366 125

109508374 150

109508382 175

109508390 200

109508408 250

Notes:  

1. All the DS3/EC1 or TMUX cable assemblies can be used for any function group. 

2. 1665 DMX High-Capacity shelf connectors J1 through J8 and J20 through J27 can be 
used for either DS1, DS3/EC1 or TMUX.

3. Each Cable assembly# listed above contains two cable assemblies, therefore a quantity of 
two per function group must be ordered for the additional capacity.

4. P1 through P8 are 62 pins DSUB male type connectors fit into J1 through J8.

5. P20 through P27 are 62 pins DSUB male type connectors fit into J20 through J27.

6. LNW18, 12TMUX uses the same cable as the DS3 12 port. The DS3 High Capacity cable 
may also be used, but only 12 ports will be supported with LNW18, 12TMUX.

7. LNW20, 48TMUX uses the same cable as the DS3/EC1 48 port.

Description
Cable 
assembly #

Cable length
(feet)

1665 DMX 
backplane 
connections
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Table 1-8 DS3/EC1 and TMUX transmission connections

Coaxial 
cable

Lead 
designation Name

Connector
pin #

Connectors J1 
- J8

(Ports 1 - 24)

1 DS3 1R/1T Signal 40

FRG1 Ground 19

2 DS3 2R/2T Signal 17

FRG2 Ground 38

3 DS3 3R/3T Signal 57

FRG3 Ground 58

4 DS3 4R/4T Signal 13

FRG4 Ground 34

5 DS3 5R/5T Signal 53

FRG5 Ground 54

6 DS3 6R/6T Signal 10

FRG6 Ground 31

7 DS3 7R/7T Signal 51

FRG7 Ground 52

8 DS3 8R/8T Signal 6

FRG8 Ground 27

9 DS3 9R/9T Signal 47

FRG9 Ground 48

10 DS3 10R/10T Signal 4

FRG10 Ground 25

11 DS3 11R/11T Signal 24

FRG11 Ground 3

12 DS3 12R/12T Signal 1

FRG12 Ground 22

13 DS3 13R/13T Signal 59

FRG13 Ground 60

14 DS3 14R/14T Signal 16

FRG14 Ground 37
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15 DS3 15R/15T Signal 36

FRG15 Ground 15

16 DS3 16R/16T Signal 55

FRG16 Ground 56

17 DS3 17R/17T Signal 12

FRG17 Ground 33

18 DS3 18R/18T Signal 32

FRG18 Ground 11

19 DS3 19R/19T Signal 9

FRG19 Ground 30

20 DS3 20R/20T Signal 49

FRG20 Ground 50

21 DS3 21R/21T Signal 28

FRG21 Ground 7

22 DS3 22R/22T Signal 5

FRG22 Ground 26

23 DS3 23R/23T Signal 45

FRG23 Ground 46

24 DS3 24R/24T Signal 43

FRG24 Ground 44

Connectors 
J20 - J27

(Ports 25 - 48)

25 DS3 25R/25T Signal 40

FRG25 Ground 19

26 DS3 26R/26T Signal 17

FRG26 Ground 38

27 DS3 27R/27T Signal 57

FRG27 Ground 58

28 DS3 28R/28T Signal 13

FRG28 Ground 34

29 DS3 29R/29T Signal 53

FRG29 Ground 54

Coaxial 
cable

Lead 
designation Name

Connector
pin #
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30 DS3 30R/30T Signal 10

FRG30 Ground 31

31 DS3 31R/31T Signal 51

FRG31 Ground 52

32 DS3 32R/32T Signal 6

FRG32 Ground 27

33 DS3 33R/33T Signal 47

FRG33 Ground 48

34 DS3 34R/34T Signal 4

FRG34 Ground 25

35 DS3 35R/35T Signal 24

FRG35 Ground 3

36 DS3 36R/36T Signal 1

FRG36 Ground 22

37 DS3 37R/37T Signal 59

FRG37 Ground 60

38 DS3 38R/38T Signal 16

FRG38 Ground 37

39 DS3 39R/39T Signal 36

FRG39 Ground 15

40 DS3 40R/40T Signal 55

FRG40 Ground 56

41 DS3 41R/41T Signal 12

FRG41 Ground 33

42 DS3 42R/42T Signal 32

FRG42 Ground 11

43 DS3 43R/43T Signal 9

FRG43 Ground 30

44 DS3 44R/44T Signal 49

FRG44 Ground 50

Coaxial 
cable

Lead 
designation Name

Connector
pin #
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45 DS3 45R/45T Signal 28

FRG45 Ground 7

46 DS3 46R/46T Signal 5

FRG46 Ground 26

47 DS3 47R/47T Signal 45

FRG47 Ground 46

48 DS3 48R/48T Signal 43

FRG48 Ground 44

Notes:  

1. Lead designation for EC1 connection for cable# x should be read as 
EC1 xR/xT instead of DS3 xR/xT, where x is a number from 1 to 48.

Coaxial 
cable

Lead 
designation Name

Connector
pin #
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12TMUX (LNW18) cable installation

Description

This section describes how to connect the TMUX cables to the 1665 DMX High-Capacity 
shelf and route the cables out of the bay and to the TMUX terminating equipment. 
Perform this procedure if TMUX cables are required for an LNW18 in a function group.

It should be noted that the cables used for 12TMUX support are DS3 cables (12 port). The 
new high capacity DS3 cables will also support 12TMUX, but only in a 12 port capacity.

Important! When cabling the 1665 DMX High-Capacity shelf to a DSX, the DSX 
becomes an extension of the 1665 DMX High-Capacity shelf backplane connections. 
Therefore, the IN on the 1665 DMX High-Capacity shelf backplane connects to the IN 
of the DSX and the OUT of the 1665 DMX High-Capacity shelf backplane connects to 
the OUT of the DSX.

TMUX cable options are listed in Table 1-7, “DS3/EC1 or TMUX cable assemblies” 
(p. 1-44).

TMUX transmission connections are in Table 1-9, “12TMUX transmission connections” 
(p. 1-57). Total of four function groups fully cabled will have 48 DS3 drop capacity.

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Obtain the TMUX (DS3) cables per Table 1-7, 
“DS3/EC1 or TMUX cable assemblies” (p. 1-44) and note the function group where each 
cable will be used. Label the cables, indicating bay, shelf, function group (A, B, C or D) 
and direction (IN or OUT of the bay) at each end.

........................................................................................................................................................................................................................

2 Connect the function group cables at the 1665 DMX High-Capacity shelf end, carefully 
matching the correct connector with the appropriate backplane connectors as shown in 
Figure 1-16, “12TMUX cable installation” (p. 1-55).

Important! DS3/EC1 and TMUX cable retaining screws must be tightened to a 
maximum of 6.5 in-lb. Do not overtighten.
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Figure 1-16  12TMUX cable installation

........................................................................................................................................................................................................................

3 Route the cables along the backplane and out of the bay to the DSX per Figure 1-17, 
“TMUX cable routing” (p. 1-56).

OUT

IN

OUT

IN IN

OUT

IN

OUT
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Figure 1-17  TMUX cable routing

Important! The shelf depicted above is a 1665 DMX standard shelf and is used for 
cable routing reference only.

........................................................................................................................................................................................................................

4 Route the cables along the cable rack and into the terminating bay (DSX or other 
terminating transmission equipment).

........................................................................................................................................................................................................................

5 Cut the cables to desired length and install the BNC connectors shipped with the cable 
assemblies.

Important! When installing BNC connectors, follow the manufacturer’s instruction 
carefully to ensure a proper connection. Failure to do so may result in faulty DS3 
signals as a result of improperly installed BNC connectors.

........................................................................................................................................................................................................................

6 Connect the cables to their respective positions on the terminating equipment.

TMUX
Cables
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........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Table 1-9 12TMUX transmission connections

Coaxial 
cable

Lead 
designation Name

Connector 
pin #

1 DS3 1R/1T Signal 40

FRG1 Ground 39

2 DS3 2R/2T Signal 17

FRG2 Ground 18

3 DS3 3R/3T Signal 57

FRG3 Ground 58

4 DS3 4R/4T Signal 13

FRG4 Ground 14

5 DS3 5R/5T Signal 53

FRG5 Ground 54

6 DS3 6R/6T Signal 10

FRG6 Ground 11

7 DS3 7R/7T Signal 51

FRG8 Ground 50

8 DS3 8R/8T Signal 6

FRG8 Ground 7

9 DS3 9R/9T Signal 47

FRG9 Ground 46

10 DS3 10R/10T Signal 4

FRG10 Ground 3

11 DS3 11R/11T Signal 24

FRG11 Ground 23

12 DS3 12R/12T Signal 1

FRG12 Ground 2
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10/100BaseT backplane Ethernet cable installation

Description

This section describes how to connect the 10/100BaseT cables to the 1665 DMX High-
Capacity shelf backplane and route the cables out of the bay and to the 10/100BaseT 
terminating equipment (for example, a 110/RJ45® punch down block). Perform this 
procedure if 10/100BaseT cables are required.

The next section covers installation of Ethernet cables connected directly to SFP modules 
on circuit pack faceplates if applicable.

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Obtain the 100BASE-TX Ethernet cables per 
Table 1-10, “10/100BaseT Ethernet cable assemblies” (p. 1-60) and note the function 
group where each cable will be used. Label the cables, indicating bay, shelf and function 
group (A, B, C or D) at each end.

........................................................................................................................................................................................................................

2 Connect the function group cables at the 1665 DMX High-Capacity shelf end, carefully 
matching the correct connector with the appropriate backplane connectors as shown in 
Figure 1-18, “10/100BaseT cable installation” (p. 1-59). Refer to Table 1-11, 
“10/100BaseT Ethernet connections” (p. 1-61).

Important! 100BASE-TX Ethernet cable retaining screws must be tightened to a 
maximum of 6.5 in-lb. Do not overtighten.
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Figure 1-18 10/100BaseT cable installation

........................................................................................................................................................................................................................

3 Route the cables along the backplane and out of the bay to the 110/RJ45 punch down 
block. Route the cables in the same manner as DS3/EC1 cables. Refer to Figure 1-15, 
“DS3/EC1 and 48TMUX cable routing” (p. 1-43).

........................................................................................................................................................................................................................

4 Route the cables along the cable rack and into the terminating bay.

........................................................................................................................................................................................................................

5 Cut cable to length and punch down cable to the 110 block. Refer to Table 1-11, 
“10/100BaseT Ethernet connections” (p. 1-61) for pin out assignments.
:

OUT

IN

OUT

IN IN

OUT

IN

OUT

CAUTION
The LNW66, LNW71 and LNW74 10/100BaseT-Ethernet packs do not have 
lightning protection for the metallic connections. Therefore it is necessary to 
use a lightning-protected patch panel, such as the Black Box CAT5 protected 
patch panel JSM110A, for intra-office applications only.
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Important! Backplane connectors are associated with function Groups as follows:

• J1, J2   ➠ Function Group A

• J3, J4   ➠ Function Group B

• J5, J6   ➠ Function Group C

• J7, J8   ➠ Function Group D

........................................................................................................................................................................................................................

6 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Table 1-10 10/100BaseT Ethernet cable assemblies

Description
Cable 

assembly #
Cable length 

(feet)

1665 DMX 
backplane 

connections

10/100baseT Ethernet cable 848819090 8 J1A (ports 1-12)
J2A (ports 13-24)

J3B (ports 1-12)
J4B (ports 13-24)

J6C (ports 1-12)
J5C (ports 13-24)

J8D (ports 1-12)
J7D (ports 13-24)

NOTE: LNW74 
has only ports 1-12 
and ports 13-16.

848778114 20

848923280 35

848778122 50

848923298 75

848778106 100

848923306 125

848778148 150

848923314 175

848923322 200

848923330 225

848923348 250

848923355 275

848778130 300
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Table 1-11 10/100BaseT Ethernet connections

Port# 

J2, J4, J5, J7 J1, J3, J6, J8
Wire 
color

Dsub 62M 
pin # Signal RJ-45 pin #

13 1 W/O 50/49 R+/R- 1/2

W/BL 8/29 T+/T- 3/6

14 2 W/BR 48/47 R+/R- 1/2

W/G 5/26 T+/T- 3/6

15 3 R/BL 7/28 R+/R- 1/2

W/S 6/27 T+/T- 3/6

16 4 R/G 46/45 R+/R- 1/2

R/O 4/25 T+/T- 3/6

17 5 R/S 56/55 R+/R- 1/2

R/BR 13/34 T+/T- 3/6

18 6 BK/O 11/32 R+/R- 1/2

BK/BL 10/31 T+/T- 3/6

19 7 BK/BR 54/53 R+/R- 1/2

BK/G 12/33 T+/T- 3/6

20 8 Y/BL 52/51 R+/R- 1/2

BK/S 9/30 T+/T- 3/6

21 9 Y/G 19/40 R+/R- 1/2

Y/O 18/39 T+/T- 3/6

22 10 Y/S 58/57 R+/R- 1/2

Y/BR 16/37 T+/T- 3/6

23 11 V/O 60/59 R+/R- 1/2

V/BL 17/38 T+/T- 3/6

24 12 V/BR 15/36 R+/R- 1/2

V/G 14/35 T+/T- 3/6

Notes:  
1. 10/100baseT Ethernet cables have transmit and receive on the same cable.

2. LNW74 has 16 10/100BaseT ports.
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Ethernet cabling to SFP modules on circuit pack faceplates

Description

Use this section to run Category 5e cables to the SFP modules on the front of LNW63, 
LNW64, LNW70 or LNW170, Ethernet circuit packs. Refer to Figure 1-19.

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Refer to Figure 1-19.

Figure 1-19 Ethernet cable routing to faceplate SFP modules
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........................................................................................................................................................................................................................

2 Connect the RJ45 plugs to the faceplate SFP modules and run the cables out of the shelf as 
shown.

Table 1-12 GbE Ethernet cables

........................................................................................................................................................E N D  O F  S T E P S

Description Cable assembly # Cable length (feet)

GbE Ethernet cables

CAT5e Gigabit Ethernet 
shielded connectorized on 
both ends with straight 
RJ45 connector.

849010483 5

849010491 10

849010509 15

849010517 20

849010525 25

849010533 30

849010541 40

849010558 50

849010566 60

849010574 70

849010582 80

849010590 90

849010608 100

849010616 110

849010624 120

849010632 130

849010640 140

849010657 150

849010665 160

849010673 180

849010681 200

849010699 220

849010707 240

849010715 260

849010723 280

849010731 300
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IAO LAN and TCP/IP cable installation

Description

This section describes how to connect the IAO LAN/TCP-IP (LAN 10BaseT) cable to the 
1665 DMX High-Capacity shelf and to the interfacing equipment. Perform this procedure 
if this cabling is required.

The 1665 DMX High-Capacity shelf supports an IntraOffice LAN (IAO LAN) interface 
for operations data communications to support operations systems such as the Navis 
Optical Management System (OMS).

Since the IAO LAN can be provisioned as an extension of the SONET DCC, the IAO 
LAN can also be used to join multiple, otherwise separate subnetworks. 

All NE-to-NE OI features that are supported over the DCC are also supported over the 
IAO LAN.

The IAO LAN/TCP-IP interface cable is available in two configurations (cross-over and 
straight-through) and may be connected to either the front or rear of the 1665 DMX High-
Capacity shelf. The following tables provide additional information:

• Table 1-13, “LAN 10BaseT cable assemblies” (p. 1-67)

• Table 1-14, “LAN 10BaseT cross-over cable connections” (p. 1-68)

• Table 1-15, “LAN 10BaseT straight-through cable connections” (p. 1-68)

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 If connecting directly to a PC, use a LAN 10BaseT cross-over cable assembly (see 
Table 1-13).

If connecting to a hub, use a LAN 10BaseT straight-through cable assembly (see 
Table 1-13).

........................................................................................................................................................................................................................

2 If connecting to the front of the 1665 DMX High-Capacity shelf, connect the cable to the 
LAN (RJ45) jack on the SYSCTL circuit pack. See Figure 1-20, “LAN cable installation 
to front of 1665 DMX High-Capacity shelf” (p. 1-65).

If connecting to the rear of the 1665 DMX High-Capacity shelf, connect the cable to the 
J16 port (IAO LAN) on the 1665 DMX High-Capacity shelf backplane. See Figure 1-21, 
“IAO LAN/TCP-IP cable installation to rear of 1665 DMX High-Capacity shelf” 
(p. 1-66).
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Figure 1-20 LAN cable installation to front of 1665 DMX High-Capacity shelf

Important! The above Figure shows a standard 1665 DMX shelf as reference only. 
The placement of the packs and PC lan port are the same on the 1665 DMX High-
Capacity shelf.
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Figure 1-21 IAO LAN/TCP-IP cable installation to rear of 1665 DMX High-Capacity 
shelf

........................................................................................................................................................................................................................

3 If a cross-over cable is used, route the cable to the desired PC LAN port.

If a straight-through cable is used, route the cable to the desired hub port location.

........................................................................................................................................................................................................................

4 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

LAN Cable
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Table 1-13 LAN 10BaseT cable assemblies

Description
Cable 
assembly #

Cable 
length (feet)

1665 DMX connections

Front Rear

LAN 10BaseT 
cross-over cable

109321810 10 SYSCTL
LAN jack

J16 (IAO LAN)

848605028 50

848605036 100

848605051 150

848605069 200

848605077 300

LAN 10BaseT 
straight-through cable

109321836 20 SYSCTL
LAN jack

J16 (IAO LAN)

109321844 30

109321851 40

848604948 50

109321869 60

109321877 70

109321885 80

109321893 90

848604955 100

109321901 110

109321919 120

109321927 130

109321935 140

848604963 150

109321943 160

109321950 180

848604971 200

109321968 220

109321976 240

109321984 260

109321992 280

848604997 300
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Table 1-14 LAN 10BaseT cross-over cable connections

Table 1-15 LAN 10BaseT straight-through cable connections

Connection

1665 DMX 
High-
Capacity 
shelf f bkpl Color Other side

 J16 (IAO LAN) 1 BL - W 3

2 W - BL 6

3 O - W 1

6 W - O 2

Connection

1665 DMX 
High-
Capacity 
shelf bkpl Color Other side

J16 (IAO LAN) 1 BL - W 1

2 W - BL 2

3 O - W 3

6 W - O 6
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............................................................................................................................................................................................................................................................

Modem cable installation

Description

The use of a modem will allow the 1665 DMX High-Capacity shelf to be accessed 
remotely via dial up.

Important! Perform this procedure for the shelf that will be directly connected to a 
modem or a distribution frame (if specified in the order).

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Obtain the modem cable per Table 1-16, “Modem cable assemblies” (p. 1-71). Connect 
the RJ45 end of the modem cable to the MODEM port (J17) of 1665 DMX High-Capacity 
shelf (See Figure 1-22, “Modem cable installation” (p. 1-70).
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Figure 1-22 Modem cable installation 

........................................................................................................................................................................................................................

2 Route the modem cable out of the 1665 DMX High-Capacity shelf bay to the modem or 
distribution frame.

........................................................................................................................................................................................................................

3 Dress and tie the modem cable to the 1665 DMX High-Capacity shelf backplane per 
Figure 1-22, “Modem cable installation” (p. 1-70).

........................................................................................................................................................................................................................

4 Connect the modem cable to the modem or distribution frame.
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........................................................................................................................................................................................................................

5 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Table 1-16 Modem cable assemblies

Table 1-17 Modem cable connections

Description
Cable 
assembly #

Cable length 
(feet)

1665 DMX 
High-Capacity 
shelf 
connections

Modem cable 848756508 50 J17 (MODEM)

848756524 100

848756516 150

848756532 250

Connection

RJ45 
connector 
pin# Color

DB25 
Connector 
Pin #

Modem cable (J17) 1 W - O 8

2 BR 20

3 W - BL 3

5 O / Shield 7

6 G 2
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Sync cable installation

Description

This section provides the instructions for installing the two types of synchronization 
(Sync) cables to the 1665 DMX High-Capacity shelf.

A Sync cable is required if the shelf is to be externally timed. The 1665 DMX High-
Capacity shelf can provide DS1 external timing to a BITS clock. When the shelf is 
externally timed by a DS1 Reference and/or is configured to provide a Sync Output, a 
Sync Input timing cable is required.

This procedure should be performed on each 1665 DMX High-Capacity shelf requiring an 
external timing source. There are two types of cables available:

1. Sync cable with a molded D-Sub 9-Pin (DB-9) connector 

2. Sync cable with a wire-wrap DB-9 connector. 

Important! Each of the Sync connections on the backplane provides an input (gray) 
and output (red) termination for timing. Refer to Table 1-19, “Synchronization cable 
(DS1 timing reference) connections” (p. 1-77) for the pinouts.

Sync cable with molded DB-9 connector procedure

Perform the following steps when using a Sync cable with a molded DB-9 connector.

........................................................................................................................................................................................................................

1 Connect the DB-9 connector end of the Sync cable to the SYNC1 (J9) port on the 1665 
DMX High-Capacity shelf backplane. Refer to Figure 1-23, “Sync cable with molded 
DB9 connector installation” (p. 1-73).
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Figure 1-23 Sync cable with molded DB9 connector installation

........................................................................................................................................................................................................................

2 Route the cable to proper location and cut to desired length.

........................................................................................................................................................................................................................

3 Terminate the wires in the red jacket for an output signal.

........................................................................................................................................................................................................................

4 Terminate the wires in the gray jacket for an input signal.

........................................................................................................................................................................................................................

5 Repeat Step 1 through Step 4 to connect the Sync cable to the SYNC2 (J14) port.

TO DS1 SYNCHRONOUS TIMING REFERENCE

CABLE TIE (TYPICAL)

TIE CABLE ASSY'S TO CABLE SUPPORT BAR

(AS REQUIRED)
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6 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Sync cable with wire-wrap DB-9 connector procedure

Perform the following steps when using the Sync cable with the wire-wrap DB-9 
connector.

........................................................................................................................................................................................................................

1 Connect the wire-wrap DB-9 connector to SYNC1 (J9). Refer to Figure 1-24, “Sync cable 
with wire-wrap connector installation” (p. 1-74).

Figure 1-24 Sync cable with wire-wrap connector installation

TO DS1 SYNCHRONOUS TIMING REFERENCE

CABLE TIE (TYPICAL)

TIE CABLE ASSY'S TO CABLE SUPPORT BAR

(AS REQUIRED)
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........................................................................................................................................................................................................................

2 Wire-wrap Rx1 and Tx1 (red cable) on the D-Sub connector for an output signal.

........................................................................................................................................................................................................................

3 Wire-wrap Rx2 and Tx2 (gray cable) on the D-Sub connector for an input signal.

........................................................................................................................................................................................................................

4 Route the cable to proper location and cut to desire length.

........................................................................................................................................................................................................................

5 Terminate the other end to a clock source or equipment.

........................................................................................................................................................................................................................

6 Repeat Step 1 through Step 5 for SYNC2 (J14) connection.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Table 1-18 Synchronization cable assemblies (SYNC1 and SYNC2)

Description
Cable 
assembly #

Cable length 
(feet)

1665 DMX 
backplane 
connections

Sync cable with molded 
DB-9 connector
DS1 timing reference for DS1 
external sync in/out timing

848839619 50 J9 (Sync1)/
J14 (Sync2)848923363 75

848839627 100

848923371 125

848839635 150

848923389 175

848923439 200

848923447 225

848839643 250

848923454 275

848923462 300

848839650 450

Sync cable with wire-wrap
DB-9 connector
DS1 timing reference for DS1 
external sync in/out timing 

848631255 50

848631271 100

848631289 150

848631297 250

848631305 450

Sync cable with filter connector 
(sync input signal only)
DS1 timing reference for DS1 
external sync in timing 

848929311 50

848929329 100

848929337 150

848929345 250

848929352 450

Notes:  

1. The Sync cable is 22 gauge.

2. Ground the Filter connector either at the bay frame ground or at the office timing source. Refer to office 
records.
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Table 1-19 Synchronization cable (DS1 timing reference) connections

Conn. Jacket Color
9-Pin 
conn.

Special 
conn. Designation Name

Sync1 (J9)/
Sync2 (J14)

Red BL 1 Rx1 RGO1/RGO2 Sync Output

W 6 Tx1 TPO1/TPO2

Gray BL 2 Rx2 RGI1/RGI2 Sync Input

W 7 Tx2 TPI1/TPI2

Drain 5 GND GRD
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Office alarm cable installation

Description

Office alarms are the common method used in a central office for maintenance personnel 
to quickly isolate a failure. Perform this procedure if connection to the office alarm system 
is required.

Important! The office alarm relay contacts are rated at 50 VA which means that they 
are capable of switching 1 amp at 50 volts, or 2 amps at 25 volts. Their ability to 
switch large transient currents means that they can, if necessary, switch up to ten 
5-watt aisle pilot lamps.

If transient voltages or currents are above these limits, transient noise-suppressing devices 
such as diodes or contact protection networks must be used to keep within the voltage and 
current limits. If these protection devices are not sufficient, an external buffer relay MUST 
be provided.

In all cases, and as a matter of good practice, suppression devices such as diodes or contact 
protection networks must be provided across any external relay coil being driven by the 
1665 DMX High-Capacity shelf to limit transient voltages and currents.

Office alarm cable assemblies are listed in Table 1-20, “Office alarm cable assemblies” 
(p. 1-82).

Alarm Mult

Office alarm cabling in a 1665 DMX High-Capacity shelf bay starts at the bottom shelf 
which is cabled directly to the office alarm system. Then as shelves are added to the bay, 
the office alarm connection is extended by multing the alarm cabling from shelf to shelf 
(bottom to top). Alarm mults do not leave the bay.

For example, J12 of one shelf should be connected to the office alarm terminal. J13 of the 
same shelf should be connected to J12 of the next 1665 DMX High-Capacity shelf and the 
same procedure should be continued to connect more shelves.



Office alarm cable installationEquipment and cable installation for 1665 Data Multiplexer 
(1665 DMX)

............................................................................................................................................................................................................................................................

365-372-304R7.1
Issue 1, November 2007

1 - 7 9

Procedure

........................................................................................................................................................................................................................

1 Obtain the office alarm cable per Table 1-20, “Office alarm cable assemblies” (p. 1-82). 
Connect the office alarm cable to ALM (J12) of the bottom 1665 DMX High-Capacity 
shelf.

........................................................................................................................................................................................................................

2 Route the office alarm cable from the bottom shelf out of the 1665 DMX High-Capacity 
shelf bay per Figure 1-25, “Office alarm cable installation” (p. 1-79) to the office alarm 
panel.

Figure 1-25 Office alarm cable installation

........................................................................................................................................................................................................................

3 Inspect the office alarm panel and add a contact protection network (if required).

CABLE TIE (TYPICAL)

TIE CABLE ASSY'S TO

CABLE SUPPORT BAR

(AS REQUIRED)

TO OFFICE ALARM INTERFACE
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........................................................................................................................................................................................................................

4 Cut the office alarm cable to the desired length.

........................................................................................................................................................................................................................

5 Wire-wrap the loose end of the office alarm cable to the alarm panel, making connections 
as listed in Table 1-21, Office alarm connections.

........................................................................................................................................................E N D  O F  S T E P S

Alarm mult

The following steps should be performed when the bottom shelf in the bay will be directly 
connected to the office alarms. The cable added in this procedure is to mult office alarms 
in a bay to the bottom shelf. In this procedure the bottom shelf is multed to the shelf 
immediately above. That shelf is then multed to the shelf above it. Continue until the top 
shelf is connected.

Important! In order for office alarms in a shelf (other than the bottom shelf) to be 
reported, all office alarm cable mults from that shelf to the bottom shelf must be in 
place. No shelf should be skipped.

........................................................................................................................................................................................................................

1 Obtain the office alarm mult cable (848589602 for DMX to DMX and 848861530 for 
DMX to Lambda Unite). Connect one end to ALM MULT (J13) of the 1665 DMX High-
Capacity shelf.

........................................................................................................................................................................................................................

2 Route the office alarm mult cable to the side of the bay and connect it to ALM (J12) of the 
1665 DMX High-Capacity shelf above or to Lambda Unite as required.
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Figure 1-26 Office alarm mult cable installation

848589602 CABLE ASSEMBLY

CONNECT THIS END OF CABLE
ASSEMBLY AS FOLLOWS

FROM TO

PATCH
CONNECTOR

TO PANEL
POSITION

OFFICE
ALARM MULT

J13
ALM MULT

CONNECT OTHER END OF CABLE ASSEMBLY
TO SUCCEEDING DMX SHELF (J12 ALM)
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........................................................................................................................................................................................................................

3 Repeat this procedure for each shelf in the bay.

........................................................................................................................................................................................................................

4 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Table 1-20 Office alarm cable assemblies

Description
Cable 
assembly #

Cable 
length 
(feet)

1665 DMX 
backplane 
connections

Office alarm cable 848558193 50 J12

848562286 100

848562294 150

848562302 250

Office alarm mult 
cable (DMX to DMX)

848589602 3 J13

Office alarm mult 
cable (DMX to 
Lambda Unite)

848861530 3 J13
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Table 1-21 Office alarm connections

Conn. Pin# Color Designation Name

J12-J13 1

2

3

4

BL-W

W-BL

O-W

W-O

RYMJV1

RYMJV2

RYMJA1

RYMJA2

Major Alarm Visible

Major Alarm Visible Return

Major Alarm Audible

Major Alarm Audible Return

5

6

7

8

G-W

W-G

BR-W

W-BR

RYMNV1

RYMNV2

RYMNA1

RYMNA2

Minor Alarm Visible

Minor Alarm Visible Return

Minor Alarm Audible

Minor Alarm Audible Return

9

10

11

12

S-W

W-S

BL-R

R-BL

RYCRV1

RYCRV2

RYCRA1

RYCRA2

Critical Alarm Visible

Critical Alarm Visible Return

Critical Alarm Audible

Critical Alarm Audible Return

Notes:  

1. The SYSCTL circuit pack reports office alarms. 

2. The connection to the central office alarms from P12 is run for each 1665 
DMX High-Capacity shelf assembly when used in a miscellaneously 
mounted individual application or from the first 1665 DMX High-Capacity 
shelf assembly when mounted in a typical bay arrangement.
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Miscellaneous (environmental) discrete telemetry cable installation

Description

The miscellaneous (environmental) discrete telemetry access allows the maintenance 
center to control and monitor equipment collocated with the 1665 DMX High-Capacity 
shelf.

The environmental control feature enables the maintenance center to remotely initiate up 
to four contact closures at the remote terminal (RT) for equipment operation such as 
pumps, generators, etc.

The environmental alarm status indications allow up to 23 miscellaneous user-settable 
alarm status indications (SI) at the remote terminal for transmission toward the central 
office.

Miscellaneous (environmental) discrete telemetry cable assemblies and the length options 
are listed in Table 1-22, “Miscellaneous discrete cable assemblies” (p. 1-86).

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Connect the miscellaneous discrete telemetry cable to the J11 MISC connector on the 
backplane of the 1665 DMX High-Capacity shelf per Figure 1-27, “Miscellaneous 
discrete cable installation” (p. 1-85).
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Figure 1-27 Miscellaneous discrete cable installation 

........................................................................................................................................................................................................................

2 Route the cable out of the 1665 DMX High-Capacity shelf bay per Figure 1-27, 
“Miscellaneous discrete cable installation” (p. 1-85) to the telemetry panel.

........................................................................................................................................................................................................................

3 Cut the miscellaneous (environmental) discrete telemetry cable to the desired length at the 
telemetry panel.

........................................................................................................................................................................................................................

4 Wire-wrap the loose end of the miscellaneous (environmental) discrete telemetry cable to 
the wire-wrap terminal strip, making connections per Table 1-23, “Miscellaneous 
(environmental) discrete telemetry connections” (p. 1-87).

TO TELEMETRY CIRCUIT, MISCELLANEOUS DISCRETES

CABLE TIE (TYPICAL)
TIE CABLE ASSY'S TO
CABLE SUPPORT BAR
(AS REQUIRED)
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Important! Each miscellaneous (environmental) discrete telemetry designation is 
connected to the 1665 DMX High-Capacity shelf by two leads (wires). 
For each input, one lead should be connected to input-common and the other lead 
should be connected to the appropriate alarm indication. 
For each output, one lead should be connected to output-common and the other lead 
should be connected to the appropriate alarm indication. 

........................................................................................................................................................................................................................

5 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Table 1-22 Miscellaneous discrete cable assemblies

Description
Cable 
assembly #

Cable 
length   
(feet)

1665 DMX 
backplane 
connections

Miscellaneous 
discrete cable

109321794 15 J11

109321802 30

848839569 50

848839577 100

848839585 150

848839593 250

848839601 350
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Table 1-23 Miscellaneous (environmental) discrete telemetry connections

Conn. Pin# Color Designation Name

 J11 1
2
3
4

BL-W
W-BL
O-W
W-O

TLMI1
TLMI2
TLMI3
TLMI4

Env. Input - #1
Env. Input - #2
Env. Input - #3
Env. Input - #4

5
6
7
8

G-W
W-G
BR-W
W-BR

TLMI5
TLMI6
TLMI7
TLMI8

Env. Input - #5
Env. Input - #6
Env. Input - #7
Env. Input - #8

9
10
11
12

S-W
W-S
BL-R
R-BL

TLMI9
TLMI10
TLMI11
TLMI12

Env. Input - #9
Env. Input - #10
Env. Input - #11
Env. Input - #12

13
14
15
16

O-R
R-O
G-R
R-G

TLMI13
TLMI14
TLMI15
TLMI16

Env. Input - #13
Env. Input - #14
Env. Input - #15
Env. Input - #16

17
18
19
20

BR-R
R-BR
S-R
R-S

TLMI17
TLMI18
TLMI19
TLMIC48VTRN

Env. Input - #17
Env. Input - #18
Env. Input - #19
Input Common

21
22
23
24
25

BL-BK/
BK-BL
O-BK
BK-O
G-BK

TLMO1
TLMO2
TLMO3
TLMO4
TLMOC

Env. Output - #1
Env. Output - #2
Env. Output - #3
Env. Output - #4
Output Common
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Main optical fiber installation (OC-12, OC-48, OC-192)

Description

This section describes how to route the optical fiber cables from the interconnecting 
equipment (for example, a LGX® optical fiber distributing frame) to the Main OLIUs of 
the 1665 DMX High-Capacity shelf. This procedure does not cover routing the optical 
fiber cable between sites.

The optical fiber cables will be connected to the 1665 DMX after the circuit packs are 
installed. The 1665 DMX requires single-mode fiber for the main OLIUs.

Important! The optical fiber cable is fragile and must be protected. The fibers should 
be placed in a protective tube or channel, such as PVC tubing, or PANDUIT cable 
channel, when running the cable from the 1665 DMX High-Capacity shelf to the cable 
rack. The fibers should be placed in the cable rack in a protective channel with nothing 
on top of them. Cable ties should NOT be used with the optical fiber cables.

Unterminated optical connectors may emit laser radiation. Do not view an unterminated 
optical connector with optical instruments.

Invisible laser radiation when unterminated. Avoid direct exposure of the eyes to the 
beam.

Important! Prior to connecting the optical fiber cables, the fibers should be 
examined to ensure that they are clean. See Appendix B, “Fiber cleaning” for 
recommended cleaning procedures.

WARNING

Laser hazard

WARNING

Laser hazard
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Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Route the optical fiber cables from the interconnecting equipment into the 1665 DMX 
High-Capacity shelf.

Important! Protective covers must be left on fibers.

........................................................................................................................................................................................................................

2 Place the optical fiber cables in a protective tube or channel.

........................................................................................................................................................................................................................

3 Label the optical fiber cables, indicating bay, shelf, pack, and direction (IN or OUT).

........................................................................................................................................................................................................................

4 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Fiber installation for low-speed packs

Description

This section describes how to route the single-mode fiber optical cables from the 
interconnecting equipment (for example, a LGX® optical fiber distributing frame) to the 
1665 DMX High-Capacity shelf OC3/OC12/OC48 optical ports. This procedure does not 
cover routing the optical fiber cable between sites. 

The optical fiber cables will be connected to the optical ports after the circuit packs are 
installed.

Important! The optical fiber cable is fragile and must be protected. The fibers should 
be placed in a protective tube or channel, such as PVC tubing, or PANDUIT cable 
channel, when running the cable from the 1665 DMX to the cable rack. The fibers 
should be placed in the cable rack in a protective channel with nothing on top of them. 
Cable ties should NOT be used with the optical fiber cables.

Important! Ensure only ANGLED LC connectors appear at IN ports of optical 
circuit packs.

Unterminated optical connectors may emit laser radiation. Do not view an unterminated 
optical connector with optical instruments.

Invisible laser radiation when unterminated. Avoid direct exposure of the eyes to the 
beam.

Important! Prior to connecting the optical fiber cables, the fibers should be 
examined to ensure that they are clean. See Appendix B, “Fiber cleaning” for 
recommended cleaning procedures.

WARNING

Laser hazard

WARNING

Laser hazard
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Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Determine the function slot where the pack will 
be inserted. The OC-3/OC-12/OC-48 pack can be inserted into any of the function slots 
including the growth slots.

........................................................................................................................................................................................................................

2 Label the optical fiber cables, indicating bay, shelf, function group, pack, and direction (IN 
or OUT).

........................................................................................................................................................................................................................

3 Route optical fiber cables from the interconnecting equipment into the OC-3/OC-12/OC-
48 optical ports

........................................................................................................................................................................................................................

4 Place the optical fiber cables in a protective tube or channel.

........................................................................................................................................................................................................................

5 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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1000Base-F and 100Base-F fiber installation

Description

This section describes how to route the optical fiber cables from the interconnecting 
equipment (for example, an LGX® optical fiber distributing frame) to the optical ports on 
LNW63, LNW64, LNW67, LNW68, LNW70, LNW74 and LNW78 Ethernet circuit 
packs. Multi-mode optical fiber is required for LNW67 (1000 Base-F), LNW70 (100Base-
F ports) and LNW74 (100 Base-F ports). Single-mode fiber is required for LNW68 (1000 
LX), LNW70 (1000Base-F ports) and LNW78(RPR) circuit packs.

The optical fiber cables will be connected to the optical ports after the circuit packs are 
installed.

Important! The optical fiber cable is fragile and must be protected. The fibers should 
be placed in a protective tube or channel, such as PVC tubing, or PANDUIT cable 
channel, when running the cable from the 1665 DMX High-Capacity shelf to the cable 
rack. The fibers should be placed in the cable rack in a protective channel with nothing 
on top of them. Cable ties should NOT be used with the optical fiber cables.

Unterminated optical connectors may emit laser radiation. Do not view an unterminated 
optical connector with optical instruments.

Invisible laser radiation when unterminated. Avoid direct exposure of the eyes to the 
beam.

Important! Prior to connecting the optical fiber cables, the fibers should be 
examined to ensure that they are clean. See Appendix B, “Fiber cleaning” for 
recommended cleaning procedures.

Procedure

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Determine the function group (slot 1 only) 
where the pack will be inserted. The LNW63, LNW64, LNW67, LNW68, LNW70, 
LNW74 and LNW78 packs can be inserted into any of the function groups (slot 1) 
including the growth slot (g1). In order to use the 10/100BaseT electrical ports on the 

WARNING

Laser hazard

WARNING

Laser hazard
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LNW74, use FN-A, FN-B, FN-C or FN-D. Only optical ports can be used when LNW74 
is located in the Growth-1 position.

........................................................................................................................................................................................................................

2 Label the optical fiber cables, indicating bay, shelf, function group, pack, and direction 
(IN or OUT).

........................................................................................................................................................................................................................

3 Route optical fiber cables from the interconnecting equipment into the optical ports.

........................................................................................................................................................................................................................

4 Place the optical fiber cables in a protective tube or channel.

........................................................................................................................................................................................................................

5 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Fibre channel fiber installation

Description

This section describes how to route the optical fiber cables from the interconnecting 
equipment (for example, an LGX® optical fiber distributing frame) to the optical ports on 
LNW73/73C Fibre Channel circuit packs. Multi-mode and single-mode optical fiber is 
supported. Refer to engineering job spec for fiber requirements.

The optical fiber cables will be connected to the optical ports after the circuit packs are 
installed.

Important! The optical fiber cable is fragile and must be protected. The fibers should 
be placed in a protective tube or channel, such as PVC tubing, or PANDUIT cable 
channel, when running the cable from the 1665 DMX to the cable rack. The fibers 
should be placed in the cable rack in a protective channel with nothing on top of them. 
Cable ties should NOT be used with the optical fiber cables.

Unterminated optical connectors may emit laser radiation. Do not view an unterminated 
optical connector with optical instruments.

Invisible laser radiation when unterminated. Avoid direct exposure of the eyes to the 
beam.

Important! Prior to connecting the optical fiber cables, the fibers should be 
examined to ensure that they are clean. See Appendix B, “Fiber cleaning” for 
recommended cleaning procedures.

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Determine the function slot that the pack will 
be inserted. The LNW73/73C can be inserted into any of the function slots including the 
growth slots. 

WARNING

Laser hazard

WARNING

Laser hazard
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........................................................................................................................................................................................................................

2 Label the optical fiber cables, indicating bay, shelf, function group, pack, and direction 
(IN or OUT).

........................................................................................................................................................................................................................

3 Route optical fiber cables from the interconnecting equipment into the optical ports.

........................................................................................................................................................................................................................

4 Place the optical fiber cables in a protective tube or channel.

........................................................................................................................................................................................................................

5 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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CIT cable installation

Description

This section provides the procedure to connect the CIT cable from the LNW2 (SYSCTL) 
to a PC (serial port). This will allow communications between the PC and the CIT port 
located on the LNW2.

Procedure

........................................................................................................................................................................................................................

1 Connect the RJ45 end of the CIT cable to the CIT jack located on the LNW2 (SYSCTL). 
Refer to Figure 1-28, “CIT cable installation” (p. 1-97).

Important! The LNW2 (SYSCTL) is not in the shelf at this time, this procedure is 
here to demonstrate the placement of the cable once the circuit pack is in place.

........................................................................................................................................................................................................................

2 Connect the 9-pin D-type connector to the serial port on the PC.
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Figure 1-28 CIT cable installation

........................................................................................................................................................................................................................

3 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Table 1-24 CIT Cable Assembly

Description
Cable 
assembly #

Cable 
length

1665 DMX High-Capacity shelf 
connections

Front CIT cable 848748869 8 feet CIT/RS-232 jack on SYSCTL (LNW2)
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Table 1-25 Standard CIT cable connections

Table 1-26 RJ-45 to DB-9 connector connections

Connection

RJ45 connector

Color

9-Pin D-type connector

Pin# Designation Pin# Designation

Front CIT cable 1 FRS232N W - O 6 DCE Ready

3 FDTR W - BL 4 DTE Ready

4 Ground W - G 5 Ground

5 FTXD O 2 Receive Data

6 FRXD G 3 Transmit Data

Notes:  

1. The connection and the colors shown above are for a standard Lucent made cable. If 
you use a RJ-45 to DB-9 connector with a standard straight-through 10BaseT LAN 
cable, refer to Table 1-26, “RJ-45 to DB-9 connector connections” (p. 1-98).

From RJ45 
connector

To 9-pin D-type 
connector

Pin# Color Pin#

1 Blue 6

3 Black 4

4 Red 5

5 Green 2

6 Yellow 3

Notes:  

1. The connection and the colors shown above are for RJ-45 to 
DB-9 connector.

2. This connector should be used with a standard straight-through 
cable which has all 8 wires connected.
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Final operations

Description

Final check on equipment and cable installation.

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Verify that all the cables are properly dressed/connected.

........................................................................................................................................................................................................................

2 Verify that all cables are properly labeled.

........................................................................................................................................................................................................................

3 Verify that designations where cables were wire-wrapped are properly labeled.

........................................................................................................................................................................................................................

4 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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2 Powering and initial circuit pack 
installation for 1665 Data 
Multiplexer (1665 DMX)

............................................................................................................................................................................................................................................................

Overview

Purpose

This section provides information for performing the following:

• Shelf powering

• Circuit pack option settings and installation.

Detailed information on the function of each circuit pack is contained in 365-372-300, 
1665 Data Multiplexer, Applications and Planning Guide.

Contents

This chapter provides information on the following topics:

Description  2-2

Powering  2-3

Circuit pack compatibility  2-7

Initial circuit pack installation  2-12
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Description

Overview

This section should be performed on all shelf installations.

Tools, test equipment and accessories

Listed below are the tools, test equipment and accessories necessary to perform the 
procedures in this section. 

Quantity Description Comments

Screwdriver(s) A screwdriver(s) with the appropriate head(s) is (are) 
required for securing the mounting screws, 
repositioning the mounting brackets, installing the 
interfacing cables, and for setting the circuit breakers 
to the OFF position.

1 ESD Wrist Strap A wrist strap must be worn when handling circuit 
packs. Use the electrostatic discharge (ESD) jack 
provided on the shelf.

1 Multimeter 
(Optional)

The voltmeter must be capable of measuring DC 
voltage in the 40- to 60-volt range. The use of the 
voltmeter is optional since the shelf will alarm or 
shut down if the proper voltage is not supplied.

1 Personal 
Computer (PC)

Required to run the WaveStar® CIT software. See PC 
minimum requirements (p. 3-2).

1 CIT Interface 
Cable

8-ft. long RJ45 to 9-pin D-sub serial cable (Comcode 
848748869). Required to connect the PC to the CIT 
jack on the front of the SYSCTL circuit pack.
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Powering

Overview

The following table lists the power requirements for the 1665 DMX High-Capacity shelf.

Table 2-1 1665 DMX High-Capacity shelf power supply requirements

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Verify that the frame or structure into which the 1665 DMX High-Capacity shelf is 
installed is properly grounded.

........................................................................................................................................................................................................................

2 Verify that both circuit breakers on the 1665 DMX High-Capacity shelf are in the ON 
position. These breakers are located on the front of the 1665 DMX High-Capacity shelf.

........................................................................................................................................................................................................................

3 Disconnect the power cables from the backplane connectors (P15 from J15 and P14 from 
J14). 

Item Description

Voltage range, all components -40.0V to -60.0V DC

Power feeders two -48V power feeders

[BREAKER (A) and 
BREAKER)B)]

Circuit breakers (two per 
shelf)

20.0A or 30.0 A
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Figure 2-1 Power connections on 1665 DMX High-Capacity shelf backplane

........................................................................................................................................................................................................................

4 If fuses are being used, install fuses that are rated 1.5 times higher than the circuit breaker 
value on the shelf, in the BDFB that powers the 1665 DMX High-Capacity shelf A and B 
feeders.

Important! The 30-ampere shelf is comcode 848793287. The 20-ampere shelf is 
comcode 848935193.

........................................................................................................................................................................................................................

5 If breakers are being used, use circuit breakers that are rated 1.25 times higher than the 
circuit breaker value on the shelf, in the BDCBB that powers the 1665 DMX High-
Capacity shelf. Then switch the breakers to the ON position for the 1665 DMX High-
Capacity shelf A and B feeders.

Important! The 30-ampere shelf is comcode 848793287. The 20-ampere shelf is 
comcode #848935193.
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6 At the 1665 DMX High-Capacity shelf backplane power connector, use a voltmeter and 
measure the voltage on the power cable between BAT A and BAT A RTN. Then measure 
the voltage between BAT B and BAT B RTN.

Requirement: The voltage MUST be between -40.00 and -60.0 VDC. 

........................................................................................................................................................................................................................

7 Put both circuit breakers on the 1665 DMX High-Capacity shelf in the OFF position.

Important! A small flat-bladed screwdriver or other similar type tool is required to 
set the 1665 DMX High-Capacity shelf circuit breakers to the OFF position.

........................................................................................................................................................................................................................

8 Reconnect the “A” feed of the power cable to the backplane connector (P14 to J14), and 
reconnect the “B” feed of the power cable to the backplane connector (P15 to J15). 

........................................................................................................................................................................................................................

9 Place both circuit breakers on the 1665 DMX High-Capacity shelf in the ON position.

........................................................................................................................................................................................................................

10 Verify that the fans have started running.

........................................................................................................................................................................................................................

11 At the BDFB either remove the fuse or put the circuit breaker, associated with the “B” 
feed of the 1665 DMX High-Capacity shelf in the OFF position.

........................................................................................................................................................................................................................

12 Verify the PWR A LED on the 1665 DMX High-Capacity shelf is lighted with only the 
“A” feed powered. 

........................................................................................................................................................................................................................

13 At the BDFB either insert the fuse or put the circuit breaker, associated with the “B” feed 
of the 1665 DMX High-Capacity shelf in the ON position. Then either remove the fuse or 

Designation Color

BAT A Red

BAT A RTN Black/Red

BAT B Red

BAT B RTN Black/Red
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put the circuit breaker, associated with the “A” feed of the 1665 DMX, in the OFF 
position.

........................................................................................................................................................................................................................

14 Verify the PWR B LED on the 1665 DMX High-Capacity shelf is lighted with only the 
“B” feed powered. 

........................................................................................................................................................................................................................

15 At the BDFB either insert the fuse or put the circuit breaker, associated with the “A” feed 
of the 1665 DMX High-Capacity shelf in the ON position. 

........................................................................................................................................................................................................................

16 Verify that the both the PWR A LED and PWR B LED on the 1665 DMX High-Capacity 
shelf user panel are lighted with both the “A” and “B” feeds powered. 

........................................................................................................................................................................................................................

17 Verify that the fans are still running and are moving air.

........................................................................................................................................................................................................................

18 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Circuit pack compatibility

Overview

Table 2-2, “Release 7.1 circuit pack compatibility” (p. 2-7) lists all the circuit packs that 
are compatible with Release 7.1 and their respective shelf locations (slots).

Table 2-2 Release 7.1 circuit pack compatibility

Slot name

A1, A2* B1, B2* G1* M1 CTL G2* M2 C1, C2* D1, D2*

LNW2

LNW6 LNW6 LNW6 LNW6

LNW7 LNW7 LNW7 LNW7

LNW8 LNW8 LNW8 LNW8

LNW16 LNW16 LNW16 LNW16

LNW18 LNW18 LNW18 LNW18

LNW19 LNW19 LNW19 LNW19

LNW19B LNW19B LNW19B LNW19B

LNW20 LNW20 LNW20† LNW20† LNW20 LNW20

LNW27 LNW27

LNW29 LNW29

LNW31 LNW31 LNW31 LNW31 LNW31 LNW31

LNW32 LNW32

LNW36 LNW36 LNW36 LNW36 LNW36 LNW36

LNW37 LNW37 LNW37 LNW37 LNW37 LNW37

LNW45 LNW45 LNW45 LNW45 LNW45 LNW45

LNW46 LNW46 LNW46 LNW46 LNW46 LNW46

LNW48 LNW48

LNW49 LNW49 LNW49 LNW49 LNW49 LNW49

LNW50 LNW50

LNW54 LNW54
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LNW55 LNW55 LNW55 LNW55 LNW55 LNW55

LNW56 LNW56

LNW57 LNW57

LNW58 LNW58

LNW59 LNW59

LNW60 LNW60

LNW62 LNW62 LNW62 LNW62 LNW62 LNW62

LNW63 LNW63 LNW63 LNW63 LNW63 LNW63

LNW64 LNW64 LNW64 LNW64 LNW64 LNW64

LNW66 LNW66 LNW66 LNW66

LNW67 LNW67 LNW67 LNW67 LNW67 LNW67

LNW68 LNW68 LNW68 LNW68 LNW68 LNW68

LNW70 LNW70 LNW70 LNW70 LNW70 LNW70

LNW71 LNW71 LNW71 LNW71

LNW73 LNW73 LNW73 LNW73 LNW73 LNW73

LNW73C LNW73C LNW73C LNW73C LNW73C LNW73C

LNW74 LNW74 LNW74‡ LNW74‡ LNW74 LNW74

LNW76 LNW76

LNW78 LNW78 LNW78 LNW78 LNW78 LNW78

LNW80 LNW80

LNW82 LNW82

LNW93 LNW93 LNW93 LNW93

LNW94 LNW94 LNW94 LNW94

LNW97

LNW98 LNW98 LNW98 LNW98 LNW98 LNW98

LNW170 LNW170 LNW170 LNW170 LNW170 LNW170

177D 177D 177D 177D 177D 177D

177E 177E

Slot name

A1, A2* B1, B2* G1* M1 CTL G2* M2 C1, C2* D1, D2*
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Switch fabric compatibility

When equipping high-speed slots, it is imperative that the switch fabric of the circuit packs 
located in Main 1 and Main 2 match. For example an LNW26B located in Main 1 may be 
used with any LNW121B-159B DWDM circuit pack in Main 2, since both have partial 
(up to 12 STS-1s) VT mapping. If circuit packs with different fabrics are inserted in Main 
1 and Main 2, for instance, an LNW29 were to be inserted in Main 2 with an LNW26B 
present in Main 1, an “unexpected circuit pack type” alarm would be raised.

Important! LNW26B, LNW28, LNW77 and the LNW1xxB series circuit packs are 
not supported in R7.1.

• OC-12 Circuit Packs with 12 STS-1 switch fabric:

– LNW48

– LNW50

– LNW54

• OC-48 Circuit Packs with 12 STS-1 switch fabric:

Important! LNW26B, LNW28, LNW77 and the LNW1xxB series circuit packs are 
not supported in R7.1.

LNW202 LNW202

LNW221 
to 
LNW259

LNW221 
to 
LNW259

LNW421 
to 
LNW459

LNW421 
to 
LNW459

LNW421 
to 
LNW459

LNW421 
to 
LNW459

LNW421 
to 
LNW459

LNW421 
to 
LNW459

LNW502 LNW502

LNW523 LNW523

LNW527 LNW527

LNW554 LNW554

LNW555 LNW555

LNW785 LNW785 LNW785 LNW785 LNW785 LNW785
* 177D Apparatus Blanks are required in all unequipped Function Unit and Growth slots to provide proper air flow for cooling.
† In G1,G2 LNW20 only supports portless operation.
‡ Only optical ports can be used in growth slot.

Slot name

A1, A2* B1, B2* G1* M1 CTL G2* M2 C1, C2* D1, D2*
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– LNW26B (jumper set to enhanced mode)

– LNW28 (jumper set to enhanced mode)

– LNW77 (jumper set to enhanced mode)

– LNW121B - 159B (jumper set to enhanced mode)

• OC-48 Circuit Packs with 48 STS-1 switch fabric:

– LNW27

– LNW29

– LNW32

– LNW76

– LNW202

– LNW221-259

• OC-192 Circuit Packs with 48 STS-1 switch fabric:

– LNW56

– LNW57

– LNW58

– LNW60

– LNW502

– LNW523

– LNW527

– LNW554

– LNW555

• Main Switch Pack (no optics) with 96 STS-1 switch fabric.

– LNW80

• OC-192 Circuit Packs with 192 STS-1 switch fabric (VLF):

– LNW59

– LNW82

Once a high-speed OLIU is installed and placed in service, another OLIU with a different 
capacity switch fabric may not be substituted without disruption to traffic.

CAUTION

Service disruption hazard
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Figure 2-2 1665 DMX High-Capacity shelf 
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Initial circuit pack installation

Description

This section provides instructions for installing, BUT NOT fully seating, circuit packs into 
the 1665 DMX High-Capacity shelf. After circuit packs have been unpacked, they may be 
placed in their respective slots in the 1665 DMX High-Capacity shelf but NOT FULLY 
ENGAGED IN THE BACKPLANE CONNECTOR. The circuit packs will be fully 
installed (seated) in Chapter 3, “Software download and circuit pack installation”, “Circuit 
pack installation” (p. 3-5).

Important! If office alarms are connected, it is advisable to disconnect the office 
alarm cable while performing the procedures in this section to prevent spurious alarms 
from being reported. Reconnect the office alarm cable after completion of all testing.

To protect against damage due to electrostatic discharge, a properly grounded ESD wrist 
strap must be worn when handling equipment.

Important! When only one main OLIU (OC-12, OC-48, OC-192) or main switch 
pack (LNW80) is required, it must be installed in the M1 slot.

LNW2 (SYSCTL) installation

Follow this procedure to install the LNW2 (SYSCTL) circuit pack into the 1665 DMX 
High-Capacity shelf.

........................................................................................................................................................................................................................

1 Remove the SYSCTL circuit pack from the packing material. Verify that there are two 
NVM memory cards.

Important! Do not remove the NVM cards.

........................................................................................................................................................................................................................

2 Identify the CTL slot on the 1665 DMX High-Capacity shelf. See Figure 2-2, “1665 DMX 
High-Capacity shelf” (p. 2-11).

CAUTION
Blank circuit packs are required in all unequipped Main slots, Function Unit, 
and Growth slots to provide proper air flow for cooling.

CAUTION

ESD hazard



Initial circuit pack installationPowering and initial circuit pack installation for 1665 Data 
Multiplexer (1665 DMX)

............................................................................................................................................................................................................................................................

365-372-304R7.1
Issue 1, November 2007

2 - 1 3

........................................................................................................................................................................................................................

3 Place the SYSCTL circuit pack into the CTL slot on the 1665 DMX High-Capacity shelf. 
Do NOT engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

OC-48 main OLIU installation

Follow this procedure to install the following OC-48 OLIU circuit packs in the 1665 DMX 
High-Capacity shelf.

• LNW27

• LNW29

• LNW32

• LNW76

• LNW202 (SFP optics)

• LNW221 - 259

Important! From your work orders, determine the wavelength that you wish to set 
on the LNW221 - LNW259. Use the Channel Select Option Label on the faceplate of 
the circuit pack to determine the correct channel. Refer to Figure 2-3, “LNW221 - 259 
channel positions” (p. 2-15) for channel jumper location.

........................................................................................................................................................................................................................

1 Remove the first OC-48 OLIU circuit pack from the packing material. 

........................................................................................................................................................................................................................

2 Identify the M1 slot on the 1665 DMX High-Capacity shelf. See Figure 2-2, “1665 DMX 
High-Capacity shelf” (p. 2-11).

........................................................................................................................................................................................................................

3 Place the OC-48 OLIU circuit pack into the M1 slot on the 1665 DMX High-Capacity 
shelf. Do NOT engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Remove the second OC-48 OLIU from the packing material.
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........................................................................................................................................................................................................................

5 Identify the M2 slot on the 1665 DMX High-Capacity shelf. See Figure 2-2, “1665 DMX 
High-Capacity shelf” (p. 2-11).

........................................................................................................................................................................................................................

6 Place the second OLIU circuit pack into the M2 slot on the 1665 DMX High-Capacity 
shelf. Do NOT engage the circuit pack in the backplane connector.

Important! If any of the Main slots are to remain unequipped, install a blank circuit pack 
to provide proper air flow for cooling.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S



Initial circuit pack installationPowering and initial circuit pack installation for 1665 Data 
Multiplexer (1665 DMX)

............................................................................................................................................................................................................................................................

365-372-304R7.1
Issue 1, November 2007

2 - 1 5

Figure 2-3 LNW221 - 259 channel positions

OC192 main OLIU installation

Follow this procedure to install the following OC-192 OLIU circuit packs in the 1665 
DMX High-Capacity shelf.

• LNW56

• LNW57

• LNW58

• LNW59 (VLF)

• LNW60

• LNW502 (SFP optics)

• LNW523

• LNW527

• LNW554

• LNW555
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........................................................................................................................................................................................................................

1 Remove the first OC-192 OLIU circuit pack from the packing material. 

........................................................................................................................................................................................................................

2 Identify the M1 slot on the 1665 DMX High-Capacity shelf. See Figure 2-2, “1665 DMX 
High-Capacity shelf” (p. 2-11).

........................................................................................................................................................................................................................

3 Place the OC-192 OLIU circuit pack into the M1 slot on the 1665 DMX shelf. Do NOT 
engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Remove the second OC-192 OLIU from the packing material.

........................................................................................................................................................................................................................

5 Identify the M2 slot on the 1665 DMX High-Capacity shelf. See Figure 2-2, “1665 DMX 
High-Capacity shelf” (p. 2-11).

........................................................................................................................................................................................................................

6 Place the second OLIU circuit pack into the M2 slot on the 1665 DMX High-Capacity 
shelf. Do NOT engage the circuit pack in the backplane connector.

Important! If any of the Main slots are to remain unequipped, install a blank circuit pack 
to provide proper air flow for cooling. Always use Main-1 (M1) for shelves equipped with 
only one main pack.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

 

OC-12 main OLIU installation

Follow this procedure to install the following OC12 OLIU circuit packs in the 1665 DMX 
High-Capacity shelf.

• LNW48

• LNW50

• LNW54

........................................................................................................................................................................................................................

1 Remove the first OC-12 OLIU circuit pack from the packing material. 



Initial circuit pack installationPowering and initial circuit pack installation for 1665 Data 
Multiplexer (1665 DMX)

............................................................................................................................................................................................................................................................

365-372-304R7.1
Issue 1, November 2007

2 - 1 7

........................................................................................................................................................................................................................

2 Identify the M1 slot on the 1665 DMX High-Capacity shelf. See Figure 2-2, “1665 DMX 
High-Capacity shelf” (p. 2-11).

........................................................................................................................................................................................................................

3 Place the OC-12 OLIU circuit pack into the M1 slot on the 1665 DMX High-Capacity 
shelf. Do NOT engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Remove the second OC-12 OLIU from the packing material.

........................................................................................................................................................................................................................

5 Identify the M2 slot on the 1665 DMX High-Capacity shelf. See Figure 2-2, “1665 DMX 
High-Capacity shelf” (p. 2-11).

........................................................................................................................................................................................................................

6 Place the second OLIU circuit pack into the M2 slot on the 1665 DMX High-Capacity 
shelf. Do NOT engage the circuit pack in the backplane connector.

Important! If any of the Main slots are to remain unequipped, install a blank circuit pack 
to provide proper air flow for cooling. Always use Main-1 (M1) for shelves equipped with 
only one main pack.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

 

8OC-3/8OC-12/2OC-48 main OLIU installation

Follow this procedure to install the following 8OC3/8OC12/2OC48 OLIU circuit packs in 
the 1665 DMX High-Capacity shelf.

• LNW82

Important! Shelf cover (comcode 849068358) is required for shelves equipped with 
LNW82 circuit packs. This shelf cover is larger and provides more space to prevent 
fibers from touching the front cover when the cover is closed.

........................................................................................................................................................................................................................

1 Remove the first OLIU circuit pack from the packing material. 
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........................................................................................................................................................................................................................

2 Identify the M1 slot on the 1665 DMX High-Capacity shelf. See Figure 2-2, “1665 DMX 
High-Capacity shelf” (p. 2-11).

........................................................................................................................................................................................................................

3 Place the OLIU circuit pack into the M1 slot on the 1665 DMX High-Capacity shelf. Do 
NOT engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Remove the second OLIU from the packing material.

........................................................................................................................................................................................................................

5 Identify the M2 slot on the 1665 DMX High-Capacity shelf. See Figure 2-2, “1665 DMX 
High-Capacity shelf” (p. 2-11).

........................................................................................................................................................................................................................

6 Place the second OLIU circuit pack into the M2 slot on the 1665 DMX High-Capacity 
shelf. Do NOT engage the circuit pack in the backplane connector.

Important! If any of the Main slots are to remain unequipped, install a blank circuit pack 
to provide proper air flow for cooling. Always use Main-1 (M1) for shelves equipped with 
only one main pack.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

 

LNW80 main switch pack installation

Follow this procedure to install the LNW80 circuit packs in the 1665 DMX High-Capacity 
shelf.

........................................................................................................................................................................................................................

1 Remove the first LNW80 circuit pack from the packing material.

........................................................................................................................................................................................................................

2 Identify the M1 slot on the 1665 DMX High-Capacity shelf. See Figure 2-2, “1665 DMX 
High-Capacity shelf” (p. 2-11).
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........................................................................................................................................................................................................................

3 Place the LNW80 circuit pack into the M1 slot on the 1665 DMX High-Capacity shelf. Do 
NOT engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Remove the second LNW80 from the packing material.

........................................................................................................................................................................................................................

5 Identify the M2 slot on the 1665 DMX High-Capacity shelf. See Figure 2-2, “1665 DMX 
High-Capacity shelf” (p. 2-11).

........................................................................................................................................................................................................................

6 Place the second LNW80 circuit pack into the M2 slot on the 1665 DMX High-Capacity 
shelf. Do NOT engage the circuit pack in the backplane connector.

Important! If any of the Main slots are to remain unequipped, install a blank circuit pack 
to provide proper air flow for cooling.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

 

LNW785 OMD5/8 8-channel low-loss DWDM Optical Mux/Demux

Follow this procedure to install the LNW785 circuit packs in the 1665 DMX High-
Capacity shelf. The LNW785 OMD5/8 circuit pack multiplexes/demultiplexes up to 8 
DWDM optical channels spaced 100 GHz apart, ranging from 1530 to 1536 nm.

Important! Shelf cover (comcode 849068358) is required for shelves equipped with 
OMD5/8 circuit packs. This shelf cover is larger and provides more space to prevent 
fibers from touching the front cover when the cover is closed.

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Identify the proper function group slots where 
LNW785 circuit packs will be installed.

........................................................................................................................................................................................................................

2 Remove the first LNW785 circuit pack from the packing material.
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........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, A2, B1, B2, C1, C2, D1, D2, G1, or G2 as 
required). Do NOT engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Repeat Step 1 through Step 3 for each additional LNW785 to be equipped.

........................................................................................................................................................................................................................

5 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

LNW6(28DS1), LNW7(28DS1PM), LNW8(56DS1E1) low-speed installation (optional)

Follow this procedure only if installing LNW6 (28DS1), LNW7 (28DS1PM), or LNW8 
(56DS1E1) circuit packs into the 1665 DMX High-Capacity shelf.

Important! LNW6 and LNW7 are not supported with LNW59 (VLF) main circuit 
packs.

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Identify the proper function group slots where 
LNW6, LNW7, or LNW8 circuit packs will be installed.

........................................................................................................................................................................................................................

2 Remove the LNW6, LNW7, or LNW8 from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, B1, C1 or D1 as required). Do NOT engage 
the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 If a protection circuit pack is required, continue with Step 5. If not, install a blank circuit 
pack into the protection circuit pack slot (A2, B2, C2 or D2 as required), then proceed to 
Step 7.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Remove the second LNW6, LNW7, or LNW8 from the packing material.
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........................................................................................................................................................................................................................

6 Place the circuit pack into the shelf (slot A2, B2, C2, or D2 as required). Do NOT engage 
the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

7 Repeat Step 1 through Step 6 for each additional function group to be equipped with 
LNW6, LNW7, or LNW8 circuit packs.

........................................................................................................................................................................................................................

8 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

LNW16 (12DS3/EC1), LNW18 (TMUX), LNW19/LNW19B (48 DS3/EC1), LNW20 (48TMUX) low-
speed installation (optional)

Follow this procedure only if installing LNW16 (12DS3/EC1), LNW18 (TMUX), 
LNW19 (48 DS3/EC1), LNW19B (48 DS3/EC1 supporting Terminal Loopbacks) or 
LNW20 (48TMUX) circuit packs into the 1665 DMX shelf.

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Identify the proper function group(s) where 
LNW16, LNW18, LNW19, LNW19B or LNW20 circuit packs will be installed.

........................................................................................................................................................................................................................

2 Remove the LNW16, LNW18, LNW19, LNW19B or LNW20 from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, B1, C1, D1 or G1 as required). Do NOT 
engage the circuit pack in the backplane connector.

Important! The LNW20 (48TMUX) is allowed in G1, G2 when used in portless 
mode. LNW16, LNW18, LNW19 and LNW19B are not allowed in G1, G2.

........................................................................................................................................................................................................................

4 If a protection circuit pack is required, continue with Step 5. If not, install a blank circuit 
pack into the protection circuit pack slot (A2, B2, C2, D2 or G2 as required), then proceed 
to Step 7.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.
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........................................................................................................................................................................................................................

5 Remove the second LNW16, LNW18, LNW19, LNW19B or LNW20 from the packing 
material.

........................................................................................................................................................................................................................

6 Place the circuit pack into the shelf (slot A2, B2, C2, D2 or G2 as required). Do NOT 
engage the circuit pack in the backplane connector.

Important! The LNW20 is allowed in G1, G2 when used in portless mode. LNW16, 
LNW18, LNW19 and LNW19B are not allowed in G1, G2.

........................................................................................................................................................................................................................

7 Repeat Step 1 through Step 6 for each additional function group to be equipped with 
LNW16, LNW18, LNW19, LNW19B or LNW20 circuit packs.

........................................................................................................................................................................................................................

8 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

LNW36 (OC-3 OLIU) low-speed installation (optional)

Follow this procedure only if installing LNW36 (OC3 OLIU) circuit packs into the 1665 
DMX shelf.

Important! LNW36 and LNW37 may be used as a protection pair. LNW36 may be 
replaced with LNW37 and vice versa as long as the SFP optics in the LNW37 are 
compatible with the optical span.

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Identify the proper function group(s) and/or 
growth slot(s) where LNW36 circuit pack will be installed.

........................................................................................................................................................................................................................

2 Remove the LNW36 from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, B1, C1, D1 or G1 as required). Do NOT 
engage the circuit pack in the backplane connector.
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........................................................................................................................................................................................................................

4 If a companion circuit pack is required, continue with Step 5. If not, install a blank circuit 
pack into the companion circuit pack slot (A2, B2, C2, D2 or G2 as required) then proceed 
to Step 7.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Remove the second LNW36 from the packing material.

........................................................................................................................................................................................................................

6 Place the circuit pack into the shelf (slot A2, B2, C2, D2 or G2). Do NOT engage the 
circuit pack in the backplane connector.

........................................................................................................................................................................................................................

7 Repeat Step 1 through Step 6 for each additional function group and/or growth slot to be 
equipped with LNW36 circuit packs.

........................................................................................................................................................................................................................

8 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

LNW37 (4 OC-3 SFP OLIU), LNW45 (8 OC-3 SFP OLIU), LNW49 (4 OC-12 SFP OLIU),
LNW55 (12OC-3/12OC12/4 OC48 SFP OLIU) or LNW62 (4 OC-48 SFP OLIU) low-speed installation 
(optional)

Follow this procedure only if installing the LNW37 (4 OC-3 SFP OLIU), LNW45 (8 OC-
3 SFP OLIU), LNW49 (4 OC-12 SFP OLIU), LNW55 (12 OC-3/12 OC-12/4 OC-48 SFP 
OLIU) or LNW62 (4 OC-48 SFP OLIU) circuit packs into the 1665 DMX shelf.

Important! Shelf cover (comcode 849068358) is required for shelves equipped with 
LNW55 circuit packs. This shelf cover is larger and provides more space to prevent 
fibers from touching the front cover when the cover is closed.

Important! The LNW37, LNW45, LNW49, LNW55 and LNW62 circuit packs 
require SFP modules for the optical interface. This procedure will consist of two parts. 
Installing the circuit card and installing the SFP per Install pluggable transmission 
modules (p. 2-34).
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........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Identify the proper function group(s) and/or 
growth slot(s) where the low-speed OLIU circuit packs will be installed.

........................................................................................................................................................................................................................

2 Remove the OLIU from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, B1, C1, D1 or G1 as required). Do NOT 
engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 If a companion circuit pack is required, continue with Step 5. If not, install a blank circuit 
pack into the companion circuit pack slot (A2, B2, C2, D2 or G2 as required), then 
proceed to Step 7.

Important! Blank circuit packs are required in all unused slots to provide proper air 
flow for cooling.

........................................................................................................................................................................................................................

5 Remove the second OLIU from the packing material.

........................................................................................................................................................................................................................

6 Place the circuit pack into the shelf (slot A2, B2, C2, D2 or G2 as required). Do NOT 
engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

7 Repeat Step 1 through Step 6 for each additional function group and/or growth slot to be 
equipped with LNW37, LNW45, LNW49, LNW55 or LNW62 circuit packs.

........................................................................................................................................................................................................................

8 Install the SFP module per Install pluggable transmission modules (p. 2-34)

........................................................................................................................................................................................................................

9 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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LNW46 (OC-12 OLIU) low-speed installation (optional)

Follow this procedure only if installing LNW46 (OC-12 OLIU) circuit packs into the 1665 
DMX High-Capacity shelf.

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Identify the proper function group(s) and/or 
growth slot(s) where LNW46 circuit packs will be installed.

........................................................................................................................................................................................................................

2 Remove the LNW46 or from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, B1, C1, D1 or G1 as required). Do NOT 
engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 If a companion circuit pack is required, continue with Step 5. If not, install a blank circuit 
pack into the companion circuit pack slot (A2, B2, C2, D2 or G2 as required), then 
proceed to Step 7.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Remove the second LNW46 from the packing material.

........................................................................................................................................................................................................................

6 Place the circuit pack into the shelf (slot A2, B2, C2, D2 or G2 as required).

........................................................................................................................................................................................................................

7 Repeat Step 1 through Step 6 for each additional function group and/or growth slot to be 
equipped with LNW46 circuit packs.

........................................................................................................................................................................................................................

8 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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LNW31 (OC-48 OLIU), or LNW421-459 (OC-48 PWDM OLIU) low-speed installation (optional)

Follow this procedure only if installing LNW31 (OC-48 OLIU) or LNW421-LNW459 
(DWDM OC-48 OLIU) circuit packs into the 1665 DMX shelf.

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Identify the proper function group(s) and/or 
growth slot(s) where LNW31 or LNW421-LNW459 circuit pack will be installed.

........................................................................................................................................................................................................................

2 Remove the LNW31 or LNW421-LNW459 from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, B1, C1, D1 or G1 as required). Do NOT 
engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 If a companion circuit pack is required, continue with Step 5. If not, install a blank circuit 
pack into the companion circuit pack slot (A2, B2, C2, D2 or G2 as required) then proceed 
to Step 7.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Remove the second LNW31 or LNW421-LNW459 from the packing material.

........................................................................................................................................................................................................................

6 Place the circuit pack into the shelf (slot A2, B2, C2, D2 or G2). Do NOT engage the 
circuit pack in the backplane connector.

........................................................................................................................................................................................................................

7 Repeat Step 1 through Step 6 for each additional function group and/or growth slot to be 
equipped with LNW31 or LNW421-LNW459 circuit packs.

........................................................................................................................................................................................................................

8 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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LNW66 (10/100T) or LNW71 (10/100-PL) installation (optional)

Follow this procedure only if installing LNW66 (10/100T) or LNW71 (10/100-PL) circuit 
packs into the 1665 DMX shelf.

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Identify the proper function group slot (A1, B1, 
C1 or D1) where the LNW66 or LNW71 circuit pack will be installed.

Important! The LNW66 or LNW71 circuit pack can only be installed in slot 1 of any 
function group.

........................................................................................................................................................................................................................

2 Remove the LNW66 or LNW71 from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, B1, C1 or D1 as required). Do NOT engage 
the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Install a blank circuit pack into the companion circuit pack slot (A2, B2, C2 or D2 as 
required).

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Repeat Step 1 through Step 4 for each additional function group slot 1’s to be equipped 
with LNW66 or LNW71 circuit packs.

........................................................................................................................................................................................................................

6 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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LNW70 (100/1G FXS), LNW74 (10/100 T/F), LNW63 (1000BASE-SX/LX/LX10), LNW64 (8 GbE), 
LNW78 (RPR) and LNW170 (100/1G FXS) installation (optional)

Follow this procedure only if installing LNW70 (100/1G FS), LNW74 (10/100 T/F), 
LNW63 (1000BASE-SX/LX/LX10), LNW64 (8 GbE), LNW78 (RPR) and LNW170 
(100/1G FXS) circuit packs into the 1665 DMX shelf.

Important! The LNW70, LNW74, LNW63, LNW64, LNW78 and LNW170 circuit 
packs require SFP modules for the Ethernet interface. This procedure will consist of 
two parts. Installing the circuit card and installing the SFP per Install pluggable 
transmission modules (p. 2-34).

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Identify the proper function group slot (A1, A2, 
B1, B2, C1, C2, D1, D2, G1 or G2) where the LNW70, LNW74, LNW63, LNW64, 
LNW78 or LNW170 circuit pack will be installed.

Important! When LNW74 is installed in the G1 or G2 position, only the faceplate 
optical 100 Base-F ports are available for use.

The LNW70, LNW74, LNW63, LNW64, LNW78 and LNW170 circuit packs can 
only be installed in slot 1 of any function group unless the mains are equipped with 
LNW59 or LNW82 (VLF) main circuit packs. With the LNW59 and LNW82 mains, 
all fn slots may be equipped.

........................................................................................................................................................................................................................

2 Remove the LNW70, LNW74, LNW63, LNW64, LNW78 or LNW170 from the packing 
material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf fn slot. Do NOT engage the circuit pack in the 
backplane connector.

........................................................................................................................................................................................................................

4 Install a blank circuit pack into the companion fn circuit pack slot as required.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Repeat Step 1 through Step 4 for each additional function group to be equipped with 
LNW70, LNW74, LNW63, LNW64, LNW78 or LNW170 circuit packs.
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........................................................................................................................................................................................................................

6 Install the SFP module per Install pluggable transmission modules (p. 2-34).

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

LNW67 (1G SX) installation (optional)

Follow this procedure only if installing LNW67 (1G SX) circuit packs into the 1665 DMX 
shelf.

Important! The LNW67 (1G SX) requires multi-mode fiber.

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Identify the proper function group slot (A1, A2, 
B1, B2, C1, C2, D1, D2) and/or growth slot (G1 or G2) where the LNW67 circuit pack 
will be installed.

Important! Unless equipped with LNW59 VLF mains, the LNW67 circuit pack can 
only be installed in slot 1 of any function group or growth slot 1.

........................................................................................................................................................................................................................

2 Remove the LNW67 from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf fn slot as required). Do NOT engage the circuit pack 
in the backplane connector.

........................................................................................................................................................................................................................

4 Install a blank circuit pack into the companion fn circuit pack slot as required.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Repeat Step 1 through Step 4 for each additional function group and/or growth slot to be 
equipped with LNW67 circuit packs.
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6 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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LNW68 (1G LX) installation (optional)

Follow this procedure only if installing LNW68 (1G LX) circuit packs into the shelf.

Important! The LNW68 (1G LX) requires single-mode fiber.

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Identify the proper function group slot (A1, A2, 
B1, B2, C1, C2, D1, D2) and/or growth slot (G1, G2) where the LNW68 circuit pack will 
be installed.

Important! Unless equipped with LNW59 VLF mains, the LNW68 circuit packs can 
only be installed in slot 1 of any function group or growth slot 1.

........................................................................................................................................................................................................................

2 Remove the LNW68 from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf fn slot as required. Do NOT engage the circuit pack in 
the backplane connector.

........................................................................................................................................................................................................................

4 Install a blank circuit pack into the companion circuit pack slot as required.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Repeat Step 1 through Step 4 for each additional function group and/or growth slot to be 
equipped with or LNW68 circuit packs.

........................................................................................................................................................................................................................

6 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

LNW73 (FC-1X/2X) and LNW73C (FC-1X/2X with compression) installation (optional)

Follow this procedure only if installing LNW73 (FC-1X/2X) and LNW73C (FC-1X/2X 
with compression) circuit packs into the 1665 DMX High-Capacity shelf.

Important! The LNW73 and LNW73C circuit pack requires SFP modules for the 
optical interface. This procedure will consist of two parts. Installing the circuit card 
and installing the SFP per Install pluggable transmission modules (p. 2-34).
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1 Refer to the engineering job specification. Identify the proper function group slot (A1, A2, 
B1, B2, C1, C2, D1, D2) and/or growth slot (G1, G2) where the LNW73 or LNW73C 
circuit pack will be installed.

Important! Unless equipped with LNW59 VLF mains, the LNW73 and LNW73C 
circuit packs can only be installed in slot 1 of any function group or growth slot 1.

........................................................................................................................................................................................................................

2 Remove the LNW73 or LNW73C from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf fn slot as required. Do NOT engage the circuit pack in 
the backplane connector.

........................................................................................................................................................................................................................

4 Install a blank circuit pack into the companion circuit pack slot as required.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Repeat Step 1 through Step 4 for each additional function group and/or growth slot to be 
equipped with LNW73 or LNW73C circuit packs.

........................................................................................................................................................................................................................

6 Install the SFP module per Install pluggable transmission modules (p. 2-34).

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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177D/LNW98 blank CP installation (optional)

Follow this procedure to install 177D Apparatus Blank(s) or LNW98 Detectable Blank(s) 
into the 1665 DMX High-Capacity shelf.

Important! A 177D Apparatus Blank or LNW98 Detectable Blank is required in any 
unequipped slots to provide proper air flow for cooling.

........................................................................................................................................................................................................................

1 Identify all the unequipped Function Unit or Growth slots.

........................................................................................................................................................................................................................

2 Remove the 177D or LNW98 from the packing material.

........................................................................................................................................................................................................................

3 Insert (fully seat) the 177D or LNW98 blank into an unequipped slot on the shelf.

........................................................................................................................................................................................................................

4 Continue with the next unequipped slot until all the unused slots are equipped with an 
177D Apparatus Blank or LNW98 Detectable Blank.

........................................................................................................................................................................................................................

5 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

 177E/LNW97 blank CP installation (optional)

Follow this procedure to install 177E Apparatus Blank(s) or LNW97 Detectable Blank(s) 
into the 1665 DMX High-Capacity shelf.

Important! A 177E Apparatus Blank or LNW97 Detectable Blank is required in the 
Main-2 (M2) slot to provide proper air flow for cooling when only one main is 
equipped. Always use Main-1 (M1) for shelves equipped with only one main pack.

........................................................................................................................................................................................................................

1 Identify any unequipped Main slots.

........................................................................................................................................................................................................................

2 Remove the 177E or LNW97 from the packing material.

........................................................................................................................................................................................................................

3 Insert (fully seat) the 177E or LNW97 into the unequipped Main slot on the shelf.
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........................................................................................................................................................................................................................

4 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Install pluggable transmission modules

This section contains the instructions for the installation of the pluggable transmission 
modules.

........................................................................................................................................................................................................................

1 Refer to the engineering job specification. Identify the proper circuit pack type and the 
port socket being equipped with the pluggable module (SFP). Make sure the transmission 
rate (OC3, OC12, 100Base Ethernet or GbE) matches the rate of the SFP. See Appendix 
G, “Pluggable transmission module installation”.

Important! Pluggable modules are shipped with a dust plug installed into the ports to 
maintain cleanliness during storage and/or transportation. It is recommended that the 
dust plug be kept in place to maintain cleanliness. With proper care and handling, 
cleaning the pluggable modules should not be necessary.

........................................................................................................................................................................................................................

2 Check the ports for cleanliness and clean the pluggable module if necessary. See 
Appendix B, “Fiber cleaning”.

........................................................................................................................................................................................................................

3 Insert the pluggable module in the required socket of the circuit pack faceplate, then 
wiggle the module to verify that it is locked in the socket. See Appendix G, “Pluggable 
transmission module installation”. Verify that all unused sockets are equipped with dust 
plugs.

........................................................................................................................................................................................................................

4 Repeat Step 1 through Step 3 if more modules need to be installed.

CAUTION
Never mechanically clean the receive (RX) port. Air blows only should be used 
on the receive (RX) port. The receive (RX) port contains a lens for focusing a 
wide input. The lens is more easily scratched than cleaned.
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........................................................................................................................................................................................................................

5 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Part II:  1665 Data Multiplexer (1665 
DMX) stand-alone installation 
tests

........................................................................................................................................................................
Overview

Purpose

Part II covers the generic software download to the 1665 Data Multiplexer (1665 DMX), 
stand-alone installation tests to verify correct interconnect cabling, alarm cabling, and as 
required, external timing and communication cabling. This section also covers circuit pack 
installation (fully seated).

Contents

This section is organized into the following chapters:

Software download and circuit pack installation Chapter 3

Installation tests Chapter 4

Operational tests Chapter 5
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3 Software download and circuit pack 
installation

............................................................................................................................................................................................................................................................

Overview

Purpose

This chapter provides the procedures for initial software download and use of the craft 
interface terminal (CIT).

Contents

This chapter provides information on the following topics: 

Tools, test equipment and accessories

Listed below are the required tools, test equipment and accessories.

Software installation  3-4

Circuit pack installation  3-5

Use of WaveStar® CIT software  3-9

Circuit pack firmware version verification  3-12

1665 DMX shelf initialization  3-13

Provision/enable/disable TCP/IP on an IAO LAN port  3-14

Reset system date and time  3-17

Provision/Enable/disable the 1665 DMX as a TL1 TCP/IP GNE  3-18

Quantity Description Comments

1 Personal Computer (PC) Required to run the WaveStar® CIT 
software. See PC minimum requirements 
(p. 3-2).
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PC minimum requirements

It is anticipated that most customers will dedicate a laptop or personal computer (PC) to 
run the WaveStar® CIT software. However, any properly configured computer will also 
suffice. The following table shows the requirements for the computer:

Table 3-1 Computer Requirements

1 CIT Interface Cables

Serial Connection

OSI LAN Connection

8-ft. long RJ45 to 9-pin D-sub serial 
cable (Comcode 848748869). Required 
to connect the PC to the CIT jack on the 
front of the SYSCTL circuit pack.

CAT5 Ethernet cable with either a 
10/100 hub or a cross-over cable for the 
LAN CIT or IAO LAN ports

LBOs 20-dB (for LNW60), 15-dB, 10-dB and 
5-dB LBOs are required when looping 
back the main OLIUs on themselves.

Components Minimum Recommended

Processor Pentium 266 MHz Pentium IV 1 GHz

RAM (1 system 
view)

128 MB 512 MB

RAM (up to 5 
system views)

256 MB 1 GB

Virtual Memory 139 MB 267 MB

Available Hard 
Disk Space*

500 MB 850 MB (for all graphical 
packages)

Video 800X600 256 Colors
(8 Bit)

1024X768 16 Million 
Colors (24 Bit)

Network Interface 10/100 baseT Network 
Card

100 baseT Network Card

CD ROM Drive Required Required

Operating System Windows® NT 4.0, 
Windows® 2000 or 
Windows® XP

Windows® 2000 or 
Windows® XP

Quantity Description Comments
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Important! Minimum requirements are sufficient to run two to three GUI System 
Views, unless otherwise noted. Recommended requirements are intended to be used as 
a general guideline to optimize WaveStar® CIT performance. As the CIT is used with 
multiple NE connections and multiple NE types, the processor type and speed and the 
memory size will all factor into CIT performance.

Internet Browser Internet Explorer
5.0/5.5/6.0/7.0

Internet Explorer
5.0/5.5/6.0/7.0_________________________________________________________

* Available hard disk space required to install and store the CIT and Generic Software
is approximately 250 MB (it is 550 MB, if all graphical packages are installed). The
additional disk space specified is to provide hard disk space to store 1665 Data
Multiplexer (1665 DMX) backup files.

Components Minimum Recommended
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Software installation

Description

Software installation is accomplished by performing the appropriate software download 
procedures in the Software Release Description (SRD) which is shipped with the software.

When the software installation is complete check off the appropriate box in Appendix 
E, “Installation checklist”.
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............................................................................................................................................................................................................................................................

Circuit pack installation

Description

This section provides instructions and the recommended order for installing (fully seating) 
the circuit packs in the 1665 DMX shelf. The procedures in this section assume that the 
SYSCTL is installed and software has been successfully downloaded as described in the 
section, Software installation (p. 3-4). 

Locations of circuit packs (Function Unit slots) are shown in Chapter 2, Figure 2-2, “1665 
DMX High-Capacity shelf” (p. 2-11). 

Circuit packs are keyed to prevent being inserted into the wrong shelf position. Installing 
circuit packs requires some force.

When a circuit pack is installed, its FAULT LED will light for several seconds to possibly 
several minutes then extinguish.

A properly grounded ESD wrist strap MUST be worn when handling circuit packs. 

Important! The UPD/INIT pushbutton on the SYSCTL circuit pack is recessed and 
will require a pointed object.

CAUTION

Laser safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.

CAUTION

Equipment damage

When installing the circuit packs, be careful to insert them straight to avoid 
damaging the backplane pins.

CAUTION

ESD hazard
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Circuit pack installation procedure

Important! Dust plugs supplied with the optical packs should always be in each 
optical port if no optical connector is installed. The dust plugs should be saved so that 
they can be reinstalled when the optical connector is removed.

................................................................................................................................................

1 Fully insert both M1 and M2 (OC3/OC12/OC48, OC-12, OC-48 or OC-192) OLIUs into 
the shelf.

Important! When LNW59, LNW82, LNW202 or LNW502 is used in the main slots, 
pluggable transmission modules are required for the optical interface. From the 
engineering work order, determine if PTMs are required and in which port(s).

The LNW59 can operate as a switch pack when PTMs are not equipped.

LNW80 is a main switch pack with no optics. If equipped, continue with Step 6.

................................................................................................................................................

2 For circuit packs in the main slots, determine if PTMs are required. If the installation calls 
for optical interfaces to the mains, locate and install the PTMs.

................................................................................................................................................

3 Insert the proper LBO into the IN connectors of each MAIN OLIU. Refer to Appendix A, 
“Laser safety and classifications and Electrostatic Discharge (ESD) considerations” for 
maximum and minimum transmit levels. If necessary, refer to Appendix C, “Installing 
fiber connectors and LBOs”.

Important! Attenuation may be required when optically looping an OLIU on itself. 
Refer toChapter 6, Table 6-1, “Attenuation Table” (p. 6-6), to find out the attenuator 
value.

................................................................................................................................................

4 Fully seat blank packs in any unequipped Main slots.

................................................................................................................................................

5 Connect IN to OUT on the OLIU in the M1 slot of the 1665 DMX shelf using an optical 
fiber jumper cable. Refer to Appendix B, “Fiber cleaning” for proper fiber cleaning 
instructions.

Connect IN to OUT on the OLIU in the M2 slot of the 1665 DMX shelf using an optical 
fiber jumper cable.
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Result: After a few minutes the flashing FAULT LEDs should extinguish on each 
OLIU circuit pack. The FAULT, MJ and NE LEDs will light on the SYSCTL due to 
DCC alarms created by optically looping the OLIUs. These SYSCTL LEDs will 
remain lit until the DCC is disabled. Refer to Chapter 4, Local equipment and cross-
connect tests (p. 4-9) to clear the alarms.

................................................................................................................................................

6 Starting with slot A1, fully seat the circuit pack slotted there using a steady pressure on 
both of the faceplate latches at the same time until the circuit pack is fully seated.

Important! All electrical circuit packs must be slotted in the function slots with the 
proper cables attached in the back of the shelf.

The ACTIVE and FAULT LEDs should light when circuit packs are inserted and the 
FAULT LED should extinguish after a short period of time. Some circuit packs such as 
LNW67/LNW68 may take several minutes before their FAULT LEDs extinguish.

................................................................................................................................................

7 Continue seating the circuit packs with slot A2 and then on to B1, B2, G1, G2, C1, C2, 
D1, and D2.

................................................................................................................................................

8 Fully seat Blank packs in any other unfilled slots.

Important! *The Fiber Bracket Kit is used in conjunction with the LNW177D and 
LNW98 that is equipped with the PEMS.

Blank Types Comcode Series Continue with

LNW177D w/o PEMS 108950585 S1:2 Step 10

LNW98 w/o PEMS 109412866 S1:2 Step 10

LNW177D w/ PEMS
*If installing the Fiber 
Bracket Kit

108950585
848949871

S1:3
NA

Step 10
Step 9

LNW98 w/ PEMS
*If installing the Fiber 
Bracket Kit

109412866
848949871

S1:3
NA

Step 10
Step 9

LNW177D w/ Fiber Bracket 
Installed

848960175 S1:3 Step 10

LNW98 w/ Fiber Bracket 
Installed

848960167 S1:3 Step 10
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................................................................................................................................................

9 Attach the fiber bracket to the blank pack with the hardware provided.

Important! The bracket must be positioned with the LC openings in the down 
position.

................................................................................................................................................

10 If there are any FAULT LEDs on or flashing on any of the inserted circuit packs, press the 
UPD/INIT pushbutton on the SYSCTL circuit pack.

Result: The operation of the UPD/INIT pushbutton on the SYSCTL circuit pack will 
update the system and should clear all standing alarms.

................................................................................................................................................

11 If FAULT LEDs remain lit on any of the inserted circuit packs, replace the respective 
circuit pack.

................................................................................................................................................

12 Any other alarms will be cleared later on in this chapter.

................................................................................................................................................

13 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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............................................................................................................................................................................................................................................................

Use of WaveStar® CIT software

Description

Complete the following steps to login to the 1665 DMX via WaveStar® CIT. It is assumed 
that the CIT software has been installed on the PC and the NE software has been 
downloaded to the 1665 DMX shelf per the Software Release Description. See Software 
installation (p. 3-4).

Login procedure

................................................................................................................................................

1 Connect the PC Serial cable to the RS232 (Serial) jack on the front of the SYSCTL circuit 
pack. Or connect a PC LAN cable (cross-over) to the LAN (OSI) connector on the front of 
the SYSCTL circuit pack.

................................................................................................................................................

2 Start the WaveStar® CIT software on the PC by double clicking on the WaveStar® icon that 
was created by the installation procedure.

................................................................................................................................................

3 Enter the following in the Login window: 

User ID: LUC01
Password: LUC+01

Important! The login and password may not be required to login to the WaveStar® 
CIT if disabled during installation.

................................................................................................................................................

4 Click OK to connect.

................................................................................................................................................

5 After reading the Legal Notice, click OK.
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Result: The following is displayed. 

................................................................................................................................................

6 Under NE Name, enter LT-DMX.

................................................................................................................................................

7 Under NE Type click on the drop-down menu arrow and choose DMX from the drop-
down list.

................................................................................................................................................

8 Under Connection Type, click on the drop-down menu arrow and choose Serial or OSI, 
depending on the type of connection you are using.

Important! An IP address must be assigned to the NIC card on the PC or laptop. 
Otherwise, you may experience login problems. To assign an IP address, start the DOS 
prompt on the computer, and type the command ipconfig/all. The command will show 
an IP address line. If there is no address line or 0.0.0.0 for an IP address, then you must 
assign an IP address in the NIC card of the computer.
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................................................................................................................................................

9 Click on the Graphical button. The following screen appears.

................................................................................................................................................

10 Enter the Login for the shelf:
User Id: LUC01
Password: DMX2.5G10G (case sensitive)

................................................................................................................................................

11 Click OK.

Result: The 1665 DMX system view is displayed.

................................................................................................................................................

12 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Circuit pack firmware version verification

Description

This section provides instructions to verify firmware versions on the circuit packs in the 
1665 DMX shelf. The procedures in this section assume that the SYSCTL is installed and 
software has been successfully downloaded and the circuit packs have been installed in the 
shelf as described in the preceding sections. 

........................................................................................................................................................................................................................

Circuit pack firmware version verification procedure

................................................................................................................................................

1 Log on to the 1665 DMX shelf using the CIT.

................................................................................................................................................

2 Select View -> Equipment...

................................................................................................................................................

3 For each circuit pack listed in the View Equipment window, highlight the CP and click 
Select.

................................................................................................................................................

4 Compare the Program Version to the information provided in the Software Release 
Description (SRD).

................................................................................................................................................

5 If the Program Version did not match the version number in the Firmware Version table in 
the SRD, reseat that circuit pack and wait 15 minutes.

................................................................................................................................................

6 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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1665 DMX shelf initialization

Description

This section provides instructions for initializing the 1665 DMX shelf, to insure that all 
circuit pack databases are correct for the current shelf and software release. The 
procedures in this section assume that the SYSCTL is installed and software has been 
successfully downloaded and the circuit packs have all been installed in the shelf as 
described in the preceding sections.

Shelf initialization procedure

................................................................................................................................................

1 Log on to the 1665 DMX shelf using the CIT software as described in the Use of 
WaveStar® CIT software (p. 3-9).

................................................................................................................................................

2 Select Fault -> Reset -> Initialize System...

................................................................................................................................................

3 Click OK and then Yes to the Warning.

Result: After a few minutes the shelf will reset and end the CIT session. 

................................................................................................................................................

4 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Provision/enable/disable TCP/IP on an IAO LAN port

Description 

This is an optional task which describes the steps necessary to provision, enable or disable 
the TCP/IP on the IAO LAN Port. 

Before you begin

Prior to performing this task, you must:

• Obtain the work instructions for this task.

• Know which LAN Port is being provisioned.

• Obtain the IP Address and IP Subnet Mask of the desired LAN Port and the IP Default 
Router Address if you are connecting to a router.

• Be able to log in to a 1665 DMX with the WaveStar® CIT and be familiar with the 
functions of the WaveStar® CIT.

Procedure

Proceed as follows:

................................................................................................................................................

1 Use the WaveStar® CIT to log in to the 1665 DMX shelf being provisioned using a 
Graphical connection.

................................................................................................................................................

2 Determine which IAO LAN Port(s) you want to use (front or rear).

Important! If you are using the rear IAO LAN port, use lan-2 as the AID. If you are 
using the front IAO LAN port, use lan-1 as the AID.

................................................................................................................................................

3 From the System View menu, select

Administration -> Data Communications

Result: The Data Communications window opens

................................................................................................................................................

4 In the Data Communications window, click on the TCP/IP tab at the top of the window.

Result: The TCP/IP parameters are displayed.
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................................................................................................................................................

5 Select and/or modify the following parameters:

1. Select the Port Aid: (lan-1 [front] or lan-2 [rear]) being provisioned.

2. If applicable, one at time, click the Modify button to set the IP Address and IP 
Subnet Mask of the desired LAN port and the IP Default Router Address, if you are 
connecting to a default router.

When the provisioning window opens for the IP address being provisioned, enter the 
IP address as four dot-separated decimal numbers ranging from 0 to 255. Click OK to 
make your changes or Cancel to quit.

3. Select Enable to enable the TCP/IP function, or Disable to disable the TCP/IP 
function.

Important! If you enter duplicate IP addresses and/or IP subnet addresses, a warning 
appears: Input, Data Not Valid, each IAO LAN Port must have a unique IP subnet 
mask.
Scroll through the Port AID drop-down menu and identify the duplication, then assign 
correct addresses as necessary.

Important! If you select Enable and click OK to apply any changes, then execute 
the command when requested, the system may reset and you will be logged off the 
system. Selecting Disable allows you to stay logged on to the system to perform more 
provisioning. You can then come back to this window and enable the TCP/IP function.

Important! Following a 1665 DMX system reset, the date and time may revert to 
January 1, 1970 (70-01-01) at midnight (00:00:00). If automatic synchronization is 
unsuccessful from the network, the date and time must be reset manually.

................................................................................................................................................

6 Click Apply at the bottom of the window to make your changes.

Result: A warning window opens and asks if you want to execute this command.

................................................................................................................................................

7 Click Yes to execute the command

Result: If you made changes and also enabled the TCP/IP function, the changes are 
applied, the system resets, and you are logged off the system. If you made changes and 
disabled the TCP/IP function, the changes are applied and you are still logged on to the 
system.

................................................................................................................................................

8 Click Close when you want to exit the window if you are still logged into the system.
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................................................................................................................................................

9 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Reset system date and time

Description

The following steps are instructions on how to change the date and time on your shelf if 
they have been reset to default values (January 1970).

................................................................................................................................................

1 Connect the PC and establish a WaveStar® CIT session (graphical).

................................................................................................................................................

2 From the System View menu, select Administration -> Set Date and Time to bring up 
the Set Systems Date and Time screen for 1665 DMX.

................................................................................................................................................

3 From the Date panel, select the Year and Month from the pull-down menus.

Result: A calendar is displayed for the month and year selected.

................................................................................................................................................

4 Click on the Date from the calendar.

................................................................................................................................................

5 From the Time panel, select the Hour, Minute and Second from the pull-down menus 
(based upon a 12-hour clock).

................................................................................................................................................

6 Select am or pm.

................................................................................................................................................

7 Click OK.

Result: The new date and time appear in the lower right-hand corner of the GUI 
System View.

................................................................................................................................................

8 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Provision/Enable/disable the 1665 DMX as a TL1 TCP/IP GNE

Purpose

Use this task to provision, enable or disable the 1665 DMX as a TL1 TCP/IP GNE.

Required equipment

The following equipment is required:

• Personal Computer (PC) with WaveStar CIT® software installed

• Wrist Strap

Safety precautions

To assure both personal safety and the proper functioning of the 1665 DMX, it is 
imperative to review and understand these warnings and precautions prior to performing 
this task.

Use a static ground wrist strap whenever handling circuit packs or working on a system 
to prevent electrostatic discharge damage to sensitive components. 

Before you begin

Prior to performing this task, you must:

• Obtain the work instructions for this task.

• Complete the Circuit pack firmware version verification procedure to provision and 
enable TCP/IP for the selected LAN port.

• Complete the “Provision/enable/disable TCP/IP on an IAO LAN port” (p. 3-14).

• Know which LAN port is being provisioned.

• Know the IP addresses, host names and host types for the gateway hosts which will be 
allowed access to the 1665 DMX TL1 TCP/IP GNE.

• Be able to log in to a 1665 DMX WaveStar®CIT and be familiar with the functions of 
the WaveStar® CIT.

CAUTION

ESD hazard
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Procedure

Proceed as follows:

................................................................................................................................................

1 Use the WaveStar® CIT to log in to the 1665 DMX TL1 TCP/IP GNE to be modified, 
enabled or disabled, using a Graphical connection.

................................................................................................................................................

2 On the System View menu, select Administration > Data Communications

Result: The Data Communications window opens.

................................................................................................................................................

3 In the Data Communications window, click on the TCP/IP tab at the top of the window.

Result: The TCP/IP parameters display.

................................................................................................................................................

4 Verify that TCP/IP is properly provisioned and enabled for the required LAN port(s).

................................................................................................................................................

5 In the Data Communications window, click on the TCP/IP Gateway tab at the top of the 
window.

Result: The TCP/IP Gateway parameters display.

................................................................................................................................................

6 From your work instructions, determine which IP calling addresses will be allowed to 
access the 1665 DMX TL1 TCP/IP GNE.

................................................................................................................................................

7 Use the  instructions on the screen to add, modify, or delete a gateway host from the 
TCP/IP Gateway Host List.

The following parameters apply:

• The OS host IP address which is four dot-separated decimal numbers, each ranging 
from 0 to 255.

• The OS Host Name which may consist of 1 to 24 alpha-numeric characters.

• The OS Type which may consist of standard types or listed as other.

Repeat this step for each of the Host IP address you want to authorize for access to the 
1665 DMX TL1 TCP/IP GNE. There may be up to 50 provisioned entries in the list.
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................................................................................................................................................

8 On the Data Communications window under TCP/IP Gateway Control, select Enable to 
enable the TCP/IP Gateway, or select Disable to disable the TCP/IP Gateway.

................................................................................................................................................

9 Click Apply at the bottom of the window.

Result: A warning window opens and asks if you want to execute this command.

................................................................................................................................................

10 Click Yes to execute the command, then click Close to exit the window, if desired.

................................................................................................................................................

11 Repeat this procedure for each TL1 TCP/IP GNE to be modified, enabled or disabled.

................................................................................................................................................

12 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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4 Installation tests

............................................................................................................................................................................................................................................................

Overview

Purpose

The purpose of this section is to verify proper transmission cabling installation and 
Release 7.1 functionality as well as the associated functionality of the 1665 Data 
Multiplexer (1665 DMX) shelf.

For end-to-end turn-up and testing procedures, refer to 365-372-301, 1665 Data 
Multiplexer User Operations Guide.

Contents

This chapter provides information on the following topics:

LBO software settings  4-4

Clearing alarms  4-7

Local equipment and cross-connect tests  4-9

DS1 protection switching  4-14

DS1 cleanup procedures  4-18

DS3/EC1 and TMUX testing procedure  4-22

DS3 protection switching  4-28

DS3 cleanup procedures  4-32

LNW66, LNW71 and LNW74 (10/100T) TX Ethernet cabling testing  4-36

OC-3 (LNW37, LNW45, LNW55)/OC-12 (LNW49, LNW55)/OC-48 (LNW55, 
LNW62) low-speed SFP test procedure

 4-41

OC-3 (low-speed) testing  4-43

OC-12 (low-speed) testing  4-47
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Tools, test equipment and accessories

Listed below are the required tools, test equipment and accessories. For complete listing 
see Part I or Part II. 

OC-48 (low-speed) testing  4-52

LED test  4-56

Additional optical tests (optional)  4-57

Quantity Description Comments

Screwdriver(s) A screwdriver(s) with the appropriate head(s) is 
(are) required for securing the mounting screws, 
repositioning the mounting brackets, installing 
the interfacing cables, and for setting the circuit 
breakers to the OFF position.

1 ESD Wrist Strap A wrist strap must be worn when handling 
circuit packs. Use the electrostatic discharge 
(ESD) jack provided on the shelf.

1 DS1 Error Rate Test Set A DS1 error rate test set is required for testing 
of DS1 cabling. A T-BERD 2209 or equivalent 
is recommended.

1 DS3 Error Rate Test Set A DS3 error rate test set is required for testing 
of DS3/EC1 and TMUX cabling. A T-BERD 
2209 or equivalent is recommended.

1 SONET Optical Test Set An OC-3, OC-12 or OC-48 test set as required 
for testing of optical circuit packs. An Agilent 
OmniBER 718 or equivalent is recommended.

2 or 3 LC-type Optical Fiber Jumper 
(108918269)

Two optical fiber jumpers with LC-type 
connectors are required to optically loop the 
1665 DMX shelf for test purposes.                                  
In addition, for shelves containing optical 
circuit packs in any of the Function Unit slots, a 
single optical fiber jumper is required for testing 
of the individual ports.
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2 or 3 15-dB LC-type LBO 
(108279480)

Two 15-dB LBOs are required when optically 
looping the 1665 DMX shelf for test 
purposes.In addition, for shelves containing 
optical circuit packs in any of the Function Unit 
slots, a single 15-dB LBO is required for testing 
of the individual ports.

2 20-dB LC-type LBO 
(108279530)

Two 20-dB LBOs are required when optically 
looping the 1665 DMX shelf equipped with 
LNW60.

1 Personal Computer (PC) Required to run the WaveStar® CIT software. 
See Chapter 3, “Software download and circuit 
pack installation”, PC minimum requirements 
(p. 3-2).

1 CIT Interface Cable 8-ft. long RJ45 to 9-pin D-sub serial cable 
(Comcode 848748869). Required to connect the 
PC to the CIT jack on the front of the SYSCTL 
circuit pack.

2 LAN 10BaseT Straight-
through Cable CAT 5 or better

As required to reach from front of 1665 DMX to 
the RJ45 patch panel

1 LAN 10BaseT Cross-over 
Cable CAT 5 or better

As required to reach from front of 1665 DMX to 
the PC

Quantity Description Comments
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LBO software settings

Description

This section provides instructions for setting the software Line Build Out (LBO) for the 
DS1, DS3/EC1 and TMUX cabling and requires that the SYSCTL, DS1, DS3/EC1 and/or 
TMUX circuit packs be installed and that software has been downloaded.

........................................................................................................................................................................................................................

Setting DS1 LBOs 

Follow this procedure to set the LBOs for the DS1, DS3/EC1 and TMUX circuit packs.

........................................................................................................................................................................................................................

1 Log on to the 1665 DMX shelf using the CIT software as described in the Chapter 3, “Use 
of WaveStar® CIT software” (p. 3-9).

........................................................................................................................................................................................................................

2 Refer to the following table of cable lengths and LBO values. Determine the LBO value 
corresponding to the DS1 cables installed.

........................................................................................................................................................................................................................

3 From the CIT GUI, select Configuration -> Equipment...

........................................................................................................................................................................................................................

4 Select the desired DS1 port by clicking the + sign next to the CP and VT Group.

........................................................................................................................................................................................................................

5 Highlight the port and click Select.

From the pull-down next to Line Build Out: choose the LBO value determined in Step 2.

LBO value Distance (feet)

20 0 - 133 (default)

40 134 - 267

60 268 - 420

80 421 - 533

100 534 - 655
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........................................................................................................................................................................................................................

6 If a change is made click Apply.

........................................................................................................................................................................................................................

7 Repeat Step 2 through Step 6 for all DS1 ports in all function unit slots which are 
populated with DS1 circuit packs.

........................................................................................................................................................................................................................

8 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Setting DS3/EC1 and TMUX LBOs

The DS3/EC1 and TMUX cabling will be tested with all ports provisioned for DS3. Set 
DS3 LBO values as follows.

........................................................................................................................................................................................................................

1 Refer to the following table of cable lengths and LBO values. Determine the LBO value 
corresponding to the DS3 (TMUX) cables installed:

Table 4-1 Cable lengths (feet)

........................................................................................................................................................................................................................

2 From the CIT GUI, select Configuration -> Equipment...

........................................................................................................................................................................................................................

3 Select the desired DS3 port by clicking the + sign next to the CP.

........................................................................................................................................................................................................................

4 Highlight the port and click Select.

........................................................................................................................................................................................................................

5 Next to Line Build Out: choose the LBO value determined in Step 1.

........................................................................................................................................................................................................................

6 Repeat Step 1 through Step 5 for all DS3 ports in all function unit slots that are populated 
with DS3 or TMUX circuit packs.

LBO Value  734D  735A

IN 0 - 225 0-125

OUT 225-450 125-250
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7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Clearing alarms

Description

In order to clear standing alarms the 1665 DMX synchronization will be optioned for 
"Free Running." The DCC will be disabled in order to prevent DCC alarms from being 
generated due to the optical loopback on the main OLIUs.

........................................................................................................................................................................................................................

1 Select Configuration -> Timing/Sync...

Result: From the Timing Mode: pull-down, choose Free Running.

........................................................................................................................................................................................................................

2 Click OK.

........................................................................................................................................................................................................................

3 Select Configuration -> DCC Terminations...

........................................................................................................................................................................................................................

4 From the Port AID: pull-down, select dcc-m1-1.

........................................................................................................................................................................................................................

5 Next to OSI Over DCC, click disabled.

........................................................................................................................................................................................................................

6 Click Apply.

........................................................................................................................................................................................................................

7 From the Port AID: pull-down, select dcc-m2-1.

........................................................................................................................................................................................................................

8 Next to OSI Over DCC, click disabled.

........................................................................................................................................................................................................................

9 Click Apply.

........................................................................................................................................................................................................................

10 Click Close.
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........................................................................................................................................................................................................................

11 If there are any FAULT LEDs on or flashing, press the UPD/INIT push button on the 
SYSCTL circuit pack.

Important! LNW16 (DS3/EC1) circuit pack require either a 75-ohm termination or a 
loopback at the DSX-3 on all ports. If loopbacks are used, make sure to take down any 
cross-connections.

........................................................................................................................................................................................................................

12 If there are still FAULT LEDs on, replace the respective circuit pack. 

........................................................................................................................................................................................................................

13 Disconnect the office alarm cable until all procedures and testing have been completed.

........................................................................................................................................................................................................................

14 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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............................................................................................................................................................................................................................................................

Local equipment and cross-connect tests

Description

The tests in this section verify the proper operation of the circuit packs and the circuit pack 
positions in the 1665 DMX shelf. It verifies proper cabling from the 1665 DMX to the 
DSX cross-connect panel or connecting equipment. The shelf must successfully pass this 
test before testing any other feature of the 1665 DMX.

It is assumed that Chapter 2, “Powering and initial circuit pack installation for 1665 Data 
Multiplexer (1665 DMX)” has been completed and the 1665 DMX shelf has fiber loop-
back cables on the Main OLIUs with proper LBOs installed, and synchronization set to 
free-running.

On initial installation/turn-up of 1665 DMX there are no default cross-connects. All cross-
connects need to be entered for these tests. Upon completion of this test all cross-
connections will be deleted.

Important! If the shelf is not fully equipped, move circuit packs to unequipped 
function slots and repeat the test. Test all circuit pack positions which have DSX 
cabling. 

Important! After completing this test, isolate and correct any incorrect wiring or 
isolate and replace any failed units. If any cabling is corrected or units replaced, repeat 
the Local Equipment and cross-connect tests until the units pass without failure. 

 A properly grounded ESD wrist strap MUST be worn when handling circuit packs.

Unterminated optical connectors may emit laser radiation. Do not view beam with 
optical instruments.

CAUTION

ESD hazard

WARNING

Laser hazard
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DS1 terminating equipment loopback testing

Facility Loopback testing allows the installer to verify electrical cabling to the DS1 
Terminating Equipment. This test is only required if the 1665 DMX shelf is connected to 
DS1 terminating equipment such as a DACS. It will be necessary to work with the 
Customer Network Control Center to have them establish a terminal loopback. If the shelf 
is NOT connected to DS1 terminating equipment, skip this section and continue with DS1 
non-terminating equipment transmission testing (optical main OLIU) (p. 4-11).

The Function Unit slot under test must contain a 28 DS1 (LNW6 or LNW7) or a 
56DS1/E1 (LNW8) circuit pack in order to perform this test. The 56DS1/E1 circuit packs 
can only be used with high capacity shelves. If the 1665 DMX shelf is not fully populated, 
it may be necessary to move the circuit pack(s) from slot to slot in order to test all DS1 
cabling.

Procedure

This command creates a cross-connect to map the first DS1 of a DS1 circuit pack in a 
Function Unit to the first VT1.5 within the first VT Group of STS1 of the Main OLIUs.

........................................................................................................................................................................................................................

1 Log on to the 1665 DMX shelf using the CIT software as described in Chapter 3, “Use of 
WaveStar® CIT software” (p. 3-9).

........................................................................................................................................................................................................................

2 Select Configuration -> Cross-Connections...

........................................................................................................................................................................................................................

3 Use the Cross-Connection Wizard to enter a new cross-connection at the VT1.5 rate, 
UPSR Ring Add/Drop, between m1-1-1-1-1 and fn1-1-1-1 (fn will be a,b,c or d depending 
on the slot where the DS1 CP is located).

........................................................................................................................................................................................................................

4 At this point it is necessary to have the Customer Network Control Center establish a 
terminal loopback at the port under test at the DS1 terminating equipment.

........................................................................................................................................................................................................................

5 Run a test transmission test to verify the electrical cabling.
Select Fault -> Test -> Transmission...

........................................................................................................................................................................................................................

6 Select the CP, VT Group and Port 1-1 (DS1) associated with the cross-connection entered 
above.
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........................................................................................................................................................................................................................

7 Select the FACILITY direction.

Result: The results should indicate that the test ran for a duration of 60 seconds 
followed by 0 es (errored seconds).

........................................................................................................................................................................................................................

8 Complete the above test on all Function Unit slots terminating at DSX equipment. Once 
you have completed the test make sure that all loopbacks have been removed at the 
Customer Network Control Center before moving on to any other testing.

........................................................................................................................................................................................................................

9 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

DS1 non-terminating equipment transmission testing (optical main OLIU)

Perform the following steps for all 1665 DMX shelf Function Unit slots that are cabled to 
a DSX-1 and not to any terminating equipment.

A Function Unit slot cabled to the DSX-1 must contain a 28DS1 (LNW6 or LNW7) 
circuit pack or a 56DS1/E1 (LNW8) circuit pack in order to perform these tests. If the 
1665 DMX shelf is not fully populated, it may be necessary to move the circuit pack(s) 
from slot to slot in order to test all DS1 cabling.

This procedure requires the use of a DS1 test set.

Procedure

This command creates a cross-connect to map the first DS1 of a DS1 circuit pack in a 
Function Unit to the first VT1.5 within the first VT Group of STS1 of the Main OLIUs.

........................................................................................................................................................................................................................

1 Log on to the 1665 DMX shelf using the CIT software as described in the Chapter 3, “Use 
of WaveStar® CIT software” (p. 3-9).

........................................................................................................................................................................................................................

2 Select Configuration -> Cross Connections...

........................................................................................................................................................................................................................

3 Use the Cross-Connection Wizard to enter a new cross-connection at the VT1.5 rate, 
UPSR Ring Add/Drop, starting with m-1-1-1-1 and fn-1-1-1 (fn will be a,b,c or d 
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depending on the slot where the DS1 CP is located). Refer to Table 4-2, “DS1 Cross-
Connections” (p. 4-18).

........................................................................................................................................................................................................................

4 Set the DS1 test set to transmit and receive a Quasi-Random Sequence Signal (QRSS) 
with B8ZS formatting.

........................................................................................................................................................................................................................

5 Connect a cable from the DS1 test set transmit connection to the IN jack of the DSX-1 
associated with the DS1 tributary to be tested (start with the first).

........................................................................................................................................................................................................................

6 Connect a cable from the DS1 test set receive connection to the OUT jack of the DSX-1 
associated with the DS1 tributary to be tested (start with the first).

Result: The DS1 test set should indicate it is receiving an error free QRSS signal with 
B8ZS formatting.

If an error free signal is not received: 

• Verify that the DS1 line coding format is set to B8ZS using the View -> Equipment 
command

• Verify that the LBOs are set according to cable length using the View -> Equipment 
command (see Setting DS1 LBOs (p. 4-4).

• Check DS1 cabling for proper connections.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

DS1 non-terminating equipment transmission testing (LNW80 switch or LNW59 without optics)

Perform this test when the 1665 DMX is equipped with LNW80 switch packs or LNW59 
without optics in the main slots.

Facility loopback testing allows the installer to verify the electrical cabling to the 1665 
DMX NE. Follow the procedure below to perform a facility loopback test at the 1665 
DMX shelf. 

To test cabling to the DSX-1, use a DS1 test set to transmit and receive toward the facility 
loopback.

Perform the following tests for each DS1 circuit cabled to the 1665 DMX.
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........................................................................................................................................................................................................................

1 Select Fault -> Analysis -> Loopback...

........................................................................................................................................................................................................................

2 Choose the DS1 port to test and click Select.

........................................................................................................................................................................................................................

3 Select Operate and Loopback Type: Facility and click Apply.

........................................................................................................................................................................................................................

4 Once the loopback is up, a test signal shall be generated at the DS1 terminating equipment 
which will verify that the cabling is correct.

Important! A test set can be applied at the DSX-1 to test cabling toward the facility 
loopback.

........................................................................................................................................................................................................................

5 Once the test is complete, remove the loopback.

Select Fault -> Analysis -> Loopback...

........................................................................................................................................................................................................................

6 Choose the DS1 port to test and click Select.

........................................................................................................................................................................................................................

7 Select Release and Loopback Type: Facility and click Apply.

........................................................................................................................................................................................................................

8 Repeat Step 1 through Step 7 for each DS1 cabled to the DSX-1.

........................................................................................................................................................................................................................

9 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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............................................................................................................................................................................................................................................................

DS1 protection switching

DS1 function unit protection switching test (manual)

While a VT cross connection exists, and a test set is connected, path switching will be 
verified.

Use this procedure to test all of the Function Unit Slots occupied by a 
LNW6/LNW7/LNW8 (DS1) circuit pack.

Important! This test is performed when the DS1 circuit packs are in a 1x1 protection 
arrangement. It is not mandatory to perform this test on each VT cross-connection, 
however this procedure should be performed on each Function Unit Slot pair.

Procedure

Proceed as follows:

........................................................................................................................................................................................................................

1 Locate the Function Group equipped with the DS1 circuit pack.

........................................................................................................................................................................................................................

2 Determine the system is alarm free by clicking on the Alarm List button on the system 
view.

........................................................................................................................................................................................................................

3 Unseat the active circuit pack. The active circuit pack has an ACTIVE LED lit. Monitor 
the test set connected to the DSX patch panel.

Result: The ACTIVE LED on the other circuit pack in the Function Group will light.
The MN alarm and the NE LED lamps on the SYSCTL will light.
Transmission at the test set will take a momentary hit and then re-establish.

Confirm that there is a CP Removed alarm by clicking on the Alarm List button on the 
system view.

........................................................................................................................................................................................................................

4 Unseat the second circuit pack of the pair.

Result: On the SYSCTL, the MN alarm extinguishes and the CR alarm lights. Test set 
will be registering continuous bit errors and indicate AIS alarm.

........................................................................................................................................................................................................................

5 Reseat the first circuit pack that was removed.
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Result: The ACTIVE LED on the reseated circuit pack will light. The FAULT LED on 
the circuit pack will light for several seconds then extinguish.
On the SYSCTL, the CR alarm extinguishes and the MN alarm and the NE LED will 
be lit. Test set will indicate good transmission.

........................................................................................................................................................................................................................

6 Reseat the second circuit pack.

Requirement: The ACTIVE LED on the first circuit pack remains on.
The ACTIVE LED on the second circuit pack remains off.
The FAULT LED on the second circuit pack will light for several seconds then 
extinguish. On the SYSCTL, the MN alarm extinguishes.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

DS1 function unit protection switching test (command)

This test will initiate switching commands from the CIT and verify proper switching and 
LED indications.

Important! It is not necessary to perform this test on each vt cross-connection, 
however this procedure should be performed on each Function Unit Slot pair.

........................................................................................................................................................................................................................

1 Select Fault -> Protection Switch...

........................................................................................................................................................................................................................

2 Click on 1+1 Equip fn-x (x is a,b,c or d corresponding to the function group equipped with 
DS1).

........................................................................................................................................................................................................................

3 Click Select.

........................................................................................................................................................................................................................

4 In the Switch Type: pull-down, select Manual (Normal).

........................................................................................................................................................................................................................

5 Click Apply.
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Result: The pack that was active should now be the standby pack and the pack that 
was standby is now active. Transmission should take a momentary hit as it is switched 
to the other pack. This information should agree with the ACTIVE LEDs on the 
LNW6/LNW7 or LNW8 circuit packs.

........................................................................................................................................................................................................................

6 Repeat Step 1 through Step 5 to verify a switch back to the original Function Unit circuit 
pack, with the same results as the previous step.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

DS1 path switching test (manual)

Important! It is not mandatory to perform this test on each vt cross-connection, 
however this procedure should be performed on each Function Unit Slot pair.

........................................................................................................................................................................................................................

1 Select Fault -> Protection Switch...

........................................................................................................................................................................................................................

2 Under Path Protection, click on Path m-1-1-1-1.

........................................................................................................................................................................................................................

3 Click Select.

........................................................................................................................................................................................................................

4 At the Switch Type: pull-down, select Manual.

........................................................................................................................................................................................................................

5 Click Apply.

Result: The Active Path: indicates a change from m1 to m2 (or if m2 was originally 
the active path, the switch is from m2 to m1).
The Switch Request State: indicates Manual Switch.

........................................................................................................................................................................................................................

6 At the Switch Type: pull-down, select Clear.

........................................................................................................................................................................................................................

7 Click Apply.
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........................................................................................................................................................................................................................

8 Repeat Step 1 through Step 7 to verify a switch back to the original ring.

........................................................................................................................................................................................................................

9 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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DS1 cleanup procedures

Delete any existing DS1 cross-connections

Before moving on to the next port to test, it is necessary to remove the cross-connection. 
This procedure details the necessary steps to delete a cross-connection.

........................................................................................................................................................................................................................

1 Select Configuration -> Cross-Connections...

........................................................................................................................................................................................................................

2 Use the Cross-Connection Wizard to Delete leg(s) of an existing cross-connection 
associated with CP main-1, Port 1.

Requirement: The DS1 test set should indicate a blue (AIS) signal is being received 
in place of the QRSS signal.

........................................................................................................................................................................................................................

3 Remove the test set connections from the DSX-1.

........................................................................................................................................................................................................................

4 Select Configuration -> Update System... -> Update All.

Result: This command will remove alarms generated by removing the test signals 
from the DSX-1.

........................................................................................................................................................................................................................

5 Repeat the DS1 terminating equipment loopback testing (p. 4-10) or the DS1 non-
terminating equipment transmission testing (optical main OLIU) (p. 4-11) procedure and 
the Delete any existing DS1 cross-connections (p. 4-18) procedure to test each of the 
remaining DS1 tributaries of the Function Unit. This is necessary in order to ensure that 
the cabling of each port address is correct.

The table below lists the tributaries and cross-connections for all DS1s associated with a 
function group.

When testing cabling for a Function Unit slot other than a, replace the a in each of the 
addresses with the letter (b, c, or d) corresponding to the Function Unit slot under test.

Table 4-2 DS1 Cross-Connections

Tributary @ DSX-1 Cross-Connection

2 m-1-1-1-2,a-1-1-2

3 m-1-1-1-3,a-1-1-3
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4 m-1-1-1-4,a-1-1-4

5 m-1-1-2-1,a-1-2-1

6 m-1-1-2-2,a-1-2-2

7 m-1-1-2-3,a-1-2-3

8 m-1-1-2-4,a-1-2-4

9 m-1-1-3-1,a-1-3-1

10 m-1-1-3-2,a-1-3-2

11 m-1-1-3-3,a-1-3-3

12 m-1-1-3-4,a-1-3-4

13 m-1-1-4-1,a-1-4-1

14 m-1-1-4-2,a-1-4-2

15 m-1-1-4-3,a-1-4-3

16 m-1-1-4-4,a-1-4-4

17 m-1-1-5-1,a-1-5-1

18 m-1-1-5-2,a-1-5-2

19 m-1-1-5-3,a-1-5-3

20 m-1-1-5-4,a-1-5-4

21 m-1-1-6-1,a-1-6-1

22 m-1-1-6-2,a-1-6-2

23 m-1-1-6-3,a-1-6-3

24 m-1-1-6-4,a-1-6-4

25 m-1-1-7-1,a-1-7-1

26 m-1-1-7-2,a-1-7-2

27 m-1-1-7-3,a-1-7-3

28 m-1-1-7-4,a-1-7-4

29* m-1-2-1-1,a-2-1-1

30* m-1-2-1-2,a-2-1-2

31* m-1-2-1-3,a-2-1-3

32* m-1-2-1-4,a-2-1-4

Tributary @ DSX-1 Cross-Connection
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Important! Tribs 29-56 (denoted *) are only used for LNW8 circuit packs.

........................................................................................................................................................................................................................

6 Repeat this procedure for each Function Unit slots cabled to a DSX-1 via DS1 cabling.

33* m-1-2-2-1,a-2-2-1

34* m-1-2-2-2,a-2-2-2

35* m-1-2-2-3,a-2-2-3

36* m-1-2-2-4,a-2-2-4

37* m-1-2-3-1,a-2-3-1

38* m-1-2-3-2,a-2-3-2

39* m-1-2-3-3,a-2-3-3

40* m-1-2-3-4,a-2-3-4

41* m-1-2-4-1,a-2-4-1

42* m-1-2-4-2,a-2-4-2

43* m-1-2-4-3,a-2-4-3

44* m-1-2-4-4,a-2-4-4

45* m-1-2-5-1,a-2-5-1

46* m-1-2-5-2,a-2-5-2

47* m-1-2-5-3,a-2-5-3

48* m-1-2-5-4,a-2-5-4

49* m-1-2-6-1,a-2-6-1

50* m-1-2-6-2,a-2-6-2

51* m-1-2-6-3,a-2-6-3

52* m-1-2-6-4,a-2-6-4

53* m-1-2-7-1,a-2-7-1

54* m-1-2-7-2,a-2-7-2

55* m-1-2-7-3,a-2-7-3

56* m-1-2-7-4,a-2-7-4

Tributary @ DSX-1 Cross-Connection
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........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Verify cross-connects removed

........................................................................................................................................................................................................................

1 Select View -> Cross-Connections...

........................................................................................................................................................................................................................

2 Choose shelf (1665 DMX) and click Select.

........................................................................................................................................................................................................................

3 Verify that there are no cross-connections on the shelf.

........................................................................................................................................................................................................................

4 Select Configuration -> Update System... -> Update All.

Result: This command will remove alarms generated by removing the test signals 
from the DSX-1.

........................................................................................................................................................................................................................

5 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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DS3/EC1 and TMUX testing procedure

Description

Perform the following steps for all 1665 DMX shelf Function Unit slots containing 
12DS3/EC1 (LNW16), 48DS3/EC1 (LNW19/LNW19B), 12TMUX (LNW18) and 
48TMUX (LNW20) circuit packs and cabled to a DSX-3 via DS3/EC1 cabling. The 
48DS3/EC1 and 48TMUX circuit packs can only be used with high capacity shelves.

If the 1665 DMX is cabled to some other type of DS3/EC1 terminating equipment, use 
this procedure by substituting these ports for the DSX-3 ports called out in the procedure. 
If the 1665 DMX shelf is not fully populated, it may be necessary to move the circuit 
pack(s) from slot to slot in order to test all DS3/EC1 and TMUX cabling.

This procedure requires the use of a DS3 test set.

Important! The LNW16 and LNW19/LNW19B circuit packs are provisioned on a 
“per port” basis for DS3 or EC1. The default setting for all ports is DS3. Tests in the 
section will verify proper cabling by using a DS3 test set with all ports provisioned as 
DS3.

TMUX is only provisionable for DS3.

Verify provisioning

Verify that all ports are provisioned as DS3.

........................................................................................................................................................................................................................

1 Select View -> Equipment...

........................................................................................................................................................................................................................

2 Click on the + sign next to the CP fn with the DS3/EC1 circuit pack.

........................................................................................................................................................................................................................

3 Verify that all ports are labeled as DS3.

........................................................................................................................................................................................................................

4 To change provisioning from EC1 to DS3, select Configuration -> Equipment... Select the 
DS3/EC1 circuit pack and port, then choose DS3 and click Apply.

........................................................................................................................................................................................................................

5 Repeat Step 1 through Step 4 for each Function Group equipped with LNW16 or 
LNW19/LNW19B circuit pack(s).
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........................................................................................................................................................................................................................

6 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

DS3 terminating equipment loopback testing (optical main OLIUs)

When the 1665 DMX is equipped with optical main OLIUs, they are looped on 
themselves and the following tests verify correct operation.

When the 1665 DMX is equipped with LNW80 switch packs or LNW59 mains without 
optics, go to DS3 terminating equipment loopback testing (LNW80 switch and LNW59 
without optics) (p. 4-24).

Facility Loopback testing allows the installer to verify the electrical cabling to the 1665 
DMX NE. Follow the procedure below to perform a facility loopback test at the 1665 
DMX shelf. When the 1665 DMX is cabled to other DS3 terminating equipment, in order 
to complete the loopback testing, it will be necessary to contact the Customer Network 
Control Center and have a signal established at the port(s) under test. 

........................................................................................................................................................................................................................

1 Log on to the 1665 DMX shelf using the CIT software as described in Chapter 3, 
“Software download and circuit pack installation”, “Use of WaveStar® CIT software” 
(p. 3-9).

........................................................................................................................................................................................................................

2 Select Configuration -> Cross-Connections...

........................................................................................................................................................................................................................

3 Using the Cross-Connection Wizard create a new cross-connection, UPSR Ring 
Add/Drop, at the STS1 rate from m1-1-1 to fn1-1 (fn is a,b,c or d).

........................................................................................................................................................................................................................

4 Select Fault -> Analysis -> Loopback...

........................................................................................................................................................................................................................

5 Choose the DS3 port to test and click Select.

........................................................................................................................................................................................................................

6 Select Operate and Loopback Type: Facility and click Apply.



............................................................................................................................................................................................................................................................

DS3/EC1 and TMUX testing procedureInstallation tests

4 - 2 4  365-372-304R7.1
Issue 1, November 2007

........................................................................................................................................................................................................................

7 Once the loopback is up, a test signal shall be generated at the DS3 terminating equipment 
which will verify that the cabling is correct.

........................................................................................................................................................................................................................

8 While observing the error free transmission, grasp the DS3 cable about two inches from 
the BNC connector head and gently rotate (twist) the cable in a clockwise and counter 
clockwise direction about 45 degrees (gently).

Result: If any errors are detected while performing this "wiggle test," the BNC 
connector must be cut off and replaced.

If an error free signal is not received:

• Check the LBOs settings using View -> Equipment (see Setting DS3/EC1 and TMUX 
LBOs (p. 4-5).

• Verify that the pack is provisioned for the framing format being sent from the test set, 
CBIT or M13.

• Verify that the port is provisioned for DS3. See Verify provisioning (p. 4-22).

• Check the DS3/EC1 cabling for proper connections.

........................................................................................................................................................................................................................

9 Once the test is complete, remove the loopback.

Select Fault -> Analysis -> Loopback...

........................................................................................................................................................................................................................

10 Choose the DS3 port to test and click Select.

........................................................................................................................................................................................................................

11 Select Release and Loopback Type: Facility and click Apply.

........................................................................................................................................................................................................................

12 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

.

DS3 terminating equipment loopback testing (LNW80 switch and LNW59 without optics)

Perform this test when the 1665 DMX is equipped with LNW80 switch packs or LNW59 
without optics in the main slots.
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Facility Loopback testing allows the installer to verify the electrical cabling to the 1665 
DMX NE. Follow the procedure below to perform a facility loopback test at the 1665 
DMX shelf. When the 1665 DMX is cabled to other DS3 terminating equipment, in order 
to complete the loopback testing, it will be necessary to contact the Customer Network 
Control Center and have a signal established at the port(s) under test.

To test cabling to the DSX-3, use a DS3 test set to transmit and receive toward the facility 
loopback.

Perform the following tests for each DS3 circuit cabled to the 1665 DMX.

........................................................................................................................................................................................................................

1 Select Fault -> Analysis -> Loopback...

........................................................................................................................................................................................................................

2 Choose the DS3 port to test and click Select.

........................................................................................................................................................................................................................

3 Select Operate and Loopback Type: Facility and click Apply.

........................................................................................................................................................................................................................

4 Once the loopback is up, a test signal shall be generated at the DS3 terminating equipment 
which will verify that the cabling is correct.

Important! A test set can be applied at the DSX-3 to test cabling toward the facility 
loopback.

........................................................................................................................................................................................................................

5 While observing the error-free transmission, grasp the DS3 cable about two inches from 
the BNC connector head and gently rotate (twist) the cable in a clockwise and counter 
clockwise direction about 45 degrees (gently).

Result: If any errors are detected while performing this "wiggle test," the BNC 
connector must be cut off and replaced.

If an error free signal is not received:

• Check the LBOs settings using View -> Equipment (see Setting DS3/EC1 and TMUX 
LBOs (p. 4-5).

• Verify that the pack is provisioned for the framing format being sent from the test set, 
CBIT or M13.

• Verify that the port is provisioned for DS3. See Verify provisioning (p. 4-22).

• Check the DS3/EC1 cabling for proper connections.
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........................................................................................................................................................................................................................

6 Once the test is complete, remove the loopback.

Select Fault -> Analysis -> Loopback...

........................................................................................................................................................................................................................

7 Choose the DS3 port to test and click Select.

........................................................................................................................................................................................................................

8 Select Release and Loopback Type: Facility and click Apply.

........................................................................................................................................................................................................................

9 Repeat Step 1 through Step 8 for each DS3 cabled to the DSX-3.

........................................................................................................................................................................................................................

10 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

.

DS3 non-terminating transmission (optical main OLIU)

Perform the remaining steps in this procedure for all Function Groups equipped with 
LNW16 (12DS3/EC1), LNW19/LNW19B (48DS3/EC1), LNW18 (TMUX) or LNW20 
(48TMUX) circuit packs that are terminated at a DSX3 patch panel.

........................................................................................................................................................................................................................

1 Select Configuration -> Cross-Connections...

........................................................................................................................................................................................................................

2 Use the Cross-Connection Wizard to enter a new cross-connection at the STS1 rate, UPSR 
Ring Add/Drop, between m-1-1 and fn-1 (fn will be a,b,c or d depending on the slot where 
the DS3 or TMUX CP is located).

........................................................................................................................................................................................................................

3 Set the DS3 test set to transmit and receive a framed Pseudo Random Bit Stream (PRBS) 
DS3 test signal M13.

M13 should be used to test TMUX.

........................................................................................................................................................................................................................

4 Connect a cable from the DS3 test set transmit connection to the IN jack of the DSX-3 
associated with the first DS3 or TMUX tributary of the 1665 DMX Function Unit slot to 
be tested.
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........................................................................................................................................................................................................................

5 Connect a cable from the DS3 test set receive connection to the OUT jack of the DSX-3 
associated with the first DS3 or TMUX tributary of the 1665 DMX Function Unit slot to 
be tested.

Result: The DS3 test set should indicate it is receiving an error free PRBS signal. To 
verify that the port on the DS3 or TMUX pack is receiving the signal, verify that the 
port has transitioned to an "in service" state with the View -> Equipment command.

A port state of "IS" indicates that the pack is receiving a good signal to the port.

........................................................................................................................................................................................................................

6 While observing the error-free transmission at the DSX, grasp the DS3 cable about two 
inches from the BNC connector head and gently rotate (twist) the cable in a clockwise and 
counter clockwise direction about 45 degrees (gently).

Result: If any errors are detected while performing this “wiggle test,” the BNC 
connector must be cut off and replaced.

If an error-free signal is not received:

• Check the LBOs settings using the View -> Equipment command (see Setting 
DS3/EC1 and TMUX LBOs (p. 4-5).

• Verify that the pack is provisioned for the framing format being sent from the test set, 
M13.

• Verify that the port is provisioned for DS3. See Verify provisioning (p. 4-22).

• Check the DS3/EC1 cabling for proper connections.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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............................................................................................................................................................................................................................................................

DS3 protection switching

DS3 function unit protection switching test (manual)

Use this procedure to test all of the Function Unit Slots occupied with an 
LNW16(DS3/EC1), LNW19/LNW19B(48DS3/EC1), LNW18 (TMUX) or LNW20 
(48TMUX) circuit pack, whether they are cabled to a DSX or terminating equipment.

Important! This test is performed when the DS3 circuit packs are in a 1x1 protection 
arrangement.
It is not mandatory to perform this test on each sts cross-connection, however this 
procedure should be performed on each Function Unit Slot pair.

........................................................................................................................................................................................................................

1 Locate the Function Group equipped with the DS3/TMUX circuit pack.

........................................................................................................................................................................................................................

2 Unseat the active circuit pack. The active circuit pack has an ACTIVE LED lit.

Result: The ACTIVE LED on the other circuit pack in the Function Group will light. 
The MN alarm and the NE LED lamps on the SYSCTL will light. Transmission at the 
test set will take a momentary hit and then re-establish.

........................................................................................................................................................................................................................

3 Unseat the second circuit pack of the pair.

Result: On the SYSCTL, the MN alarm extinguishes and the CR alarm lights. The test 
set is registering loss of transmission.

........................................................................................................................................................................................................................

4 Reseat the first circuit pack that was removed.

Result: The ACTIVE LED on the reseated circuit pack will light. The FAULT LED on 
the circuit pack will light for several seconds then extinguish. On the SYSCTL, the CR 
alarm extinguishes and the MN alarm and the NE LED will be lit. Transmission is re-
established at the test set.

........................................................................................................................................................................................................................

5 Reseat the second circuit pack.
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Requirement: The ACTIVE LED on the first circuit pack remains on.
The ACTIVE LED on the second circuit pack remains off.
The FAULT LED on the second circuit pack will light for several seconds then extinguish.
On the SYSCTL, the MN alarm extinguishes.

........................................................................................................................................................................................................................

6 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

DS3 function unit protection switching test (command)

While an STS cross-connection exists, and a test set is connected, the protection switching 
will be verified.

This test will initiate switching commands from the CIT and verify proper switching and 
LED indications while monitoring transmission at a test set.

Important! It is not necessary to perform this test on each sts cross-connection, 
however this procedure should be performed on each Function Unit Slot pair.

........................................................................................................................................................................................................................

1 Select Fault -> Protection Switch...

........................................................................................................................................................................................................................

2 Click on 1+1 Equip fn-x (x is a,b,c or d corresponding to the function group equipped with 
DS3).

........................................................................................................................................................................................................................

3 Click Select.

........................................................................................................................................................................................................................

4 In the Switch Type: pull-down, select Manual (Normal).

........................................................................................................................................................................................................................

5 Click Apply.

Result: The pack that was active should now be the standby pack and the pack that 
was standby is now active. Transmission should take a momentary hit as it is switched 
to the other pack. This information should agree with the ACTIVE LEDs on the 
LNW16/LNW19/LNW19B, LNW18 or LNW20 circuit packs.
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........................................................................................................................................................................................................................

6 Repeat Step 1 through Step 5 to verify a switch back to the original Function Unit circuit 
pack, with the same results as the previous step.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

DS3 path switching test (command)

While an STS cross-connection exists, and a test set is connected, path switching will be 
verified.

Important! It is not mandatory to perform this test on each sts cross-connection, 
however this procedure should be performed on each Function Unit Slot pair.

........................................................................................................................................................................................................................

1 Select Fault -> Protection Switch...

........................................................................................................................................................................................................................

2 Under Path Protection, click on Path m-1-1.

........................................................................................................................................................................................................................

3 Click Select.

........................................................................................................................................................................................................................

4 At the Switch Type: pull-down, select Manual.

........................................................................................................................................................................................................................

5 Click Apply.

Result: The Active Path: indicates a change from m1 to m2 (or if m2 was originally 
the active path, the switch is from m2 to m1).
The Switch Request State: indicates Manual Switch.

........................................................................................................................................................................................................................

6 At the Switch Type: pull-down, select Clear.

........................................................................................................................................................................................................................

7 Click Apply.
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........................................................................................................................................................................................................................

8 Repeat Step 1 through Step 7 to verify a switch back to the original ring.

........................................................................................................................................................................................................................

9 Repeat Step 1 through Step 7 to verify a switch back to the original ring.

........................................................................................................................................................................................................................

10 Check off the appropriate box in Appendix E, “Installation checklist”

........................................................................................................................................................E N D  O F  S T E P S



............................................................................................................................................................................................................................................................

DS3 cleanup proceduresInstallation tests

4 - 3 2  365-372-304R7.1
Issue 1, November 2007

............................................................................................................................................................................................................................................................

DS3 cleanup procedures

Delete the existing DS3 cross-connections

Before moving on to the next port to test, it is necessary to remove the cross-connection.

........................................................................................................................................................................................................................

1 Select Configuration -> Cross-Connections...

........................................................................................................................................................................................................................

2 Use the Cross-Connection Wizard to Delete leg(s) of an existing cross-connection 
associated with CP main-1, Port 1.

Result: The DS3 test set should indicate a blue (AIS) signal is being received in place 
of the PRBS signal.

........................................................................................................................................................................................................................

3 Remove the test set connections from the DSX-3.

........................................................................................................................................................................................................................

4 Select Configuration -> Update System... -> Update All.

Result: This command will remove alarms generated by removing the test signals 
from the DSX-3.

........................................................................................................................................................................................................................

5 Repeat the DS3 terminating equipment loopback testing (optical main OLIUs) (p. 4-23) or 
the DS3 non-terminating transmission (optical main OLIU) (p. 4-26) procedure and the 
Delete the existing DS3 cross-connections (p. 4-32) procedure to test each of the 
remaining DS3 tributaries of the Function Unit, substituting the following address 
information within the Cross-Connection Wizard. This is necessary in order to ensure that 
the cabling of each port address is correct.

The table below lists the tributaries and cross-connections for all DS3s associated with a 
function group.

When testing cabling for a Function Unit slot other than a, replace the a in each of the 
addresses with the letter (b, c, or d) corresponding to the Function Unit slot under test.
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Table 4-3 DS3 Cross-Connections

Tributary @ DSX-3 Cross-Connection

2 m-1-2,a-2

3 m-1-3,a-3

4 m-1-4,a-4

5 m-1-5,a-5

6 m-1-6,a-6

7 m-1-7,a-7

8 m-1-8,a-8

9 m-1-9,a-9

10 m-1-10,a-10

11 m-1-11,a-11

12 m-1-12,a-12

13* m-1-13,a-13

14* m-1-14,a-14

15* m-1-15,a-15

16* m-1-16,a-16

17* m-1-17,a-17

18* m-1-18,a-18

19* m-1-19,a-19

20* m-1-20,a-20

21* m-1-21,a-21

22* m-1-22,a-22

23* m-1-23,a-23

24* m-1-24,a-24

25* m-1-25,a-25

26* m-1-26,a-26

27* m-1-27,a-27

28* m-1-28,a-28

29* m-1-29,a-29
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Important! Tribs 13-48 (denoted *) are for LNW19/LNW19B and LNW20 circuit packs 
only.

........................................................................................................................................................................................................................

6 Repeat this procedure for each Function Unit slot cabled to a DSX-3 via DS3/EC1 
cabling.

........................................................................................................................................................................................................................

7 Verify there are no existing DS3 cross-connections. Use the View -> Cross-Connections 
command.

........................................................................................................................................................................................................................

8 Select Configuration -> Update System... -> Update All.

30* m-1-30,a-30

31* m-1-31,a-31

32* m-1-32,a-32

33* m-1-33,a-33

34* m-1-34,a-34

35* m-1-35,a-35

36* m-1-36,a-36

37* m-1-37,a-37

38* m-1-38,a-38

39* m-1-39,a-39

40* m-1-40,a-40

41* m-1-41,a-41

42* m-1-42,a-42

43* m-1-43,a-43

44* m-1-44,a-44

45* m-1-45,a-45

46* m-1-46,a-46

47* m-1-47,a-47

48* m-1-48,a-48

Tributary @ DSX-3 Cross-Connection
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Result: This command will remove alarms generated by removing the test signals 
from the DSX-3.

........................................................................................................................................................................................................................

9 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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............................................................................................................................................................................................................................................................

LNW66, LNW71 and LNW74 (10/100T) TX Ethernet cabling testing

Description

This procedure is used to test the Ethernet 10/100 TX cabling from the function groups to 
the RJ45 patch panel.

Ethernet port assignment verification testing

........................................................................................................................................................................................................................

1 Connect the Front CIT cable between the PC and the CIT/RS 232 jack of System 
Controller and login to the shelf using the serial connection.

........................................................................................................................................................................................................................

2 Identify the function groups that contain an LNW66, LNW71 or LNW74 (10/100T) 
circuit packs with cabling for testing.

........................................................................................................................................................................................................................

3 Identify the RJ45 patch panel associated with the function groups identified above.

........................................................................................................................................................................................................................

4 Connect the RJ45 cable from the first RJ45 on the patch panel to the Ethernet port on your 
PC.

........................................................................................................................................................................................................................

5 Watch for the link LED to light on the PC’s Ethernet card or wait for 30 seconds and then 
disconnect the RJ45 cable from the patch panel.

........................................................................................................................................................................................................................

6 The Fault LED will start flashing on the LNW66, LNW71 or LNW74.

........................................................................................................................................................................................................................

7 Verify that there is an inc. FE-LAN LOS alarm associated with the Ethernet port where the 
signal was removed. Use the Alarm List button on the CIT system view.

........................................................................................................................................................................................................................

8 Select Configuration -> Update System... -> Update All.

Result: The flashing fault LED on the LNW66, LNW71 or LNW74 will clear.
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........................................................................................................................................................................................................................

9 Connect the RJ45 cable to the next jack on the RJ45 patch panel and repeat starting at Step 
5 until all connected jacks have been tested.

........................................................................................................................................................................................................................

10 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Ethernet port wiring verification testing

Important! Continue with the following section only for LNW66 circuit packs. 
Testing is complete for LNW71 and LNW74 packs!

........................................................................................................................................................................................................................

1 If not still connected serially from the last procedure then, connect the Front CIT cable 
between the PC and the CIT/RS-232 jack of System Controller and login to the shelf using 
the serial connection.

........................................................................................................................................................................................................................

2 Select Configuration -> Data -> Create Virtual Switch.

........................................................................................................................................................................................................................

3 Choose the LNW66 that is being tested.

........................................................................................................................................................................................................................

4 Click Select.

........................................................................................................................................................................................................................

5 Enter Virtual Switch ID: 1.

........................................................................................................................................................................................................................

6 Under Ethernet (LAN) Ports, click Select All.

........................................................................................................................................................................................................................

7 Click Apply.

........................................................................................................................................................................................................................

8 Click Close

........................................................................................................................................................................................................................

9 Select Configuration -> Data -> Create VLAN
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........................................................................................................................................................................................................................

10 Choose the CP fn circuit pack that applies.

........................................................................................................................................................................................................................

11 Click Select.

........................................................................................................................................................................................................................

12 Enter VLAN ID:100

........................................................................................................................................................................................................................

13 Choose Virtual Switch:1

........................................................................................................................................................................................................................

14 Under “Untagged Traffic” click on Select All.

........................................................................................................................................................................................................................

15 Click Apply.

........................................................................................................................................................................................................................

16 Connect a RJ45 Ethernet cable from the LAN port on the LNW2 SYSCTL to the first 
position on the RJ45 Ethernet patch panel.

........................................................................................................................................................................................................................

17 Connect a second RJ45 Ethernet cable from the PC Ethernet port to the second position on 
the RJ45 Ethernet patch panel.

........................................................................................................................................................................................................................

18 Watch for the link LED to light on the PC’s Ethernet card or wait for 30 seconds.

........................................................................................................................................................................................................................

19 Login to the shelf using the OSI connection.

Result: Successful login to the 1665 DMX.

........................................................................................................................................................................................................................

20 Log out of the 1665 DMX shelf.

........................................................................................................................................................................................................................

21 At the RJ45 Ethernet patch panel disconnect the RJ45 Ethernet cable run to the PC 
Ethernet port and connect it to the next position on the RJ45 Ethernet patch panel to be 
tested.
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........................................................................................................................................................................................................................

22 Ignore the flashing fault LED on the Ethernet circuit pack and any alarms on the shelf.

........................................................................................................................................................................................................................

23 Watch for the link LED to light on the PC’s Ethernet card or wait for 30 seconds.

........................................................................................................................................................................................................................

24 Login to the shelf using the OSI connection.

Result: Successful login to the 1665 DMX.

........................................................................................................................................................................................................................

25 Log out of the 1665 DMX shelf.

........................................................................................................................................................................................................................

26 Repeat this procedure starting at Step 21 for the remaining Ethernet connections on the 
RJ45 patch panel connected to the LNW66 under test, then continue on to Step 27.

........................................................................................................................................................................................................................

27 Disconnect the PC from the RJ45 patch panel and the 1665 DMX LAN port from the RJ45 
patch panel.

........................................................................................................................................................................................................................

28 Connect the Front CIT cable between the PC and the CIT/RS 232 jack of System 
Controller and login to the shelf using the serial connection.

........................................................................................................................................................................................................................

29 Select Configuration -> Update System... -> Update All.

Result: The flashing fault LED on the Ethernet circuit pack will clear and any alarms 
on the 1665 DMX shelf will also clear.

........................................................................................................................................................................................................................

30 Select Configuration -> Data -> Delete Virtual Switch.

........................................................................................................................................................................................................................

31 Choose the LNW66 circuit pack and click Select.

........................................................................................................................................................................................................................

32 Select the VRTSW ID and click Apply.
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........................................................................................................................................................................................................................

33 Log out and disconnect the PC from the 1665 DMX serial port.

........................................................................................................................................................................................................................

34 Repeat this procedure for every slot containing and LNW66, LNW71, and LNW74.

........................................................................................................................................................................................................................

35 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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OC-3 (LNW37, LNW45, LNW55)/OC-12 (LNW49, LNW55)/OC-48 

............................................................................................................................................................................................................................................................

(LNW55, LNW62) low-speed SFP test procedure

OC-3/OC-12/OC-48 SFP low-speed SFP test procedure

Important! When reference is made to optical fiber loopback connections to IN and 
OUT on the OLIU, make the connections at the LGX equipment in order to verify 
correct installation and labeling of the fibers.

LBOs are installed on the OLIU faceplate IN port.

........................................................................................................................................................................................................................

1 Identify the function groups that contain an LNW37/LNW45 OC-3, LNW49 OC-12, 
LNW62 OC-48 or LNW55 12 port multi-rate OLIU circuit pack.

........................................................................................................................................................................................................................

2 Insert a 15-dB LC-type LBO into the top IN connector (Port 1) of the first SFP equipped. 
Refer to Appendix C, “Installing fiber connectors and LBOs”.

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 1).

........................................................................................................................................................................................................................

3 Connect the Port 1 IN connector to the Port 1 OUT connector (at the LGX) of the OC-3, 
OC-12 or OC-48 OLIU using an optical fiber jumper cable. Refer to Appendix B, “Fiber 
cleaning” for proper fiber cleaning instructions.

Requirement: The FAULT LED on the OLIU will begin flashing and the MN and NE 
LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OLIU 
and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

4 Remove the optical fiber jumper from the OLIU (at the LGX).

CAUTION

Laser safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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Result: The FAULT LED should begin flashing on the OLIU and only the MN and 
NE LEDs should be lit on the SYSCTL circuit pack.

The alarm on the SFP module will flash.

........................................................................................................................................................................................................................

5 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

6 Select Configuration -> Update System... -> Update All.

Requirement: The flashing FAULT LED should extinguish on the OLIU. There 
should be no alarm indications on the 1665 DMX shelf.

........................................................................................................................................................................................................................

7 From the system view click Alarm List to verify that the circuit pack alarm is cleared.

........................................................................................................................................................................................................................

8 Repeat this entire procedure for each LNW37, LNW45, LNW49, LNW55 or LNW62 SFP 
equipped in the 1665 DMX shelf.

........................................................................................................................................................................................................................

9 Replace all protective dust covers on the LNW37, LNW45, LNW49 or LNW62 SFP 
OLIU connectors (OLIU and LGX), that were removed to perform this procedure.

........................................................................................................................................................................................................................

10 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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............................................................................................................................................................................................................................................................

OC-3 (low-speed) testing

OC-3 testing procedure

Perform the following steps for all 1665 DMX shelf Function Unit or Growth slots 
containing OC-3 (LNW36) OLIU circuit packs.

Important! When reference is made to optical fiber loopback connections to IN and 
OUT on the OLIU, make the connections at the LGX equipment in order to verify 
correct installation and labeling of the fibers.

LBOs are installed on the OLIU faceplate IN port.

........................................................................................................................................................................................................................

1 Identify the function groups that contain an OC-3 OLIU circuit pack and fully insert the 
OLIU into the shelf.

Requirement: After a few moments, the ACTIVE LED should be lit on the OC-3 
OLIU.

........................................................................................................................................................................................................................

2 Insert a 15-dB LC-type LBO into the top IN connector (Port 1) of the OC-3 OLIU. Refer 
to Appendix C, “Installing fiber connectors and LBOs”.

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 1).

........................................................................................................................................................................................................................

3 Connect the Port 1 IN connector to the Port 1 OUT connector (at the LGX) of the OC-3 
OLIU, using an optical fiber jumper cable. Refer to Appendix A, “Laser safety and 
classifications and Electrostatic Discharge (ESD) considerations” for proper fiber cleaning 
instructions.

Requirement: The FAULT LED on the OC-3 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC-3 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

CAUTION

Laser safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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........................................................................................................................................................................................................................

4 Remove the optical fiber jumper from the OC-3 OLIU (at the LGX).

Result: The FAULT LED should begin flashing on the OC-3 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

5 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

6 Select Configuration -> Update System... -> Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-3 OLIU. There 
should be no alarm indications on the 1665 DMX shelf.

........................................................................................................................................................................................................................

7 Place the 15-dB LBO that was removed from the OC-3 OLIU (Port 1) and place it on the 
IN connector directly below it (Port 2).

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 2).

........................................................................................................................................................................................................................

8 Connect the Port 2 IN connector to the Port 2 OUT connector (at the LGX) of the OC-3 
OLIU, using an optical fiber jumper cable.

Requirement: The FAULT LED on the OC-3 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC-3 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

9 Remove the optical fiber jumper from the OC-3 OLIU (at the LGX).

Result: The FAULT LED should begin flashing on the OC-3 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

10 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.
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........................................................................................................................................................................................................................

11 Select Configuration -> Update System... -> Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-3 OLIU. There 
should be no alarm indications on the 1665 DMX shelf.

........................................................................................................................................................................................................................

12 Remove the 15-dB LBO from the OC-3 OLIU (Port 2) and place it on the IN connector 
directly below it (Port 3).

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 3).

........................................................................................................................................................................................................................

13 Connect the Port 3 IN connector to the Port 3 OUT connector (at the LGX) of the OC-3 
OLIU, using an optical fiber jumper cable.

Requirement: The FAULT LED on the OC-3 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC-3 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

14 Remove the optical fiber jumper from the OC-3 OLIU (at the LGX).

Result: The FAULT LED should begin flashing on the OC-3 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

15 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

16 Select Configuration -> Update System... -> Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-3 OLIU. There 
should be no alarm indications on the 1665 DMX shelf.

........................................................................................................................................................................................................................

17 Remove the 15-dB LBO from the OC-3 OLIU (Port 3) and place it on the IN connector 
directly below it (Port 4).

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 4).
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18 Connect the Port 4 IN connector to the Port 4 OUT connector (at the LGX) of the OC-3 
OLIU, using an optical fiber jumper cable.

Requirement: The FAULT LED on the OC-3 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC-3 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

19 Remove the optical fiber jumper from the OC-3 OLIU (at the LGX).

Result: The FAULT LED should begin flashing on the OC-3 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

20 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

21 Select Configuration -> Update System... -> Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-3 OLIU. There 
should be no alarm indications on the 1665 DMX shelf.

........................................................................................................................................................................................................................

22 Remove the 15-dB LBO from the OC-3 OLIU (port 4).

........................................................................................................................................................................................................................

23 Replace all protective dust covers on the OC-3 OLIU connectors (OLIU and LGX), that 
were removed to perform this procedure.

........................................................................................................................................................................................................................

24 Repeat this entire procedure for each OC-3 OLIU in the 1665 DMX shelf.

........................................................................................................................................................................................................................

25 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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OC-12 (low-speed) testing 

OC-12 testing procedure

Perform the following steps for all 1665 DMX shelf Function Unit or Growth slots 
containing OC-12 (LNW46) OLIU circuit packs.

Important! When reference is made to optical fiber loopback connections to IN and 
OUT on the OLIU, make the connections at the LGX equipment in order to verify 
correct installation and labeling of the fibers.

LBOs are installed on the OLIU faceplate IN port.

........................................................................................................................................................................................................................

1 Identify the function groups that contain an OC-12 OLIU circuit pack and fully insert the 
OLIU into the shelf.

Requirement: After a few moments, the ACTIVE LED should be lit on the OC-12 
OLIU.

........................................................................................................................................................................................................................

2 Insert a 15-dB LC-type LBO into the top IN connector (Port 1) of the OC-12 OLIU. Refer 
to Appendix C, “Installing fiber connectors and LBOs”.

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 1).

........................................................................................................................................................................................................................

3 Connect the Port 1 IN connector to the Port 1 OUT connector (at the LGX) of the OC-12 
OLIU, using an optical fiber jumper cable. Refer to Appendix B, “Fiber cleaning” for 
proper fiber cleaning instructions.

Requirement: The FAULT LED on the OC-12 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC1-2 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

CAUTION

Laser safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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4 Remove the optical fiber jumper from the OC-12 OLIU (at the LGX).

Result: The FAULT LED should begin flashing on the OC-12 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

5 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

6 Select Configuration -> Update System... -> Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-12 OLIU. 
There should be no alarm indications on the 1665 DMX shelf.

........................................................................................................................................................................................................................

7 Remove the 15-dB LBO from the OC-12 OLIU (Port 1) and place it on the IN connector 
directly below it (Port 2).

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 2).

........................................................................................................................................................................................................................

8 Connect the Port 2 IN connector to the Port 2 OUT connector (at the LGX) of the OC-12 
OLIU, using an optical fiber jumper cable.

Requirement: The FAULT LED on the OC-12 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC-12 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

9 Remove the optical fiber jumper from the OC-12 OLIU (at the LGX).

Result: The FAULT LED should begin flashing on the OC-12 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

10 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.
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........................................................................................................................................................................................................................

11 Select Configuration -> Update System... -> Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-12 OLIU. 
There should be no alarm indications on the 1665 DMX shelf.

........................................................................................................................................................................................................................

12 Remove the 15-dB LBO from the OC-12 OLIU (Port 2).

........................................................................................................................................................................................................................

13 Replace all protective dust covers on the OC-12 OLIU connectors, that were removed to 
perform this procedure.

........................................................................................................................................................................................................................

14 Repeat this entire procedure for each OC-12 OLIU in the 1665 DMX shelf.

........................................................................................................................................................................................................................

15 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

OC-12 facility loopback testing

Facility Loopback testing allows the installer to verify cabling to the OC-12 equipment. 
This test is only required if the 1665 DMX shelf is connected to OC-12 equipment. If the 
shelf is NOT connected to OC-12 equipment, skip this section and continue to the section 
on OC-48 low-speed testing procedure (p. 4-52).

Important! An optical test set with the capability to transmit OC-12 SONET levels 
are necessary for the testing.

The Function Unit slot under test must contain a OC-12 (LNW46) circuit pack in order to 
perform this test.

........................................................................................................................................................................................................................

1 Log on to the 1665 DMX shelf using the CIT software as described in the Chapter 3, 
“Software download and circuit pack installation”, “Use of WaveStar® CIT software” 
(p. 3-9).

........................................................................................................................................................................................................................

2 Select Configuration -> Cross-Connections...
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........................................................................................................................................................................................................................

3 Use the Cross-Connection Wizard to enter a new cross-connection at the STS-12 rate, 
UPSR Ring Add/Drop, between m-1-1 and fn-1-1 (fn will be a,b,c,d or g depending on the 
slot where the OC-12 CP is located).

This command creates a cross-connect to map the first OC-12 of an OC-12 circuit pack to 
the first STS-12 of the Main OLIUs.

........................................................................................................................................................................................................................

4 Verify transmission at the patch panel.

........................................................................................................................................................................................................................

5 Select Configuration -> Cross-Connections...

........................................................................................................................................................................................................................

6 Use the Cross-Connection Wizard to Delete leg(s) of an existing cross-connection 
associated with CP main-1, Port 1 (the OC-12 cross-connection).

........................................................................................................................................................................................................................

7 Verify loss of transmission at the patch panel. This should be evident by a SONET alarm 
and a loss of pattern alarm.

........................................................................................................................................................................................................................

8 Select Fault -> Analysis -> Loopback...

........................................................................................................................................................................................................................

9 Choose the correct port on the OC-12 CP and click Select.

........................................................................................................................................................................................................................

10 Click on Operate and Loopback Type: Facility.

........................................................................................................................................................................................................................

11 Click Apply.

This command creates a facility loopback on the OC-12 port of an OC-12 circuit pack.

........................................................................................................................................................................................................................

12 Verify transmission at the patch panel. There should be no alarms at the test set.

........................................................................................................................................................................................................................

13 Select Fault -> Analysis -> Loopback...
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........................................................................................................................................................................................................................

14 Choose the correct port on the OC-12 CP and click Select.

........................................................................................................................................................................................................................

15 Click on Release.

........................................................................................................................................................................................................................

16 Click Apply.

........................................................................................................................................................................................................................

17 Verify loss of transmission at the patch panel. This should be evident by a SONET alarm 
and a loss of pattern alarm.
........................................................................................................................................................................................................................

18 Repeat this section for all OC-12 ports.

........................................................................................................................................................................................................................

19 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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OC-48 (low-speed) testing 

OC-48 low-speed testing procedure

Perform the following steps for all 1665 DMX shelf Function Unit or Growth slots 
containing OC-48 (LNW31, LNW425, LNW427, LNW447, LNW449, LNW453, 
LNW455, LNW459) OLIU.

Important! When reference is made to optical fiber loopback connections to IN and 
OUT on the OLIU, make the connections at the LGX equipment in order to verify 
correct installation and labeling of the fibers.

LBOs are installed on the OLIU faceplate IN port.

........................................................................................................................................................................................................................

1 Identify the function groups that contain an OC-48 OLIU circuit pack and fully insert the 
OLIU into the shelf.

Requirement: After a few moments, the ACTIVE LED should be lit on the OC-48 
OLIU.

........................................................................................................................................................................................................................

2 Insert a 15-dB LC-type LBO into the IN connector of the OC-48 OLIU. Refer to Appendix 
C, “Installing fiber connectors and LBOs”.

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 1).

........................................................................................................................................................................................................................

3 Connect the IN connector to the OUT connector (at the LGX) of the OC-48 OLIU, using 
an optical fiber jumper cable. Refer to Appendix B, “Fiber cleaning” for proper fiber 
cleaning instructions.

Requirement: The FAULT LED on the OC-48 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC-48 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

CAUTION

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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........................................................................................................................................................................................................................

4 Remove the optical fiber jumper from the OC-48 OLIU (at the LGX).

Result: The FAULT LED should begin flashing on the OC-48 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

5 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

6 Select Configuration -> Update System... -> Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-48 OLIU. 
There should be no alarm indications on the 1665 DMX shelf.

........................................................................................................................................................................................................................

7 Remove the 15-dB LBO from the OC-48 OLIU.

........................................................................................................................................................................................................................

8 Replace all protective dust covers on the OC-48 OLIU connectors, that were removed to 
perform this procedure.

........................................................................................................................................................................................................................

9 Repeat this entire procedure for each OC-48 OLIU in the 1665 DMX shelf.

........................................................................................................................................................................................................................

10 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

OC-48 facility loopback testing

Facility Loopback testing allows the installer to verify cabling to the OC-48 equipment. 
This test is only required if the 1665 DMX shelf is connected to OC-48 equipment. If the 
shelf is NOT connected to OC-48 equipment, skip this section and continue to the next 
chapter.

Important! An optical test set with the capability to transmit OC-48 SONET levels 
are necessary for the testing.

The Function Unit slot under test must contain an OC-48 (LNW31, LNW425, LNW427, 
LNW447, LNW449, LNW453, LNW455, LNW459) circuit pack in order to perform this 
test. 
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........................................................................................................................................................................................................................

1 Log on to the 1665 DMX shelf using the CIT software as described in the Chapter 3, 
“Software download and circuit pack installation”, “Use of WaveStar® CIT software” 
(p. 3-9).

........................................................................................................................................................................................................................

2 Select Configuration -> Cross-Connections...

........................................................................................................................................................................................................................

3 Use the Cross-Connection Wizard to enter a new cross-connection at the STS48 rate, 
UPSR Ring Add/Drop, between m-1-1 and fn-1-1 (fn will be a,b,c,d or g depending on the 
slot where the OC-48 CP is located).

This command creates a cross-connect to map the first STS-48 of an OC-48 circuit pack to 
the first STS-48 of the Main OLIUs.

........................................................................................................................................................................................................................

4 Verify transmission at the patch panel. There should be no alarms at the test set.

........................................................................................................................................................................................................................

5 Select Configuration -> Cross-Connections...

........................................................................................................................................................................................................................

6 Use the Cross-Connection Wizard to Delete leg(s) of an existing cross-connection 
associated with CP main-1, Port 1 (the OC-48 cross-connection).

........................................................................................................................................................................................................................

7 Verify loss of transmission at the patch panel. This should be evident by a SONET alarm 
and a loss of pattern alarm.

........................................................................................................................................................................................................................

8 Select Fault -> Analysis -> Loopback...

........................................................................................................................................................................................................................

9 Choose the correct port on the OC-48 CP and click Select.

........................................................................................................................................................................................................................

10 Click on Operate and Loopback Type: Facility.

........................................................................................................................................................................................................................

11 Click Apply.

This command creates a facility loopback on the OC-48 port of an OC-48 circuit pack.
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........................................................................................................................................................................................................................

12 Verify transmission at the patch panel. There should be no alarms at the test set.

........................................................................................................................................................................................................................

13 Select Fault -> Analysis -> Loopback...

........................................................................................................................................................................................................................

14 Choose the correct port on the OC-48 CP and click Select.

........................................................................................................................................................................................................................

15 Click on Release.

........................................................................................................................................................................................................................

16 Click Apply.

........................................................................................................................................................................................................................

17 Verify loss of transmission at the patch panel. This should be evident by a SONET alarm 
and a loss of pattern alarm.

........................................................................................................................................................................................................................

18 Repeat this section for all OC-48 ports.

........................................................................................................................................................................................................................

19 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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LED test

Description

This test verifies proper operation of all LEDs on the 1665 DMX circuit packs. Operation 
of all the LEDs is necessary to assist in trouble isolation.

Important! If there are any LED failures, determine if the problem is with the circuit 
pack or shelf and replace the faulty unit.

Important! If the shelf is not fully equipped, move circuit packs around and repeat 
the test for all valid circuit pack positions.

LED test procedure

........................................................................................................................................................................................................................

1 Select Fault -> Test -> LED...

........................................................................................................................................................................................................................

2 Choose shelf (1665 DMX).

........................................................................................................................................................................................................................

3 Click Select.

........................................................................................................................................................................................................................

4 Choose Number of Iterations: 1.

........................................................................................................................................................................................................................

5 Click OK.

Result: All LEDs on the shelf should light for 10 seconds, then extinguish for 10 
seconds, and then the proper LEDs will light to indicate the current status of the shelf.

........................................................................................................................................................................................................................

6 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Additional optical tests (optional)

Low -speed optical testing

The following procedure is provided for installers wishing to further test the low-speed 
optical packs using an optical test set. Perform the following steps for all 1665 DMX shelf 
Function Unit or Growth slots. DCC will be disabled in order to prevent DCC alarms from 
being generated due to the optical loopback.

To test this procedure an optical test set is required as well as a 1x2 optical splitter.

Important! When reference is made to optical fiber loopback connections to IN and 
OUT on the High-Speed OLIU, make the connections at the LGX equipment in order 
to verify correct installation and labeling of the fibers.

The high-speed packs (OC-12, OC-48 or OC-192) should still be looped back on 
themselves and the dcc disabled to prevent dcc alarms. The dcc can be verified with 
the View -> DCC GUI command. If the high speed packs are no longer looped back, 
do so at the LGX panel. The dcc should also be disabled at the function unit slot under 
test since it will be connected to a test set and will register alarms. The dcc can be 
provisioned with the Provision -> DCC Terminations GUI command. Change the dcc 
on M2 and the FN slots by using the same command and double clicking on the m1 
and selecting m2 or selecting the FN a-g slot.

The OC-48 Optical Packs including the High-Speed OLIUs should be attenuated with 
15-dB LBOs. If using OC-192 in the high-speed slots, attenuate with 5 dB. LBOs are 
installed on the OLIU faceplate IN port. 

Procedure

Log in to the 1665 DMX shelf and verify that there are no existing alarms by viewing the 
Alarm List. 

CAUTION

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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1 Starting at Function Slot A, insert the optical packs to be tested in Slot A-1 and A-2. Both 
packs must be of the same type, otherwise a circuit pack not allowed alarm will be 
displayed.

........................................................................................................................................................................................................................

2 At the LS LGX Bay, measure the TX output level of all Ports on all OC-3, OC-12 and OC-
48 low-speed cards. Ensure the transmit level conforms to Appendix A, Table A-2, “1665 
DMX Optical Circuit Pack Laser Safety Specifications” (p. A-11). If the levels are not 
within specification, check the levels at the 1665 DMX. If levels are not within 
specification at the 1665 DMX, replace the pack with a spare and return the suspect pack 
back through the RMA process. If levels meet specifications, check the fiber to the LGX 
panel for continuity. 

........................................................................................................................................................................................................................

3 Ensure that the optical packs to be tested have 15-dB attenuators inserted to the IN port of 
the port under test. Failing to insert attenuators may overdrive the circuitry and cause 
permanent damage to the circuit packs. Start testing in Port 1.

........................................................................................................................................................................................................................

4 Connect the optical test set using the 1 x 2 optical splitter. The TX of the test set is 
connected to the LGX ports corresponding to the RX of both FN-1 and FN-2 of the 
function slots under test. The LGX port corresponding to the TX of the port under test of 
FN-1 (active slot) is connected to the RX of the test set. (Some test sets require an 
attenuation of at least 10dB on the RX side). Reference Figure 4-1, “Optical test set 
arrangement” (p. 4-59).
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Figure 4-1 Optical test set arrangement

........................................................................................................................................................................................................................

5 Set the test set to the required rate for the packs under test. Refer to Table 4-4, 
Transmission rate.

Table 4-4 Transmission rate

........................................................................................................................................................................................................................

6 Once the test set is in place, it will display pattern and AIS alarms. This is due to the fact 
that we have not established a cross-connection. Enter a cross-connection either through 
the GUI using the cross-connect wizard. Enter the command according to the optical pack 
and function slot under test.

TX

RX

1x2

splitter

RX

RX

TX

OC3
OC12
OC48

Optical
Test
Set TX

Standby
(FN-2)

Active
(FN-1)

OC-3 
(LNW36,LNW37, 
LNW45,LNW55)

 OC-12 
(LNW46,LNW49,
LNW55)

OC-48 
(LNW31,LNW55, 
LNW62,LNW425, 
LNW427, 
LNW447, 
LNW449, 
LNW453, 
LNW455, 
LNW459)

Test signal 
mapping

STS-3C STS-3C/12C STS-3C/12C/48C

Pattern 2^23 -1 PRBS 2^23 -1 PRBS 2^23 -1 PRBS
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7 Check the transmission at the test set. It should show no alarms. If alarms are present, 
check the test set provisioning and the cross-connection to ensure they correspond to the 
pack under test. Make any adjustments necessary, and do not continue the test until 
transmission is good.

........................................................................................................................................................................................................................

8 Check that the pack in FN-1 is the active pack with the GUI command View -> Protection 
and selecting the associated pack. 

If slot 1 is the active slot continue with testing, if slot 2 is active and slot 1 is standby, 
reseat the pack in slot 2, switching the active path to slot 1.

........................................................................................................................................................................................................................

9 At the LS LGX Bay, move the Test Set RX cable to the Standby TX Port, refer to 
Figure 4-2. Examine the test traffic received by the test set. Look for errors or any other 
signal information that the test set is capable of indicating. The Standby OCN card should 
be running without errors.

Figure 4-2 Optical test arrangement RX fiber moved

........................................................................................................................................................................................................................

10 Remove the Test Set TX cable from the Active OCN Card in FN-1. This will result in an 
Active to Standby OCN card switch. Verify that the traffic switched to the current Active 
OCN card FN-2, and that there is a LOS alarm issued against the current Standby OCN 

TX

RX

1x2

splitter

RX

RX

TX

OC3
OC12
OC48

Optical
Test
Set TX

Standby
(FN-2)

Active
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card FN-1. Retrieving the alarms can be accomplished by selecting the Alarm List button 
on the top right of the GUI.

Important! The test set will indicate that there was a transmission hit indicating the 
switch, but should clear and show good transmission.

........................................................................................................................................................................................................................

11 Return the Test Set TX Cable to normal operation and ensure that the LOS alarm clears.

........................................................................................................................................................................................................................

12 Delete any cross-connects through the GUI Cross-Connection Wizard.

........................................................................................................................................................................................................................

13 Select Configuration -> Update System... -> Update All.

........................................................................................................................................................................................................................

14 Repeat this test on all OCN ports for all optical packs which will reside in the shelf.

........................................................................................................................................................................................................................

15 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Overview

Purpose

This section provides instructions to test protection switching and the non-transmission 
cabling. This section is not intended to replace acceptance test procedures. If problems are 
encountered, refer to 365-373-302, 1665 Data Multiplexer Alarm Messages and Trouble 
Clearing Guide for detailed troubleshooting procedures.

Contents

This chapter provides information on the following topics:

Office alarm test  5-4

Automatic protection switching and alarm test  5-8

Manual switching tests  5-11

External timing verification  5-13

Miscellaneous (environmental) discrete telemetry test  5-16

Modem connection test  5-19

Final operations  5-21
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Tools, test equipment and accessories

Listed below are the tools, test equipment and accessories necessary to perform the 
procedures in this section.

Quantity Description Comments

Screwdriver(s) A screwdriver(s) with the appropriate head(s) is (are) 
required for securing the mounting screws, 
repositioning the mounting brackets, installing the 
interfacing cables, and for setting the circuit breakers 
to the OFF position.

1 ESD Wrist Strap A wrist strap must be worn when handling circuit 
packs. Use the electrostatic discharge (ESD) jack 
provided on the shelf.

1 Multimeter 
(Optional)

The voltmeter must be capable of measuring DC 
voltage in the 40 to 60 volt range. The use of the 
voltmeter is optional since the shelf will alarm or shut 
down if the proper voltage is not supplied.

1 DS1 Error Rate Test 
Set

A DS1 error rate test set is required for testing of DS1 
cabling. A T-BERD 211 or equivalent is 
recommended.

1 DS3 Error Rate Test 
Set

A DS3 error rate test set is required for testing of DS3 
cabling. A T-BERD 305 or equivalent is 
recommended.

1 SONET Optical Test 
Set

An ONC3, OC-12, or OC-48 test set is required for 
testing of optical circuit packs. An Agilent OmniBER 
718 or equivalent is recommended.

2 LC-type Optical 
Fiber Jumper 
(108918269)

Two optical fiber jumpers with LC type connectors 
are required to optically loop the 1665 DMX shelf 
for test purposes.

2 15 dB LC-type LBO 
(108279480)

Two 15-dB LBOs are required when optically looping 
the 1665 DMX shelf for test purposes.

2 20-dB LC-type LBO 
(108279530)

Two 20-dB LBOs are required when optically looping 
the 1665 DMX shelf equipped with LNW60.

1 Personal Computer 
(PC)

See Chapter 3, “Software download and circuit pack 
installation”, “PC minimum requirements” (p. 3-2).

1 CIT Interface Cable 8-ft. long RJ45 to 9-pin D-sub serial cable (Comcode 
848748869).
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Safety instructions

Important! All precautions should be observed when handling fiber. 

Unterminated optical connectors may emit laser radiation. Do not view beam with 
optical instruments.

WARNING

Laser hazard

CAUTION

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.

CAUTION
The operational tests in this section are run only in an out-of-service mode of 
operation. Office alarms will normally be connected only during the office 
alarm test to prevent constant alarms throughout this section. 
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Office alarm test

Description

This test verifies proper operation and wiring of the office alarms in a Network Equipment 
Building System (NEBS) environment.

Audible and visual reporting of critical, major, minor alarms will be verified.

Prerequisite

The following is a list of items to verify before beginning tests in this section.

• The 1665 Data Multiplexer (1665 DMX) Main OLIUs should be optically looped from 
the previous section. Verify that the 1665 DMX shelf is clear of all alarms (only green 
LEDs are lighted) prior to and after completing this test.

• The office alarm cable will be temporarily connected during this procedure. Table 5-1, 
“Office Alarm Connections” (p. 5-5) lists the office alarms connections.

• It is a requirement that alarms on the 1665 DMX do not affect and are not affected by 
other equipment via office alarm connections. During this test, the alarm state of other 
equipment connected to the same office alarms as the 1665 DMX should be examined 
after creating or clearing every alarm.

• A properly grounded ESD wrist strap must always be worn while handling circuit 
packs.

• This test should be performed on all shelves where office alarm reporting is required.

• After completing the office alarm test, the 1665 DMX office alarms should be 
disconnected from the office alarm system for the remainder of the test procedures. 
This will prevent the office alarms from being activated while performing the other 
tests in this section.
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Table 5-1 Office Alarm Connections

Office alarm test procedure

........................................................................................................................................................................................................................

1 Connect the office alarm cable to J12 (ALM) on the backplane of the 1665 DMX shelf. If 
the shelf to be tested is part of a multiple shelf bay arrangement, the office alarm cable 
connects to shelf 1.

........................................................................................................................................................................................................................

2 Verify that one of the function groups is equipped with LNW6/LNW7/LNW8 DS1, 
LNW16/LNW19/LNW19B DS3 or LNW18/20 TMUX circuit packs.

........................................................................................................................................................................................................................

3 Establish a CIT session by following the procedure under “Use of WaveStar® CIT 
software” (p. 3-9) in Chapter 3, “Software download and circuit pack installation”.

........................................................................................................................................................................................................................

4 Select Configuration -> Cross-Connections.

........................................................................................................................................................................................................................

5 Use the Cross-Connection Wizard to enter a new cross-connection at the STS-1 rate, 
UPSR Ring Add/Drop, between m1-1-1 and fn1-1 (fn will be a,b,c or d depending on the 
slot where the DS1, DS3, or TMUX CP is located).

Conn. Pin# Color Designation Name

J12-J13 1

2

3

4

BL-W

W-BL

O-W

W-O

RYMJV1

RYMJV2

RYMJA1

RYMJA2

Minor Alarm Visible

Minor Alarm Visible Return

Minor Alarm Audible

Minor Alarm Audible Return

5

6

7

8

G-W

W-G

BR-W

W-BR

RYMNV1

RYMNV2

RYMNA1

RYMNA2

Major Alarm Visible

Major Alarm Visible Return

Major Alarm Audible

Major Alarm Audible Return

9

10

11

12

S-W

W-S

BL-R

R-BL

RYCRV1

RYCRV2

RYCRA1

RYCRA2

Critical Alarm Visible

Critical Alarm Visible Return

Critical Alarm Audible

Critical Alarm Audible Return
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This command creates a cross-connection to map 28 DS1s of a DS1circuit pack or the first 
DS3 of a DS3/EC1 or TMUX circuit pack in a Function Unit slot(s) to the first STS-1 of 
the Main OLIUs.

........................................................................................................................................................................................................................

6 Select Configuration -> Alarms -> Alarm Configuration.

........................................................................................................................................................................................................................

7 Choose Power Alarm Level: Major.

........................................................................................................................................................................................................................

8 Click OK.

........................................................................................................................................................................................................................

9 Unseat one of the LNW6/LNW7/LNW8, LNW16/LNW19/LNW19B or LNW18 circuit 
packs from the function group being used. 

Requirement: Activated office alarms: MN visual, MN audible.

Important! Alarms will not be activated until the alarm delay time has passed. The 
default time is 2 seconds. 

........................................................................................................................................................................................................................

10 Press the ACO pushbutton on the SYSCTL.

Requirement: Activated office alarm: MN visual. 
The MN audible alarm clears.

........................................................................................................................................................................................................................

11 Using a small flat bladed screwdriver, set one of the circuit breakers to OFF.

Requirement: Activated office alarms: MN visual, MN audible.

........................................................................................................................................................................................................................

12 Press the ACO pushbutton on the SYSCTL.

Requirement: Activated office alarm: MJ visual.
The MJ audible alarm should clear.

........................................................................................................................................................................................................................

13 Unseat the second circuit pack from the same function group pair as the circuit pack 
removed in Step 9.

Result: Activated office alarms: CR visual, CR audible. 
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........................................................................................................................................................................................................................

14 Press the ACO pushbutton on the SYSCTL. 

Result: Activated office alarm: CR visual.
The CR audible alarm should clear.

........................................................................................................................................................................................................................

15 Reseat the pair of function units.

........................................................................................................................................................................................................................

16 Turn on the breaker that was turned off in Step 11.

Result: After a few minutes, all alarm indications should clear.

........................................................................................................................................................................................................................

17 Disconnect the office alarm cable connected in Step 1 for the remainder of the test 
procedures in this chapter.

........................................................................................................................................................................................................................

18 Select Configuration -> Alarms -> Alarm Configuration.

........................................................................................................................................................................................................................

19 Choose Power Alarm Level: Minor.

........................................................................................................................................................................................................................

20 Click OK.

Important! Do NOT delete the cross-connect that was entered for this test.

........................................................................................................................................................................................................................

21 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Automatic protection switching and alarm test

Description

This section provides the procedures for verifying the 1665 DMX shelf automatic 
protection switching.

Note the following:

• These tests do NOT simulate circuit pack failures.

• The tests will verify proper alarm reporting and LED indications when circuit 
packs are removed.

• All protected circuit packs will be tested. 

• A properly grounded wrist strap must always be worn while handling circuit 
packs. 

• This test is performed with the 1665 DMX shelf optically looped back on itself 
(that is, with the IN of the OLIU M1 looped to the OUT of the OLIU M1, and the 
IN of the OLIU M2 looped to the OUT of the OLIU M2). 

• Prior to performing each test, the shelf under test must be clear of all alarms (that 
is, only green LEDs are lit).

A properly grounded ESD wrist strap MUST be worn when handling circuit packs.

Unterminated optical connectors may emit laser radiation. Do not view beam with 
optical instruments. 

Main OLIU switching test 

Use this procedure to test the following Main OLIU circuit packs in a UPSR (default) 
configuration:

CAUTION

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.

CAUTION

ESD hazard

WARNING

Laser hazard
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OC-3

LNW82

OC-12

LNW48, LNW50, LNW54, LNW82

OC-48

LNW27, LNW29, LNW32, LNW76, LNW82, LNW202, LNW221-LNW259

OC-192

LNW56, LNW57, LNW58, LNW59 (VLF), LNW60, LNW502, LNW523, LNW527, 
LNW554 or LNW555.

It should be noted that switching tests for Function Unit circuit packs were performed in 
the previous chapter.

........................................................................................................................................................................................................................

1 Establish a CIT session by following the procedure under Use of WaveStar® CIT software 
(p. 3-9) in Chapter 3, “Software download and circuit pack installation”. 

........................................................................................................................................................................................................................

2 Select View -> Cross-Connections.

........................................................................................................................................................................................................................

3 Choose shelf (1665 DMX) and click Select.

........................................................................................................................................................................................................................

4 Verify that the cross-connection entered in the previous section is on the list. If there is no 
cross connect remaining from the previous section, then a cross connection must be 
established before continuing.

........................................................................................................................................................................................................................

5 Select Configuration -> Cross-Connections.

........................................................................................................................................................................................................................

6 Use the Cross-Connection Wizard to enter a new cross-connection at the STS-1 rate, 
UPSR Ring Add/Drop, between m1-1-1 and fn1-1 (fn will be a,b,c or d depending on the 
slot where the DS1, DS3, or TMUX CP is located).

This command creates a cross-connection to map 28 DS1s of a DS1 circuit pack or the 
first DS3 of a DS3/EC1 or TMUX circuit pack in a Function Unit slot(s) to the first STS-1 
of the Main OLIUs.
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........................................................................................................................................................................................................................

7 Select View -> Protection.

........................................................................................................................................................................................................................

8 Under Path Protection choose m-1-1.

........................................................................................................................................................................................................................

9 Click Select.

........................................................................................................................................................................................................................

10 Note the Active Path: (m1-1-1 or m2-1-1).

The M1 OLIU is associated with Ring 1 and the M2 OLIU is associated with Ring 2.

........................................................................................................................................................................................................................

11 Disconnect the optical fiber connected to the IN port of the OLIU that is the active 
receiver.

Result: The MN and then NE alarm LED should light on the SYSCTL and the FAULT 
LED should flash on the OLIU.

........................................................................................................................................................................................................................

12 Click Refresh in the View Protection window.

Result: The Active path has changed. (If m1-1-1 was active before, m2-1-1 is active 
now).

........................................................................................................................................................................................................................

13 Reconnect the fiber at the OLIU.

Result: After a short time, the MN and NE alarm LEDs on the SYSCTL and the 
FAULT LED on the OLIU should extinguish.

........................................................................................................................................................................................................................

14 Repeat Step 10 through Step 13 to verify a switch back to the OLIU that was originally 
active.

........................................................................................................................................................................................................................

15 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Manual switching tests

Description

This test will initiate switching commands from the CIT and verify proper switching and 
LED indications.

Main OLIU switch test

Important! An STS-1 cross-connect should still exist from the previous tests.

........................................................................................................................................................................................................................

1 Select Fault -> Protection Switch.

........................................................................................................................................................................................................................

2 Under Path Protection choose Path m-1-1.

........................................................................................................................................................................................................................

3 Click Select.

........................................................................................................................................................................................................................

4 Note the Active Path:.

........................................................................................................................................................................................................................

5 In the Switch Type: pull-down, choose Manual.

........................................................................................................................................................................................................................

6 Click Apply.

Requirement: The ring that was active in Step 4 is no longer active and the other ring 
is now active.

........................................................................................................................................................................................................................

7 In the Switch Type pull-down, choose Clear.

........................................................................................................................................................................................................................

8 Click Apply.

........................................................................................................................................................................................................................

9 Repeat Step 4 through Step 8 to verify a switch back to the original ring.
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........................................................................................................................................................................................................................

10 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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External timing verification

Description

This test should be performed if the 1665 DMX shelf is going to be externally timed. The 
shelf timing cable must be installed and connected between the 1665 DMX shelf and the 
office timing source (BITS clock) and the timing source must be active.

Timing verification test procedure

........................................................................................................................................................................................................................

1 Determine the frame format (SF or ESF) and line code (AMI or B8ZS) of the DS1 timing 
signals being generated by the timing source.

........................................................................................................................................................................................................................

2 Select Configuration -> Timing/Sync.

........................................................................................................................................................................................................................

3 In the Timing Mode: pull-down, verify External Timing is displayed. If not choose 
External and click OK and select Configuration -> Timing/Sync.

........................................................................................................................................................................................................................

4 Click on the Timing Input Ports tab at the top of the window.

........................................................................................................................................................................................................................

5 Enter the DS1 Input and Output Format: (SF or ESF) for REF-1 and REF-2.

........................................................................................................................................................................................................................

6 Enter the DS1 Input Line Code: (AMI or B8ZS) for REF-1 and REF-2.

........................................................................................................................................................................................................................

7 Click OK.

........................................................................................................................................................................................................................

8 Select View -> Timing/Sync.

Result: 

• Correct line coding and frame format

• Provisioned and active timing mode are both external
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• Both references are in service (IS)

• Which of the two references is active.

Important! If a reference does not indicate IS, that input is not receiving a proper 
timing reference. Verify:

– Cabling between the timing source and the 1665 DMX shelf

– Correct line coding

– Correct frame format.

........................................................................................................................................................................................................................

9 At the rear of the shelf (see Figure 5-1, “1665 DMX Shelf Backplane” (p. 5-14), 
disconnect the input timing cable from the connector associated with the active reference.

Requirement: The MN LED lights on the SYSCTL and the FAULT LED flashes on 
the MAIN OLIU circuit pack associated with that reference (SYNC1 is associated 
with M1 and SYNC2 is associated with M2).

Figure 5-1 1665 DMX Shelf Backplane 
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Important! Above is the 1665 DMX shelf, but it should be noted that the timing 
connections are the same for the 1665 DMX High-Capacity shelf.

........................................................................................................................................................................................................................

10 Click Refresh in the View Timing/Sync window

Result: The other reference is now the active reference.

........................................................................................................................................................................................................................

11 Reconnect the timing cable at the rear of the shelf.

Requirement: The MN LED extinguishes on the SYSCTL and the FAULT LED on 
the OLIU stops flashing.

........................................................................................................................................................................................................................

12 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Miscellaneous (environmental) discrete telemetry test

Description

Miscellaneous discrete telemetry access allows the maintenance center to control and 
monitor equipment co-located with the 1665 DMX shelf. Perform this procedure for 
shelves that are cabled for miscellaneous discrete telemetry.

........................................................................................................................................................................................................................

Miscellaneous discrete telemetry test procedure

........................................................................................................................................................................................................................

1 Determine which environmental inputs are to be monitored via the 1665 DMX shelf.

........................................................................................................................................................................................................................

2 Verify that the miscellaneous discrete cable is connected to the J11 MISC connector on the 
shelf. See Figure 5-1, “1665 DMX Shelf Backplane” (p. 5-14).

........................................................................................................................................................................................................................

3 Refer to Table 5-2, “Miscellaneous (Environmental) Discrete Telemetry Connections” 
(p. 5-18) to determine the wire color of the cable lead associated with the environmental 
input to be tested.

........................................................................................................................................................................................................................

4 At the far end of the cable, short the associated environmental input lead to the red-slate 
(R-S) Input Common lead.

........................................................................................................................................................................................................................

5 Verify that the minor (MN) alarm lights on the SYSCTL.

........................................................................................................................................................................................................................

6 From the system view click Alarm List.

Result: Verify that the correct environmental alarm has been activated.

........................................................................................................................................................................................................................

7 Remove the short and verify that the minor (MN) alarm indication on the SYSCTL clears.

........................................................................................................................................................................................................................

8 Repeat Step 3 through Step 7 for each environmental input being used.
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........................................................................................................................................................................................................................

9 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Figure 5-2 Miscellaneous (Environmental) Discrete Functions 

Env. Alarm/Status

Env. Input #19

Env. Input #2

Env. Input #1

2

1

20

Water, Fire, etc.)
High Temp, High

Inputs (Open Door,

Remote Terminal

Input Common

19

Env. Output #3

Env. Output #2

Env. Output #1

Pump, etc.
Generator,

25

24

23

22

21

Env. Output #4

J11

Output Common

To



............................................................................................................................................................................................................................................................

Miscellaneous (environmental) discrete telemetry testOperational tests

5 - 1 8  365-372-304R7.1
Issue 1, November 2007

Table 5-2 Miscellaneous (Environmental) Discrete Telemetry Connections

Conn. Pin# Color Designation Name

 J11 1

2

3

4

BL-W

W-BL

O-W

W-O

TLMI1

TLMI2

TLMI3

TLMI4

Env. Input - #1

Env. Input - #2

Env. Input - #3

Env. Input - #4

5

6

7

8

G-W

W-G

BR-W

W-BR

TLMI5

TLMI6

TLMI7

TLMI8

Env. Input - #5

Env. Input - #6

Env. Input - #7

Env. Input - #8

9

10

11

12

S-W

W-S

BL-R

R-BL

TLMI9

TLMI10

TLMI11

TLMI12

Env. Input - #9

Env. Input - #10

Env. Input - #11

Env. Input - #12

13

14

15

16

O-R

R-O

G-R

R-G

TLMI13

TLMI14

TLMI15

TLMI16

Env. Input - #13

Env. Input - #14

Env. Input - #15

Env. Input - #16

17

18

19

20

BR-R

R-BR

S-R

R-S

TLMI17

TLMI18

TLMI19

TLMIC48VT
RN

Env. Input - #17

Env. Input - #18

Env. Input - #19

Input Common

21

22

23

24

25

BL-BK

BK-BL

O-BK

BK-O

G-BK

TLMO1

TLMO2

TLMO3

TLMO4

TLMOC

Env. Output - #1

Env. Output - #2

Env. Output - #3

Env. Output - #4

Output Common
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Modem connection test

Description

This test will verify proper modem connection to the 1665 DMX shelf.

This test should only be performed if a modem is required.

........................................................................................................................................................................................................................

Modem connection test procedure

........................................................................................................................................................................................................................

1 Verify the generic parameters of the modem are set to the following:

Modem parameters

• 1200, 2400, 4800, 9600, or 19,200 baud 

• Full duplex

• 8 data bits

• No parity bits

• 1 start bit

• 1 stop bit

• No flow control

• Transparent data mode - ON

• Direct operating mode - ON

Important! Modems supporting a large set of options and error detection capabilities 
may require other options be set before using the modems to download generic 
software. Refer to manufacture’s manuals for instructions on setting modem 
parameters.

........................................................................................................................................................................................................................

2 Verify that the modem cable is properly connected from the modem to J17 (CIT) on the 
backplane of the 1665 DMX shelf.

........................................................................................................................................................................................................................

3 Verify that the modem is connected to the phone line.

........................................................................................................................................................................................................................

4 Select Administration -> Data communications...
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........................................................................................................................................................................................................................

5 Click the Serial Port tab.

........................................................................................................................................................................................................................

6 Choose CIT Port: cit-2.

........................................................................................................................................................................................................................

7 Choose Baud Rate: to match the modem being connected.

........................................................................................................................................................................................................................

8 Dial into the modem using an application such as HyperTerminal from a PC with a 
modem configured to similar parameters.

........................................................................................................................................................................................................................

9 After a connection is established, press the enter key.

Result: /* SYSTEM TID: LT-DMX */

........................................................................................................................................................................................................................

10 Enter the command:

act-user:LT-DMX:LUC01:ctag::DMX2.5G10G;

Result: A message indicating that the command completed will be displayed along 
with the Alcatel-Lucent disclosure.

........................................................................................................................................................................................................................

11 Enter the command:

canc-user:LT-DMX:LUC01:ctag;

Result: A message indicating that the command completed will be displayed.

........................................................................................................................................................................................................................

12 Disconnect the HyperTerminal session.

........................................................................................................................................................................................................................

13 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S



Final operationsOperational tests

............................................................................................................................................................................................................................................................

365-372-304R7.1
Issue 1, November 2007

5 - 2 1
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Final operations

Description

The following procedure ensures that all test signals and cross-connects have been 
removed and the 1665 DMX shelf is alarm free and ready for network connection 
procedures.

Procedure

........................................................................................................................................................................................................................

1 Select Configuration -> Cross-Connections...

........................................................................................................................................................................................................................

2 Choose Delete leg(s) of an existing cross-connection.

........................................................................................................................................................................................................................

3 Click Next and continue with the Cross-Connection Wizard to delete the cross-
connections associated with CP main-1, Port 1.

........................................................................................................................................................................................................................

4 To verify that all cross-connections are deleted, select View-> Cross-Connections...

........................................................................................................................................................................................................................

5 Choose shelf (1665 DMX) and click select.

........................................................................................................................................................................................................................

6 Verify that no alarm LEDs are lit and no FAULT LED is lit on any circuit pack.

If any alarm is present, refer to 365-373-302, 1665 Data Multiplexer, Alarm Messages 
and Trouble Clearing Guide.

........................................................................................................................................................................................................................

7 If desired, reconnect the office alarm cable at this time.

........................................................................................................................................................................................................................

8 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S



............................................................................................................................................................................................................................................................

Final operationsOperational tests

5 - 2 2  365-372-304R7.1
Issue 1, November 2007



I I I - 1365-372-304R7.1
Issue 1, November 2007

............................................................................................................................................................................................................................................................

Part III:  1665 Data Multiplexer (1665 
DMX) ring setup and testing

........................................................................................................................................................................
Overview

Purpose

This section starts the process of integrating the 1665 Data Multiplexer (1665 DMX) into 
the customer’s network. The section provides the procedures to connect inter-office fibers 
and verify DCC communications and path switching.

Contents

This section is organized into the following chapters:

Ring setup and testing: integration procedures Chapter 6
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6 Ring setup and testing: integration 
procedures

............................................................................................................................................................................................................................................................

Overview

Purpose

This procedure is used to make fiber connections between nodes in a ring. It is not 
intended to replace acceptance test procedures. If problems are encountered, refer to 365-
373-302, 1665 Data Multiplexer Alarm Messages and Trouble Clearing Guide for detailed 
troubleshooting procedures.

If additional provisioning procedures are desired, refer to 365-372-301 1665 Data 
Multiplexer User Operations Guide.

Contents

This chapter provides information on the following topics:

Fiber installation  6-4

Optical transmission test (OC-192, OC-48, OC-12)  6-11

Automatic protection switching test  6-12

Manual switching tests  6-14

Final operations  6-17
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Tools, test equipment and accessories

Listed below are the tools, test equipment and accessories necessary to perform the 
procedures in this section.

Quantity Description Comments

Screwdriver(s) A screwdriver(s) with the appropriate head(s) is 
(are) required for securing the mounting screws, 
repositioning the mounting brackets, installing 
the interfacing cables, and for setting the circuit 
breakers to the OFF position.

1 ESD Wrist Strap A wrist strap must be worn when handling 
circuit packs. Use the electrostatic discharge 
(ESD) jack provided on the shelf.

1 Multimeter (Optional) The voltmeter must be capable of measuring 
DC voltage in the 40- to 60-volt range. The use 
of the voltmeter is optional since the shelf will 
alarm or shut down if the proper voltage is not 
supplied.

1 DS1 Error Rate Test Set A DS1 error rate test set is required for testing 
of DS1 cabling. A T-BERD 2209 or equivalent 
is recommended.

1 DS3 Error Rate Test Set A DS3 error rate test set is required for testing 
of DS3 cabling. A T-BERD 2209 or equivalent 
is recommended.

1 OC-48 Test Set An OC-48 test set is required for testing of 
optical circuit packs. An Agilent OmniBER 718 
or equivalent is recommended.

1 Personal Computer (PC) See Chapter 3, “Software download and circuit 
pack installation”, PC minimum requirements 
(p. 3-2).

1 CIT Interface Cable 8-ft. long RJ45 to 9-pin D-sub serial cable 
(Comcode 848748869).

1 Optical Power Meter
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Safety instructions

Important! All precautions should be observed when handling fiber. 

Unterminated optical connectors may emit laser radiation. Do not view beam with 
optical instruments.

WARNING

Laser hazard

CAUTION
The operational tests in this section are run only in an out-of-service mode of 
operation. Office alarms will normally be connected only during the office 
alarm test to prevent constant alarms throughout this section.
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Fiber installation

Description

This section is used to verify proper fiber connections between 1665 Data Multiplexer 
(1665 DMX) nodes.

Prerequisite

The following is a list of items to verify before beginning tests in this section.

• Two people are required to perform the end-to-end turn up in this section (one at each 
adjacent node).

• The 1665 DMX Main OLIUs should be optically looped from the previous section. 
Verify that the 1665 DMX shelf is clear of all alarms (only green LEDs are lighted) 
prior to and after completing this test.

• CIT is still connected to the 1665 DMX.

• The office alarm cable will remain disconnected during this procedure.

A properly grounded ESD wrist strap MUST be worn when handling circuit packs.

Unterminated optical connectors may emit laser radiation. Do not view beam with 
optical instruments. 

CAUTION

ESD hazard

WARNING

Laser hazard

CAUTION

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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Fiber installation procedure 

The following procedures are performed at each end of the optical span being tested.

........................................................................................................................................................................................................................

1 Verify that the office alarm cable to J12 (ALM) on the backplane of the 1665 DMX shelf 
is disconnected. If the shelf to be tested is part of a multiple shelf bay arrangement, the 
office alarm cable connects to shelf 1.

........................................................................................................................................................................................................................

2 Enter the shelf TID per the customer order or set TIDs to LT-DMX-1 and LT-DMX-2, etc.

........................................................................................................................................................................................................................

3 Enable Remote NE Status and Alarm Gateway (AGNE) at LT-DMX-1 only. Select 
Administration -> Set NE...

........................................................................................................................................................................................................................

4 Enable Remote NE Status at the far end node. Select Administration -> Set NE...

........................................................................................................................................................................................................................

5 Dress optical cables in the fiber tray at the bottom front of the shelf.

........................................................................................................................................................................................................................

6 Route the optical jumpers from the bottom of the shelf.

........................................................................................................................................................................................................................

7 Establish communications with the technician at the other end of the optical span.

........................................................................................................................................................................................................................

8 At both ends of the optical span, remove protective covers from receive and transmit 
optical jumper cables and clean LC connectors.

Important! The 1665 DMX OLIUs require single-mode lightguide cable. Single-
mode optical fibers connecting this shelf with the far-end shelf should not be 
connected to the OLIU until at least 45 seconds after an optical loopback is removed. 
It may take from 15 seconds to 3.5 minutes for the FAULT LEDs to stop flashing after 
the cables are connected, depending on the setting of the signal degrade threshold.

........................................................................................................................................................................................................................

9 At both ends of the optical span, ensure that only the dual LC adapter is installed on the 
OLIU (no LBO).
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Important! For 1665 DMX ring configurations, optical fibers extend in two different 
directions to make up the ring. At each shelf (node) in the ring, the M1 OLIU will 
connect to the M2 OLIU in one adjacent node, and the M2 OLIU will connect to the 
M1 OLIU in the other adjacent node. Likewise, when the 1665 DMX is interfacing 
with other equipment at low-speeds (OC-3, OC-12 or OC-48) using 0x1 protection, 
the Function Group slot (A, B, C, D, or G) 1 will connect to Main 2 on whatever shelf 
the 1665 DMX is being connected to. The Function Group slot (A, B, C, D, or G) 2 
will connect to Main 1.

........................................................................................................................................................................................................................

10 At each end of the optical span, connect the optical fiber transmit cables to the OLIU OUT 
connectors.

........................................................................................................................................................................................................................

11 At each end of the optical span, measure the optical power of the optical fiber receive 
cables using an optical power meter.

........................................................................................................................................................................................................................

12 Determine the LBO value required based on the received optical power measurement. 
Refer to the following table.

Table 6-1 Attenuation Table

Optics Circuit Pack
Received 
Power (dBM)

LBO 
(dB)

OC-48 (High 
Speed)

LNW27

LNW29

LNW221 - 259

LNW421 - 459

LNW32

+3.0 to -9.0

-9.0 to -29.0

15

 0

LNW76 -3.0 to -18.0 0

Low-Speed 
Optics (OC-3, 
OC-12, OC-48)

LNW36 (OC-3) 0.0 to -15.0  10

-15.0 to -34.0 0

LNW46 (OC-12) +2.0 to -8.0 10

-8.0 to -15.0 5

-15.0 to -30.5 0

LNW31 (OC-48) 0.0 to -18.0 0
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Table 6-2 Attenuation table (Pluggable Transmission Modules)

OC-12 (high 
speed)

LNW48 -8.0 to -28.0  0

LNW50 +2.0 to -7.0 10

-7.0 to -30.5  0

LNW54 +2.0 to -7.0 10

-7.0 to -29.0 0

OC-192 (high 
speed)

LNW57 +6.0 to +3.0 15

+3.0 to -7.0 10

-7.0 to -24.0 0

LNW60 +12.5 to +6.0 20

+6.0 to +3.0 15

+2.0 to -7.0 10

-7.0 to -24.0 0

LNW555 +6.0 to 0  15

0.0 to -22.0  0

LNW523, LNW527, 
LNW554 

+6.0 to +1.0 15

+1.0 to -7.0 10

-7.0 to -24.0 0

LNW56 +2.0 to -1.0 5

-1.0 to -14.0 0

LNW58 -1.0 to -11.0 0

SFP/XFP 
optics

Circuit Pack Received 
Power (dBM)

LBO 
(dB)

S15512 LNW37, LNW45, 
LNW55, LNW82

-8.0 to -23.0 0

OC-3 IR1-I1 LNW37, LNW45, 
LNW55, LNW82

-8.0 to -28.0 0

Optics Circuit Pack
Received 
Power (dBM)

LBO 
(dB)
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OC-3 LR1-I1 LNW37, LNW45, 
LNW55, LNW82

0.0 to -5.0 15

-5.0 to -10 10

-10 to -34.0 0

OC-12 IR1-I1 LNW49, LNW55, 
LNW82

-8.0 to -28.0 0

OC-12 LR1-I1 LNW49, LNW55, 
LNW82

+2.0 to -5.0 15

-5.0 to -15 10

-15 to -28.0 0

OC-12 LR2-I1 LNW49, LNW55, 
LNW82

+2.0 to -5.0 15

-5.0 to -15 10

-15 to -28.0 0

OC-48 SR-I1 LNW55, LNW62, 
LNW82, LNW202

-3.0 to -18.0 0

OC-48 LR-I1 LNW55, LNW62, 
LNW82, LNW202

+3.0 to -5.0 15

-5.0 to -10.0 10

-10.0 to -15.0 5

-15.0 to -27.0 0

OC-48 LR2-I1 LNW55, LNW62, 
LNW82, LNW202

+3.0 to -5.0 15

-5.0 to -10.0 10

-10.0 to -15.0 5

-15.0 to -27.0 0

S2DxxC6 series LNW55, LNW62, 
LNW82, LNW202

+3.0 to -5.0 15

-5.0 to -10.0 10

-10.0 to -15.0 5

-15.0 to -27.0 0

OC192SR1-C1 LNW59, LNW502 -1.0 to -11 0

OC192IR2-C1 LNW59, LNW502 +2.0 to -1.0 5

-1.0 to -14 0

SFP/XFP 
optics

Circuit Pack Received 
Power (dBM)

LBO 
(dB)
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........................................................................................................................................................................................................................

13 Select the proper LBO based on the value required and the comcode as listed below.

........................................................................................................................................................................................................................

14 Clean LC LBOs and install LBO assemblies in the OLIU IN connector.

........................................................................................................................................................................................................................

15 At the far end, connect the input optical fiber to the proper OLIU IN connector.

Requirement: The FAULT LED on the OLIU extinguishes.

........................................................................................................................................................................................................................

16 At the near end, connect the input optical fiber to the proper OLIU IN connector.

Requirement: The FAULT LED on the OLIU extinguishes.

........................................................................................................................................................................................................................

17 Disconnect the fiber cable from the OUT connector on the OLIU at one end of the span. 
At the other end, verify that the associated FAULT LED is flashing, indicating a loss of 
signal. Reconnect the fiber and repeat the process for the other direction of transmission.

........................................................................................................................................................................................................................

18 Enable communications with the adjacent 1665 DMX nodes. Configuration -> DCC 
Terminations...

........................................................................................................................................................................................................................

19 Select Port AID: dcc-m1-1, OSI Over DCC: enabled, LAPD Role: user-side.

OC192LR2-C1 LNW59, LNW502 +4.0 to 0.0 15dB

0.0 to -7.0 10

-7.0 to -24.0 0

SFP/XFP 
optics

Circuit Pack Received 
Power (dBM)

LBO 
(dB)

Code Comcode Loss (dB)

ABLCS-05.0 108279381 5

ABLCS-10.0 108279431 10

ABLCS-15.0 108279480 15

ABLCS-20.0 108279530 20
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........................................................................................................................................................................................................................

20 Select Port AID: dcc-m2-1, OSI Over DCC: enabled, LAPD Role: network-side.

........................................................................................................................................................................................................................

21 Set the timing to internal (free running) at LT-DMX-1 and line time LT-DMX-2. 
Configuration -> Timing/Sync... Timing Mode: Free Running.

........................................................................................................................................................................................................................

22 Verify proper communications with the adjacent 1665 DMX nodes. Administration->OSI 
Neighbor Map.

Result: The adjacent node appears in the neighbor list.

........................................................................................................................................................................................................................

23 Perform steps in this procedure on all adjacent nodes in the ring.

........................................................................................................................................................................................................................

24 After all connections and tests have been made, verify optical fiber cables are placed in 
fiber tray and properly routed in bay framework.

........................................................................................................................................................................................................................

25 Reconnect the office alarm cable disconnected in Step 1.

........................................................................................................................................................................................................................

26 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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............................................................................................................................................................................................................................................................

Optical transmission test (OC-192, OC-48, OC-12)

Overview

The following test verifies error-free transmission between nodes.

Transmission test procedure

........................................................................................................................................................................................................................

1 At the test location, select Performance -> View PM Reports -> OCn Section...

........................................................................................................................................................................................................................

2 Choose CP main-1, Port 1

........................................................................................................................................................................................................................

3 Click Select.

........................................................................................................................................................................................................................

4 Select Time Period: 15-Min, Monitored Date: Current Date and Monitor Level: 0 UP.

........................................................................................................................................................................................................................

5 Click Select All to move all Available Parameters to the Selected Parameters column.

........................................................................................................................................................................................................................

6 Click Apply.

Result: The Response Window indicates no transmission errors.

........................................................................................................................................................................................................................

7 Repeat Step 1 through Step 6 substituting CP main-2 in Step 2.

........................................................................................................................................................................................................................

8 Repeat Step 1 through Step 7 for all 1665 DMX shelves at the test location.

........................................................................................................................................................................................................................

9 Repeat Step 1 and Step 8 for each node in the ring.

........................................................................................................................................................................................................................

10 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Automatic protection switching test

Description

This section provides the procedures for verifying the 1665 DMX shelf automatic and 
manual protection switching.

Note the following:

• These tests do NOT simulate circuit pack failures.

• A properly grounded wrist strap must always be worn while handling circuit packs.

• Prior to performing each test, the shelf under test must be clear of all alarms (that is, 
only green LEDs are lighted).

 Main OLIU switch test

........................................................................................................................................................................................................................

1 In order to perform path switching, an add/drop cross-connection must be entered. Select 
Configuration -> Cross-Connections... and use the Cross-Connection Wizard to enter an 
add/drop cross-connection.

........................................................................................................................................................................................................................

2 Select View -> Protection...

........................................................................................................................................................................................................................

3 Under Path Protection choose Path m-1-1 and click Select.

........................................................................................................................................................................................................................

4 Note the Active Path (m1 or m2).

........................................................................................................................................................................................................................

5 Disconnect the optical fiber connected to the IN port on the active path OLIU.

Result: The MN and then MJ alarm LED should light on the SYSCTL and the FAULT 
LED should flash on the OLIU.

........................................................................................................................................................................................................................

6 Click refresh in the View Protection window.

........................................................................................................................................................................................................................

7 Verify the Active Path has changed (from m1 to m2 or m2 to m1).
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........................................................................................................................................................................................................................

8 Reconnect the optical fiber to the OLIU. 

Result: After a short time, the MJ alarm LED on the SYSCTL and the FAULT LED 
on the OLIU should extinguish.

........................................................................................................................................................................................................................

9 Repeat Step 2 through Step 8 to verify a switch back to the OLIU that was originally 
active.

........................................................................................................................................................................................................................

10 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Manual switching tests

Description

This test will initiate switching commands from the CIT and verify proper switching and 
LED indications.

Important! An STS-1 cross-connect is required in order to perform manual 
switching.

Manual switching test procedure

........................................................................................................................................................................................................................

1 Enter an STS-1 add/drop cross-connection between an equipped Function Unit and the 
Main OLIU. Select Configuration -> Cross-Connections... and use the Cross-Connection 
Wizard to enter an add/drop cross-connection.

........................................................................................................................................................................................................................

2 Select Fault -> Protection Switch...

........................................................................................................................................................................................................................

3 Under Path Protection choose Path m-1-1 and click Select.

........................................................................................................................................................................................................................

4 Note the Active Path (m1 or m2).

........................................................................................................................................................................................................................

5 Choose Switch Type: Manual.

........................................................................................................................................................................................................................

6 Click Apply.

........................................................................................................................................................................................................................

7 Verify that the Active Path: has changed (m1 to m2 or m2 to m1).

........................................................................................................................................................................................................................

8 Repeat Step 2 through Step 7 to verify a switch back to the original ring.
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........................................................................................................................................................................................................................

9 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Function units/growth slots, switching test

This test will initiate switching commands from the CIT and verify proper switching and 
LED indications.

Important! This procedure should be performed on each Function Unit equipped 
with protected electrical TDM circuit packs. 

........................................................................................................................................................................................................................

1 Select Fault -> Protection Switch...

........................................................................................................................................................................................................................

2 Click on 1+1 Equip fn-x (x is a,b,c or d corresponding to the function group equipped).

........................................................................................................................................................................................................................

3 Click Select.

........................................................................................................................................................................................................................

4 Note which Function Unit or Growth Slot circuit pack is the active circuit pack.

........................................................................................................................................................................................................................

5 In the Switch Type: pull-down, select Manual (Normal).

........................................................................................................................................................................................................................

6 Click Apply.

Result: The pack that was active should now be the standby pack and the pack that 
was standby is now active. Transmission should take a momentary hit as it is switched 
to the other pack. This information should agree with the ACTIVE LEDs on the circuit 
packs.

........................................................................................................................................................................................................................

7 Repeat Step 1 through Step 6 to verify a switch back to the original Function Unit circuit 
pack, with the same results as the previous step.

........................................................................................................................................................................................................................

8 Repeat this procedure for each Function Unit pair.
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........................................................................................................................................................................................................................

9 Swap circuit packs from another function group to test any unequipped function slots.

........................................................................................................................................................................................................................

10 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Final operations

Description

The following procedure ensures that all test signals and cross-connects have been 
removed and the 1665 DMX shelf is alarm free and ready for network connection 
procedures.

Procedure

........................................................................................................................................................................................................................

1 Select Configuration -> Cross-Connections...

........................................................................................................................................................................................................................

2 Use the Cross-Connection Wizard to Delete leg(s) of an existing cross-connection 
associated with CP main-1, Port 1.

........................................................................................................................................................................................................................

3 Select Configuration -> Update System... -> Update All.

........................................................................................................................................................................................................................

4 Verify that no alarm LEDs are lit and no FAULT LED is lit on any circuit pack.

If any alarm is present, refer to 365-373-302, 1665 Data Multiplexer (1665 DMX), Alarm 
Messages and Trouble Clearing Guide.

........................................................................................................................................................................................................................

5 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S

Clear PM registers

The following steps will clear all the performance monitoring registers:

........................................................................................................................................................................................................................

1 Select Performance -> Initiate PM Registers -> Both.

........................................................................................................................................................................................................................

2 If desired, reconnect the office alarm cable at this time.



............................................................................................................................................................................................................................................................

Final operationsRing setup and testing: integration procedures

6 - 1 8  365-372-304R7.1
Issue 1, November 2007

........................................................................................................................................................................................................................

3 Check off the appropriate box in Appendix E, “Installation checklist”.

........................................................................................................................................................E N D  O F  S T E P S
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Part IV:  1665 Data Multiplexer (1665 
DMX) supplementary 
information and installation 
checklist

........................................................................................................................................................................
Overview

Purpose

This section provides supplementary information that is useful when installing the 1665 
Data Multiplexer (1665 DMX) system and using this Installation Manual.

The Installation Checklist is also contained in this part.

Contents

This section is organized into the following sections:

Appendix A, “Laser safety and classifications and Electrostatic Discharge (ESD) 
considerations”

Appendix B, “Fiber cleaning”

Appendix C, “Installing fiber connectors and LBOs”

Appendix D, “Backplane pin replacement”

Appendix E, “Installation checklist”

Appendix F, “Fiber labeling”

Appendix G, “Pluggable transmission module installation”

Appendix H, “Technical support”

Glossary

Index
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Overview

Purpose

This appendix provides laser safety information and precautions.

Contents

This appendix provides information on the following topics:

Laser safety  A-2

Electrostatic Discharge ESD considerations  A-5

Laser product classification  A-9

1665 DMX optical specifications  A-11
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Laser safety

System design

The Alcatel-Lucent 1665 Data Multiplexer (1665 DMX) product line complies with 
FDA/CDRH 21 CFR 1040.10 and 1040.11 as a Class IIIb laser product and with IEC 
60825-1:2001 as a Class 1M Optical Fiber Telecommunication laser product.

The system has been designed to ensure that the operating personnel is not endangered by 
laser radiation during normal system operation. The safety measures specified in the Food 
and Drug Administration’s Center for Devices and Radiological Health (FDA/CDRH) 
regulations and the international standards IEC-60825 or DIN/EN 60825 are met. Please 
also refer to Laser product classification (p. A-9).

Potential sources of danger

Beware of the following potential sources of danger which will remain despite all safety 
measures taken:

• Laser radiation can cause damage to the skin and eyes.

• Laser radiation from optical transmission systems is in a wavelength range that is 
invisible to the human eye.

CAUTION

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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Laser warning labels 

The following figure shows the different types of laser warning labels.

Figure A-1 Laser Warning Labels

Legend

1. Laser symbol.

2. Laser classification labels. This label may show only the laser class or both the laser 
class and the maximum output power.

3. Laser warning labels.

CAUTION

Do not view directly
with optical
instruments.

CLASS 1M INVISIBLE
LASER RADIATION
WHEN OPEN
AND FIBER
DISCONNECTED.

ATTENTION
RAYONNEMENT
LASER DE CLASSE
1M INVISIBLE
LORSQUE
L’APPAREIL EST
OUVERT ET QUE
LA FIBRE EST
DÉCONNECT E.
Ne pas regarder
directement au moyen
d’un instrument optique.

É

848950572

MA-DMX-416

H

H

HAZARD
LEVEL

1M

1

2

3

CLASS 1 LASER

PRODUCT

H

DANGER

INVISIBLE LASER RADIATION
WHEN OPEN AND FIBER
DISCONNECTED

Avoid direct exposure to beam
Do not view beam directly with
optical instruments
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Laser safety instructions

Observe the following instructions to avoid exposing yourself and others to risk.

• Read the relevant descriptions in the manuals before taking equipment into operation 
or carrying out any installation and maintenance work on the optical port units, and 
follow the instructions. Ignoring the instructions can result in exposure to dangerous 
radiation.

• Do not view directly into the laser beam with optical instruments such as a fiber 
microscope, because viewing of laser emission in excess of Class 1 limits significantly 
increases the risk of eye damage.

• Never look into the end of an exposed fiber or an open connector as long as the optical 
source is still switched on.

• Ensure that the optical source is switched off before disconnecting optical fiber 
connectors.

• In the event of doubt, check that the optical source is switched off by measuring with 
an optical power meter.
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Electrostatic Discharge ESD considerations

ESD precautions

Industry experience has shown that all integrated circuit packs can be damaged by static 
electricity that builds up on work surfaces and personnel. The static charges are 
produced by various charging effects of movement and contact with other objects. Dry air 
allows greater static charges to accumulate. Higher potentials are measured in areas 
with low relative humidity, but potentials high enough to cause damage can occur 
anywhere. 

In order to prevent damage by electrostatic discharge the following precautions should be 
observed when handling circuit packs:

• Assume all circuit packs contain solid state electronic components that can be 
damaged by ESD. 

• When handling circuit packs (storing, inserting, removing, etc.) or when working on 
the backplane, always wear a grounded wrist strap such as the one shown in 
Figure A-2 or wear a heel strap and stand on a grounded, static dissipating floor mat. If 
a static dissipating floor mat is used, be sure that it is clean to ensure a good discharge 
path.

• Handle all circuit packs by the faceplate or latch and by the top and bottom outermost 
edges. Never touch the components, conductors, or connector pins.

• Observe warning labels on bags and cartons. Whenever possible, do not remove circuit 
packs from antistatic packaging until ready to insert them into slots.

• If possible, open all circuit packs at a static safe work position, using properly 
grounded wrist straps and static dissipating table mats. If a static dissipating floor mat 
is used, be sure that it is clean to ensure a good discharge path.

• Always store and transport circuit packs in static safe packaging. Shielding is not 
required unless specified. 

• Keep all static generating materials such as food wrappers, plastics, and styrofoam 
containers away from all circuit packs. Upon removal from bay, immediately put 
circuit packs into static safe packages. 

• Whenever possible, maintain relative humidity above 20 percent.

To reduce the possibility of ESD damage, assemblies are equipped with grounding jacks 
to enable personnel to ground themselves using wrist straps. See Figure A-1, Laser 
Warning Labels (p. A-3) while handling circuit packs or working on an assembly. The jack 

CAUTION

ESD hazard
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for connection of wrist straps is located at the upper left-hand corner of each assembly and 
is labeled. When grounding jacks are not provided, an alligator clip adapter enables 
connection to bay frame ground.

Figure A-2 Static control wrist strap

IMPORTANT SAFETY INSTRUCTIONS

READ AND UNDERSTAND ALL INSTRUCTIONS

The exclamation point within an equilateral triangle is intended to alert the user 
to the presence of important operating and maintenance (servicing) instructions 
in the literature accompanying this product.

When installing, operating, or maintaining this equipment, basic safety precautions should 
always be followed to reduce the risk of fire, electric shock, and injury to persons, 
including the following:

1. Read and understand all instructions.

2. Follow all warnings and instructions marked on this product. 

3. This product should be only operated from the type of power sources indicated on the 
marking label.

4. Connect this product only to the type of power sources recommended by Lucent 
Technologies.

5. This equipment is suitable for mounting on a concrete or other noncombustible surface 
only.

6. For information on proper mounting instructions, consult the Installation Manual.

7. Install only equipment identified in this Installation Manual. Use of other equipment 
may result in improper connection of circuitry leading to fire or injury to persons.

TO
GROUND
CONNECTION
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8. All metallic telecommunication interfaces (traffic ports) should not leave the building 
premises unless connected to telecommunication devices providing primary and 
secondary protection, as applicable.

9. Do not use this product near water, for example, in a wet basement.

10. Do not place this product on an unstable cart, stand or table. The product may fall, 
causing serious damage to the product.

11. Use caution when installing or modifying telecommunications lines.

12. Never install telecommunications wiring during a lightning storm.

13. Never install telecommunications connections in wet locations.

14. Never touch uninsulated telecommunications wires or terminals unless the 
telecommunications line has been disconnected at the network interface.

15. Never touch uninsulated wiring or terminals carrying direct current or ringing current, 
or leave this wiring exposed. Protect and tape uninsulated wiring and terminals to 
avoid risk of fire, electric shock, and injury to service personnel.

16. Never push objects of any kind into this product through slots as they may touch 
dangerous voltage points or short out parts that could result in a risk of fire or electrical 
shock. Never spill liquids of any kind on the product.

17. Slots and openings in the unit are provided for ventilation, to protect it from 
overheating, and these openings must not be blocked or covered. This product should 
not be placed in a built-in installation unless proper ventilation is provided.

18. To reduce the risk of an electrical shock, do not disassemble this product. Service 
should be performed by trained personnel only. Opening or removing covers and/or 
circuit boards may expose you to dangerous voltages or other risks. Incorrect 
reassembly can cause electrical shock when the unit is subsequently used.

19. Some of the 1665 DMX Family hardware modules contain FDA/CDRH Class 
IIIb/IEC Class 1M single-mode laser products that are enclosed lightwave 
transmission systems. Under normal operating conditions, lightwave transmission 
systems are completely enclosed; nonetheless, the following precautions must be 
observed because of the potential for eye damage:

• Do not disconnect any lightwave cable or splice and stare into the optical 
connectors terminating the cables.

• Lightwave/lightguide operations should not be performed by a technician who has 
not satisfactorily completed an approved training course.

• Do not use optical instruments such as an eye loupe to view a fiber or unterminated 
connector.

• More information about laser safety can be found in Appendix A, “Laser safety 
and classifications and Electrostatic Discharge (ESD) considerations”

20. For a unit intended to be powered from -48 V dc voltage sources, read and understand 
the following:

• To be powered only by Safety Extra Low Voltage (SELV) -48 Vdc Sources.
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• Disconnect up to two (2) power supply connections when removing power from 
the system.

• This equipment must be provided with a readily accessible disconnect device as 
part of the building installation.

• Ensure that there is no exposed wire when the input power cables are connected to 
the unit.

• Installation must include an independent frame ground drop to building ground. 
This ground symbol is marked on the product, adjacent to the ground (earth) area 
for the connection of the ground (earth) conductor.

• This Equipment is to be installed only in restricted access Areas on business and 
customer premises applications in accordance with Articles 110-16, 110-17, and 
110-18 of the National Electrical Code, ANSI/NFPA No.70. Other installations 
exempt from the enforcement of the National Electrical Code may be engineered 
according to the accepted practices of the local telecommunications utility.

SAVE THESE INSTRUCTIONS
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Laser product classification

Standards compliance

The product complies with both IEC standards and the Food and Drug Administration’s 
Center for Devices and Radiological Health (FDA/ CDRH) regulations.

FDA/CDRH regulations 

Laser products are classified in accordance with the FDA/CDRH - 21 CFR 1010 and 1040. 
The classification scheme is based on the ability of the laser emission to cause injury to 
eye or skin during normal operating conditions.

In the United States, lasers and laser systems in the infrared wavelength range (greater 
than 700 nm) are assigned to one of the following classes:

• Class I,

• Class IIIb, or

• Class IV.

Laser classification is dependent upon operating wavelength, output power and fiber 
modefield diameter (core diameter).

IEC requirements 

There are five major differences between the FDA/CDRH regulations and the IEC 
requirements:

According to the IEC classification, lasers and laser systems in the infrared wavelength 
range (greater than 700 nm) are assigned to one of the following classes:

• Class 1, 1M

• Class 3R

• Class 3B

• Class 4.

There are some major differences between the FDA/CDRH regulations and IEC:

• The Accessible Emission Limits (AEL) are different

• Class 3R applies to all wavelengths

• Class 3B requires strict engineering controls

• Classification is under single fault conditions (IEC).
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Laser classes

The maximum output power of laser radiation depends on the type of laser diode used. 
The international standards IEC-60825 or DIN/EN 60825 define the maximum output 
power of laser radiation for each laser class in accordance with the wavelength.

Table A-1 Laser Classes

Hazard level assignment 

Hazard level refers to the potential hazard from laser emission at any location in an end-
to-end optical fiber communication system that may be accessible during service or in the 
event of a failure. The assignment of hazard level uses the AELs for the classes.

Hazard levels for optical transmission equipment are assigned in either of the following 
two ways:

• actual output power from the connector or fiber cut.

• if automatic power reduction is used, output power at the connector or fiber cut at one 
second after automatic power reduction takes place provided that maximum output 
and restart conditions are met.

Classification of optical telecommunication equipment

Optical telecommunication equipment is generally classified as IEC Class 1 or 
FDA/CDRH Class I, because under normal operating conditions, the transmitter ports 
terminate on optical fiber connectors. These are covered by a front panel to ensure 
protection against emissions from any energized, unterminated transmitter. The circuit 
packs themselves, however, may be IEC Class 1, 1M or 3R or FDA/CDRH Class I or IIIb.

Laser class Wavelength
Maximum Output Power of 
Laser Radiation

1 1310 nm 8.85 mW

1550 nm 10 mW

3R 1310 nm 24 mW

1550 nm 50 mW

3B 1310 nm 0.5 W

1550 nm 0.5 W
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1665 DMX optical specifications

Overview

Table A-2 provides the optical specifications for 1665 DMX optical circuit packs.

Table A-2 1665 DMX Optical Circuit Pack Laser Safety Specifications

Laser 
Circuit Pack 
Code

Wavelength 
(nm)

Maximum 
Output 
Power (dBm)

Fiber Type 
(µm)

Connector 
Type

FDA Class/
IEC Class

LNW36 1310 0.0 Single Mode (9) LC I(LN50)/1

LNW46 1310 +2.0 Single Mode (9) LC I(LN50)/1

LNW48 1310 -8.0 Single Mode (9) LC I(LN50)/1

LNW50 1310 +2.0 Single Mode (9) LC I(LN50)/1

LNW54 1550 +2.0 Single Mode (9) LC I(LN50)/1

LNW27 1310 +3.0 Single Mode (9) LC I(LN50)/1

LNW29 1550 +3.0 Single Mode (9) LC I(LN50)/1

LNW31 1310 0.0 Single Mode (9) LC I(LN50)/1

LNW32 1310 1.5 Single Mode (9) LC I(LN50)/1

LNW76 1310 -3.0 Single Mode (9) LC I(LN50)/1

LNW223 1558.98
1558.17

+2.0 Single Mode (9) LC I(LN50)/1

LNW225 1557.36
1556.56

+2.0 Single Mode (9) LC I(LN50)/1

LNW227 1555.75
1554.94

+2.0 Single Mode (9) LC I(LN50)/1

LNW231 1552.52
1551.72

+2.0 Single Mode (9) LC I(LN50)/1

LNW233 1550.92
1550.12

+2.0 Single Mode (9) LC I(LN50)/1

LNW235 1549.32
1548.52

+2.0 Single Mode (9) LC I(LN50)/1

LNW237 1547.72
1546.92

+2.0 Single Mode (9) LC I(LN50)/1
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LNW245 1542.14
1541.35

+2.0 Single Mode (9) LC I(LN50)/1

LNW247 1540.56
1539.77

+2.0 Single Mode (9) LC I(LN50)/1

LNW249 1538.98
1538.19

+2.0 Single Mode (9) LC I(LN50)/1

LNW253 1535.82
1535.04

+2.0 Single Mode (9) LC I(LN50)/1

LNW255 1534.25
1533.47

+2.0 Single Mode (9) LC I(LN50)/1

LNW259 1531.12
1530.33

+2.0 Single Mode (9) LC I(LN50)/1

LNW425 1557.36
1556.56

+2.0 Single Mode (9) LC I(LN50)/1

LNW427 1555.75
1554.94

+2.0 Single Mode (9) LC I(LN50)/1

LNW447 1540.56
1539.77

+2.0 Single Mode (9) LC I(LN50)/1

LNW449 1538.98
1538.19

+2.0 Single Mode (9) LC I(LN50)/1

LNW453 1535.82
1535.04

+2.0 Single Mode (9) LC I(LN50)/1

LNW455 1534.25
1533.47

+2.0 Single Mode (9) LC I(LN50)/1

LNW459 1531.12
1530.33

+2.0 Single Mode (9) LC I(LN50)/1

LNW56 1550 +2.0 Single Mode (9) LC I(LN50)/1

LNW57 1550 +6.0 Single Mode (9) LC I(LN50)/1

LNW58 1310 -1.0 Single Mode (9) LC I(LN50)/1

LNW60 1550 +12.5 Single Mode (9) LC IIIb/1M

LNW523 1558 to 1560* +6.0 Single Mode (9) LC I(LN50)/1

LNW527 1554 to 1557 +6.0 Single Mode (9) LC I(LN50)/1

Laser 
Circuit Pack 
Code

Wavelength 
(nm)

Maximum 
Output 
Power (dBm)

Fiber Type 
(µm)

Connector 
Type

FDA Class/
IEC Class
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packs.

Table A-3 1665 DMX Optical Specifications

LNW554 1533 to 1535* +6.0 Single Mode (9) LC I(LN50)/1

LNW555 1533.465 +6.0 Single Mode (9) LC I(LN50)/1______________________________________________________________
* Refer to 1665 Data Multiplexer Application and Planning Guide for detailed Wavelength information.

Laser 
Circuit Pack 
Code

Wavelength 
(nm)

Maximum 
Output 
Power (dBm)

Fiber Type 
(µm)

Connector 
Type

FDA Class/
IEC Class

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Output 
Power (dBm)

Fiber Type 
(µm)

Connector 
Type

FDA 
Class/
IEC 
Class

100BASE-
LX-L1

LNW70 
LNW74 
LNW78 
LNW170

1310 -8.0 Single Mode 
(9)

LC I(LN50)/1

1000BASE-
SX-C1

LNW70 
LNW78

850 0.0 Multimode 
(50 and 62.5)

LC I(LN50)/1

1000BASE-
ZX-I1

LNW63 
LNW64 
LNW70 
LNW78 
LNW170

1550 +5.0 Single Mode 
(9)

LC I(LN50)/1

BASE-TC1-
electrical

LNW63 
LNW64 
LNW70 
LNW78 
LNW170

NA NA NA RJ45 NA

ESCON-
MM-I1

LNW73/73C 1310 -14.0 Multimode 
(50 and 62.5)

LC I(LN50)/1

GE-
1X2XFC-
LX-C1

LNW64 
LNW70 
LNW73/73C
LNW78 
LNW170

1310 -3.0 Single Mode 
(9)

LC I(LN50)/1
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GE-
1X2XFC-
LX-I1

LNW63 
LNW64 
LNW70 
LNW73/73C 
LNW78 
LNW170

1310 -3.0 Single Mode 
(9)

LC I(LN50)/1

GE-
1X2XFC-
SX-C1

LNW64
LNW70
LNW73/73C
LNW78 
LNW170

850 -2.5 Multimode 
(50 and 62.5)

LC I(LN50)/1

GE-
1X2XFC-
SX-I1

LNW63 
LNW64 
LNW70 
LNW73/73C 
LNW78 
LNW170

850 -2.5 Multimode 
(50 and 62.5)

LC I(LN50)/1

S15512 LNW37
LNW45

LNW55

LNW82

1310 -8.0 Single Mode 
(9)

LC I(LN50)/1

OC3IR1-I1 LNW37
LNW45

LNW55

LNW82

1310 -8.0 Single Mode 
(9)

LC I(LN50)/1

OC3LR1-I1 LNW37
LNW45

LNW55

LNW82

1310 -0.0 Single Mode 
(9)

LC I(LN50)/1

OC12IR1-I1 LNW49

LNW55

LNW82

1310 -8.0 Single Mode 
(9)

LC I(LN50)/1

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Output 
Power (dBm)

Fiber Type 
(µm)

Connector 
Type

FDA 
Class/
IEC 
Class
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OC12LR1-
I1

LNW49

LNW55

LNW82

1310 +2.0 Single Mode 
(9)

LC I(LN50)/1

OC12LR2-
I1

LNW49

LNW55

LNW82

1550 +2.0 Single Mode 
(9)

LC I(LN50)/1

OC48LR1-
I1

LNW55

LNW62

LNW82

LNW202

1310 +3.0 Single Mode 
(9)

LC I(LN50)/1

OC48LR2-
I1

LNW55

LNW62

LNW82

LNW202

1550 +3.0 Single Mode 
(9)

LC I(LN50)/1

OC48SR1-I1 LNW55

LNW62

LNW82

LNW202

1310 -3.0 Single Mode 
(9)

LC I(LN50)/1

S2D23C6 LNW82

LNW202

1558.983 +4.0 Single Mode 
(9)

LC I(LN50)/1

S2D25C6 LNW55

LNW62

LNW82

LNW202

1557.363 +4.0 Single Mode 
(9)

LC I(LN50)/1

S2D27C6 LNW55

LNW62

LNW82

LNW202

1555.747 +4.0 Single Mode 
(9)

LC I(LN50)/1

S2D31C6 LNW82

LNW202

1552.524 +4.0 Single Mode 
(9)

LC I(LN50)/1

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Output 
Power (dBm)

Fiber Type 
(µm)

Connector 
Type

FDA 
Class/
IEC 
Class
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S2D33C6 LNW82

LNW202

1550.918 +4.0 Single Mode 
(9)

LC I(LN50)/1

S2D35C6 LNW82

LNW202

1549.315 +4.0 Single Mode 
(9)

LC I(LN50)/1

S2D37C6 LNW82

LNW202

1547.715 +4.0 Single Mode 
(9)

LC I(LN50)/1

S2D45C6 LNW82

LNW202

1541.349 +4.0 Single Mode 
(9)

LC I(LN50)/1

S2D47C6 LNW55

LNW62

LNW82

LNW202

1539.766 +4.0 Single Mode 
(9)

LC I(LN50)/1

S2D49C6 LNW82

LNW202

1538.186 +4.0 Single Mode 
(9)

LC I(LN50)/1

S2D53C6 LNW55

LNW62

LNW82

LNW202

1535.036 +4.0 Single Mode 
(9)

LC I(LN50)/1

S2D55C6 LNW55

LNW62

LNW82

LNW202

1533.465 +4.0 Single Mode 
(9)

LC I(LN50)/1

S2D59C6 LNW55

LNW62

LNW82

LNW202

1530.334 +4.0 Single Mode 
(9)

LC I(LN50)/1

OC192IR2-
C1

LNW59

LNW502

1550 +2.0 Single Mode 
(9)

LC I(LN50)/1

OC192LR2-
C1

LNW59

LNW502

1550 +4.0 Single Mode 
(9)

LC I(LN50)/1

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Output 
Power (dBm)

Fiber Type 
(µm)

Connector 
Type

FDA 
Class/
IEC 
Class
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OC192SR1-
C1

LNW59

LNW502

1310 -1.0 Single Mode 
(9)

LC I(LN50)/1

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Output 
Power (dBm)

Fiber Type 
(µm)

Connector 
Type

FDA 
Class/
IEC 
Class
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Appendix B: Fiber cleaning
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Overview

Purpose

This appendix describes the Alcatel-Lucent recommended method for the cleaning and 
inspection of optical connectors using specific tools and materials that have been proven to 
be effective in the assembly and testing of optical transmission equipment. It is critical that 
connector faces are clean and free from particular contamination to assure proper 
performance and reliability of lightwave systems. With the modern high speed, high 
power, and wider bandwidth optical transmission systems, clean connectors along the 
optical path are essential for successful operation.

Contents

This appendix provides information on the following topics:

Objectives

This chapter provides information to perform the following:

1. Properly clean an optical connector.

2. Inspect an optical connector for cleanliness.

Equipment requirements and recommendations  B-3

Safety instructions  B-5

Cleaning/inspecting optical connectors  B-6

Cleaning pluggable optics modules  B-12
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Related information

A course on connector cleaning and the connector inspection process is now offered 
through Alcatel-Lucent University, Course Code: LMC200H “Understanding Fiber Optic 
Cleaning, Inspection and Testing.” To learn more about this course, consult your local 
Alcatel-Lucent Account Representative.
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Equipment requirements and recommendations

Description

For proper cleaning, the following equipment and materials are recommended:

Table B-1 Required and Recommended Equipment and Materials

Product
Model/ 
Description Comcode ITE #

Installation 
Order #

Optical Fiber 
Scope

Noyes OFS 
300-200X

408197028 ITE-7129 33712900

2.5mm 
Universal 
adapter cap

For use with 
the Noyes OFS 
300-200X

408197044 ITE-7129D1 33712901

1.25mm 
Universal 
adapter cap

For use with 
the Noyes OFS 
300-200X

408197069 ITE-7129D2 33712902

Video Fiber 
Scope1

Noyes VFS-1 TBD TBD TBD

Individual 
presaturated 
alcohol 
wipes

99% pure 
isopropyl 
alcohol

901375147 ITE-7136 33713600

CLETOP 
Cleaning 
Cassette

Type A Reel 901375154 ITE-7137 33713700

CLETOP 
Cleaning 
Cassette 
Replacement 
Reel

Type A Reel 901375014 ITE-7137 D1 33713701

Luminex 
Stick port 
cleaners

1.25 mm 901375030 ITE-7134 33713400

Luminex 
Stick port 
cleaners 

2.5 mm 901375022 ITE-7135 33713500
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Important! The equipment and material listed above has been tested and is proven 
effective when used in conjunction with this procedure. Substitution of equipment or 
materials is at the discretion of the user and is not recommended.

Luminex 
Cloth

5.5” x 5.5” 408201226 R6033 23603300

Notes:  

1. This equipment may not be necessary at all locations. It is to be used when 
the ports need to be verified for cleanliness. If care is exercised when 
cleaning fibers, the video scope may not be needed.

Product
Model/ 
Description Comcode ITE #

Installation 
Order #
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Safety instructions

Description

Never view an energized optical cable with the naked eye or with an optical magnifying 
instrument. Disconnected or separated optical connectors may emit invisible laser 
radiation and direct exposure can severely injure the eye. If inspecting the endface of a 
connector with a fiberscope, be absolutely certain that the system is deactivated.

Alcohol is flammable and is harmful if swallowed, inhaled or absorbed through the skin. 
Keep alcohol away from heat, sparks, or flame. Avoid contact with eyes, skin and 
clothing.

WARNING

Laser hazard

WARNING

Noxious substance hazard
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Cleaning/inspecting optical connectors

Introduction

The procedure that follows utilizes the “Wet/Dry” method for connector cleaning. This 
method first applies a “wet” solvent such as high purity alcohol to the connector endface 
to dissolve/remove any organic particulate or oily films, followed by a “dry” double clean 
wipe using the CLETOP cleaning cassette. 

This procedure is recommended for connector ferrules 2.5 mm and 1.25 mm in diameter 
associated with ST, SC, FC, and LC connectors. The ferrule of a fiber optic connector 
consists of a ceramic or stainless steel cylinder with a hole located longitudinally down the 
center of its axis, allowing enough tolerance for a fiber to pass through. 

All optical connectors should be cleaned prior to being connected. Keep the protective 
ferrule dust cap on the connector until initiating the cleaning process.

Cleaning procedure

The following cleaning procedure is acceptable for field service/installation activities:

........................................................................................................................................................................................................................

1 Remove the dust cap from the connector ferrule, thus exposing the connector endface.

........................................................................................................................................................................................................................

2 Open an individual foil packet of pre-saturated isopropyl alcohol (99% pure) wipe. 

See Figure B-1, “Cleaning the Ferrule Endface” (p. B-7).

Grasp the connector housing and place the connector ferrule endface perpendicular to the 
alcohol wipe.

Drag it against the wipe three (3) times in a figure eight pattern. This action applies the 
alcohol solvent to the endface and initially loosens and scrubs away organic/solid 
contaminates.
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Figure B-1 Cleaning the Ferrule Endface

........................................................................................................................................................................................................................

3 If a CLETOP cassette cleaner is not available, proceed with Step 7. Otherwise, hold the 
CLETOP cassette cleaner in the palm of your hand with the cassette shutter door facing 
up.

See Figure B-2, “CleTop Cleaner” (p. B-8).

Rotate the cassette lever all the way down with your thumb. Do not release the lever. The 
lever advances the “dry” Luminex cleaning cloth inside the case and simultaneously opens 
the shutter. The CLETOP cassette shutter door is now open and ready for cleaning the 
connector.
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Figure B-2 CleTop Cleaner

........................................................................................................................................................................................................................

4 Insert and press the connector ferrule endface perpendicular against the cleaning cloth in 
the first of two slots of the cleaner. 

See Figure B-3, “Acceptability Criteria for Fiber Cleaning” (p. B-10).

Drag it down (in the direction indicated by the arrows on the cleaner). Make certain not to 
release the lever of the cassette.

........................................................................................................................................................................................................................

5 Lift the connector from the first slot and rotate it 90 degrees and repeat the downward 
motion using the second slot. Be sure the ferrule is pressed snug against the cleaning cloth 
while dragging the ferrule to assure the proper cleaning action.

........................................................................................................................................................................................................................

6 Release the cassette lever allowing the shutter door to close to its initial position. Continue 
with Step 5.

........................................................................................................................................................................................................................

7 Wrap a Luminex cleaning cloth around the ferrule and rotate the connector housing, 
cleaning the outside periphery of ferrule. 

Follow this by folding an unused portion of the cloth over the end of the ferrule endface 
and then with light pressure from the thumb, slightly drag the cloth from the center of the 
ferrule to the edge while rotating the connector 360 degrees. If the Luminex cleaning cloth 
is not available, a lint free cleanroom optic wipe can be used. The Luminex cleaning cloth 
is washable and can be used multiple times, optic wipes are single use and disposable.
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........................................................................................................................................................................................................................

8 Inspect the connector for cleanliness. If necessary, repeat the cleaning process.

See “Connector inspection” (p. B-9).

........................................................................................................................................................E N D  O F  S T E P S

Connector inspection 

After cleaning the connector, inspect the ferrule endface to ensure that it is free from any 
particulate contamination using an optical fiber inspection scope of at least 200X 
magnification. When using an optical fiber scope (for example, the Noyes OFS 300-200X) 
exercise extreme caution to assure fiber being examined is de-energized.

........................................................................................................................................................................................................................

1 Follow the instructions in the manual provided with the Optical Fiber Scope to view the 
ferrule endface of the fiber under inspection.

........................................................................................................................................................................................................................

2 The visual area of the ferrule endface (ferrule and fiber) as observed by the inspection 
system/scope should be free of any contaminates. See Figure B-3, “Acceptability Criteria 
for Fiber Cleaning” (p. B-10).

Repeat the Cleaning Procedure if the fiber endface does not meet the following 
requirements:

Requirement: No fixed type of contamination (contaminates that remain at the same 
location after three wet-dry cleaning cycles), regardless of size, is allowed in the 
restricted area of the glass fiber endface. 

Requirement: The restricted area is defined as ~66 microns (µm) diameter for both 
singlemode and multimode fibers.

Requirement: No chips, cracks or scratches are allowed near the core of the glass 
fiber endface.

Requirement: No large floating (loose) contaminates are allowed on the glass fiber 
and ceramic ferrule endface.

WARNING
When using an optical power meter to verify the connector and fiber to be 
clean, take special precaution to make sure the no power is being emitted from 
the fiber before viewing.
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Figure B-3  Acceptability Criteria for Fiber Cleaning 

........................................................................................................................................................................................................................

3 After the connector has been verified to be cleaned, it should be immediately inserted into 
the adapter buildout of the optical component. This will assure maximum cleanliness and 
effectiveness of the connector.

........................................................................................................................................................................................................................

4 If the cleaned connector cannot be immediately connected to a corresponding adapter, the 
connector ferrule must be protected with a connector dust cap. Before placing the cap on 
the ferrule, make sure the cap is clean. This can be accomplished by inserting a CLETOP 
stick cleaner (swab) of the same inside diameter as the cap (either 2.5 or 1.25 mm) and 
rotate the stick 360 degrees three (3) times. Following this procedure, carefully place the 
cap over the ferrule. When the cleaned connector is ready for assembly, it should be re-
inspected for cleanliness prior to connection.

........................................................................................................................................................E N D  O F  S T E P S

Fiber adapters or circuit pack connectors

During testing and/or trouble shooting activities it may be necessary to clean the optical 
buildout adapter or the circuit pack connector. The following procedure is recommended.

66um

core

fiber

Restricted Area
1/2 SM Core + 1/2 Fiber
Diameters - 66 µm dia.

No Loose or No Fixed
Contamination

Monitor 
Viewing
Area

No LOOSE 
contamination or 
particulate fibers 
in viewing area. If 
not removable in 3 
cleaning attempts, 
it is defined as 
fixed particulate. 

Fixed particles 
(<8.0µm in size) 
allowed in this area.

CAUTION
Do not attempt to clean ports equipped with yellow Light guide BuildOut (LBO) 
attenuators. Attenuators contain a thin glass lens that is extremely fragile. The 
LBO will be damaged if cleaned using this method.
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........................................................................................................................................................................................................................

1 Using the appropriate CLETOP stick cleaner (2.5 mm for SC, ST, and FC connectors, 1.25 
mm for LC connectors) dampen the stick cleaner with Ethyl alcohol using the alcohol 
wipe. Insert the stick cleaner into the adapter rotating the stick 360 degrees while 
inserting. Push/rotate stick until the stick cleaner makes contact with the connector. Apply 
slight pressure upon contact and rotate stick 360 degrees at least three (3) times.

........................................................................................................................................................................................................................

2 Remove the stick cleaner rotating it upon removal.

........................................................................................................................................................................................................................

3 Using a dry CLETOP stick cleaner of appropriate diameter, repeat the above cleaning 
procedure. This procedure will clean the side walls of the adapter and the endface of the 
circuit pack connector.

........................................................................................................................................................................................................................

4 Gently insert the Video Fiber Scope probe into the port until the fiber ferrule comes into 
view.

........................................................................................................................................................................................................................

5 Verify that the fiber ferrule is clean. Repeat Step 1 through Step 3 if the fiber does not 
meet the requirements specified in “Connector inspection” (p. B-9).

........................................................................................................................................................E N D  O F  S T E P S
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Cleaning pluggable optics modules

Purpose

This task describes the Alcatel-Lucent recommended method for cleaning pluggable 
optics modules using specific tools and materials that have been proven to be effective in 
the assembly and testing of optical transmission equipment.

Important! Pluggable optics modules are shipped with a water-tight process plug 
installed into the optical ports to maintain cleanliness during storage and/or 
transportation. It is recommended that the process plug be kept in place to maintain 
cleanliness until the optical fiber is connected. With proper care and handling, 
cleaning the pluggable optics modules should not be necessary.Because a major source 
of contamination is often a contaminated mating connector, it is extremely important 
to clean the connector ferrule end surface each time before making connections.

Procedure

Complete the following steps to clean a pluggable optics module.

........................................................................................................................................................................................................................

1 Remove the protective process plug from the pluggable optics module. Keep the process 
plug clean until reinstalled later, if required.

When performing this step hold the canned dry nitrogen or air upright. If the canned dry 
nitrogen or air is held upside down, inert gas may be released onto the connector surface. 
The inert gas leaves contamination on the connector surface that cannot be removed.

........................................................................................................................................................................................................................

2 While holding the canned dry nitrogen or air, position the tip of the nozzle extension as 
close as possible, but not close enough to make physical contact, to the sleeve inside the 
port receptacle and make three consecutive short blows (approximately one second each). 

Repeat this step for the other port.

........................................................................................................................................................................................................................

3 Using the stereo zoom scope, visually inspect the optics module. If required, repeat Step 2 
up to two more times then go to the next step.

CAUTION

Corrosive substance hazard
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........................................................................................................................................................................................................................

4 If required, insert a CLETOP stick into the transmit (TX) port sleeve until vertical force 
can be applied to the fiber stub end surface. Rotate the CLETOP stick five full rounds. 

........................................................................................................................................................................................................................

5 Using the stereo zoom scope, visually inspect the optics module. If required, repeat Step 4.

........................................................................................................................................................................................................................

6 If required, reinstall the process plug into the optical ports to maintain cleanliness.

........................................................................................................................................................E N D  O F  S T E P S

CAUTION
This step should only be performed on the transmit (TX) port if the air blows 
did not work. Do not perform this step on the receive (RX) port. The receive 
(RX) port contains a lens for focusing a wide input. The lens is more easily 
scratched than cleaned.

CAUTION
It is recommended that the process plug be installed into the optical ports on 
the pluggable optics module to maintain cleanliness until the optical fiber is 
connected.
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Overview

Purpose

This appendix provides procedures for installing and removing Line Build Out units 
(LBOs) and fiber connectors onto input and output ports found on the 1665 Data 
Multiplexer (1665 DMX) optical circuit packs. 

Contents

This appendix provides information on the following topics:

Objectives

This appendix provides information to perform the following:

• Install and remove LC-type LBOs onto and from LC-type ports.

• Install and remove LC-type fiber connections.

Fiber cleaning

Refer to Appendix B, “Fiber cleaning” for fiber cleaning information. Do not attempt to 
clean LBOs as they may be damaged by a cleaning attempt. Discard suspect LBOs and 
replace with a new unit.

LBOs  C-2

Fiber connections  C-5
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LBOs

General

LBOs are fixed-value optical attenuators that mate into mounting blocks and provide a 
specific connector interface (LC, ST, FC or SC-type) for external fiber connections. The 
1665 DMX optical circuit packs are equipped with LC-type connector ports designed for 
use with LC-type LBOs and fiber connectors. Dust caps should be applied on all LBOs 
when not installed in connector ports.

LC-type connector port

The LC-type connector port will only accept LC-type LBOs for external fiber connection. 

Figure C-1 LC-Type Connector Ports on Circuit Pack

LC-type LBO

1665 DMX utilizes Alcatel-Lucent’s state-of-the-art AllWave ADVANTAGE™ Fiber Optic 
Attenuators. These attenuators reduce optical power from the transmitter that can result in 
over-saturation of the receiver, have low reflection to meet stringent system requirements, 
and are backward-compatible with existing transmission systems. Unique to the AllWave 
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ADVANTAGE optical connectivity solution (OCS), the new LC™ optic attenuators are 
designed to provide flat spectral loss across the full spectrum, allowing the attenuators to 
be used in the 1300-nm, 1400-nm, and 1500-nm bands.

Figure C-2 LC-Type LBO

Assembly of LC-type LBO into LC block

The LC-type LBOs are installed into the LC-type connector by aligning the alignment key 
with the slot in the connector port and pushing the LBO into the port until it snaps into 
place.

Figure C-3 LC-Type LBO Inserted Into LC-Type Connector Port 

Removal of LC-type LBO from LC block

The LC-type LBOs are removed from the LC-type connector port by depressing the tab to 
release the LBO and then pulling straight out.

ALIGNMENT KEY

SNAP-ACTION TAB

ALIGNMENT
SLOT

15 dB LBO
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Figure C-4 Removing LC-Type LBO From LC-Type Connector Port

DEPRESS TAB
TO RELEASE LBO



Fiber connectionsInstalling fiber connectors and LBOs

............................................................................................................................................................................................................................................................

365-372-304R7.1
Issue 1, November 2007

C- 5

............................................................................................................................................................................................................................................................

Fiber connections

General

1665 DMX uses AllWave ADVANTAGE™ Lightguide Jumpers, part of Lucent’s AllWave 
ADVANTAGE™ Optical Connectivity Solution (OCS). These jumpers contain a boot 
angled at 40 degrees, allowing the jumpers to dress appropriately into the fiber tray. The 
angled boot eliminates projection outside the front of the shelf assembly.

All fiber connectors should be cleaned and inspected before assembling into connector 
ports. Refer to Appendix B, “Fiber cleaning” for Fiber Cleaning information. Dust caps 
should be applied to all fiber connectors when not installed in a connector port.

LC-type connections

LC-type fiber connectors use a snap-action, lever-tab locking method to join the fiber 
connector to the port connector.

Figure C-5 LC-Type Fiber Connector

The LC-type fiber connector is assembled onto an LC-type connector port of a circuit pack 
or LC-type LBO by aligning the alignment key with the slot in the connector port and 
pushing the connector into the port until it snaps into place.

The LC-type fiber connector is removed from a connector port by depressing the snap-
action lever to disengage the fiber connector.

ALIGNMENT KEY SNAP-ACTION TAB SNAP-ACTION LEVER
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Figure C-6 LC-Type Fiber Connection

ALIGNMENT
SLOT

DEPRESS LEVER
TO RELEASE THE
SNAP-ACTION TAB
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Overview

Purpose

This appendix provides information and the procedures used when a connector and/or pin 
on the 1665 Data Multiplexer (1665 DMX) backplane has been bent or broken.

Contents

This appendix provides information on the following topics:

Objectives

This appendix provides information and procedures to do the following:

• Identify a bent or broken pin

• Determine the correct replacement pin and pin kit

• Straighten bent pin

• Replace broken pins

Pin and connector background  D-2

Repair kits and tools  D-4

Simple repair methods  D-5

Replacement methods  D-7
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Pin and connector background

Description

This section describes the procedures for the repair/replacement of the press-fit connector 
pins used on the backplane of the 1665 DMX shelf. Trouble clearing procedures may lead 
you to inspect the backplane for damaged connectors. 

Circuit packs are plugged into METRAL™ signal pin connectors which have been press-
fit into the backplane. A plastic shroud is included with the connectors to protect the pins. 
The signal pin press-fit terminals in these connectors my be replaced individually if they 
have been damaged beyond simple repair methods.

D-subminiature connectors

Interface cabling to and from the 1665 DMX shelves is connected through D-
Subminiature connectors which have been press-fit into the backplane. Should these 
connectors be damaged beyond simple repair methods, contact your next level of support 
for the replacement procedure.

RJ45 jacks

Interface cabling to and from the 1665 DMX shelves is connected through RJ45 
connectors (jacks) which have been press-fit into the backplane. Should these jacks be 
damaged beyond simple repair methods, contact your next level of support for the 
replacement procedure. 

Shelves and backplanes

The 1665 DMX has its connectors and terminal identifiers stenciled on the back surface 
for identification of location or position. The stenciling can only be seen when the back 
cover is removed.

Pins are identified by a column and row position on the backplane. D-Subminiature 
connectors are identified by their designation and J-number. All the METRAL™ pins used 
on the 1665 DMX shelves have the same tail length of 4.30 mm (0.169 in.).

Table D-1, “Backplane Locations of METRAL Pins” (p. D-3) show the location and type 
of METRAL™ pins on the 1665 DMX backplane.
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Table D-1 Backplane Locations of METRAL Pins

Row Column Type

Mating 
Length 
(mm)

Tail 
Length 
(mm)

001, 154, 156, 162 GND Signal Pin 5.75 4.30

001, 154, 156, 162 a, b, c, d, e Signal Pin 8.00 4.30

All others All others Signal Pin 5.75 4.30
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Repair kits and tools

Repair kits

For the repair or replacement of METRAL signal pins, use one of the following repair 
kits:

• Berg Electronic MT370-01 Shelf Level Press-Fit Repair Kit

• IMDARC R-6004 Metral Pin Repair Kit - Comcode 407959881

This kit include the tools, parts and instructions for repair and replacement of signal pins.

Replacement pins

Replacement pins are available. These pins are defined by the mating length extending 
beyond the inside of the plastic shroud and by their tail length for press-fitting into the 
backplane. The tail length includes a compliant press-fit section needed to achieve a gas-
tight connection in four contact areas. All the METRAL pins used on the 1665 DMX 
shelves have the same tail length of 4.30 mm (0.169 in.).

Additional replacement signal pins may be ordered in packages of 100 by the part number 
shown in Table D-2, “Metral Pins” (p. D-4).

Table D-2 Metral Pins

Type
Mating Length 
(mm) Berg Part #

Ground 5.75 88929-502

Signal Pin 5.75 88929-502

Signal Pin 8.00 88929-519
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Simple repair methods

Precautions

Proper ESD precautions must be followed.

Make sure that you have adequate space to access the backplane area and that you have 
good light sources so that you can see what you are doing.

Visual examination

Visually examine the connector pins to determine which pins may have been damaged and 
the degree of the damage. Pins that have been slightly bent may be carefully restored to 
their initial straight position. Examine both sides of the backplane to determine if the 
press-fit termination has been disturbed. These pins depend on an undisturbed interference 
fit between the terminal body and the plated-through hole in the backplane to create a 
reliable connection.

If the visual examination suggests that the connector pins are loose or are damaged beyond 
repair, replace the connector pin.

METRAL™ backplane pins 

Follow the instructions and use the tools provided in the MT370-01 Shelf Level Press-Fit 
Repair Kit to straighten METRAL pins which may have been bent out of position.

Guide pins and keying pins

If a stainless steel guide pin or keying pin has been bent out of alignment, attempts to 
straighten it may damage the backplane. The recommended alternative is to replace the 
bent pin.

CAUTION
These procedures should be done with the shelf out of service and powered 
down to ensure no further damage to the equipment or to the person doing the 
repair. If service cannot be removed or rerouted, contact your next level of 
support before proceeding.

CAUTION

ESD hazard

CAUTION
This is a delicate procedure. Take your time to gently straighten the pin in 
several small steps. Large movements may damage adjacent pins.
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D-subminiature pins

The D-subminiature connectors on the 1665 DMX backplane are all of the receptacle type. 
These connectors are designated as jacks and not as plugs. The individual connector 
terminals are protected somewhat by the molded plastic insert inside the connector shell. It 
is unlikely that these terminals would be bent in the manner that the exposed pin terminals 
of a plug might be bent. The damage concern for these receptacle terminals is that they 
may be “crushed” or otherwise distorted out of shape. Attempts to “straighten” these 
terminals may result in fracturing them. If a receptacle terminal has been damaged to the 
extent that the mating plug connector cannot be connected, then the recommended 
alternative is to replace the entire backplane.

RJ45 jacks

The RJ45 connectors (jacks) are press-fitted into the 1665 DMX backplane. Should these 
jacks be damaged beyond simple repair methods, contact your next level of support for the 
replacement procedure.



Replacement methodsBackplane pin replacement

............................................................................................................................................................................................................................................................

365-372-304R7.1
Issue 1, November 2007

D- 7

............................................................................................................................................................................................................................................................

Replacement methods

Background

Connector pins are designed to withstand a considerable removal force. An impact-type 
tool is used to generate a controlled removal force. Similarly, proper insertion of a press-fit 
connector pin is done with an impact-type tool to control the insertion forces and not 
damage adjacent pins.

Precautions

Read the following Important statements before proceeding:

Important! Any press-fit connector pin may be removed and replaced one time in 
the 1665 DMX backplane. A second removal and replacement in the same plated-
through hole may not meet the long-term reliability objectives. If a replacement is 
needed for a previously replaced connector pin, contact your next level of support 
before proceeding. 

Important! Protect the surrounding area from any debris which may be generated 
during the pin removal and replacement.

Procedure for METRAL™ pins 

Use the procedure below to replace pins when required:

........................................................................................................................................................................................................................

1 Verify that the problem cannot be fixed using a simple repair procedure.

........................................................................................................................................................................................................................

2 Secure the proper tool kit.

........................................................................................................................................................................................................................

3 Read the tool kit instructions before beginning.

........................................................................................................................................................................................................................

4 Plan and write out a “Method of Procedure” specific to your location.

........................................................................................................................................................................................................................

5 Follow the instructions provided to remove the damaged pin.

........................................................................................................................................................................................................................

6 Install the replacement pin.
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........................................................................................................................................................................................................................

7 Verify that the new pin is securely in the backplane.

........................................................................................................................................................................................................................

8 If the replacement is not successful, contact your next level of support.

........................................................................................................................................................E N D  O F  S T E P S

Guide and keying pin procedure

If it becomes necessary to replace Guide or Keying Pins, contact your next level of support 
for tooling, replacement parts and detailed replacement procedures. The replacements will 
need to installed with screws and washers.

D-subminiature pin procedure

If it becomes necessary to replace either the D-Subminiature pins or connector, contact 
your next level of support for detailed replacement procedures.

RJ45 jacks

If it becomes necessary to replace a RJ45 connector, contact your next level of support for 
the replacement procedure.
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Appendix E: Installation checklist

............................................................................................................................................................................................................................................................

Overview

Purpose

This chapter provides the recommended checklist to follow when installing a 1665 Data 
Multiplexer (1665 DMX) system. Use of the installation checklist is required to ensure a 
quality installation, all completed tasks should be checked off and those not completed 
should be duly noted as to the reason why. This checklist should be turned in as part of 
your job complete paperwork.

Contents

This chapter contains the following:

Table E-1 Installation Acceptance Checklist

Overview  E-1

Section and Chapter Procedure Required

Completed

Yes No

Part I: “1665 Data Multiplexer (1665 DMX) physical installation and powering”

Chapter 1, “Equipment and 
cable installation for 1665 
Data Multiplexer (1665 
DMX)”

Inspection (p. 1-8) Yes

1665 DMX High-Capacity shelf installation (p. 
1-9)

Yes

Heat baffle installation (p. 1-14) See Note 1

Power cable and cable bracket installation (p. 
1-16)

Yes
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Fiber management installation (optional) (p. 
1-27)

Yes

Installing the fiber ducts (optional) (p. 1-31) See Note 1

Cable and optical fiber installation (p. 1-32) Yes

DS1 cable installation (p. 1-34) See Note 1

DS3/EC1 and 48TMUX cable installation (p. 
1-41)

See Note 1

12TMUX (LNW18) cable installation (p. 1-54) See Note 1

10/100BaseT backplane Ethernet cable 
installation (p. 1-58)

See Note 1

Ethernet cabling to SFP modules on circuit 
pack faceplates (p. 1-62)

See Note 1

IAO LAN and TCP/IP cable installation (p. 
1-64)

See Note 1

Modem cable installation (p. 1-69) See Note 1

Sync cable installation (p. 1-72)

Sync cable with molded DB-9 connector 
procedure (p. 1-72)

See Note 1

Sync cable with wire-wrap DB-9 connector 
procedure (p. 1-74)

See Note 1

Office alarm cable installation (p. 1-78) See Note 1

Miscellaneous (environmental) discrete 
telemetry cable installation (p. 1-84)

See Note 1

Main optical fiber installation (OC-12, OC-48, 
OC-192) (p. 1-88)

See Note 1

Fiber installation for low-speed packs (p. 1-90) See Note 1

1000Base-F and 100Base-F fiber installation 
(p. 1-92)

See Note 1

Fibre channel fiber installation (p. 1-94) See Note 1

CIT cable installation (p. 1-96) See Note 1

Final operations (p. 1-99) Yes

Section and Chapter Procedure Required

Completed

Yes No
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Chapter 2, “Powering and 
initial circuit pack 
installation for 1665 Data 
Multiplexer (1665 DMX)”

Powering (p. 2-3) Yes

Initial circuit pack installation (p. 2-12)

LNW2 (SYSCTL) installation (p. 2-12) Yes

OC-48 main OLIU installation (p. 2-13) See Note 1

OC192 main OLIU installation (p. 2-15) See Note 1

OC-12 main OLIU installation (p. 2-16) See Note 1

8OC-3/8OC-12/2OC-48 main OLIU 
installation (p. 2-17)

See Note 1

LNW80 main switch pack installation (p. 2-18) See Note 1

LNW785 OMD5/8 8-channel low-loss DWDM 
Optical Mux/Demux (p. 2-19)

See Note 1

LNW6(28DS1), LNW7(28DS1PM), 
LNW8(56DS1E1) low-speed installation 
(optional) (p. 2-20)

See Note 1

LNW16 (12DS3/EC1), LNW18 (TMUX), 
LNW19/LNW19B (48 DS3/EC1), LNW20 
(48TMUX) low-speed installation (optional) 
(p. 2-21)

See Note 1

LNW36 (OC-3 OLIU) low-speed installation 
(optional) (p. 2-22)

See Note 1

LNW37 (4 OC-3 SFP OLIU), LNW45 (8 OC-3 
SFP OLIU), LNW49 (4 OC-12 SFP OLIU), 
LNW55 (12OC-3/12OC12/4 OC48 SFP OLIU) 
or LNW62 (4 OC-48 SFP OLIU) low-speed 
installation (optional) (p. 2-23)

See Note 1

LNW46 (OC-12 OLIU) low-speed installation 
(optional) (p. 2-25)

See Note 1

LNW31 (OC-48 OLIU), or LNW421-459 (OC-
48 PWDM OLIU) low-speed installation 
(optional) (p. 2-26)

See Note 1

Section and Chapter Procedure Required

Completed

Yes No



............................................................................................................................................................................................................................................................

OverviewInstallation checklist

E - 4  365-372-304R7.1
Issue 1, November 2007

LNW66 (10/100T) or LNW71 (10/100-PL) 
installation (optional) (p. 2-27)

See Note 1

LNW70 (100/1G FXS), LNW74 (10/100 T/F), 
LNW63 (1000BASE-SX/LX/LX10), LNW64 
(8 GbE), LNW78 (RPR) and LNW170 (100/1G 
FXS) installation (optional) (p. 2-28)

See Note 1

LNW67 (1G SX) installation (optional) (p. 
2-29)

See Note 1

LNW73 (FC-1X/2X) and LNW73C (FC-
1X/2X with compression) installation 
(optional) (p. 2-31)

See Note 1

177D/LNW98 blank CP installation (optional) 
(p. 2-33)

See Note 1

177E/LNW97 blank CP installation (optional) 
(p. 2-33)

See Note 1

Install pluggable transmission modules (p. 
2-34)

See Note 1

Part II: “1665 Data Multiplexer (1665 DMX) stand-alone installation tests”

Chapter 3, “Software 
download and circuit pack 
installation”

Software installation (p. 3-4) See Note 1

Circuit pack installation (p. 3-5) See Note 1

Use of WaveStar® CIT software (p. 3-9) Yes

Circuit pack firmware version verification (p. 
3-12)

See Note 1

1665 DMX shelf initialization (p. 3-13) Yes

Provision/enable/disable TCP/IP on an IAO 
LAN port (p. 3-14)

See Note 1

Reset system date and time (p. 3-17) Yes

Provision/Enable/disable the 1665 DMX as a 
TL1 TCP/IP GNE (p. 3-18)

See Note 1

Chapter 4, “Installation 
tests”

LBO software settings (p. 4-4)

Setting DS1 LBOs (p. 4-4) See Note 1

Section and Chapter Procedure Required

Completed

Yes No
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Setting DS3/EC1 and TMUX LBOs (p. 4-5) See Note 1

Clearing alarms (p. 4-7) Yes

Local equipment and cross-connect tests (p. 4-9)

DS1 terminating equipment loopback testing 
(p. 4-10)

See Note 1

DS1 non-terminating equipment transmission 
testing (optical main OLIU) (p. 4-11)

See Note 1

DS1 protection switching (p. 4-14)

DS1 function unit protection switching test 
(manual) (p. 4-14)

See Note 1

DS1 function unit protection switching test 
(command) (p. 4-15)

See Note 1

DS1 path switching test (manual) (p. 4-16) See Note 1

DS1 cleanup procedures (p. 4-18)

Delete any existing DS1 cross-connections (p. 
4-18)

See Note 1

Verify cross-connects removed (p. 4-21) See Note 1

DS3/EC1 and TMUX testing procedure (p. 4-22)

Verify provisioning (p. 4-22) See Note 1

DS3 terminating equipment loopback testing 
(optical main OLIUs) (p. 4-23)

See Note 1

DS3 non-terminating transmission (optical 
main OLIU) (p. 4-26)

See Note 1

DS3 protection switching (p. 4-28)

DS3 function unit protection switching test 
(manual) (p. 4-28)

See Note 1

DS3 function unit protection switching test 
(command) (p. 4-29)

See Note 1

DS3 path switching test (command) (p. 4-30) See Note 1

DS3 cleanup procedures (p. 4-32)

Section and Chapter Procedure Required

Completed

Yes No
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Delete the existing DS3 cross-connections (p. 
4-32)

See Note 1

LNW66, LNW71 and LNW74 (10/100T) TX 
Ethernet cabling testing (p. 4-36)

Ethernet port assignment verification testing (p. 
4-36)

See Note 1

Ethernet port wiring verification testing (p. 
4-37)

See Note 1

OC-3 (LNW37, LNW45, LNW55)/OC-12 
(LNW49, LNW55)/OC-48 (LNW55, LNW62) 
low-speed SFP test procedure (p. 4-41)

OC-3/OC-12/OC-48 SFP low-speed SFP test 
procedure (p. 4-41)

See Note 1

OC-3 (low-speed) testing (p. 4-43)

OC-3 testing procedure (p. 4-43) See Note 1

OC-12 (low-speed) testing (p. 4-47)

OC-12 testing procedure (p. 4-47) See Note 1

OC-12 facility loopback testing (p. 4-49) See Note 1

OC-48 (low-speed) testing (p. 4-52)

OC-48 low-speed testing procedure (p. 4-52) See Note 1

OC-48 facility loopback testing (p. 4-53) See Note 1

LED test (p. 4-56)

LED test procedure (p. 4-56) See Note 1

Additional optical tests (optional) (p. 4-57)

Low -speed optical testing (p. 4-57) See Note 1

Chapter 5, “Operational 
tests”

Office alarm test (p. 5-4)

Office alarm test procedure (p. 5-5) See Note 1

Automatic protection switching and alarm test 
(p. 5-8)

Main OLIU switching test (p. 5-8) See Note 1

Section and Chapter Procedure Required

Completed

Yes No
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Manual switching tests (p. 5-11)

Main OLIU switch test (p. 5-11) See Note 1

External timing verification (p. 5-13)

Timing verification test procedure (p. 5-13) See Note 1

Miscellaneous (environmental) discrete 
telemetry test (p. 5-16)

Miscellaneous discrete telemetry test procedure 
(p. 5-16)

See Note 1

Modem connection test (p. 5-19)

Modem connection test procedure (p. 5-19) See Note 1

Final operations (p. 5-21)

Procedure (p. 5-21) Yes

Section and Chapter Procedure Required

Completed

Yes No
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Part III: “1665 Data Multiplexer (1665 DMX) ring setup and testing”

Chapter 6, “Ring setup and 
testing: integration 
procedures”

Fiber installation (p. 6-4)

Fiber installation procedure (p. 6-5)

Optical transmission test (OC-192, OC-48, 
OC-12) (p. 6-11)

Transmission test procedure (p. 6-11)

Automatic protection switching test (p. 6-12)

Main OLIU switch test (p. 6-12)

Manual switching tests (p. 6-14)

Manual switching test procedure (p. 6-14) Yes

Function units/growth slots, switching test (p. 
6-15)

Final operations (p. 6-17)

Procedure (p. 6-17)

Clear PM registers (p. 6-17)

Notes:  

1. Only required if equipped.

Section and Chapter Procedure Required

Completed

Yes No
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............................................................................................................................................................................................................................................................

Overview

Purpose

This chapter describes the labeling of the fiber.

Contents

This chapter contains the following.

Fiber description  F-2

Fiber labels  F-4
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Fiber description

Fibers

There are three different types of single-mode fiber used with the 1665 Data Multiplexer 
(1665 DMX) system, simplex blue fiber, simplex yellow fiber, and the customer's fiber, 
and two types of multi-mode fiber used with the 1665 DMX, multi-mode simplex gray 
fiber and the customer's multi-mode fiber. Multi-mode fiber is only supported for use with 
the LNW67 1GSX circuit pack.

Gray fiber

Gray fiber is made up of a multi-mode gray colored fiber equipped with LC connectors at 
both ends. The Gray Fibers come in different lengths as well as custom lengths. The length 
is given on the protection boot of the LC connector.

These fibers are used to make connections from the circuit pack to the LGX. Installation is 
covered in Chapter 1, Chapter 2, Chapter 3, and Chapter 6.

Yellow fiber

Yellow fiber is made up of a single-mode yellow colored fiber equipped with LC 
connectors at both ends. The Yellow Fibers come in different lengths as well as custom 
lengths. The length is given on the protection boot of the LC connector.

These fibers are used to make connections from the circuit pack to the LGX. Installation is 
covered in Chapter 1, Chapter 2, Chapter 3, and Chapter 6.

Outside fiber

Outside fiber is the fiber connecting the customer equipment to the 1665 DMX. 
Depending on the customers specifications, these fibers may be any combination of SC, 
FC, or ST connectors. The length of these fibers depends on the system interface setup. 
This fiber is usually referred to as the Outside Bay or Plant Fiber.

Outside Bay Fiber management should be specified by the customer. It is beyond the 
scope of this document to specify the route or dressings that the fiber should take once it 
leaves the equipment bays.
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Precautions

Single-mode fiber testing requirements

All fibers shall be tested after they are installed as follows:

• All fibers shall be tested after installation, but prior to turn-up

• Before fibers are tested, they shall be labeled properly and all cable tags shall be 
removed.

• A 1310-nm or 1550-nm test source and an ITE# 7116 (or equivalent) optical power 
meter shall be used to perform all tests.

• The light source shall first be measured for a reference point/baseline.

• No fiber jumper may have a measured loss of more than 2 dB.

CAUTION

Equipment Damage

Fiber is constructed of glass and should be treated with care. It should not be 
pulled or stretched. This could cause damage to the fiber or the fiber connector.

Fiber should not be bent in a radius of less than 1-1/2”.
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Fiber labels

Introduction

If pre-printed labels are not available, use a label-maker to create labels for each end of 
each fiber. The label should include:

• Rack location

• Circuit pack

• Port

• Direction (IN,OUT)

Labeling the fibers

To apply the labels to the connectors, use the following procedure.

........................................................................................................................................................................................................................

1 Remove the appropriate label from the backing sheet or the label maker.

........................................................................................................................................................................................................................

2 Apply the label to the strain relief boot, close to the body of the LC connector.

........................................................................................................................................................................................................................

3 Adhere the end of the label with the printed text first.

........................................................................................................................................................................................................................

4 The label must be oriented perpendicular to the main axis of the connector.

........................................................................................................................................................................................................................

5 Wrap the label around the boot so that the second wrap is directly on top of the first wrap. 
(The label will wrap around the boot approximately two times). The text is printed 
diagonally on the label so that it can be read when applied the correct way.

Important! Do not apply the label diagonally to the boot. The label must wrap 
directly on top of itself for the adhesive to work.

........................................................................................................................................................E N D  O F  S T E P S
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Appendix G: Pluggable transmission 
module installation

............................................................................................................................................................................................................................................................

Overview

Purpose

This chapter describes how to insert a pluggable transmission module (PTM) into a 1665 
Data Multiplexer (1665 DMX) circuit pack. PTMs are sometimes referred to as SFP 
(small form pluggable) modules.

Contents

This chapter contains the following.

CAUTION

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.

Pluggable transmission modules  G-2

Install pluggable transmission modules  G-6
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Pluggable transmission modules

Alcatel-Lucent approved Class 1 SFP transceivers

The following table lists all the current approved pluggable transmission modules to be 
used with 1665 DMX.

Table G-1 Alcatel-Lucent Approved Pluggable Transmission Modules

Apparatus Code Comcode Description Used in

BASE-T-C1
FE and GbE 
(electrical - NOT 
OSP)

109565549 Electrical PTM, 
provisionable to 100 or 
1000 Mbps, Lucent 
approved RJ-45 Cat 5-
E cable, maximum span 
length of 100 meters

LNW63, LNW64, 
LNW70, LNW78, 
LNW170

OC-3IR1-I1 109453894 OC-3 PTM TRCVR 
Intermediate Reach, 1.3 
IR-1, 1310nm

LNW37, LNW45, 
LNW55, LNW82

OC-3LR1-I1 109453886 OC-3 PTM TRCVR 
Long Reach, 1.3 LR-1, 
1310nm

LNW37, LNW45, 
LNW55, LNW82

S15512 109602599 OC-3 PTM TRCVR 
Short Reach, 1.3 SR-1, 
1310 nm

LNW37, LNW45, 
LNW55, LNW82

OC-12IR1-I1 109453902 OC-12 PTM TRCVR 
Intermediate Reach, 1.3 
IR-1, 1310nm

LNW49, LNW55, 
LNW82

OC-12LR1-I1 109467522 OC-12 PTM TRCVR 
Long Reach, 1.3 LR-1, 
1310nm

LNW49, LNW55, 
LNW82

OC-12LR2-I1 109604447 OC-12 PTM TRCVR 
Long Reach, 1.5 LR-2 
(80km), 1550

LNW49, LNW55, 
LNW82

OC48SR1-I1 109564518 OC48 PTM TRCVR 
Short Reach, 1.3 SR-1 
(2km), 1310nm

LNW55, LNW62, 
LNW82, LNW202
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OC48LR1-I1 109493528 OC48 PTM TRCVR 
Long Reach, 1.3 LR-1 
(40km), 1310nm

LNW55, LNW62, 
LNW82, LNW202

OC48LR2-I1 109504431 OC-48 PTM TRCVR 
Long Reach, 1.5 LR-2 
(80 km), 1550 nm

LNW55, LNW62, 
LNW82, LNW202

S2D23C6 109610378 OC48/STM16/OTU1 
DWDM 
192.3THz/1558.983nm

LNW82, LNW202

S2D25C6 109610394 OC48/STM16/OTU1 
DWDM 
192.5THz/1557.363nm

LNW55, LNW62, 
LNW82, LNW202

S2D27C6 109610410 OC48/STM16/OTU1 
DWDM 
192.7THz/1555.747nm

LNW55, LNW62, 
LNW82, LNW202

S2D31C6 109610451 OC48/STM16/OTU1 
DWDM 
193.1THz/1552.524nm

LNW82, LNW202

S2D33C6 109610477 OC48/STM16/OTU1 
DWDM 
193.3THz/1550.918nm

LNW82, LNW202

S2D35C6 109610493 OC48/STM16/OTU1 
DWDM 
193.5THz/1549.315nm

LNW82, LNW202

S2D37C6 109610519 OC48/STM16/OTU1 
DWDM 
193.7THz/1547.715nm

LNW82, LNW202

S2D45C6 109610600 OC48/STM16/OTU1 
DWDM 
194.5THz/1541.349nm

LNW82, LNW202

S2D47C6 109610626 OC48/STM16/OTU1 
DWDM 
194.7THz/1539.766nm

LNW55, LNW62, 
LNW82, LNW202

S2D49C6 109610642 OC48/STM16/OTU1 
DWDM 
194.9THz/1538.186nm

LNW82, LNW202

Apparatus Code Comcode Description Used in
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S2D53C6 109610691 OC48/STM16/OTU1 
DWDM 
195.3THz/1535.036nm

LNW55, LNW62, 
LNW82, LNW202

S2D55C6 109610717 OC48/STM16/OTU1 
DWDM 
195.5THz/1533.465nm

LNW55, LNW62, 
LNW82, LNW202

S2D59C6 109610766 OC48/STM16/OTU1 
DWDM 
195.9THz/1530.334nm

LNW55, LNW62, 
LNW82, LNW202

OC192SR1-C1 109537902 OC-192 XFP TRCVR 
Short Reach, 1.3 SR-1 
(2 km), 1310 nm

LNW59, LNW502

OC192IR2-C1 109537563 OC-192 XFP TRCVR 
Intermediate Reach, 1.5 
IR-2 (40 km), 1550 nm

LNW59, LNW502

OC192LR2-C1 109537555 OC-192 XFP TRCVR 
Long Reach, 1.5 LR-2 
(80 km), 1550 nm

LNW59, LNW502

100BASE-LX-I1 
(FE-TX)

 109527812 Optical Fast Ethernet 
PTM LC-type 
connectors
(FE-1310SM)

LNW74, LNW70, 
LNW78, LNW170

GE-1X2XFC-LX-C1
(1000BASE-LX, 
1Gbps and 2 Gbps 
Fibre-Channel/
FICON)

 109527804 GbE long-reach, Single 
Mode PTM, supports 
Ethernet, FICON, and 
Fibre-Channel traffic, 
LC-type connectors
(GbE/FC/2FC-1310)

LNW64, LNW70, 
LNW73, LNW73C, 
LNW78, LNW170

GE-1X2XFC-SX-C1
(1000BASE-SX, 
1Gbps and 2 Gbps 
Fibre-Channel)

 109527796 GbE short-reach, 
Single Mode PTM, 
supports Ethernet and 
Fibre-Channel traffic, 
LC-type connectors
(GbE/FC/2FC-850)

LNW64, LNW70, 
LNW73, LNW73C, 
LNW78, LNW170

ESCON-MM-I1 
(ESCON)

 109523886 ESCON, Multi-Mode 
PTM, LC-type 
connectors
(ESCON - 1310)

LNW73, LNW73C

Apparatus Code Comcode Description Used in
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GE-1X2XFC-SX-I1
(1000BASE-SX, 
1Gbps)

109570606 GbE short-reach, 
Single Mode PTM, 
supports Ethernet and 
Fibre-Channel traffic, 
LC-type connectors 
OSP hardened
(GbE/FC/2FC-850)

LNW63, LNW64, 
LNW70, LNW73, 
LNW73C, LNW78, 
LNW170

GE-1X2XFC-LX-I1 
(1000BASE-LX,
1 Gbps)

109568782 GbE long-reach, Single 
Mode PTM, supports 
Ethernet, FICON, and 
Fibre-Channel traffic, 
LC-type connectors, 
OSP hardened
(GbE/FC/2FC-1310)

LNW63, LNW64, 
LNW70, LNW73, 
LNW73C, LNW78, 
LNW170

1000BASE-ZX-I1
(1000BASE-ZX, 
1Gbps)

109541862 GbE Short-reach, 
Single Mode PTM, 
supports Ethernet, LC-
type connectors, OSP 
hardened (GbE - 1550)

LNW63, LNW64, 
LNW70, LNW78, 
LNW170

Apparatus Code Comcode Description Used in
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Install pluggable transmission modules

Procedure

Complete the following steps to install pluggable transmission modules in a circuit pack 
that has already been installed in a shelf.

........................................................................................................................................................................................................................

1 Determine the circuit pack and socket being equipped with the pluggable transmission 
module.

........................................................................................................................................................................................................................

2 Hold the connector/latch-end of the module in your left hand with the gold fingers facing 
you. The module should be positioned in manner similar to Figure G-1, “Pluggable 
Transmission Module With Dust Plug (Optical PTMs Only)” (p. G-6).

Figure G-1 Pluggable Transmission Module With Dust Plug (Optical PTMs Only)

Important! Do not remove the dust plug unless you are ready to connect fibers or if 
you need to clean the module.

Dust plugs (Optical PTMs only) There are a variety of different types of dust plugs. 
Any of the following examples could be similar to the dust plug in your pluggable 
transmission module.

MA-DMX-422
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Figure G-2 Examples of Dust Plugs

........................................................................................................................................................................................................................

3 Referring to Figure G-3, “Module Types” (p. G-7) below, determine the type of latching 
mechanism on the pluggable transmission module you have.

Figure G-3 Module Types

MA-DMX-421

Gold Fingers

Gold Fingers

MA-DMX-445

1

2

3

Gold Fingers

Port

Port

Port
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Important! Optical pluggable transmission modules are shipped with a dust plug 
installed into the optical ports to maintain cleanliness during storage and/or 
transportation. It is recommended that the dust plug be kept in place to maintain 
cleanliness until the cabling is connected. With proper care and handling, cleaning the 
pluggable transmission modules should not be necessary.

Gold Fingers

Gold Fingers

Gold Fingers

MA-DMX-439

4

5

6

Port

Port

Port

7

8

MA-DMX-442

Gold FingersPort

Gold Fingers

Port
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........................................................................................................................................................................................................................

4 Referring to Step 3, what type of latching mechanism does your module have?.

........................................................................................................................................................................................................................

5 Before inserting the module, the latch must be in the closed position. With the dust plug in 
place, the latch is in the closed position.

Figure G-4 shows the open and closed position of the latch. Depending on your PTM type, 
the appearance of the port opening and latch mechanism may vary.

Figure G-4 Latch Type 3 (Opened and Closed)

........................................................................................................................................................................................................................

6 Proceed to Step 8.

........................................................................................................................................................................................................................

7 Before inserting the module, the latch must be in the closed position. With the dust plug in 
place, the latch is in the closed position.

Figure G-5 shows the open and closed position of the latch. Depending on your PTM type, 
the appearance of the port opening and latch mechanism may vary.

If... Then...

Type 1 or 2 (optical) Proceed to Step 8

Type 3 (optical) Continue with Step 5

Type 4, 5, or 6 (optical) Proceed to Step 7

Type 7 or 8 (electrical) Proceed to Step 7

MA-DMX-423

Swivel Latch
Closed Position

(to the right)

Swivel Latch
Open Position

(to the left)
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Figure G-5 Latch Type 4, 5, 6, 7 and 8 (Opened and Closed)

........................................................................................................................................................................................................................

8 With your left hand, hold the pluggable transmission module by the dust plug (optical) or 
port end (electrical). The ports are in your left hand and the gold fingers are visible (facing 
you). (Do not insert pluggable transmission module.)

........................................................................................................................................................................................................................

9 Rotate the module; the dust plug or port end is facing you and the gold fingers are pointing 
away from you and are facing to the right. (Do not insert pluggable transmission module.)

........................................................................................................................................................................................................................

10 Insert the pluggable transmission module in the required socket of the circuit pack 
faceplate. Confirm that the pluggable transmission module is locked in the socket. Verify 
that all unused sockets on the circuit pack are equipped with dust covers.

MA-DMX-424

Swivel Latch
Closed Position

(to the left)

Swivel Latch
Open Position
(to the right)
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Table G-2 Insert Pluggable Transmission Module Into Socket

Result: The port appears in the WaveStar® CIT System View indicating successful 
installation. 

If response is not correct, replace the pluggable transmission module. If the pluggable 
transmission module fails when inserted, and another pluggable transmission module 
in the shelf fails at the same time, replace the newly-installed pluggable transmission 
module. Each pluggable transmission module has unique internal data for warranty 
purposes. If this data for any reason is not unique, both pluggable transmission 
modules with the duplicated information will be declared failed. Refer to the 1665 
Data Multiplexer Alarm Messages and Trouble Clearing Guide, 365-372-302.

........................................................................................................................................................................................................................

11 Push on the dust plug or port end to insert the module. The latch automatically catches 
when the module is inserted. The module is secure.

To verify that the pluggable transmission module is properly latched in the cage, gently 
pull the pluggable transmission module (parallel to the direction the pluggable 
transmission module was installed). Do not rotate the swivel latch or activate the de-
latching feature on the pluggable transmission module.

MA-DMX-427

Gold Fingers

Socket
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12

........................................................................................................................................................................................................................

13 To test the OC-n optical port on installed OLIU circuit packs, loop back the OC-n optical 
port on itself (IN to OUT) with a 15-dB Attenuator.

Result: No alarms on the OLIU.

........................................................................................................................................................................................................................

14 Remove the lightguide jumper used to loop back the OC-n optical port and the LBO.

Result: The port LED starts flashing. The MN and NE LEDs are lighted on the 
SYSCTL circuit pack.

........................................................................................................................................................................................................................

15 From the System View window, select Configuration → Update System → Update All.

Result: The port LED stops flashing. All alarms are cleared.

........................................................................................................................................................................................................................

16 Repeat Step 1 to Step 15 for additional pluggable transmission modules.

........................................................................................................................................................................................................................

17 If all pluggable transmission modules are installed, then from the System View menu click 
on the Alarm List button to verify that no alarms are present for the pluggable 
transmission modules just installed on the circuit packs.

........................................................................................................................................................E N D  O F  S T E P S

If installing a pluggable transmission 
module in an...

Then...

Optical OLIU circuit pack, Continue with Step 13.

Ethernet/DATA circuit pack, Proceed to Step 17.
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Appendix H: Technical support

............................................................................................................................................................................................................................................................

Overview

Purpose

This chapter provides important technical assistance information for the 1665 Data 
Multiplexer (1665 DMX).

Contents

This appendix contains the following sections

Technical assistance  H-2

Accessing and navigating the On-Line Customer Support (OLCS) web site  H-7

Other technical support services  H-13
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Technical assistance

Overview

Alcatel-Lucent provides the following Technical Support Services:

• Remote Technical Support (RTS) - remote technical support to troubleshoot and 
resolve system problems.

• On-site Technical Support (OTS) - on-site assistance with operational issues and 
remedial maintenance.

• Repair and Replacement (R&R) - technical support services for device repair/return or 
parts replacement.

• Alcatel-Lucent On-Line Customer Support (OLCS) - online access to information and 
services that can help resolve technical support requests.

Important! Technical Support Services are available 24 hours a day, 7 days a week.

For additional information regarding Alcatel-Lucent Worldwide Services, refer to the 
Alcatel-Lucent web site at http://www.alcatel-lucent.com/solutions.

Select the appropriate category:

• Service Providers

• Enterprise

Important! Use the appropriate steps below for the above categories.

Service Providers:

1. Select Service Providers.

2. Select Services.

3. Select Network Support and Maintenance Services located in the Maintenance 
section.

Important! An overview of services provided is displayed. If more detailed 
information on a particular category is needed, then select the appropriate information 
from the top tabs displayed.

Enterprises:

1. Select Enterprises.

2. Under the Evaluate section at the bottom of the page, select Products and Services.

3. At the Products and Services page, select Services.

http://www.alcatel-lucent.com/solutions
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Important! An overview of the services provided is displayed. For more 
information, select one of the three categories shown at the bottom of the page: 
Consult & Design, Maintain & Operate, or Integrate & Deploy.

Technical support

Many of our customers have established their own support procedures. These procedures 
usually involve escalation within their own companies. However, some instances may 
require additional assistance from Alcatel-Lucent.

Alcatel-Lucent has been and continues to be committed to providing excellence in 
technical support for its products and services. Therefore, we provide a hierarchical 
support structure ready and available to solve any Alcatel-Lucent product technical issue.

When additional assistance is required, the Alcatel-Lucent Welcome Center is the first 
point of contact. An Alcatel-Lucent Welcome Center operator can direct the request to 
engineers that are highly trained and skilled in resolving issues, involving Alcatel-Lucent 
products. Technical assistance is available 24 hours a day, 7 days a week.

On-line customer support

Overview

On-Line Customer Support (OLCS) is the Customer Support web site for our customers’ 
technical support needs. This customer web access tool provides an easy method to access 
data about Alcatel-Lucent products using the World Wide Web. A customer must first 
request access to this web site to gain access to the following customer support features:

• Ask AL Knowledge base

• Customer Assistance Request Entry System (CARES)

• Data Drop Box

• Documentation

• Downloads

• Alcatel-Lucent Alerts

• Product Change Notices

• RMA (Repair and Exchange)

Alcatel-Lucent Welcome Center

1 866 582 3688, prompt 1 (continental U.S.)
+1 (630) 224 4672 (outside continental U.S.)
(24 hours a day, 7 days a week)

By using the Alcatel-Lucent Welcome Center as the entry point for Alcatel-Lucent support, 
customers will be assured of a timely and effective technical support service.
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Ask AL Knowledge base

The Ask AL Knowledge base web interface feature connects you to the Knowledge 
Management solutions database. The Ask AL Knowledgeably feature lets you search for 
solutions by using natural language queries. Many products have an extensive set of 
Solutions available. Solutions are created by technicians to provide customers with a 
method to resolve issues without calling for assistance. Solutions are displayed, showing 
the percentage weight or percent match, based on search criteria. Searches can be 
performed on all products that are entitled, through the level of service contract a customer 
has for RTS services.

CARES

The CARES web interface feature makes it easy for you to submit an Assistance Request 
(AR), subscribe to AR Notifications (be notified when an AR is updated), and view all the 
customer ARs. The CARES feature lets you open an AR for low severity issues or 
questions. Any high severity issue should be called into CTAM. Users can stay informed 
about their ARs by using the flexible AR Notification subscriptions. Users can choose a 
method for receiving updates: email, text messaging messages, or none. Users can choose 
when updates are wanted (when the state of the AR changes, any update to the 
investigation field occurs, or any time any text field is modified). Users can log into the 
OLCS web site and view ARs 24 hours a day, 7 days a week.

Data Drop Box

The Data Drop Box feature allows Alcatel-Lucent support technicians to provide 
customers with a quick method to share files. The Data Drop Box allows a technician to 
provide or receive a file from a customer quickly. These files remain in place for 7 days. 

Documentation

The Documentation feature on the OLCS web site contains three areas: Manuals and 
Guides, Technical Notes, and Release Information. 

• Manuals and Guides

This section contains the documents that are available in paper or electronic copy and 
are distributed with a new product. These are the documents that are available within 
the Alcatel-Lucent Product Documentation web site. The OLCS web site contains 
links to the actual documents at the Customer Information Center (CIC) web site. The 
following is a list of possible documents that are available from this site:

– Administration Guide

– Applications Planning Guide (APG)/Applications Planning and Ordering Guide 
(APOG)

– Getting Started Guide

– Installation Manual (IM)/Installation Guide (IG)
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– Modification Implementation Procedure (MIP)

– User Guide

– Alarm Messaging and Trouble Clearing Guide (AMTCG)

– Framework User Guide

– Graphical User Interface (GUI) Guide

– Maintenance Guide, Provisioning Guide

– User Operations Guide (UOG)

• Technical Notes

This section contains documents that are specific to the product and are technical in 
nature. Most of these documents will provide information in product data sheets or 
white papers, which are technical documents that explain the operation of a particular 
part of the system. The following documents are available in this section:

– Change Notice (CN)

– Ethernet Management Guide

– Method of Procedure (MOP)

– Planning Guide

– Service Assurance Guide

– Engineering Change Procedure (ECP)

– Feature Contents

– Operations Interworking (OI) Guide

– Screen Help

– White Papers

These documents will vary from product to product.

• Release Information

This section contains documents that are specific to the release of a product. The 
following documents are available in this section: 

– Acceptance Documents

– Software Release Descriptions (SRD)

– Specific SRD sections

– White Papers (release specific)

– Software Compatibility

– Upgrade Paths
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Downloads

Important! This may not apply to all products.

The Downloads area allows Alcatel-Lucent support technicians to provide access to 
software downloads that are specific to a customers contract. This feature is only allowed 
through negotiation with the Account Team and the Product Manager of the product. 

Alcatel-Lucent Alerts

The Alcatel-Lucent Alerts tool is a subscription-based tool that provides the same 
information that our Product Notifications (PNs) did previously provide. This new method 
of communication is a vehicle to share product and support issues that are of 
informational, maintenance, or preventive nature. Alcatel-Lucent Alerts contain detailed 
text descriptions and urgency of Alcatel-Lucent product issues that need to be quickly 
communicated to customers after the deployment of a release or product. 

Product Change Notices

The Product Change Notices (PCN) area provides information on hardware changes for a 
product. There is a selection of choices to help you search for Change Notices (CNs) or 
Customer Change Notices (CCNs).

Return Material Authorization (RMA) (Repair and Exchange)

Important! This may not apply to all products.

The RMA area provides a list of contact information on all Alcatel-Lucent products. There 
is a “request an RMA number” on-line for most Alcatel-Lucent products. An RMA 
number is required for all returned parts and this feature provides you with an easy method 
to obtain the RMA number. Please check the warranty status before submitting a request.
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Accessing and navigating the On-Line Customer Support (OLCS) 

............................................................................................................................................................................................................................................................

web site

Description

This section provides the method to access the On-Line Customer Support (OLCS) web 
site, obtain a login (if necessary), and navigate to each feature listed in this document.

Accessing the OLCS web site

To access the Alcatel-Lucent OLCS web site, enter: www.alcatel-lucent.com/support. 
Once you are at this web page, select Lucent Global Support. This will bring you to the 
web site where you can log in to gain access to the entitled products.

Obtaining a login for OLCS

To request a login, a customer must register, then and an email confirmation is sent within 
2 business days. The following steps tell you how to register for a login:

1. Select “Register Here” on the top right (just below the Login and Password boxes) of 
the Online Customer Support (https://support.lucent.com/portal/olcsHome.do) web 
site.

2. Follow this registration process:

• Select the role and accept the terms of use.

• Provide a business identification, and enter in all of the required information.

• Validate your email address.

• Confirm your business identity and set a password.

• Select content. (This will be verified against the current contract agreements.)

• Register for the selected content.

3. An email confirmation of the registration and the site access privileges is sent within 2 
business days.

4. Customize the web view once you have gained access to the OLCS web site.

• After logging in, a personalized view of the Customer Support Home page 
displays. This view is based on the user's and company support entitlements.

http://www.alcatel-lucent.com/wps/portal/support
https://support.lucent.com/portal/olcsHome.do
https://support.lucent.com/portal/olcsHome.do
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Need Help while registering?

View an OLCS website

After you have logged into the OLCS web site, a personalized view of the Customer 
Support Home page is displayed. This view is based on the user's and company support 
entitlements.

To set Customer Support as the default, if it is the primary destination on the www.alcatel-
lucent.com website, click “Select default home page” on the left column. The “My 
Products” section provides you with quick navigation to the entitled products and also 
quick access to the CARES tool. While navigating through the various tools, you can 
establish bookmarks to certain tools, documents, or web pages (within OLCS) by clicking 
“Add to Bookmarks.”

The Customer Support home page can be customized by selecting “Customize page 
layout” and adjusting the fields to be displayed (uncheck the boxes to de-select those 
elements). These fields can be adjusted at any time. The changes take effect immediately.

There are two methods to find product information. Click “My Products” to choose a 
product, or click “Documentation” or “Downloads” to display a complete product listing. 
When the full product list is displayed, use the alphabetic listing (default) or the category 
list, whichever you prefer. Once a product is selected, a “Product Summary Page” is 
displayed, which describes all of the tools and features available for this product.

Important! If content has been posted, but contract entitlements do not allow access, 
then the following padlock icon is displayed:

Ask AL Knowledge base

The Ask AL web page can be accessed from the left column on the Customer Support 
homepage (unless you changed the view), from the “Technical Support” section in the 
center of the page, or from the “My Bookmarks” section (if it was added there). Once at 

From the U.S. 1 (866) 582 3688, prompt 7

From outside the U.S.  +1 (630) 218 7688

In Asia/Pacific Please contact the in-country technical 
support hotline.

Via email Use the email address: olcshelp@alcatel-
lucent.com or use the site's “Contact Us” 
form

Use the OLCS help desk number for OLCS access problems, registration 
questions, password resets, navigation questions, etc. 

http://ww.alcatel-lucent.com
http://ww.alcatel-lucent.com
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the Ask AL Knowledge base web page, enter a question or phrase using natural language, 
and click the check boxes for only the products that should be searched; otherwise, all 
products checked will be searched.

The results that return show a percentage weight or percent match based on the search 
criteria. To refine a search, add more details to the question or phrase and answer the other 
questions displayed. Once you find a solution of interest, select that solution, and the 
complete solution will display.

Many of the solutions are based on generated ARs or Known Problems from the SRD. To 
provide quality information, solutions go through a review process before being posted. 
Content can grow daily as solutions move through the review cycle. 

CARES

CARES ARs are accessed from the left column on the Customer Support homepage 
(unless this view was changed), under the “Technical Support” section in the center of the 
page, from the “My Bookmarks” section (if CARES was added there), or from the Quick 
Link section “CARES Assistance Requests,” at the bottom of the Customer Support 
homepage. Product Notifications and Solutions can also be selected in this section. These 
are both legacy tools. The new tools, Alcatel-Lucent Alerts and Ask AL Knowledge base, 
are discussed in other sections of this document.

When you select CARES, a general web page displays. From that page, a particular 
function can be selected from the left column. To provide more information on the 
selected tool, select “More” from the center column.

ARs can be viewed (using “Find an AR” or “Advanced query”), created (using “Create an 
AR”), or used to report a warranty defect (using “Report a warranty defect”). The CARES 
web interface has features that keep you informed about the progress of ARs. With the 
flexible AR Notification subscriptions, CARES can email or send text messages on a 
variety of activities regarding an AR. A notification is sent when the AR state is changed 
to Created, Resolved, Closed, or Pending Customer Action. Other conditions that generate 
notifications are if the following fields are updated: Investigation, Short Description, 
Current Summary, Description, and Resolution. You can set up (subscribe), remove 
(unsubscribe), or change these conditions at any time.

Data Drop Box

You can access the Data Drop Box from the left column on the Customer Support 
homepage (unless your view was changed), from the “Technical Support” menu in the 
center of the page, or from the “My Bookmarks” section (if Data Drop Box has been 
added there). Click the “Upload a file” button in the Data Drop Box window to send a file 
to the Alcatel-Lucent support technician. An email address can also be entered so that the 
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Alcatel-Lucent technician will be notified when the file has been sent. Click the 
“Download a file” button from the Data Drop Box if the Alcatel-Lucent technician has 
sent a file to be downloaded. These files will remain on the site for 7 days.

Documentation

You can access documentation by selecting a product from the “My Products” area. 
Alternatively, documentation can also be accessed from the left column on the Customer 
Support home page (unless this view has been changed), from the “Technical Support” 
section in the center of the page, or from the “My Bookmarks” section (if Documentation 
has been added there). If accessing Documentation by means other than the “My 
Products” area, choose the product whose documentation you wish to access by selecting 
the product from the alphabetical listing or the category list.

Once you are on the product web page, select “Manuals and Guides” from the list under 
the “Documentation and downloads” section. The “Manuals and Guides” link brings you 
to the Library of Manuals and Guides for the product you have chosen. The document 
links bring you to the document stored in the Alcatel-Lucent Customer Information Center 
(CIC) web site or to another OLCS webpage that contains the product documentation.

Within the “Documentation and Downloads” area, the “Technical Notes” link brings you 
to a web page which contains documents that are not release specific and are technical in 
nature.

Also, within the “Documentation and Downloads” area, the Release Information link 
brings you to a Library of Release Notes web page that contains documents which are 
release specific and are listed by release.

Click on these links to download or open a PDF file. 

Downloads

Important! This may not apply to all products.

You can access downloads by selecting a product from the “My Products” section. 
Downloads can also be accessed from the left column on the Customer Support homepage 
(unless this view has been changed), from the “Technical Support” section in the center of 
the page, or from the “My Bookmarks” section (if Downloads was added there). If 
accessing Downloads by means other than the “My Products” area, choose the product 
whose Downloads you wish to access by selecting the product from the alphabetical 
listing or the category list.

Once you are on the product web page, click the “Downloads: Electronic Delivery” link 
from the list under the “Documentation and Downloads” area. Select the appropriate 
release to be downloaded from the drop-down list, and click “Next.” Select the file to be 
downloaded and click “Next.” On the next web page, enter the path where the file should 
be downloaded and click “Download.”
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Alcatel-Lucent Alerts

You can access Alcatel-Lucent Alerts from the left column on the Customer Support 
homepage (unless this view has been changed), from the “Technical Support” section in 
the center of the page, or from the “My Bookmarks” section (if Alcatel-Lucent Alerts is 
added there).

Once you are on the Alcatel-Lucent Alerts web page, a list of products are displayed. 
Click on a product to see a list of Alerts for that product. Alternatively, use the “Enter the 
number of the Alert” field to find a specific Alert, or use the text search to search for 
Alerts with certain words.

To subscribe to Alcatel-Lucent Alerts, click the “Alerts Subscription Page” link. Once at 
the “Alcatel-Lucent Alerts Subscription” page, fill out the form and choose the product 
whose alerts you would like to subscribe to.

You have the option to click “Modify Subscription” or “Cancel Subscription.” Modify 
Subscription allows you to modify the Urgency, Type, and/or Products selected. “Cancel 
Subscription” will stop future Alcatel-Lucent Alerts email messages.

Product Change Notices (PCNs)

You can access Product Change Notices (PCNs) from the left column on the Customer 
Support home page (unless this view has been changed), from the “Technical Support” 
section in the center of the page, or from the “My Bookmarks” section (if PCNs were 
added there).

Once on the PCN web page, a list of PCNs is displayed. You can search PCNs by clicking 
one of the following links:

• PCN cross-reference

• Search for specific text in Class A PCNs

• PCNs added or updated within the past 30 day

• Change Notice summary report

Return Material Authorization (RMA) (Repair and Exchange)

Important! This may not apply to all products.

Return Material Authorization (RMA) can be accessed from the left column on the 
Customer Support home page (unless this view has been changed), from the “Technical 
Support” section in the center of the page, or from the “My Bookmarks” section (if it was 
added there).
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Once on the RMA web page, a table with contact information is displayed. Use the contact 
information provided or choose to fill in the online RMA request form at the bottom of 
that web page. 
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Other technical support services

The technical support services expert workshop series

Audience: Technicians, installers, maintenance engineers, technical support personnel, 
product evaluators, and anyone who has a working knowledge of the products involved 
and is interested in a hands-on workshop covering advanced troubleshooting issues.

Description: The same engineers that resolve the Assistance Requests (ARs) have 
developed a series of advanced, hands-on workshops that can be customized to the unique 
network applications. Individual product modules will provide the knowledge and skills to 
perform troubleshooting and fault-finding activities at the equipment site or from a remote 
operations center. There are lab exercises using Alcatel-Lucent network management 
systems to simulate real-world provisioning and troubleshooting scenarios. In addition, 
general technology modules will round out the understanding of the network element (NE) 
troubleshooting performed.

Objectives: Each module has specific objectives. Some overall series objectives are listed 
below:

• Understand advanced network element security features

• Setup and understand interworking between Alcatel-Lucent network elements

• Perform provisioning operations and remote trouble-shooting using CIT, EMS and 
TL1 interfaces.

• Analyze Performance Monitoring Data

• Understand alarm handling / alarm management

• Provision and understand system synchronization techniques

• Provision and understand protection schemes (BLSR, UPSR, 1+1 APS)

• Understand network communication issues (OSI and TCP/IP interfacing)

Length: Product Modules are scheduled for 3 days. Technology Modules are scheduled 
for 1 day.

Expected Foundation Knowledge: Suggested prerequisites are listed on each module's 
workshop description. Generally, customers should have a basic understanding of digital 
fundamentals and lightwave transmission systems. In addition, customers should have 
taken a previous Alcatel-Lucent Operating & Maintenance course or have equivalent 
experience with operations and maintenance issues related to the product
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Activities Prior to Workshop Delivery: The effectiveness of this workshop series relies 
on the fact that it allows a customer to address the issues experienced in their network 
today. To achieve this, prior to the workshop, a conference call will be set up with the 
engineers that will facilitate the workshop. During this call, the logistics of simulating the 
customer's network environment will be discussed.

Workshop Location: This workshop will be delivered in the Customer Advocate System 
Test Labs in Westford, MA. The format is 75% hands-on lab exercises, reinforced with 
25% classroom instruction.

How to Sign Up:

To enroll in the training course:

• Within the United States,

– Visit https://training.lucent.com

– Call 1 (888) 582 3688: Prompt 2.

• Outside the continental United States,

– Visit https://training.lucent.com

– Contact your in-country training representative

– Call: +1 (407) 767 2798

– Fax: +1 (407)767 2677

• Enter “Advanced Workshops” in the search menu and click “Go.”

• Choose which Advanced Maintenance Workshop you’d like to register for by clicking 
on the link.

• Read the workshop description(s) and follow the links to register.

https://training.lucent.com/Saba/Web/Main
https://training.lucent.com/Saba/Web/Main
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Acronyms and abbreviations

A ABN
Abnormal (status condition)

ACO
Alarm Cutoff

ACO/SW
Alarm Cutoff and Test

ADM
Add/Drop Multiplexer

AGNE
Alarm Gateway Network Element

AIS
Alarm Indication Signal

AMI
Alternate Mark Inversion

ANSI
American National Standards Institute

APS
Automatic Protection Switch

ARM
Access Resource Manager

AS&C
Alarm, Status, and Control

ASCII
American Standard Code for Information Interchange
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ASN.1
Abstract Syntax Notation 1

ASNE
Alarm Server Network Element

ATM
Asynchronous Transfer Mode

Auto
Automatic

AUXCTL
Auxiliary Control

B B3ZS
Bipolar 3-Zero Substitution

B8ZS
Bipolar 8-Zero Substitution

BDFB
Battery Distribution and Fuse Bay

BER
Bit Error Ratio

BIP
Bit Interleaved Parity

BITS
Building Integrated Timing Supply

BRI
Basic Rate Interface

C CC
Clear Channel

CCITT
International Telephone and Telegraph Consultative Committee

CEV
Controlled Environment Vault

CD-ROM
Compact Disk, Read-Only Memory

CDTU
Channel and Drop Test Unit
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CIT
Craft Interface Terminal

CLF
Carrier Line Failure Status

CLK
Clock

CMISE
Common Management Information Service Element

CMOS
Complementary Metal Oxide Semiconductor

CMTS
Cable Modem Termination System

CO
Central Office

CP
Circuit Pack

CPE
Customer Premises Equipment

CR
Critical (alarm status)

CSA
Carrier Serving Area

CSU
Channel Service Unit

CS&O
Customer Support and Operations

CV
Coding Violation

CVFE
Coding Violation Far End

D DCC
Data Communications Channel

DCE
Data Communications Equipment

DEMUX
Demultiplexer
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DLC
Digital Loop Carrier

DPLL
Digital Phase-Locked Loop

DRI
Dual Ring Interworking

DS1
Digital Signal Level 1

DS3
Digital Signal Level 3

DSLAM
Digital Subscriber Line Access Multiplexer

DSNE
Directory Services Network Element

DSX
Digital Cross-Connect Panel

DT
Distant Terminal

DTE
Data Terminating Equipment

E EC-1
Electrical Carrier Level 1

ECI
Equipment Catalog Item

EEPROM
Electrically-Erasable Programmable Read-Only Memory

EIA
Electronic Industries Association

EMC
Electromagnetic Compatibility

EMI
Electromagnetic Interference

EOOF
Excessive Out of Frame

EPROM
Erasable Programmable Read-Only Memory
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EQ
Equipped (memory administrative state)

ES
Errored Seconds

ESD
Electrostatic Discharge

ESF
Extended Super Frame

EST
Environmental Stress Testing

F FCC
Federal Communications Commission

FDDI
Fiber Distribution Data Interface

FE
Far End

FE ACTY
Far End Activity

FEBE
Far End Block Error

FE ID
Far End Identification

FEPROM
Flash EPROM

FERF
Far End Receive Failure

FE SEL
Far End Select

FIT
Failures in 109 hours of operation.

G GbE
Gigabit Ethernet

GNE
Gateway Network Element
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GR
Telcordia Technologies General Requirement

GTP
General Telemetry Processor

GTSIP
Global Technical Support Information Platform

GUI
Graphical User Interface

H HECI
Humans Equipment Catalog Item

I IC
Internal Clock

ID
Identifier

IEC
International Electrotechnology Commission

IMF
Infant Mortality Factor

INC
Incoming Status

I/O
Input/Output

IP
Internet Protocol

IR
Intermediate Reach

IS
In Service

ISCI
Intershelf control Interface

ISI
Intershelf Interface

ISDN
Integrated Services Digital Network



............................................................................................................................................................................................................................................................

G L - 7365-372-304R7.1
Issue 1, November 2007

............................................................................................................................................................................................................................................................

............................................................................................................................................................................................................................................................

ISO
International Standards Organization

ISP
Internet Service Provider

IVHS
Intelligent Vehicle Highway System

L LAN
Local Area Network

LAPD
Link Access Procedure "D"

LBO
Line Build Out

LCN
Local Communications Network

LEC
Local Exchange Carrier

LED
Light-Emitting Diode

LOF
Loss of Frame

LOP
Loss of Pointer

LOS
Loss of Signal

LR
Long Reach

LS
Low Speed

M MD
Mediation Device

MJ
Major Alarm

MM
Multimode
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MML
huMan-Machine Language 

MN
Minor Alarm

MPEG
Moving Picture Experts Group

MSDT
Multi-Services Distant Terminal

MTBF
Mean Time Between Failures

MTBMA
Mean Time Between Maintenance Activities

Mult
Multipling

MUX
Multiplex

MXBIU
Multiplexer and Backplane Interface Unit

N NE
Near End

NE
Network Element

NE ACTY
Near-End Activity

NEBS
Network Equipment-Building System

nm
Nanometer (10-9 meters)

NMA
Network Monitoring and Analysis

NMON
Not Monitored (provisioning state)

NRZ
Nonreturn to Zero

NNI
Network-Network Interface
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NSA
Not Service Affecting

NSAP
Network Services Access Point

NTF
No Trouble Found

O OAM&P
Operations, Administration, Maintenance, and Provisioning

OC-1
Optical Carrier Level 1 Signal (51.84 Mb/s)

OC-3
Optical Carrier Level 3 Signal (155 Mb/s)

OC-12
Optical Carrier Level 12 Signal (622 Mb/s)

OC-48
Optical Carrier Level 48 Signal

OLIU
Optical Line Interface Unit

OOF
Out of Frame

OOL
Out of Lock

OPS/INE
Operations System/Intelligent Network Element

OS
Operations System

OSGNE
Operations System Gateway Network Element

OSI
Open Systems Interconnection

OSMINE
Operations Systems Modifications for the Integration of Network Elements

OSP
Outside Plant
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P P-bit
Performance Bit

PC
Personal Computer

PCU
Power Conversion Unit

PID
Program Identification

PINFET
Positive Intrinsic Negative Field Effect Transistor

PJC
Pointer Justification Count

PLL
Phase-Locked Loop

PM
Performance Monitoring

PMN
Power Minor Alarm

POH
Path Overhead

POP
Points of Presence

POTS
Plain Old Telephone Service

PRM
Performance Report Message

PROTN
Protection

PRS
Primary Reference Source

PSU
Power Supply Unit

PTM
Pluggable Transmission Module

PVC
Permanent Virtual Circuit
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PWR
Power

R RAM
Random Access Memory

RPP
Reliability Prediction Procedure (described in Telcordia Technologies TR-NWT-00032)

RT
Remote Terminal

NARTAC
Lucent Regional Technical Assistance Center (1-866-LUCENT8)

RZ
Return to Zero

S SA
Service Affecting

SCADA
Supervisory Control and Data Acquisition

SD
Signal Degrade

SDH
Synchronous Digital Hierarchy

SEFS
Severely Errored Frame Seconds

SEO
Single-Ended Operations

SES
Severely Errored Seconds

SF
Super Frame (format for DS1 signal)

SFP
Small Form Pluggable

SID
System Identification

SLA
Service Level Agreements
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SLIM
Subscriber Loop Interface Module

SM
Single Mode

SONET
Synchronous Optical NETwork

SPE
Synchronous Payload Envelope

SQU
Sync Quality Unknown

SRD
Software Release Description

STS, STS-n
Synchronous Transport Signal

STM
Synchronous Transfer Mode

STS-1 SPE
STS-1 Synchronous Payload Envelope

STS-3c
Synchronous Transport Level 3 Concatenated Signal

STS-12c
Synchronous Transport Level 12 Concatenated Signal

SYSCTL
System Controller (circuit pack)

T T1X1 and T1M1
The ANSI committees responsible for telecommunications standards

TA
Telcordia Technologies Technical Advisory

TABS
Telemetry Asynchronous Byte Serial (Protocol)

TARP
Target ID Address Resolution Protocol

TCA
Threshold-Crossing Alert

TCP/IP
Transmission Control Protocol/Internet Protocol
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TCVCXO
Termperature-Compensated Voltage-Controlled Crystal Oscillator

TDM
Time Division Multiplexing

TID
Target Identifier

TL1
Transaction Language 1

TLB
Timing Looped Back

TOP
Task Oriented Practice

TR
Telcordia Technologies Technical Requirement

TSA
Time Slot Assignment

TSI
Time Slot Interchange

TSO
Technical Support Organization

U UAS
Unavailable Seconds

UNI
User Network Interface

UOC
Universal Optical Connector

UPD/INIT
Update/Intialize

UPSR
Unidirectional Path Switched Rings

V VF
Voice Frequency

VLAN
Virtual Local Area Network
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VLSI
Very Large Scale Integration

VM
Violation Monitor

VMR
Violation Monitor and Removal

VoIP
Voice over Internet Protocol

VONU
Virtual Optical Network Unit

VPN
Virtual Private Network

VT
Virtual Tributary

VT1.5
Virtual Tributary 1.5 (1.728 Mb/s)

VT-G
Virtual Tributary Group

W WAN
Wide Area Network
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Terms and definitions

0x1
See Ring (0x1) Low-Speed Interface.

1+1
The 1+1 protection switching architecture protects against failures of the optical transmit/receive equipment 
and their connecting fiber facility. One bidirectional interface (two fibers plus associated OLIUs on each 
end) is designated "service," and the other is designated "protection." In each direction, identical signals are 
transmitted on the service and protection lines ("dual-fed"). The receiving equipment monitors the incoming 
service and protection lines independently, and selects traffic from one line (the "active" line) based on 
performance criteria and technician/OS control. In 1+1 both service and protection lines could be active at 
the same time (service in one direction, protection in the other).

1xN, 1x1
1xN protection switching pertains to circuit pack protection that provides a redundant signal path through 
the DMX 2.5G Multiplexer (it does not cover protection switching of an optical facility; se "1+1"). In 1xN 
switching, a group of N service circuit packs share a single spare protection circuit pack. 1x1 is a special 
case of 1xN, with N=1. In 1x1 only one is active at a time. 

A Active
Active identifies a 1+1 protected OC-N line which is currently selected by the receiver at either end as the 
payload carrying signal or a 1x1 or 1xN protected circuit pack that is currently carrying service. (See 
Standby).

AGNE  -  Alarm Gateway Network Element
A defined NE in an alarm group through which members of the alarm group exchange information.

AIS  -  Alarm Indication Signal
A code transmitted downstream in a digital network that shows that an upstream failure has been detected 
and alarmed. 

AMI  -  Alternate Mark Inversion
A line code that employs a ternary signal to convey binary digits, in which successive binary ones are 
represented by signal elements that are normally of alternating, positive and negative polarity but equal in 
amplitude, and in which binary zeros are represented by signal elements that have zero amplitude.

ASCII  -  American Standard Code for Information Interchange 
A standard 8-bit code used for exchanging information among data processing systems and associated 
equipment.

Auto
One possible state of a service interface port. In this state, the port will automatically be put "in service" if 
a good incoming signal is detected on the port.
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Automatic Protection Switch
A feature that allows another synchronization source to be automatically selected and the synchronization 
source provisioning to be automatically reconfigured in the event of a synchronization source failure or 
network synchronization change, for example, a fiber cut.

Available Time
In performance monitoring, the 1-second intervals.

B B3ZS  -  Bipolar 3-Zero Substitution
A line coding method that replaces a string of three zeros with a sequence of symbols having some special 
characteristic.

B8ZS  -  Bipolar 8-Zero Substitution
A line coding method that replaces a string of eight zeros with a sequence of symbols having some special 
characteristic.

Backbone Ring
A host ring.

BER  -  Bit Error Ratio
The ratio of bits received in error to the total bits sent.

BIP  -  Bit Interleaved Parity 
A method of error monitoring over a specified number of bits, that is BIP-3 or BIP-8.

BITS  -  Building Integrated Timing Supply 
A single clock that provides all the DS1 and DS0 synchronization references required by clocks in a 
building.

Broadband
Any communications channel with greater bandwidth than a voice channel; sometimes used synonomously 
with wideband.  Also refers to signals at the DS3 (44.736 Mb/s) and higher.  Wideband refers to lower rates 
(i.e. DS1, VT1.5, etc.).

C CC  -  Clear Channel
A provisionable mode for the DS3 output that causes parity violations not to be monitored or corrected 
before the DS3 signal is encoded.

CCITT  -  International Telephone and Telegraph Consultative Committee
An international advisory committee under United Nations’ sponsorship that has composed and 
recommended for adoption worldwide standards for international communications. Recently changed to the 
International Telecommunications Union Telecommunications Standards Sector (ITU-TSS).

Channel
A logical signal within a port. For example, for an EC-1 port, there is one STS-1 channel and sometimes 28 
VT1.5 channels. See Port.
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Channel State Provisioning
A feature that allows a user to suppress reporting of alarms and events during provisioning by supporting 
multiple states (automatic, in-service and not monitored) for VT1.5 and STS-1 channels. See Port State 
Provisioning.

CV  -  Coding Violation
A performance monitoring parameter.

CVFE  -  Coding Violation Far-End
An indication returned to the transmitting terminal that an errored block has been detected at the receiving 
terminal.

D DACS III-2000
Digital Access and Cross-Connect System that provides clear channel switching at either the DS3 or the 
STS-1 rates, eliminating the need for manual DSXs.

DACS IV-2000
Digital Access and Cross-Connect System that provides electronic DS3/STS-1 or DS1/VT1.5 cross-connect 
capability, eliminating the need for manual DSXs.

DCC  -  Data Communications Channel
The embedded overhead communications channel in the SONET line. It is used for end-to-end 
communications and maintenance. It carries alarm, control, and status information between network 
elements in a SONET network.

DCE  -  Data Communications Equipment
In a data station, the equipment that provides the signal conversion and coding between the data terminal 
equipment (DTE) and the line. The DCE may be separate equipment or an integral part of the DTE or of 
intermediate equipment. A DCE may perform other functions usually performed at the network end of the 
line.

DDM-2000
Lucent’s first generation SONET multiplexers that multiplex DS1, DS3, or EC-1 inputs into EC-1, OC-1, 
OC-3, or OC-12 outputs. 

Default Provisioning
The parameter values that are preprogrammed as shipped from the factory.

Demultiplexing
A process applied to a multiplexed signal for recovering signals combined within it and for restoring the 
distinct individual channels of these signals.

DEMUX  -  Demultiplexer
The DEMUX direction is from the fiber toward the DSX.

Digital Multiplexer
Equipment that combines time-division multiplexing several digital signals into a single composite digital 
signal. 
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DRI  -  Dual Ring Interworking
Two ring networks interconnected at two common nodes.

Drop and Continue
A technique that allows redundant signal appearances at two central offices in a DRI network, allowing 
protection against central office failures.

DS1
Digital Signal Level 1 (1.544 Mb/s).

DS1(28) Circuit Pack
The DS1(28) circuit pack interfaces to the DSX-1 panel.

DS3
Digital Signal Level 3 (44.736 Mb/s).

DS3/EC-1 Circuit Pack
The DS3/EC-1 circuit pack interfaces to the DSX-3 panel.

DSn  -  Digital Signal Rate n
One of the possible digital signal rates at DMX 2.5G Multiplexer interfaces:  DS1 (1.544 Mb/s) or DS3 
(44.736 Mb/s).

DSNE  -  Directory Services Network Element
A designated network element that is responsible for administering a database that maps network element 
names (TIDs) to addresses (NSAPs - network service access points) in an OSI subnetwork. There can be 
one DSNE per ring. Can also be a GNE.

DSX  -  Digital Cross-Connect Panel
A panel designed to interconnect to equipment that operates at a designated rate. For example, a DSX-3 
interconnects equipment operating at the DS3 rate.

DTE  -  Data Terminating Equipment
That part of a data station that serves as a data source (originates data for transmission), a data sink (accepts 
transmitted data), or both.

Dual Homing
A network topology in which two DMXs serve as hosts supporting up to 16 OC-3 rings or 4 OC-12 rings. 
Each OC-3 and OC-12 ring is interconnected between the two separate hosts.

E EC-1, EC-n  -  Electrical Carrier
The basic logical building block signal with a rate of 51.840 Mb/s for an EC-1 signal and a rate of n times 
51.840 Mb/s for an EC-n signal. An EC-1 signal can be built in two ways: A DS1 can be mapped into a 
VT1.5 signal and 28 VT1.5 signals multiplexed into an EC-1 (VT1.5 based EC-1), or a DS3 can be mapped 
directly into an EC-1 (DS3 based EC-1).

ECI  -  Equipment Catalog Item
The bar code number on the faceplate of each circuit pack used by some inventory systems.

ES  -  Errored Seconds
A performance monitoring parameter. 
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ESF  -  Extended Super Frame
The format for a DS1 signal.

F FE  -  Far End
Any other network element in a maintenance subnetwork other than the one the user is at or working on. 
Also called remote.

FE ACTY  -  Far End Activity
An LED on the SYSCTL circuit pack faceplate.

FEBE  -  Far End Block Error
An indication returned to the near-end transmitting node that an errored block has been detected at the far 
end.

FEPROM  -  Flash EPROM
Nonvolatile Electrically-erasable Programmable Read-Only Memory.

FERF  -  Far End Receive Failure
An indication returned to the transmitting terminal that the receiving terminal has detected an incoming 
section failure.

FE SEL  -  Far End Select
An LED on the faceplate of the SYSCTL circuit pack.

FIT
Failures in 109 hours of operation.

Free Running
An operating condition of a clock in which its local oscillator is not locked to an internal synchronization 
reference and is using no storage techniques to sustain its accuracy.

FT-2000
Lucent’s SONET OC-48 Lightwave System.

Function Unit
Refers to any one of a number of different circuit packs that can reside in the A, B, C, or D function unit 
slots on the DMX 2.5G Multiplexer.

G GNE  -  Gateway Network Element
A network element that has an active X.25 link. Can also be a DSNE.

H Hairpin Routing
A cross-connection between function units (inter-function unit). For example, function unit C to function 
untis A, B, or D. Also, a cross-connection within the same function unit (intra-function unit). Cross-
connections go through Main, but no bandwidth or time slots are taken from the backbone ring. Eliminates 
need for another shelf.
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Holdover
An operating condition of a network element in which its local oscillator is not locked to any 
synchronization reference but is using storage techniques to maintain its accuracy with respect to the last 
known frequency comparison with a synchronization reference.

I IC  -  Internal Clock
Used in synchronization messaging.

ID
See shelf ID and site ID.

IR  -  Intermediate Reach
A term used to describe distances of 15 to 40 km between optical transmitter and receiver without 
regeneration. See long reach.

IS  -  In Service
One possible state of a DS1, DS3,  or EC-1 port. Other possible states are "auto" (automatic) and "nmon" 
(not monitored).

J Jitter
Timing jitter is defined as short-term variations of the significant instants of a digital signal from their ideal 
positions in time.

L LBO  -  Line Build Out
An equalizer network between the DMX 2.5G Multiplexer and the DSX panel. It guarantees the proper 
signal level and shape at the DSX panel.

LED  -  Light Emitting Diode
Used on a circuit pack faceplate to show failure (red) or service state. It is also used to show the alarm and 
status condition of the system.

Line Timing
The capability to directly derive clock timing from an incoming OC-N signal while providing theuser the 
capability to provision whether switching to an alternate OC-N from a different source (as opposed to 
entering holdover) will occur if the OC-N currently used as the timing reference for that NE becomes 
unsuitable as a reference. For example, intermediate nodes in a linear network are line timed. See Loop 
Timing.

Local
See Near-End.

Locked Cross-Connection
This is a variation of the ring cross-connection that allows the user to lock the path selector to a specified 
rotation of the ring. Any signal received from the other rotation of the ring is ignored.

LOF  -  Loss of Frame
A failure to synchronize to an incoming signal.
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Loop Timing
Loop timing is a special case of line timing. It applies to NEs that have only one OC-N interface. For 
example, terminating nodes in a linear network are loop timed. See Line Timing.

LOP  -  Loss of Pointer
A failure to extract good data from an STS-1 payload.

LOS  -  Loss of Signal
The complete absence of an incoming signal.

LR  -  Long Reach
A term used to describe distances of 40 km or more between optical transmitter and reciever without 
regeneration.  See Intermediate Reach.

M Main
The two slots (M-1 and M-2) on the DMX 2.5G Multiplexer shelf in which the OC-48 OLIU circuit packs 
are installed.

Midspan Meet
The capability to interface between two lightwave terminals of different vendors. This applies to high-speed 
optical interfaces.

Multiplexing
The process of combining several distinct digital signals into a single composite digital signal.

Mult  -  Multipling
The cascading of signals in a bay. In the MULT mode, the DS1 external reference can be cascaded to other 
shelves in a bay using Mult cables. Normally starting with the bottom shelf (Number 1) and working 
towards the top of the bay.

N NE  -  Near End
The network element the user is at or working on.  Also called local.

NE  -  Network Element
The basic building block of a telecommunications equipment within a telecommunication network that 
meets SONET standards. Typical internal attributes of a network element include: onr or more high- and 
low-speed transmission ports, built-in intelligence, synchronization and timing capability, and  access 
interfaces for use by technicians and/or operation systems. In addition, a network element may also include 
a time slot interchanger.

NE ACTY  -  Near End Activity
An LED on the faceplate of the SYSCTL circuit pack.

NMA  -  Network Monitoring and Analysis
An operations system designed by Telcordia Technologies which is used to monitor network facilities.

NMON  -  Not Monitored
A provisioning state for equipment that is not monitored or alarmed.
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Node
In SONET, a node is a line terminating element.

Non-Revertive
A protection switching mode in which, after a protection switch occurs, the equipment remains in its current 
configuration after any failure conditions that caused a protection switch to occur clear or after any external 
switch commands are reset. See Revertive.

NSAP  -  Network Services Access Point
An address that identifies a network element.  Used for maintenance subnetwork communication using the 
OSI protocol.

O OC, OC-n  -  Optical Carrier
The optical signal that results from an optical inversion of an STS signal; that is, OC-1 from STS-1 and OC-
n from STS-n.

OC-1
Optical Carrier Level 1 Signal (51.844 Mb/s).

OC-3
Optical Carrier Level 3 Signal (155 Mb/s).

OC-3c (STS-3c)
Optical Carrier Level 3 Concatenated Signal. Low-speed broadband equivalent to three STS-1s linked 
together with a single path overhead.

OC-12
Optical Carrier Level 12 Signal (622 Mb/s).

OC-12c (STS-12c)
Optical Carrier Level 12 Concatenated Signal. High-speed broadband equivalent to twelve STS-1s linked 
together with a single path overhead.

OC-48
Optical Carrier Level 48 Signal.

Operations Interface
Any interface that provides information on the system performance or control. These include the equipment 
LEDs, SYSCTL faceplate, and office alarms.

OS  -  Operations System
A central computer-based system used to provide operations, administration, and maintenance functions.

OSI  -  Open Systems Interconnection
Referring to the OSI reference model, a logical structure for network operations standardized by the 
Internation Standards Organization (ISO).

OSGNE  -  Operations System Gateway Network Element
An OSGNE serves as a single interface to the OS for NEs in the same subnetwork using X.25 interfaces.
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P Pass Through
Paths that are cross-connected directly across an intermediate node in a ring network.

Plesiochronous Network
A network that contains multiple maintenance subnetworks, each internally synchronous and all operating 
at the same nominal frequency, but whose timing may be slightly different at any particular instant. For 
example, in SONET networks, each timing traceable to their own Stratum 1 clock are considered 
plesiochronous with respect to each other.

PM  -  Performance Monitoring
Measures the quality of service and identifies degrading or marginally operating systems (before an alarm 
would be generated).

Port
The physical, electrical, or optical interface on a system. For example, DS1, DS3, EC-1, OC-3, OC-12, and 
OC-48. See Channel.

Port State Provisioning
A feature that allows a user to supress alarm reporting and performance monitoring during provisioning by 
supporting multiple states (automatic, in-service, and not monitored) for low-speed ports. See Channel 
State Provisioning.

Proactive Maintenance
Refers to the process of detecting degrading conditions not severe enough to initiate protection switching or 
alarming, but indicative of an impending signal fail or signal degrade defect (for example, performance 
monitoring).

Protection Line
As defined by the SONET standard, the protection line is the pair of fibers (one transmit and one receive) 
that carry the SONET APS channel (K1 and K2 bytes in the SONET line overhead). On a DMX 2.5G 
Multiplexer, a protection line is a pair of fibers that terminate an OLIU circuit pack in the Main-2, A-2, B-
2, C-2, D-2, or G-2 slots. See Service Line.

Product Family 2000
Lucent’s first line of SONET standard network products providing total network solutions.

R Reactive Maintenance
Refers to decting defects/failures and clearing them.

Remote
See Far-End (FE).

Revertive
A protection switching mode in which, after a protection switch occurs, the equipment returns to the 
nominal configuration (that is, the service equipment is active, and the protection equipment is standby) 
after the clearing of any failure conditions that caused a protection switch to occur or after any external 
switch commands are reset. See Non-Revertive.



............................................................................................................................................................................................................................................................

G L - 2 4  365-372-304R7.1
Issue 1, November 2007

............................................................................................................................................................................................................................................................

Ring
A configuration of nodes comprised of network elements connected in a circular fashion. Under normal 
conditions, each node is interconnected with its neighbor and includes capacity for transmission in either 
direction between adjacent nodes. Path switched rings use a head-end bridge and tail-end switch. Line 
switched rings actively reroute traffic over a protection line. 

Ring (0x1) Low-Speed Interface
Formerly referred to as dual 0x1 or single 0x1. In ring applications, the DMX 2.5G Multiplexer may use a 
0x1 interface, meaning both fibers carry service, as opposed to a linear (1+1) low-speed interface where one 
fiber is used for service and other for protection. See 1+1.

RPP  -  Reliability Prediction Procedure
Described in Telcordia Technologies TR-NWT-00032.

RT  -  Remote Terminal
An unstaffed equipment enclosure that may have a controlled or uncontrolled environment.

S Self-Healing
Ring architecture in which two or more fibers are used to provide route diversity. Node failures only affect 
traffic dropped at the failed node.

SEO  -  Single-Ended Operations
The maintenance capability that provides remote access to all DMX 2.5G Multiplexer systems from a single 
location over the DCC.

Service Line
On a DMX 2.5G Multiplexer system, a service (or "working") line is a pair of fibers (one transmit and one 
receive) that terminate on an OLIU circuit pack in the Main-1, A-1, B-1, C-1, or D-1 slots. As defined by 
the SONET standard, the SONET APS channel is not defined on a service line. See Protection Line.

SES  -  Severely Errored Seconds
This performance monitoring parameter is a second in which a signal fail occurs, or more than a preset 
amount of coding violations (dependent on the type of signal) occurs.

SF  -  Super Frame
The format for DS1 signals.

Small Form Pluggable (SFP)Optics
SFP optics are used on the LNW37/45/49/70/73/74 packs. SFP optics are “pluggable" optics. This means 
that the circuit pack does not come equipped with optics. The customer orders the number and type of optics 
required at the time of installation. Additional optics can be ordered as new services are required. Thus 
DMX interface density is made scalable to meet the unique needs of each customer. The SFP optics also 
allow for some versatility in the span lengths and rates that can be covered by the same pack. The SFP optics 
adhere to Telcordia GR-253 and ITU G.957 standards.
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Single 0x1 Cross-Connection
In a dual-homed application, the DMX 2.5G Multiplexer uses a single 0x1 cross-connection to map the 
VT1.5 channels between the DDM-2000 FiberReach, OC-3 Multiplexer, or OC-12 Multiplexer and the 
DMX 2.5G Multiplexer rings. This single 0x1 architecture maps low speed to high speed on a specified ring 
rotation. The high speed to low speed drop is made on the same specified ring with no path switching. 
Protection is provided at the VT1.5 end points.

Single Homing
A network topoly in which a single DDM-2000 FiberReach, OC-3 Multiplexer, or OC-12 Multiplexer 
serves as a DMX 2.5G Multiplexer host supporting up to six OC-3 or OC-12 rings. 

Standby
Standby identifies a 1+1 protected OC-N line which is not currently selected by the receiver at either end as 
the payload carrying signal, or 1x1 or 1xN protected circuit pack that  is not currently carrying service. See 
Active.

Status
The indication of a short-term change in the system.

STS, STS-n  -  Synchronous Transport Signal
The basic building block signal with a rate of 51.840 Mb/s for an STS-1 signal and a rate of n times 51.840 
Mb/s for an STS-n signal.

STS-1 SPE  -  STS-1 Synchronous Payload Envelope
A 125-microsecond frame structure composed of STS path overhead and the STS-1 payload.

STS-3c  
Synchronous Transport Level 3 Concatenated Signal. See OC-3c.

Subnetwork
Group of SONET network elements that share a SONET data communications channel.

Synchronization Messaging
SONET synchronization messaging is used to communicate the quality of network timing, internal timing 
status, and timing states throughout a subnetwork.

SYSCTL  -  System Controller
The system controller circuit pack that provides overall administrative control of the terminal.

T T1X1 and T1M1
The ANSI committees responsible for telecommunications standards.

TCA  -  Threshold Crossing Alert
A condition set when a performance monitoring counter exceeds a user-selected threshold. A TCA does not 
generate an alarm but is available on demand through the CIT and causes a message to be sent to NMA via 
the X.25/TL1 interface.

TL1  -  Transaction Language 1
A Telcordia Technologies machine-to-machine communications language that is a subset of ITU-TSS, 
formerly CCITT’s, human-machine language.
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U UAS  -  Unavailable Seconds
In performance monitoring, the count of seconds in which a signal is declared failed or, in which, 10 
consecutively severely errored seconds (SES) occurred, until the time when 10 consecutive non-SES occur.

Unidirectional
A protection switching mode in which the system at each end of an optical span monitors both service and 
protection lines and independently chooses the best signal (unless overridden by an equipment failure or by 
an external request, such as a forced switch or lockout). In a system that uses unidirectional line switching, 
both the service and protection lines may be active simultaneously, with one line carrying traffic in one 
direction and other line carrying traffic in the other direction. For a 1+1 protection scheme the K1 and K2 
bytes in the SONET line overhead are used to convey to the far end which line the near-end receiver has 
chosen, so that an "active" indication may be made at the far end.

UOC  -  Univeral Optical Connector
Receptacles on the faceplate of some OLIUs that accept ST, SC, or FC connectors.

UPD/INIT
A push-button on the SYSCTL faceplate.

V VM  -  Violation Monitor
A mode of the DS3 circuit pack in which it will monitor but not remove P-bit parity violations on the DS3 
signal from the received fiber.

VMR  -  Violation Monitor and Removal
A mode of the DS3 circuit pack in which it will monitor and remove P-bit parity violations on the DS3 signal 
received from the fiber.

VT  -  Virtual Tributary
A structure designed for transport and switching of a sub-DS3 payload.

VT1.5
A 1.728 Mb/s virtual tributary.

VT-G  -  Virtual Tributary Group
A 9-row by 12-column SONET structure (108 bytes) that carries one or more VTs of the same size. Seven 
VT groups (756 bytes) are byte-interleaved within the VT-organized STS-1 synchronous payload envelope

Z Zero Code Suppression
A technique used to reduce the number of consecutive zeros in a line-codes signal (B3ZS for DS3 signals 
and B8ZS for DS1 signals).
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test equipment, 5-2, 6-2

10/100Base-T cables, 1-58

1000Base-T
optical fiber cables, 1-92, 

1-93, 1-94, 1-95

110/RJ45 punch down block, 
1-59

110/RJ45® punch down block, 
1-58

177E, 2-33

8OC, 2-17

A Accessible Emission Limits 
(AEL), A-9

Alarm Cut-Off (ACO), 5-6, 5-7

alarm panel, 1-79, 1-80

alarm reporting, 5-8

alarm status indications
user settable, 1-84

alarm(s)
critical (CR), 1-83, 5-5, 5-6, 

5-7

default delay time, 5-6

environmental, 1-84

fan shelf, 5-8, 6-12

LED, 5-8

major (MJ), 1-83, 5-5, 5-6

.............................................................................
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minor (MN), 1-83, 5-5, 5-6

office, 5-3, 5-6, 6-3

Alternate Mark Inversion (AMI), 
5-13

automatic protection switch, 5-8, 
6-12

B battery distribution fuse board 
(BDFB), 1-16, 1-21, 1-22, 
1-23, 1-24

bay frame ground, 6

bipolar 8 zero substitution 
(B8ZS), 5-13

BITS clock, 5-13

C cable(s)
10/100Base-T, 1-58

1000Base-T, 1-92, 1-94

1000Base-T optical fiber

optical fiber

1000Base-T, 1-93,
1-95

CIT, 3-2

CIT interface, 2-2, 4-3, 5-2, 
6-2

discrete cables, 1-84

DS1, 1-34, 1-36, 1-41, 1-54

DS1 color codes, 1-36

DS3/EC-1, 1-41, 1-54

DS3/EC-1 cable connections, 
1-44

environmental, 1-84

IAO LAN/TCP-IP, 1-64

miscellaneous discrete, 1-84

modem, 1-69, 1-70

OC-3, 1-90, 1-91

OC-48, 1-89

OC-48 optical fiber, 1-88

office alarm, 1-78, 1-79, 
1-80, 4-8

office alarm connections, 
1-82, 1-83

optical fiber, 1-89, 1-90, 
1-91, 1-92, 1-94

power, 1-21, 1-23

power cable, 2-3

SYNC, 1-74

SYNC cable connections, 
1-77

cabling
checklist, 1-4

power, 1-21

central office (CO), 1-78, 1-84

CIT
interface cable, 4-3, 5-2, 6-2

serial port, 1-96

software, 3-9

CIT Interface Cable, 1-5

CIT interface cable, 2-2, 5-2, 6-2
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CLETOP cleaning cassette, 1-4, 
B-3

coaxial wire stripper, 1-3

commands, 5-11, 6-14, 6-15

connectors
DB-15 pinouts, 1-7

DB-25 pinouts, 1-7

DB-62 pinouts, 1-7

DB-9 pinouts, 1-7

pinouts, 1-7

RJ-45 pinouts, 1-7

crimping tool, 1-3

critical alarm (CR), 1-83, 5-5, 
5-6, 5-7

cross-connect tests, 4-9

cross-connects, 4-9
VT1.5, 4-9

D DB-15 connector pinouts, 1-7

DB-25 connector pinouts, 1-7

DB-62 connector pinouts, 1-7

DB-9 connector pinouts, 1-7

discrete, 1-84

DS1
cable assemblies, 1-34, 1-36, 

1-41, 1-54

DS1 error rate test set, 1-3, 4-2, 
5-2, 6-2

DS1 timing reference, 1-76

DS3 error rate test set, 1-3, 4-2, 
5-2, 6-2

DS3/EC-1
cables, 1-41, 1-54

DSX, 1-34, 1-36, 1-41, 1-54, 4-9

DSX cabling, 4-9

E EIA-type bay frame
network bay frame

EIA-type, 1-4

...........................................................................

...........................................................................

...........................................................................

...........................................................................

...........................................................................

environmental alarm, 1-84

environmental discrete, 1-84, 
5-16, 5-17

ESD
damage, 5

electronic components, 5

jack, 1-3, 2-2, 4-2, 5-2, 6-2

wrist strap, 1-3, 2-2, 4-2, 
5-2, 5-4, 5-8, 6-2, 6-12, 5, 
6

Extended superframe (ESF), 
5-13

external buffer relay, 1-78

F fan alarm, 5-8, 6-12

FDA/CDRH, A-2
21 CFR 1040.10 and 

1040.11, A-2

FDA/CDRH regulations, A-9

fiber cleaning, B-1
acceptable criteria, B-10

function group, 5-6

function unit, 5-7, 6-15

G ground, 1-3, 1-4, 1-12, 1-13
bay frame, 6

I IAO LAN/TCP-IP
cabling, 1-64

IEC
60825-1, A-2

IEC requirements, A-9

J jumper(s)
optical fiber, 1-4, 4-2, 4-43, 

4-44, 4-45, 4-46, 4-47, 
4-48, 4-52, 5-2

L labels

...........................................................................
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laser safety, A-3

Laser, A-10

laser
classes, A-10

DMX optical specifications, 
A-10

product classifications, A-9

radiation, 5-3, 6-3

safety, A-2

laser radiaition, 1-92, 1-94

laser radiation, 1-88, 1-90, 1-92, 
1-94, 4-9, 5-8, 6-4, B-5

LBO, 1-4, 4-3, 5-2, C-2, C-3

LBO Table, 6-6

LC Block, C-3

LC-type connector port, C-2

LC-type fiber connectors, C-5

LED, 5-8, 6-12

LGX, 1-88, 1-90, 1-92, 1-94

line coding, 5-13

local equipment tests, 4-9

Luminex Stick port cleaners, 
1-5, B-3

M major alarm (MJ), 1-83, 5-5, 5-6

minor alarm (MN), 1-83, 5-5, 
5-6

miscellaneous discrete, 5-16, 
5-17

modem, 1-69, 5-19
cable, 5-19

modem cable, 1-70

mult office alarms, 1-80

multimeter, 1-3, 2-2, 5-2, 6-2

N network bay frame, 1-4
seismic, 1-4

Network Equipment Building 
System (NEBS), 5-4
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O OC, 2-16

OC-3
optical fiber cables, 1-90, 

1-91

OC-48
optical fiber cables, 1-88, 

1-89

office alarm, 1-78, 1-80, 5-3, 5-6, 
6-3

alarm(s)

office, 5-4

cable, 1-78, 5-4, 6-4

connections, 1-82, 1-83, 5-4

mult, 1-80

relay contacts, 1-78

test, 5-4

office alarm cable, 1-79, 1-80, 
4-8

office alarm panel, 1-79, 1-80

ohmmeter, 1-3, 1-4

optical attenuators, C-2

optical fiber scope, 1-4, B-3

out-of-service mode, 5-3, 6-3

P Personal Computer (PC), 5-2, 6-2
CIT requirements, 1-5, 2-2, 

3-1, 4-3

pinouts
connectors, 1-7

power
cables, 2-3

power cable, 1-21, 1-23

product disposal, xxii

product take-back, xxii

protection network, 1-79

protection switching, 5-1
automatic, 5-8, 6-12

R recycle, xxii

.............................................................................
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remote terminal (RT), 1-84

RJ-45 connector pinouts, 1-7

S safety
FDA/CDRH, 7

instructions, B-5

laser, A-2

laser instructions, A-4

laser warning labels, A-3

screwdriver(s), 1-2, 2-2, 4-2, 5-2, 
6-2

seismic network bay frame, 1-4

serial port, 1-96

single-mode fiber, 1-88

standards
Pacific Bell Equipment 

Framework Standard PBS-
000-102PT, 1-4

Superframe (SF), 5-13

SYNC cable, 1-74
cable(s)

SYNC, 1-72

SYNC cables
DS1 timing, 1-77

synchronization cable 
connections, 1-77

timing, 1-77

T technical support, H-1

telemetry, 1-84, 5-16
connections, 5-18

telemetry panel, 1-85

test equipment
CIT interface cable, 2-2

DS1 error rate test set, 1-3, 
4-2, 5-2, 6-2

DS3 error rate test set, 1-3, 
4-2, 5-2, 6-2

LBO, 5-2

multimeter, 1-3, 2-2
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ohmmeter, 1-3, 1-4

optical fiber jumpers, 1-4, 5-2

optical fiber scope, 1-4, B-3

Personal Computer (PC), 5-2, 
6-2

screwdrivers, 2-2

video fiber scope, 1-4, B-3

timing
DS1, 1-77

external sync, 1-76

tools
CLETOP cleaning cassette, 

1-4, B-3

coaxial wire stripper, 1-3

crimping, 1-3

Luminex Stick port cleaners, 
1-5, B-3

screwdriver(s), 1-2, 5-2, 6-2

screwdrivers, 4-2

torque wrench, 1-3, 1-4

wire-wrap gun, 1-3

torque wrench, 1-3, 1-4

transient currents, 1-78

transient voltages, 1-78

V video fiber scope, 1-4, B-3

VT1.5
cross-connects, 4-9

W wire-wrap gun, 1-3

wrist strap
ESD, 1-3, 2-2, 4-2, 5-2, 5-4, 

5-8, 6-2, 6-12, 5, 6



I N - 4  365-372-304R7.1
Issue 1, November 2007

Index

............................................................................................................................................................................................................................................................


	Title page
	Legal page
	Contents
	List of figures
	List of tables
	About this document
	Part I: 1665 Data Multiplexer (1665 DMX) physical installation and powering
	1 Equipment and cable installation for 1665 Data Multiplexer (1665 DMX)
	Planning
	Connector references
	Inspection
	1665 DMX High-Capacity shelf installation
	Heat baffle installation
	Power cable and cable bracket installation
	Fiber management installation (optional)
	Installing the fiber ducts (optional)
	Cable and optical fiber installation
	DS1 cable installation
	DS3/EC1 and 48TMUX cable installation
	12TMUX (LNW18) cable installation
	10/100BaseT backplane Ethernet cable installation
	Ethernet cabling to SFP modules on circuit pack faceplates
	IAO LAN and TCP/IP cable installation
	Modem cable installation
	Sync cable installation
	Office alarm cable installation
	Miscellaneous (environmental) discrete telemetry cable installation
	Main optical fiber installation (OC-12, OC-48, OC-192)
	Fiber installation for low-speed packs
	1000Base-F and 100Base-F fiber installation
	Fibre channel fiber installation
	CIT cable installation
	Final operations

	2 Powering and initial circuit pack installation for 1665 Data Multiplexer (1665 DMX)
	Description
	Powering
	Circuit pack compatibility
	Initial circuit pack installation


	Part II: 1665 Data Multiplexer (1665 DMX) stand-alone installation tests
	3 Software download and circuit pack installation
	Software installation
	Circuit pack installation
	Use of WaveStar® CIT software
	Circuit pack firmware version verification
	1665 DMX shelf initialization
	Provision/enable/disable TCP/IP on an IAO LAN port
	Reset system date and time
	Provision/Enable/disable the 1665 DMX as a TL1 TCP/IP GNE

	4 Installation tests
	LBO software settings
	Clearing alarms
	Local equipment and cross-connect tests
	DS1 protection switching
	DS1 cleanup procedures
	DS3/EC1 and TMUX testing procedure
	DS3 protection switching
	DS3 cleanup procedures
	LNW66, LNW71 and LNW74 (10/100T) TX Ethernet cabling testing
	OC-3 (LNW37, LNW45, LNW55)/OC-12 (LNW49, LNW55)/OC-48 (LNW55, LNW62) low-speed SFP test procedure
	OC-3 (low-speed) testing
	OC-12 (low-speed) testing
	OC-48 (low-speed) testing
	LED test
	Additional optical tests (optional)

	5 Operational tests
	Office alarm test
	Automatic protection switching and alarm test
	Manual switching tests
	External timing verification
	Miscellaneous (environmental) discrete telemetry test
	Modem connection test
	Final operations


	Part III: 1665 Data Multiplexer (1665 DMX) ring setup and testing
	6 Ring setup and testing: integration procedures
	Fiber installation
	Optical transmission test (OC-192, OC-48, OC-12)
	Automatic protection switching test
	Manual switching tests
	Final operations


	Part IV: 1665 Data Multiplexer (1665 DMX) supplementary information and installation checklist
	Appendix A: Laser safety and classifications and Electrostatic Discharge (ESD) considerations
	Laser safety
	Electrostatic Discharge ESD considerations
	Laser product classification
	1665 DMX optical specifications

	Appendix B: Fiber cleaning
	Equipment requirements and recommendations
	Safety instructions
	Cleaning/inspecting optical connectors
	Cleaning pluggable optics modules

	Appendix C: Installing fiber connectors and LBOs
	LBOs
	Fiber connections

	Appendix D: Backplane pin replacement
	Pin and connector background
	Repair kits and tools
	Simple repair methods
	Replacement methods

	Appendix E: Installation checklist
	Overview

	Appendix F: Fiber labeling
	Fiber description
	Fiber labels

	Appendix G: Pluggable transmission module installation
	Pluggable transmission modules
	Install pluggable transmission modules

	Appendix H: Technical support
	Technical assistance
	Accessing and navigating the On-Line Customer Support (OLCS) web site
	Other technical support services


	Glossary
	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.3
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


